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How to send your comments

Your feedback is important in helping to provide the most accurate and highest quality information.
» To send comments on articles in the WebSphere Application Server Information Center
1. Display the article in your Web browser and scroll to the end of the article.

2. Click on the Feedback link at the bottom of the article, and a separate window containing an e-mail
form appears.

3. Fill out the e-mail form as instructed, and click on Submit feedback .

* To send comments on PDF books, you can e-mail your comments to: wasdoc@us.ibm.com or fax
them to 919-254-5250.

Be sure to include the document name and number, the WebSphere Application Server version you are
using, and, if applicable, the specific page, table, or figure number on which you are commenting.

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the information
in any way it believes appropriate without incurring any obligation to you.
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Changes to serve you more quickly

Print sections directly from the information center navigation

PDF books are provided as a convenience format for easy printing, reading, and offline use. The
information center is the official delivery format for IBM WebSphere Application Server documentation. If
you use the PDF books primarily for convenient printing, it is now easier to print various parts of the
information center as needed, quickly and directly from the information center navigation tree.

To print a section of the information center navigation:

1. Hover your cursor over an entry in the information center navigation until the Open Quick Menu icon
is displayed beside the entry.

2. Right-click the icon to display a menu for printing or searching your selected section of the navigation
tree.

3. If you select Print this topic and subtopics from the menu, the selected section is launched in a
separate browser window as one HTML file. The HTML file includes each of the topics in the section,
with a table of contents at the top.

4. Print the HTML file.

For performance reasons, the number of topics you can print at one time is limited. You are notified if your
selection contains too many topics. If the current limit is too restrictive, use the feedback link to suggest a
preferable limit. The feedback link is available at the end of most information center pages.

Under construction!

The Information Development Team for IBM WebSphere Application Server is changing its PDF book
delivery strategy to respond better to user needs. The intention is to deliver the content to you in PDF
format more frequently. During a temporary transition phase, you might experience broken links. During
the transition phase, expect the following link behavior:

+ Links to Web addresses beginning with http:// work
» Links that refer to specific page numbers within the same PDF book work
* The remaining links will not work. You receive an error message when you click them

Thanks for your patience, in the short term, to facilitate the transition to more frequent PDF book updates.

© Copyright IBM Corp. 2008 ix
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Chapter 1. Overview and new features for developing and
deploying applications

Use the links provided in this topic to learn more about developing applications for deployment on this
product.

|What is new for developers|

This topic provides an overview of new and changed features of the programming model and
application serving environment as it pertains to development and test efforts.

[Learn about WebSphere applications: Overview and new features|

This topic provides an overview of the programming model.

IAccessing the Samples (Samples Gallery)

The Samples are a good way to become familiar with the programming model.

Assembly tools

WebSphere® Application Server supports assembly tools that you can use to develop, assemble, and
deploy Java™ Platform, Enterprise Edition (Java EE) modules.

The IBM® Rational® Application Developer for WebSphere Software product provides supported assembly
tools.

Although this information center refers to Rational developer products as the assembly tools, you can use
the products to do more than assemble modules. Rational Application Developer is an integrated
development environment that provides development, testing, assembly and deployment capabilities.
Rational Application Developer provides extensive online documentation. Topics on application assembly in
this information center supplement that documentation, focusing on assembling Java EE modules using
the Java EE Perspective of the assembly tools.

Rational Application Developer is available in the WebSphere Application Server disc package with two
licenses. The license for assembly and deployment capabilities does not expire. The license for
development and other capabilities is available on a Trial basis and is only available for a limited time.

The Trial download for Rational Application Developer is available at http://www.ibm.com/developerworks/
downloads/r/rad/.

Note: The assembly tools run on Windows® and Linux® Intel® platforms. Users of WebSphere Application
Server on all platforms must assemble their modules using an assembly tool installed on Windows
or Linux Intel platforms. To install an assembly tool, follow instructions available with the tool.

Enterprise (Java EE) applications

Enterprise applications (or Java EE applications) are applications that conform to the Java Platform,
Enterprise Edition (Java EE) specification. Prior to Java EE 5, the specification name was Java 2 Platform,
Enterprise Edition (J2EE). The term Java EE includes Java EE 5 and J2EE specifications.

Enterprise applications can consist of the following:

» Zero or more EJB modules (packaged in JAR files)

» Zero or more Web modules (packaged in WAR files)

» Zero or more connector modules (packaged in RAR files)

» Zero or more Session Initiation Protocol (SIP) modules (packaged in SAR files)
» Zero or more application client modules

© IBM Corporation 2003 1



» Additional JAR files containing dependent classes or other components required by the application
* Any combination of the above

A Java EE application is represented by, and packaged in, an enterprise archive (EAR) file.

System applications

A system application is a Java Platform, Enterprise Edition (Java EE) enterprise application that is central
to a WebSphere Application Server product.

Examples of system applications include isclite, managementEJB and filetransfer.

Because a system application is an important part of a WebSphere Application Server product, a system
application is deployed when the product is installed and is updated only through a product fix or upgrade.
For some system applications, such as filetransfer, users cannot change the metadata for the system
application, unless the metadata assigns users and groups for security purposes. For these applications,
non-security related metadata such as its Java EE bindings or extensions must be updated through a
product fix or upgrade.

System applications are not shown in the list of installed applications on the console |Enterprise
|Applications page} or through wsadmin and Java application programming interfaces, to prevent users
from accidentally stopping, updating or removing the system applications.

Note that Java EE Samples are not system applications even though they are provided as part of a
WebSphere Application Server product. Similarly, applications that support changes to their metadata are
not system applications.

Common deployment framework

The common deployment framework enables you to implement plug-ins that add steps to default Java
Platform, Enterprise Edition (Java EE) application management operations such as install, uninstall, edit
and update.

Using the framework, you can implement management operations on specific types of deployable
contents. For example, the deployable contents might include EAR, WAR, JAR or other Java EE modules
and the management operations might include install and uninstall. Each operation is divided into a
number of steps. For example, the install operation has steps for EJBDeploy and JavaServer Pages (JSP)
compilation, among others. Using the common deployment framework, you can add steps to the default
logic for Java EE operations.

The product supports framework plug-ins that extend deployment of EAR files. An EAR file has operations
such as createEarWrapper, installApplication, uninstallApplication and editApplication. Using a framework
plug-in, you can add steps to default install operations that support, for example, creating additional
configuration artifacts in a configuration session, modifying an input EAR file using code generation, or
additional validating of input parameters.

To extend application management operations using the framework, a plug-in must do the following:
* Implement each step.

A step runs logic that performs an operation. A step can access the deployment context and the
deployable object. The deployment context provides information such as the operation name, the
configuration session identifier, the temporary location for creating temporary files, operations
parameters, and the like. A step is added by the extension provider.

* Implement an extension provider that adds each implemented step.
An extension provider is a class that provides steps for an operation on a given type, the EAR file type.
* Register the plug-in with a WebSphere Application Server server.
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The plug-in is implemented as an Eclipse plug-in and is placed in|app_server_rool/plugins directory.
Add the extension point for the extension provider in the META-INF/pTugin.xm1 file within the plug-in JAR
file.

For an example of these steps, refer to[‘Extending application management operations through|
|programming” on page 155.|

Business-level applications

A business-level application is an administration model that provides the entire definition of an application
as it makes sense to the business. A business-level application is a WebSphere configuration artifact,
similar to a server or cluster, that is stored in the product configuration repository.

* [Business-level application characteristics|
+ [Comparisons to Java EE applications|

Business-level application characteristics

A business-level application has the following characteristics:

* A business-level application is an administration model of the definition of an enterprise-level application
that consists of WebSphere and non-WebSphere artifacts. The business-level application might not
explicitly manage the lifecycle of every artifact. It is a model for defining an application.

* A business-level application does not represent or contain application binary files. It is a configuration
that lists one or more composition units, which represent the application binary files. A business-level
application uses the binary files to run the application business logic. Administration of binary files is
separate from administration of the application definition.

* A business-level application supports recursive composition by reference that facilitates hierarchical
assembly of business-level applications and individual deployed artifacts within or outside a WebSphere
product. The composition at its lowest level consists of configured instances of application binary files
that run in a specific runtime environment such as an application server. Installable packages or
archives, such as Java archives (JAR) or enterprise archive (EAR) files, typically deliver the business
logic that these configured instances represent to corresponding runtime platforms.

The following diagram shows the composition model for business-level applications:

i
Composition Al
Application
Application
Configuration
»> : . :
EJB \ 4 .
module Y v
Library Web Enterprise
module application

Business Loglc .
Java
I|brary
EJB JAR

A business-level application does not introduce new programming, runtime, or packaging models:
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* You do not need to change your application business logic. The business-level application function does
not introduce new application programming interfaces (APIs).

* You do not need to change your application runtime settings. The product supports all of the runtime
characteristics, such as security, class loading and isolation, required by individual programming models
to which business components are written.

* You do not need to change your application packaging. There is no specific unique packaging model
that provides a business-level application definition.

Typically, you first create an empty business-level application and then add composition units to it. The
business-level application name must be unique within a cell. The business level application itself has
minimal configuration data associated with it, solely the list of composition units, but individual composition
units might save application-specific configuration data.

A business-level application is defined in the product configuration repository under|app_server_r004/cells/
cell_namelblas/business_level_application_name/bver/BASE/bla.xml.

Comparisons to Java EE applications

Business-level applications can consist of or aggregate Java Platform, Enterprise Edition (Java EE)
applications and modules with non-Java EE artifacts. The contents of Java EE applications integrate with
business-level application concepts for deployment and management of applications. Existing Java EE
application management APIs continue to work after you add Java EE application or modules to a
business-level application. The business-level application management APl accepts Java EE contents and
configurations and delegates to existing Java EE management APIs. Control operations such as starting
and stopping a Java EE composition unit are delegated to ApplicationManager MBean on application
servers that start and stop Java EE applications.

Table 1. Java EE concepts compared to business-level application concepts

Business-level application

Java EE concept concept Description

EAR or stand-alone Asset Java EE application contents are assets.

module for

deployment

Java EE application Composition unit A Java EE application is in an enterprise archive (EAR)

created at the end of file. The product saves the EAR file in the product

application install repository as a composition unit.

Java EE modules Deployable units in the asset Each module in the EAR file is a deployable unit that you

within the EAR file can install on independent deployment targets. The EAR
file is still managed as a single asset in its entirety.
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Table 1. Java EE concepts compared to business-level application concepts (continued)

Java EE concept

Business-level application
concept

Description

Java EE application
installation using the
administrative
console,
programming, or
wsadmin commands

Multiple business-level
application management
commands

During Java EE application
deployment, you can specify the
name of the business-level
application to include the Java
EE application. If the
business-level application name
is not set, the product creates a
default business-level
application with the same name
as the Java EE application
name. The product adds a
composition unit with the same
name as the Java EE
application name under the
business-level application. You
can deploy multiple Java EE
applications under a single
business-level application.

You can make a Java EE application a business-level
application and add it to another business-level application:

1. Install the Java EE application (EAR file) using the
enterprise application installation console wizard,
programming, or wsadmin. Keep the default selection
to create a business-level application that has the
same name as the Java EE application.

2. Create an empty business-level application.

3. Add the EAR file business-level application to the
empty business-level application. The EAR file
business-level application is a composition unit of the
containing business-level application.

Or, you can make a Java EE application an asset and add
it to another business-level application:

1. Import an EAR file as an asset. It has an asset type
aspect of Java EE ear.

2. Create an empty business-level application.

3. Add the Java EE application asset to the business-level
application. The EAR file asset is a composition unit of
the containing business-level application.

4. Collect targets for each deployable unit (Java EE
module).

Uninstall Java EE
application

Multiple business-level
application management
commands

You delete the Java EE application composition unit from
the business-level application:

1. Remove the composition unit for the Java EE
application from the business-level application.

2. If the EAR file is an asset, delete the asset.

Start the Java EE

Start the composition unit.

Starting a business-level application starts any Java EE

application. application in it.

Stop the Java EE Stop the composition unit. Stopping a business-level application stops any Java EE
application. application in it.

Assets

An asset represents one or more application binary files that are stored in an asset repository. Typical
assets include application business logic such as Java Platform, Enterprise Edition (Java EE) archives,
library files, and other resource files.

An asset repository stores the binary files for the asset. The product configuration repository provides a
default asset repository.

Assets in the configuration repository are managed by the product management domain. The configuration
repository stores asset binary files in|app_server_roofconfig/cells/cell_namelassets/asset_name/aver/

BASE/bin/.

An asset name must be unique within a cell, the product administrative domain.

The product creates an asset.xml file when an asset is registered with the product configuration. The file
contains information about the asset such as its name, destination location, and dependencies on other

assets.

Chapter 1. Overview and new features: Developing and deploying
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You must register files as assets before you can add them to one or more business-level applications. At
the time of asset registration, you can import the physical application files into the product configuration
repository or you can specify an external location where the asset resides.

EJB 3.0 deployment overview

Learn about the Enterprise JavaBeans (EJB) 3.0 deployment model, including to Just-In-Time (JIT)
deployment.

All Java Platform, Enterprise Edition (Java EE ) application server products have some form of EJB
deployment phase where your application is customized to run in that particular application server
implementation. Typically, this is accomplished by an application server-specific deployment tool, which
generates code to bridge your EJB interface and implementation code to the application server's EJB
container implementation. Some application server products’ deploy tools alter the bytecodes of your
application classes rather than using code generation, but the end result is similar.

In WebSphere Application Server, the bridging is accomplished by generating code that wraps your EJB
implementation classes, connecting them to the product EJB container, which in turn allows the EJB
container to host your enterprise beans and provide services to them. If one or more of your enterprise
beans has defined remote interfaces, additional code is generated to provide the remote function.

Historically, EJB deployment in the WebSphere product has been performed by the EJBDeploy tool that is
included with product and packaged with WebSphere product-oriented development tools.

The EJBDeploy tool introspects your EJB external interfaces, generates the wrapper code as .java files,
then compiles it using the javac compiler to produce .class files, which are then packaged in your EJB
module with your application code. The EJBDeploy tool also runs the rmic tool against the remote EJB
interfaces in the application, producing additional stub and tie class files that interact with the Remote
Method Invocation over Internet Inter-ORB Protocol (RMI-1IOP) Object Request Broker (ORB), providing
remote object support. Typically, you run the EJBDeploy tool either when you install the application on the
product or sometime before you install the application from the command-line tool or within a development
tool.

Just-In-Time deployment

The EJB 3.0 support in WebSphere Application Server adds a new feature called Just-In-Time
Deployment. With Just-In-Time Deployment, the EJB container dynamically generates the wrapper, stub,
and tie classes in-memory as needed when the application is running. Additionally, the Web container and
application client containers dynamically generate the stub class required for remote EJB invocations.
Effectively, this means that you do not need to process EJB 3.0 modules, Web modules that invoke EJB
3.0 beans, or client modules that invoke EJB 3.0 beans, through the EJBDeploy tool prior to running them
in WebSphere.

createEJBStubs tool

Even though the Just-In-Time Deployment feature, in many cases, dynamically generates the RMI-IIOP
stub classes that are required for invocation of remote EJB interfaces, there remain some cases where
these stub classes are not dynamically generated. For EJB 3.0 clients not running inside a Web container,
EJB container, or client container, that is upgraded to EJB 3.0 level, you must generate the stub classes
with the createEJBStubs tool, then make the generated stubs available in the client environment’s
classpath. Typically you would accomplish this by copying the generated stubs to the location where the
client’s business interface class resides.

To summarize, the createEJBStubs tool must be used to generate client-side stubs for the following
environments:
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» "Bare” Java Standard Edition (SE) clients, where a Java SE Java Virtual Machine (JVM) is the client
environment.

* WebSphere Application Server container environments prior to Version 7 that do not have the Feature
Pack for EJB 3.0 applied.

* Non-WebSphere Application Server environments.

For more information about packaging your EJB module, see the topic, "EJB 3.0 module packaging
overview.”

Service Data Objects: Resources for learning

Use the following links to find relevant supplemental information about the service data object and various
other functions that can be used with it. The information resides on IBM and non-IBM Internet sites, whose
sponsors control the technical accuracy of the information.

These links are provided for convenience. Often, the information is not specific to this product but is useful
all or in part for understanding the product. When possible, links are provided to technical papers and
Redbooks® that supplement the broad coverage of the release documentation with in-depth examinations
of particular product areas.

Service Data Objects

For an introduction to Service Data Objects, refer to:
+ [Introduction to Service Data Objects]

For an overview of the Service Data Objects specification, refer to:
* [Service Data Objectg|

A good place to start to learn about the Eclipse Modeling Framework is:
+ [EMF Eclipse Modeling Framework|

Information about XSD to SDO/EMF mapping for Version 6 can be found at:
« [XML Schema to Ecore Mapping|

Web application presentation layer technologies

For a brief overview of JavaServer Faces, refer to:
« [Java Sun J2EE 1.4 tutorial

Good places to start to learn about JavaServer Pages Standard Tag Library are:
- [JavaServer Pages Standard Tag Library|
« [A JSTL primer, Part 1: The expression languagel
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Chapter 2. Debugging applications

To debug your application, you must use a development environment like the IBM Rational Application
Developer for WebSphere to create a Java project. You must then import the program that you want to
debug into the project.

About this task

By following the steps below, you can import the WebSphere Application Server examples into a Java

project. Two debugging styles are available:

» Step-by-step debugging mode prompts you whenever the server calls a method on a Web object. A
dialog lets you step into the method or skip it. In the dialog, you can turn off step-by-step mode when
you are finished using it.

» Breakpoints debugging mode lets you debug specific parts of programs. Add breakpoints to the part of
the code that you must debug and run the program until one of the breakpoints is encountered.

Breakpoints actually work with both styles of debugging. Step-by-step mode just lets you see which Web
objects are being called without having to set up breakpoints ahead of time.

You do not need to import an entire program into your project. However, if you do not import all of your
program into the project, some of the source might not compile. You can still debug the project. Most
features of the debugger work, including breakpoints, stepping, and viewing and modifying variables. You
must import any source that you want to set breakpoints in.

The inspect and display features in the source view do not work if the source has build errors. These
features let you select an expression in the source view and evaluate it.

Create a Java Project by opening the New Project dialog.

Select Java from the left side of the dialog and Java Project in the right side of the dialog.
Click Next and specify a name for the project, for example, WASExamples.

Click Finish to create the project.

Select the new project, choose File > Import > File System, then Next to open the import file
system dialog.

6. Browse the directory for files.

Go to the following directory: instalIedApps/node_name/DefauItAppIication.ear/
DefaultWebApplication.war.

7. Select DefaultWebApplication.war in the left side of the Import dialog and then click Finish. This
imports the JavaServer Pages files and Java source for the examples into your project.

8. Add any JAR files needed to build to the Java Build Path.

Select Properties from the right-click menu. Choose the Java Build Path node and then select the
Libraries tab. Click Add External JARs to add the following JAR files:
+ [profile_roofinstalledApps/node_name/DefaultApplication.ear/Increment jar.

When you have added this JAR file, select it and use the Attach Source function to attach the
Increment.jar file because it contains both the source and class files.

* lapp_server_rooflib/j2ee.jar

* |lapp_server_roofplugins//com.ibm.ws.runtime.jar

* |app_server_roofplugins/com.ibm.ws.webcontainer.jar

Click OK when you have added all of the JARs.

9. You can set some breakpoints in the source at this time if you like, however, it is not necessary as
step-by-step mode will prompt you whenever the server calls a method on a Web object.
Step-by-step mode is explained in more detail below.

ok wn =
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10. To start debugging, you need to start the WebSphere Application Server in debug mode and make
note of the JVM debug port. The default value of the JVM debug port is 7777.

11. When the server is started, switch to the debug perspective by selecting Window > Open
Perspective > Debug. You can also enable the debug launch in the Java Perspective by choosing
Window > Customize Perspective and selecting the Debug and Launch checkboxes in the Other
category.

12. Select the workbench toolbar Debug pushbutton and then select WebSphere Application Server
Debug from the list of launch configurations. Click the New pushbutton to create a new configuration.

13. Give your configuration a name and select the project to debug (your new WASExamples project).
Change the port number if you did not start the server on the default port (7777).

14. Click Debug to start debugging.
15. Load one of the examples in your browser. For example: http://your.server.name:9080/hitcount

What to do next

To learn more about debugging, launch the The IBM Rational Application Developer for WebSphere, select
Help > Help Contents and choose the Debugger Guide bookshelf entry. To learn about known
limitations and problems that are associated with the IBM Rational Application Developer for WebSphere,
see the IBM Rational Application Developer for WebSphere release notes. For current information
available from IBM Support on known problems and their resolution, see the page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [Must gatherl documents page for information to gather to send to IBM
Support.

Debugging components in the IBM Rational Application Developer for
WebSphere

The IBM Rational Application Developer for WebSphere, included with the WebSphere Application Server
on a separately-installable CD, includes debugging functionality that is built on the Eclipse workbench.
Documentation for the IBM Rational Application Developer for WebSphere is provided with that product. To
learn more about the debug components, launch the IBM Rational Application Developer for WebSphere,
select Help > Help Contents and choose the Developing > Debugging applications bookshelf entries.

The IBM Rational Application Developer for WebSpheret includes the following:

The WebSphere Application Server debug adapter
which allows you to debug Web objects that are running on WebSphere Application Server and
that you have launched in a browser. These objects include enterprise beans, JavaServer Pages
files, and servlets.

The JavaScript™ debug adapter
which enables server-side JavaScript debugging.

The Compiled language debugger
which allows you to detect and diagnose errors in compiled-language applications.

The Java development tools (JDT) debugger
which allows you to debug Java code.

All of the debug components in the IBM Rational Application Developer for WebSphere can be used for
debugging locally and for remote debugging. To learn more about the debug components, launch the IBM
Rational Application Developer for WebSphere, select Help > Help Contents and choose the Developing
> Debugging applications bookshelf entries.
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Chapter 3. Assembling applications

Application assembly consists of creating Java Platform, Enterprise Edition (Java EE) modules that can be
deployed onto application servers. The modules are created from code artifacts such as Web application
archives (WAR files), resource adapter archives (RAR files), enterprise bean (EJB) JAR files, and
application client archives (JAR files). This packaging and configuring of code artifacts into enterprise
application modules (EAR files) or stand-alone Web modules is necessary for deploying the modules onto
an application server.

Before you begin

This topic assumes that you have developed code artifacts that you want to deploy onto an application
server and have unit tested the code artifacts in your favorite integrated development environment. Code
artifacts that you might assemble into deployable Java EE modules include the following:

« [Enterprise beang

* |Servletd, YavaServer Pages| (JSP) files and other Web components

+ |Resource adapter (connector) implementations

« [Application clients|

+ Session Initiation Protocol (SIP) modules (SAR files)

» Other supporting classes and files

To assemble your code artifacts into deployable Java EE modules, you can use a|supported assembly|
The product supports IBM Rational Application Developer for WebSphere Software for developing,
assembling, and deploying Java EE modules.

About this task

You assemble code artifacts into Java EE modules in order to deploy the code artifacts onto an application
server. When you assemble code artifacts, you package and configure the code artifacts into deployable
Java EE applications and modules, edit annotations or deployment descriptors, and map databases as
needed. Unless you assemble your code artifacts into Java EE modules, you cannot run them successfully
on an application server.

This topic describes how to assemble Java EE code artifacts into deployable modules using an assembly
tool. Alternatively, you can use a rapid deployment tool to quickly assemble and deploy Java 2 Platform,
Enterprise Edition (J2EE) 1.3 or 1.4 code artifacts. Refer to "Rapid deployment of J2EE applications” for
details.

1. Start an assembly tool.

2. Optional: Read the online documentation for the assembly tool.
3. Configure the assembly tool for work on Java EE modules.
4

Migrate J2EE 1.4 or earlier projects or code artifacts created with the Application Server Toolkit,
Assembly Toolkit, Application Assembly Tool (AAT) or a different tool.

To migrate files, use the Migration wizard or import the files to the assembly tool.

5. Create an enterprise application project to which you can add archive files. You can create an
enterprise application project separately or when you create archive files such as the following:

* Create a Web project.

» Create an enterprise bean (EJB) project.

» Create an application client.

» Create a resource adapter (connector) project.

6. Edit the annotations or deployment descriptors as needed. You can edit annotations or deployment
descriptors for enterprise application, Web, application client, and enterprise bean (EJB) modules.
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Topics in Rational Application Developer documentation provide extensive information on editing
annotations or deployment descriptors.

7. Optional: Generate enterprise bean (EJB) to relational database (RDB) mappings for EJB 2.1 or earlier
modules.

8. Verify the archive files.

9. |Generate code for deployment for Web services-enabled modules| or for enterprise applications that
use Web service modules.

What to do next

After assembling your applications, use a systems management tool to deploy the EAR or WAR files onto
the application server. |“Ways to install enterprise applications or modules” on page 33| lists systems
management tools available for deploying Java EE modules on an application server. The systems
management tool follows the security and deployment instructions defined in the annotations or
deployment descriptors, and enables you to modify bindings specified within an assembly tool. The tool
locates the required external resources that the application uses, such as enterprise beans and databases.

Package your application so that the EAR file contains necessary modules only. Modules can include
metadata for the modules such as information on annotations, deployment descriptors, bindings, and IBM
extensions.

Use the administrative console at installation to complete the security instructions defined in the
annotations or deployment descriptors and to locate required external resources, such as enterprise beans
and databases. You can add configuration properties and redefine properties defined in an
assembly tool.

Application assembly and enterprise applications

Application assembly is the process of creating an enterprise archive (EAR) file containing all files related
to an application. This configuration and packaging prepares the application for deployment onto an
application server.

EAR files are comprised of the following archives:

* Enterprise bean JAR files (known as EJB modules)

* Web archive (WAR) files (known as Web modules)

» Application client JAR files (known as client modules)

* Resource adapter archive (RAR) files (known as resource adapter modules)
SAR files (known as Session Initiation Protocol (SIP) modules)

Ensure that modules are contained in an EAR file so that they can be deployed onto the server. The
exceptions are WAR modules, which you can deploy individually. Although WAR modules can contain
regular Java archive (JAR) files, they cannot contain the other module types described previously.

The assembly process includes the following actions:
» Selecting all of the files to include in the module.

» Creating an annotation or deployment descriptor containing instructions for module deployment on the
application server.

You can use the graphical interface of Rational Application Developer assembly tools to generate the
annotation or deployment descriptor. You can also edit annotations or descriptors directly in your favorite
XML editor.

» Packaging modules into a single EAR file, which contains one or more files in a compressed format.

As part of the assembly process, you might also set environment-specific binding information. These
bindings are defaults for an administrator to use when installing the application through the administrative
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console. Further, you might define IBM extensions to the Java Platform, Enterprise Edition (Java EE)
specifications, such as to allow servlets to be served by class name. To ensure portability to other
application servers, these extensions are saved in an XML file that is separate from the standard
annotation or deployment descriptor.

Assembly tools

WebSphere Application Server supports assembly tools that you can use to develop, assemble, and
deploy Java Platform, Enterprise Edition (Java EE) modules.

The IBM Rational Application Developer for WebSphere Software product provides supported assembly
tools.

Although this information center refers to Rational developer products as the assembly tools, you can use
the products to do more than assemble modules. Rational Application Developer is an integrated
development environment that provides development, testing, assembly and deployment capabilities.
Rational Application Developer provides extensive online documentation. Topics on application assembly in
this information center supplement that documentation, focusing on assembling Java EE modules using
the Java EE Perspective of the assembly tools.

Rational Application Developer is available in the WebSphere Application Server disc package with two
licenses. The license for assembly and deployment capabilities does not expire. The license for
development and other capabilities is available on a Trial basis and is only available for a limited time.

The Trial download for Rational Application Developer is available at http://www.ibm.com/developerworks/
downloads/r/rad/.

Note: The assembly tools run on Windows and Linux Intel platforms. Users of WebSphere Application
Server on all platforms must assemble their modules using an assembly tool installed on Windows
or Linux Intel platforms. To install an assembly tool, follow instructions available with the tool.

Generating code for Web service deployment

Before deploying Web services-enabled modules or any enterprise application archive (EAR) files that
contain Web services-enabled module onto an application server, you must generate deployment code for
the application.

Before you begin

This article assumes you have assembled a module enabled with Web services, added it to an application,
saved the application, and verified the application. It also assumes that you have started and configured
an assembly tool.

About this task

You can use anjassembly tool|to generate deployment code for the Web services-enabled module or for
the EAR file that contains the Web services-enabled module.

1. If you have turned automatic validation off, manually validate any modules that use Web services with
the Web services validator before generating deployment code for them. If validating your
module results in compilation errors or validation errors, fix the errors before generating deployment
code. However, if validating your module results in warning or information messages, you can generate
deployment code.

2. In the Project Explorer view of the assembly tool, right-click on the Web services-enabled module
(WAR, enterprise bean JAR, or application client JAR file) for which you want to generate code for
deployment.
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3. Click Deploy. Alternatively, you can generate deployment code for Web services-enabled modules
using the deployment tool for Web services (wsdeploy) from a command prompt.

4. If messages indicate that automatic file overwriting is not enabled, click Yes to All so the generated
files are added to the module.

5. If errors such as Unbound classpath variable: WAS_50_PLUGINDIR display in the Tasks list, change
the Java build path libraries properties to define that variable to be the WebSphere Application Server
installation directory.

Results

Code is generated into the folder where your Web services-enable module is located. Problems with the
generation of code result in a window that displays error messages.

What to do next

Install the Java Platform, Enterprise Edition (Java EE) application on your server machine. You can M
fthe application onto a server using the administrative console] Before installing the application, you might
need to set class paths.

Assembling applications: Resources for learning

Additional information and guidance on assembling applications is available on various Internet sites.

Use the following links to find relevant supplemental information about the application assembly and using
an assembly tool. The information resides on IBM and non-IBM Internet sites, whose sponsors control the
technical accuracy of the information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

View links to additional information about:

« [‘Programming instructions and examples’
« [‘Programming specifications” on page 15|
« [‘Administration” on page 15|

Programming instructions and examples

» Rational Application Developer V7 Programming Guide, SG24-7501-00, http://www.redbooks.ibm.com/
abstracts/sg247501.html?Open

» Rational developer community, http://www.ibm.com/developerworks/rational/

* WebSphere Application Server - Express V6 Developers Guide and Development Examples,
http://www.redbooks.ibm.com/abstracts/sg246500.html

* IBM WebSphere Developer Technical Journal: Using Rational Developer to create a simple Web service
and use it in a Web application, http://www.ibm.com/developerworks/websphere/techjournal/
0506_parkin/0506_parkin.html

« Java EE Tutorials, http://java.sun.com/javaee/reference/tutorials/

* Recommended reading list: J2EE and WebSphere Application Server, http://www.ibm.com/
developerworks/websphere/library/techarticles/0305_issw/recommendedreading.html

» Automated Deployment of Enterprise Application Updates: Part 1 - Basic concepts,
http://websphere.sys-con.com/read/47889.htm
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Programming specifications
* |Specifications and API documentation|

Administration

* IBM WebSphere Developer Technical Journal: System management for WebSphere Application Server
V6 -- Part 1 Overview of system management enhancements, http://www.ibm.com/developerworks/
websphere/techjournal/0501_williamson/0501_williamson.html

* IBM WebSphere Developer Technical Journal: System management for WebSphere Application Server
V6 -- Part 5: Flexible options for updating deployed applications, http://www.ibm.com/developerworks/
websphere/techjournal/0510_apte/0510_apte.html

* WebSphere Application Server V6.1: System Management Configuration Handbook, SG24-7304-00,
http://www.redbooks.ibm.com/abstracts/SG247304.htmI?Open
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Chapter 4. Class loading

Class loaders are part of the Java virtual machine (JVM) code and are responsible for finding and loading
class files. Class loaders enable applications that are deployed on servers to access repositories of
available classes and resources. Application developers and deployers must consider the location of class
and resource files, and the class loaders used to access those files, to make the files available to
deployed applications. Class loaders affect the packaging of applications and the runtime behavior of
packaged applications of deployed applications.

Before you begin

This topic describes how to configure class loaders for application files or modules that are installed on an
application server.

To better understand class loaders in WebSphere Application Server, read|“CIass Ioaders.”l The topic
[‘Class loading: Resources for learning” on page 27| refers to additional sources.

About this task

Configure class loaders for application files or modules that are installed on an application server using the
administrative console. You configure class loaders to ensure that deployed application files and modules
can access the classes and resources that they need to run successfully.

1. If an installed application module uses a resource, [create a resource provider| that specifies the
directory name of the resource drivers.

Do not specify the resource Java archive (JAR) file names. All JAR files in the specified directory are
added into the class path of the WebSphere Application Server extensions class loader. If a resource
driver requires a native library (.d11 or .so file), specify the name of the directory that contains the
library in the native path of the resource configuration.

Specify [class-loader values for an application server|
Specify [class-loader values for an installed enterprise application]
Specify the [class-loader mode for an installed Web module}

If your deployed application uses shared library files, associate the shared library files with your
application. Use a library reference to associate a shared library file with your application.

a. If you have not done so already, [define shared libraries| for library files that your applications need.
b. [Define a library reference|for each shared library that your application uses.

ok 0N

What to do next

After configuring class loaders, ensure that your application performs as desired. To diagnose and fix
problems with class loaders, refer to[Troubleshooting class loaders|

Class loaders

Class loaders find and load class files. Class loaders enable applications that are deployed on servers to
access repositories of available classes and resources. Application developers and deployers must
consider the location of class and resource files, and the class loaders used to access those files, to make
the files available to deployed applications.

This topic provides the following information about class loaders in WebSphere Application Server:
+ [“Class loaders used and the order of use” on page 18|

 |“‘Class-loader isolation policies” on page 19|

« [‘Class-loader modes” on page 21|
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Class loaders used and the order of use

The product runtime environment uses the following class loaders to find and load new classes for an
application in the following order:

1. The bootstrap, extensions, and CLASSPATH class loaders created by the Java virtual machine

The bootstrap class loader uses the boot class path (typically classes in jre/lib) to find and load
classes. The extensions class loader uses the system property java.ext.dirs (typically jre/lib/ext) to find
and load classes. The CLASSPATH class loader uses the CLASSPATH environment variable to find
and load classes.

The CLASSPATH class loader loads the Java Platform, Enterprise Edition (Java EE) application
programming interfaces (APIs) provided by the WebSphere Application Server product in the j2ee.jar
file. Because this class loader loads the Java EE APIs, you can add libraries that depend on the Java
EE APIs to the class path system property to extend a server class path. However, a preferred method
of extending a server class path is to fadd a shared library}

2. A WebSphere extensions class loader

The WebSphere extensions class loader loads the WebSphere Application Server classes that are
required at run time. The extensions class loader uses a ws.ext.dirs system property to determine the
path that is used to load classes. Each directory in the ws.ext.dirs class path and every Java archive
(JAR) file or ZIP file in these directories is added to the class path used by this class loader.

The WebSphere extensions class loader also loads resource provider classes into a server if an
application module installed on the server refers to a resource that is associated with the provider and
if the provider specifies the directory name of the resource drivers.

3. One or more application module class loaders that load elements of enterprise applications running in
the server

The application elements can be Web modules, enterprise bean (EJB) modules, resource adapter
archives (RAR files), and dependency JAR files. Application class loaders follow Java EE class-loading
rules to load classes and JAR files from an enterprise application. The product enables you to
associate shared libraries with an application.

4. Zero or more Web module class loaders

By default, Web module class loaders load the contents of the WEB-INF/classes and WEB-INF/lib
directories. Web module class loaders are children of application class loaders. You can specify that an
application class loader load the contents of a Web module rather than the Web module class loader.

Java class loaders

WebSphere extensions

class loader
Application module class loader Application module class loader

Web module class loader Web module class loader

Each class loader is a child of the previous class loader. That is, the application module class loaders are
children of the WebSphere extensions class loader, which is a child of the CLASSPATH Java class loader.
Whenever a class needs to be loaded, the class loader usually delegates the request to its parent class
loader. If none of the parent class loaders can find the class, the original class loader attempts to load the
class. Requests can only go to a parent class loader; they cannot go to a child class loader. If the
WebSphere extensions class loader is requested to find a class in a Java EE module, it cannot go to the
application module class loader to find that class and a ClassNotFoundException error occurs. After a
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class is loaded by a class loader, any new classes that it tries to load reuse the same class loader or go
up the precedence list until the class is found.

Class-loader isolation policies
The number and function of the application module class loaders depend on the class-loader policies that
are specified in the server configuration. Class loaders provide multiple options for isolating applications

and modules to enable different application packaging schemes to run on an application server.

Two class-loader policies control the isolation of applications and modules:

Class-loader policy Description

Application Application class loaders load EJB modules, dependency JAR files, embedded resource
adapters, and application-scoped shared libraries. Depending on the application
class-loader policy, an application class loader can be shared by multiple applications
(Single) or unique for each application (Multiple). The application class-loader policy
controls the isolation of applications that are running in the system. When set to Single,
applications are not isolated. When set to Multiple, applications are isolated from each
other.

WAR By default, Web module class loaders load the contents of the WEB-INF/classes and
WEB-INF/lib directories. The application class loader is the parent of the Web module class
loader. You can change the default behavior by changing the Web application archive
(WAR) class-loader policy of the application.

The WAR class-loader policy controls the isolation of Web modules. If this policy is set to
Application, then the Web module contents also are loaded by the application class loader
(in addition to the EJB files, RAR files, dependency JAR files, and shared libraries). If the
policy is set to Module, then each Web module receives its own class loader whose parent
is the application class loader.

Note: The console and the underlying deployment.xml file use different names for WAR
class-loader policy values. In the console, the WAR class-loader policy values are
Application or Module. However, in the underlying deployment.xml file where the policy is
set, the WAR class-loader policy values are Single instead of Application, or Multiple
instead of Module. Application is the same as Single, and Module is the same as
Multiple.

Note: WebSphere Application Server class loaders never load application client modules.

For each application server in the system, you can set the application class-loader policy to Single or
Multiple. When the application class-loader policy is set to Single, then a single application class loader
loads all EJB modules, dependency JAR files, and shared libraries in the system. When the application
class-loader policy is set to Multiple, then each application receives its own class loader that is used for
loading the EJB modules, dependency JAR files, and shared libraries for that application.

An application class loader loads classes from Web modules if the application’s WAR class-loader policy is
set to Application. If the application’s WAR class-loader policy is set to Module, then each WAR module
receives its own class loader.

The following example shows that when the application class-loader policy is set to Single, a single
application class loader loads all of the EJB modules, dependency JAR files, and shared libraries of all
applications on the server. The single application class loader can also load Web modules if an application
has its WAR class-loader policy set to Application. Applications that have a WAR class-loader policy set
to Module use a separate class loader for Web modules.

Server's application class-loader policy: Single
Application's WAR class-loader policy: Module

Application 1
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Module: EJBI.jar
Module: WAR1l.war
MANIFEST Class-Path: Dependencyl.jar
WAR Classloader Policy = Module
AppTlication 2
Module: EJB2.jar
MANIFEST Class-Path: Dependency?2.jar
Module: WARZ2.war
WAR Classloader Policy = Application

WebSphere extensions class loader

Classpath:
WebSphere/AppServer/classes
WebSphere/AppServer/lib
WebSphere/AppServer/lib/ext

N

Application class loader
Classpath:

Ejb1.jar

Dependency1.jar

Ejb2.jar

Dependency?2.jar

WAR2.war (WEB-INF/classes, ...)

/

WAR class loader

WAR1.war

The following example shows that when the application class-loader policy of an application server is set
to Multiple, each application on the server has its own class loader. An application class loader also loads
its Web modules if the application WAR class-loader policy is set to Application. If the policy is set to
Module, then a Web module uses its own class loader.

Server's application class-Toader policy: Multiple
Application's WAR class-loader policy: Module

Application 1
Module: EJBIL.jar
Module: WARL.war
MANIFEST Class-Path: Dependencyl.jar
WAR Classloader Policy = Module
Application 2
Module: EJB2.jar
MANIFEST Class-Path: Dependency?2.jar
Module: WARZ.war
WAR Classloader Policy = Application
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WebSphere extensions class loader

Classpath:
WebSphere/AppServer/classes
WebSphere/AppServer/lib
WebSphere/AppServer/lib/ext

/ AN

Application class loader Application class loader
Classp.ath:. Classpath:
Ejb1.jar _ Ejb2.jar
Dependency1.jar Dependency?2.jar
WAR2.war (WEB-INF/classes, ...)

/

WAR class loader
WAR1.war

Class-loader modes

The class-loader delegation mode, also known as the class loader order, determines whether a class

loader delegates the loading of classes to the parent class loader. The following values for class-loader
mode are supported:

Class-loader mode Description

Parent first The Parent first class-loader mode causes the class loader to delegate the loading of
classes to its parent class loader before attempting to load the class from its local class

Also known as Classes | path. This value is the default for the class-loader policy and for standard JVM class
loaded with parent loaders.

class loader first.

Parent last The Parent last class-loader mode causes the class loader to attempt to load classes
from its local class path before delegating the class loading to its parent. Using this policy,
Also known as Classes | an application class loader can override and provide its own version of a class that exists in

loaded with local the parent class loader.
class loader first or

Application first.

The following settings determine the mode of a class loader:

 If the application class-loader policy of an application server is Single, the server-level mode value
defines the mode for an application class loader.

 If the application class-loader policy of an application server is Multiple, the application-level mode
value defines the mode for an application class loader.

» |If the WAR class-loader policy of an application is Module, the module-level mode value defines the
mode for a WAR class loader.

Configuring class loaders of a server

You can configure the application class loaders for an application server. Class loaders enable applications
that are deployed on the application server to access repositories of available classes and resources.
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Before you begin

This topic assumes that an administrator created an application server on a WebSphere Application Server
product.

About this task

Configure the class loaders of an application server to set class-loader policy and mode values which
affect all applications that are deployed on the server. Use the administrative console to configure the
class loaders.

1.

Click Servers > Server Types > WebSphere application servers > server_name to access an
lapplication server settings page,

2. Specify the application class-loader policy for the application server.

The application class-loader policy controls the isolation of applications that run in the system (on the
server). An application class loader groups enterprise bean (EJB) modules, shared libraries, resource
adapter archives (RAR files), and dependency Java archive (JAR) files associated to an application.
Dependency JAR files are JAR files that contain code which can be used by both enterprise beans
and servlets. The application class-loader policy controls whether an application class loader can be
shared by multiple applications or is unique for each application.

Use the fapplication server settings page|to specify the application class-loader policy for the server:

Option Description

Single Applications are not isolated from each other. Uses a
single application class loader to load all of the EJB
modules, shared libraries, and dependency JAR files in
the system.

Multiple Applications are isolated from each other. Gives each
application its own class loader to load the EJB modules,
shared libraries, and dependency JAR files of that
application.

3. Specify the application class-loader mode for the application server.

The application class loading mode specifies the class-loader mode when the application class-loader
policy is Single.
On the |application server settings page], select either of the following values:

Option Description

Classes loaded with parent class loader first Causes the class loader to delegate the loading of

classes to its parent class loader before attempting to
load the class from its local class path. Classes Toaded
with parent class Toader first is the default value for
class loading mode.

This value is also known as parent first.

Classes loaded with local class loader first (parent Causes the class loader to attempt to load classes from
last) its local class path before delegating the class loading to

its parent. Using this policy, an application class loader
can override and provide its own version of a class that
exists in the parent class loader.

4. Specify the class-loader mode for the class loader.
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a. On the application server settings page, click Java and Process Management » Class loader to
access the Class loader page.

b. On the|Class loader page), click New to access the settings page for a class loader.
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c. On thelclass loader settings pagel, specify the class loader order.

The Classes Toaded with parent class Toader first value causes the class loader to delegate
the loading of classes to its parent class loader before attempting to load the class from its local
class path.

The Classes loaded with Tocal class Toader first (parent last) value causes the class loader
to attempt to load classes from its local class path before delegating the class loading to its parent.

d. Click OK.

An identifier is assigned to a class-loader instance. The instance is added to the collection of class
loaders shown on the [Class loader page|

What to do next

Save the changes to the administrative configuration.

Class loader collection

Use this page to manage class-loader instances on an application server. A class loader determines
whether an application class loader or a parent class loader finds and loads Java class files for an
application.

To view this administrative console page, click Servers » Server Types > WebSphere application
servers > server_name > Java and Process Management » Class loader.

Class loader ID

Specifies a string that is unique to the server identifying the class-loader instance. The product assigns the
identifier.

Class loader order

Specifies whether the class loader searches in the parent class loader or in the application class loader
first to load a class. The standard for development kit class loaders and WebSphere Application Server
class loaders is Classes loaded with parent class loader first (Parent first). By specifying Classes
Toaded with Tocal class loader first (Parent last), your application can override classes contained in
the parent class loader, but this action can potentially result in ClassCastException or LinkageErrors if you
have mixed use of overridden classes and non-overridden classes.

Class loader settings
Use this page to configure a class loader for applications that reside on an application server.

To view this administrative console page, click Servers » Server Types > WebSphere application
servers > server_name > Java and Process Management » Class loader - class_loader_ID.

Class loader ID
Specifies a string that is unique to the server identifying the class-loader instance. The product assigns the
identifier.

Data type String

Class loader order

Specifies whether the class loader searches in the parent class loader or in the application class loader
first to load a class. The standard for development kit class loaders and WebSphere Application Server
class loaders is Classes loaded with parent class Toader first. By specifying Classes Toaded with
Tocal class loader first (parent last), your application can override classes contained in the parent
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class loader, but this action can potentially result in ClassCastException or LinkageErrors if you have
mixed use of overridden classes and non-overridden classes.

The options are Classes loaded with parent class Toader first and Classes loaded with local class
Toader first (parent last). The default is to search in the parent class loader before searching in the
application class loader to load a class.

For your application to use the default configuration of Jakarta Commons Logging in this product, set this
application class loader order to Classes loaded with parent class Toader first. For your application to
override the default configuration of Jakarta Commons Logging, your application must provide the
configuration in a form supported by Jakarta Commons Logging and this class loader order must be set to
Classes loaded with Tocal class Toader first (parent last). Also, to override the default
configuration, set the class loader order for each Web module in your application so that the correct logger
factory loads.

Data type String
Default Parent first

Configuring application class loaders

You can set values that control the class-loading behavior of an installed enterprise application. Class
loaders enable an application to access repositories of available classes and resources.

Before you begin

This topic assumes that you |installed an application| on an application server.

About this task

Configure the class loaders of an enterprise application to set class-loader policy and mode values for this
application.

An application class loader groups enterprise bean (EJB) modules, shared libraries, resource adapter
archives (RAR files), and dependency Java archive (JAR) files associated to an application. Dependency
JAR files are JAR files that contain code which can be used by both enterprise beans and servlets.

An application class loader is the parent of a Web application archive (WAR) class loader. By default, a
Web module has its own WAR class loader to load the contents of the Web module. The WAR
class-loader policy value of an application class loader determines whether the WAR class loader or the
application class loader is used to load the contents of the Web module.

Use the administrative console to configure the class loaders.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

1. Click Applications » Application Types > WebSphere enterprise applications > application_name
> Class loading and update detection to access the|settings page for an application class Ioaded

2. Specify whether to reload application classes when the application or its files are updated.

By default, class reloading is not enabled. Select Override class reloading settings for Web and
EJB modules to choose to reload application classes. You might specify different values for EJB
modules and for Web modules such as servlets and JavaServer Pages (JSP) files.
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3. Specify the number of seconds to scan the application’s file system for updated files.

The value specified for Polling interval for updated files takes effect only if class reloading is
enabled. The default is the value of the reloading interval attribute in the IBM extension
(META-INF/ibm-application-ext.xmi) file of the enterprise application (EAR file). You might specify
different values for EJB modules and for Web modules such as servlets and JSP files.

To enable reloading, specify an integer value that is greater than zero (for example, 1 to 2147483647).

To disable reloading, specify zero (0).

4. Specify the class loader order for the application.

The application class loader order specifies whether the class loader searches in the parent class
loader or in the application class loader first to load a class. The default is to search in the parent class
loader before searching in the application class loader to load a class.

Select either of the following values for Classes loader order:

Option

Description

Classes loaded with parent class loader first

Causes the class loader to search in the parent class
loader first to load a class. This value is the standard for
Development Kit class loaders and WebSphere
Application Server class loaders.

Classes loaded with local class loader first (parent
last)

Causes the class loader to search in the application class
loader first to load a class. By specifying Classes Toaded
with local class loader first (parent last), your
application can override classes contained in the parent
class loader.

Note: Specifying the Classes Toaded with Tocal class
Toader first (parent last) value might result in
LinkageErrors or ClassCastException messages if you
have mixed use of overridden classes and non-overridden
classes.

5. Specify whether to use a single or multiple class loaders to load Web application archives (WAR files)

of your application.

By default, Web modules have their own WAR class loader to load the contents of the
WEB-INF/classes and WEB-INF/lib directories. The default WAR class loader value is Class loader
for each WAR file in application, which uses a separate class loader to load each WAR file. Setting
the value to Single class loader for application causes the application class loader to load the
Web module contents as well as the EJB modules, shared libraries, RAR files, and dependency JAR
files associated to the application. The application class loader is the parent of the WAR class loader.

Select either of the following values for WAR class loader policy:

Option

Description

Class loader for each WAR file in application

Uses a different class loader for each WAR file.

Single class loader for application

Uses a single class loader to load all of the WAR files in
your application.

6. Click OK.

What to do next

Save the changes to the administrative configuration.

Configuring Web module class loaders

You can set values that control the class-loading behavior of an installed Web module.
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Before you begin

This topic assumes that you [installed a Web module| on an application server.

About this task

Configure the class loader order value of an installed Web module. By default, a Web module has its own
Web application archive (WAR) class loader to load the contents of the Web module, which are in the
WEB-INF/classes and WEB-INF/Iib directories.

An application class loader is the parent of a WAR class loader. The WAR class-loader policy value of an
application class loader determines whether the WAR class loader or the application class loader is used
to load the contents of the Web module.

The default WAR class loader policy value is Class loader for each WAR file in application. If the
policy is set to Class Toader for each WAR file in application, then each Web module receives its own
class loader whose parent is the application class loader. If the policy is set to Single class Toader for
application on the [settings page of an application class loader| then the application class loader loads the
Web module contents as well as the enterprise bean (EJB) modules, shared libraries, resource adapter
archives (RAR files), and dependency Java archive (JAR) files associated to an application. Thus, the
configuration of the parent application class loader affects the WAR class loader.

Use the administrative console to configure the application and WAR class loaders.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

1. If you have not done so already, [configure the application class loader|

Settings such as Override class reloading settings for Web and EJB modules, Polling interval for
updated files and WAR class loader policy can affect Web module class loading.

If WAR class loader policy is set to Class Toader for each WAR file in application, then the Web
module receives its own class loader and the WAR class-loader policy of the Web module defines the
mode for a WAR class loader. If the policy is set to Single class loader for application, then the
application class loader loads the Web module contents.

2. Specify the class loader order for the installed Web module.

The Web module class-loader mode specifies whether the class loader searches in the parent
application class loader or in the WAR class loader first to load a class. The default is to search in the
parent application class loader before searching in the WAR class loader to load a class.
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Select either of the following values for Class loader order:

Option

Description

Classes loaded with parent class loader first

Causes the class loader to search in the parent
application class loader first to load a class. This is the
standard for Development Kit class loaders and
WebSphere Application Server class loaders.

Note: If classes and resources needed by the Web
module cannot be accessed by the application class
loader, but can be accessed by the WAR class loader,
specify Classes loaded with Tocal class Toader first
(parent Tast). If the application class loader cannot find
a class, the class loader delegates the request to find the
class to its parent, the WebSphere Application Server
extensions class loader. If the WebSphere Application
Server extensions class loader cannot find the class, the
class loader delegates the request to its parent, the
bootstrap, extensions, and CLASSPATH class loaders
created by the Java virtual machine. Requests can only
go to a parent class loader; they cannot go to a child
class loader. Thus, if Classes loaded with parent class
loader first is specified, the WAR class loader never
receives a request to load a class.

Classes loaded with local class loader first (parent
last)

Causes the class loader to search in the WAR class
loader first to load a class. By specifying Classes loaded
with local class Toader first (parent last), your
WAR class loader can override classes contained in the
parent application class loader.

Note: Specifying the Classes loaded with local class
Toader first (parent last) value might result in
LinkageErrors or ClassCastException messages if you
have mixed use of overridden classes and non-overridden
classes.

3. Click OK.

What to do next

Save the changes to the administrative configuration.

Class loading: Resources for learning

Additional information and guidance on class loading is available on various Internet sites.

Use the following links to find relevant supplemental information about class loaders. The information
resides on IBM and non-IBM Internet sites, whose sponsors control the technical accuracy of the

information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

View links to additional information about:

* [“Programming model and decisions” on page 28]

* [“Programming instructions and examples” on page 28|

+ [“Programming specifications” on page 28
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Programming model and decisions

Demystifying class loading problems, Part 1: An introduction to class loading and debugging tools -
Learn how class loading works and how your JVM can help you sort out class loading problems
(developerWorks, November 2005), http://www.ibm.com/developerworks/java/library/j-dclp1/
?S_TACT=106AH10W&S_CMP=NC

Demystifying class loading problems, Part 2: Basic class loading exceptions - An in-depth look at some
simple class loading quirks and conundrums (developerWorks, December 2005), http://www.ibm.com/
developerworks/java/library/j-dclp2.htmI?S_TACT=105AGX10&S_CMP=NC

Demystifying class loading problems, Part 3: Tackling more unusual class loading problems -
Understand class loading and quash subtle exceptions (developerWorks, December 2005),
http://www.ibm.com/developerworks/java/library/j-dclp3/?S_TACT=105AGX10&S_CMP=NC

J2EE Class Loading Demystified (developerWorks, August 2002), http://www.ibm.com/developerworks/
websphere/library/techarticles/0112_deboer/deboer.html

Java programming dynamics, Part 1: Classes and class loading - A look at classes and what goes on
as they’re loaded by a JVM (developerWorks, April 2003), http://www.ibm.com/developerworks/java/
library/j-dyn0429/

Programming instructions and examples

WebSphere Application Server V6.1: System Management Configuration Handbook, SG24-7304-00,
http://www.redbooks.ibm.com/abstracts/SG247304.htmI?Open

IBM WebSphere Developer Technical Journal: Co-hosting multiple versions of J2EE applications,
http://www.ibm.com/developerworks/websphere/techjournal/0405_poddar/0405_poddar.htmi

Programming specifications
+ [Specifications and APl documentation|
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Chapter 5. Deploying and administering enterprise
applications

Deploying an enterprise application file consists of installing an application file on a server configured to
hold installable Java Platform, Enterprise Edition (Java EE) modules.

Before you begin
Before installing an enterprise application or other installable module on an application server, you must

develop the module, fassemble] the module, and [configure the target server] . Before choosing a
deployment target for the module, ensure that the|target versiod is compatible with your module.

About this task

During installation, you can configure the module enough to enable it to run on the server. After
installation, you can configure the module further, start or stop the application, and otherwise manage its
activity.

The topics in this section describe how to deploy and administer applications or modules using the
administrative console. You can also use scripting or administrative programs (JMX).

* |Install Java EE application files| on an application server.

* [Edit the administrative configuration| for an application.

» Optional: |View the deployment descriptor| for an application or module.
[Start and stop enterprise applications]

[Export enterprise applications}

[Export a file in a Java EE application or modulé|.

[Export DDL files|

[Update a Java EE application or module]

[Uninstall enterprise applications,.

. from a Java EE application or module.
What to do next

After making changes to administrative configurations of your applications in the administrative console,
ensure that you save the changes.

Enterprise (Java EE) applications

Enterprise applications (or Java EE applications) are applications that conform to the Java Platform,
Enterprise Edition (Java EE) specification. Prior to Java EE 5, the specification name was Java 2 Platform,
Enterprise Edition (J2EE). The term Java EE includes Java EE 5 and J2EE specifications.

Enterprise applications can consist of the following:

» Zero or more EJB modules (packaged in JAR files)

» Zero or more Web modules (packaged in WAR files)

» Zero or more connector modules (packaged in RAR files)

» Zero or more Session Initiation Protocol (SIP) modules (packaged in SAR files)

» Zero or more application client modules

» Additional JAR files containing dependent classes or other components required by the application
* Any combination of the above

A Java EE application is represented by, and packaged in, an enterprise archive (EAR) file.
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System applications

A system application is a Java Platform, Enterprise Edition (Java EE) enterprise application that is central
to a WebSphere Application Server product.

Examples of system applications include isclite, managementEJB and filetransfer.

Because a system application is an important part of a WebSphere Application Server product, a system
application is deployed when the product is installed and is updated only through a product fix or upgrade.
For some system applications, such as filetransfer, users cannot change the metadata for the system
application, unless the metadata assigns users and groups for security purposes. For these applications,
non-security related metadata such as its Java EE bindings or extensions must be updated through a
product fix or upgrade.

System applications are not shown in the list of installed applications on the console
|App|ications page[, or through wsadmin and Java application programming interfaces, to prevent users
from accidentally stopping, updating or removing the system applications.

Note that Java EE Samples are not system applications even though they are provided as part of a
WebSphere Application Server product. Similarly, applications that support changes to their metadata are
not system applications.

Common deployment framework

The common deployment framework enables you to implement plug-ins that add steps to default Java
Platform, Enterprise Edition (Java EE) application management operations such as install, uninstall, edit
and update.

Using the framework, you can implement management operations on specific types of deployable
contents. For example, the deployable contents might include EAR, WAR, JAR or other Java EE modules
and the management operations might include install and uninstall. Each operation is divided into a
number of steps. For example, the install operation has steps for EJBDeploy and JavaServer Pages (JSP)
compilation, among others. Using the common deployment framework, you can add steps to the default
logic for Java EE operations.

The product supports framework plug-ins that extend deployment of EAR files. An EAR file has operations
such as createEarWrapper, installApplication, uninstallApplication and editApplication. Using a framework
plug-in, you can add steps to default install operations that support, for example, creating additional
configuration artifacts in a configuration session, modifying an input EAR file using code generation, or
additional validating of input parameters.

To extend application management operations using the framework, a plug-in must do the following:

* Implement each step.
A step runs logic that performs an operation. A step can access the deployment context and the
deployable object. The deployment context provides information such as the operation name, the
configuration session identifier, the temporary location for creating temporary files, operations
parameters, and the like. A step is added by the extension provider.

* Implement an extension provider that adds each implemented step.
An extension provider is a class that provides steps for an operation on a given type, the EAR file type.

* Register the plug-in with a WebSphere Application Server server.
The plug-in is implemented as an Eclipse plug-in and is placed in|app_server_rooz|/p1 ugins directory.
Add the extension point for the extension provider in the META-INF/plugin.xml file within the plug-in JAR
file.
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For an example of these steps, refer to|‘Extending application management operations through|
[programming” on page 155.|

Installing enterprise application files

As part of deploying an application, you install application files on a server configured to hold installable
modules.

Before you begin

Before you can install your Java Platform, Enterprise Edition (Java EE) application files on an application
server, you must|assemble modules| as needed.

Also, before you install the files, configure the target application server. As part of configuring the server,
determine whether your application files can be installed to your|deployment targets|

About this task

You can install the following modules on a server:
* Enterprise archive (EAR)

» Enterprise bean (EJB)

* Web archive (WAR)

» Session Initiation Protocol (SIP) module (SAR)
» Resource adapter (connector or RAR)

» Application client modules

Application client files can be installed in a WebSphere Application Server configuration but cannot be run
on a server.

Compilete the following steps to install your files.
1. Determine which method to use to install your application files. The product provides several

install modules

2. Install the application files using
« |Administrative console]
* wsadmin scripts

» Java administrative programs that use Java Management Extensions (JMX) application
programming interfaces (APIs)

« Java programs that define a Java EE DeploymentManager| object in accordance with Java EE
Application Deployment specification (JSR-88)

3. Start the deployed application files using
+ |Administrative console]
* wsadmin startApplication
» Java programs that use ApplicationManager or AppManagement MBeans
» Java programs that define a Java EE DeploymentManager object in accordance with Java EE
Application Deployment specification (JSR-88)

What to do next
Save the changes to your administrative configuration.

Next, test the application. For example, point a Web browser at the URL for a deployed application
(typically http://hostname:9060/ Web_module_name, where hostname is your valid Web server and 9060 is
the default port number) and examine the performance of the application. If the application does not
perform as desired, ledit the application configuration] then save and test it again.
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Installable enterprise module versions

The contents of a Java Platform, Enterprise Edition (Java EE) module affect whether you can install the
module on a deployment target. A deployment target is a server on a WebSphere Application Server
product.

Installable application modules

Select only appropriate deployment targets for a module. You must install an application, enterprise bean
(EJB) module, Session Initiation Protocol (SIP) module (SAR), or Web module on a Version 7.x target
under any of the following conditions:

* The module supports Java Platform, Enterprise Edition (Java EE) 5.

* The module calls a 7.x runtime application programming interface (API).

* The module uses a 7.x product feature.

If a module supports Java 2 Platform, Enterprise Edition (J2EE) 1.4, then you must install the module on a
Version 6.x or 7.x deployment target. Modules that call a 6.1.x APl or use a 6.1.x feature can be installed
on a 6.1.x or 7.x deployment target. Modules that call a 6.0.x API or use a 6.0.x feature can be installed
on a 6.0.x, 6.1.x or 7.x deployment target. Modules that require 6.1.x feature pack functionality can be
installed on a 7.x deployment target or on a 6.1.x deployment target that has been enabled with that
feature pack.

Selecting options such as Precompile JavaServer Pages files, Use binary configuration, Deploy Web
services or Deploy enterprise beans during application installation indicates that the application uses
6.1.x product features. You cannot deploy such applications on a 5.x or 6.0.x deployment target. You must
deploy such applications on a 6.1.x or 7.x deployment target.

You can install an application or module developed for a Version 5.x product on a 5.x, 6.x or 7.x
deployment target.

Note: You must package container-managed persistence (CMP) or bean-managed persistence (BMP)
entity beans in an EJB 2.1 or earlier module. You cannot install an EJB 3.0 module that contains
CMP or BMP entity beans. Installation fails when a CMP or BMP entity bean is packaged in an EJB
3.0 module. You can install EJB 2.1 or earlier modules on a 5.x, 6.x or 7.x deployment target.

Installable RAR files

You can install a standalone resource adapter (connector) module, or RAR file, developed for a Version
5.x product to a 5.x, 6.x or 7.x deployment target, provided the module does not call any 6.x or 7.x runtime
APls. If the module calls a 6.x API, then you must install the module on a 6.x or 7.x deployment target. If
the module calls a 7.x API, then you must install the module on a 7.x deployment target.

Deployment targets

A 5.x deployment target is a server on a WebSphere Application Server Version 5 product.

A 6.x deployment target is a server on a WebSphere Application Server Version 6 product.

A 7.x deployment target is a server on a WebSphere Application Server Version 7 product.

Table 2. Compatible deployment target versions for 5.x, 6.x and 7.x modules

Module type Module Java Module calls 6.x or |Client versions that |Deployment target
support 7.x runtime APIs or |can install module versions
uses 6.x or 7.x
features?
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Table 2. Compatible deployment target versions for 5.x, 6.x and 7.x modules (continued)

Application, EJB,
Web, or client

J2EE 1.3

No

5.x, 6.x or 7.x

5.x, 6.x or 7.x

Application, EJB,
Web, or client

J2EE 1.3

Yes

6.x for 6.x or 7.x APls
or features

7.x for 7.x APls or
features

6.x or 7.x

You must install
modules that call
6.1.x runtime APIs or
use 6.1.x features on
a6.1.xor7.x
deployment target.
You can install
modules that call
6.0.x runtime APlIs or
use 6.0.x features on
any 6.x or 7.x
deployment target.

Application, EJB,
SAR, Web, or client

J2EE 1.4

Yes or No

6.x or 7.x

6.x or 7.x

Application, EJB,
SAR, Web, or client

Java EE 5

Yes or No

7.X

7.X

Resource adapter

JCA1.0

No

5.x, 6.x or 7.X

5.x, 6.x or 7.X

Resource adapter

JCA 1.0

Yes

6.x or 7.xX

6.x or 7.x

You must install
modules that call
6.1.x runtime APIs on
a6.1.xor7.x
deployment target.
You can install
modules that call
6.0.x runtime APIs on
any 6.x or 7.x
deployment target.

Resource adapter

JCA 15

Yes or No

6.x or 7.x

6.x or 7.x

You must install
modules that call
6.1.x runtime APIs on
a6.1.xor7.x
deployment target.
You can install
modules that call
6.0.x runtime APIs on
any 6.x or 7.x
deployment target.

Ways to install enterprise applications or modules
The product provides several ways to install Java Platform, Enterprise Edition (Java EE) application files.

Installable files include enterprise archive (EAR), enterprise bean (EJB), Web archive (WAR), Session
Initiation Protocol (SIP) module (SAR), resource adapter (connector or RAR), and application client
modules. They can be installed on a server. Application client files can be installed in a WebSphere

Application Server configuration but cannot be run on a server.
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Table 3. Ways to install application files

Option

Method

Modules

Comments

Starting after install

Administrative
console install wizard

See [installing]

lenterprise application|
[iiles with the console’|

|on page 36.|

Click Applications -
New application >
New Enterprise
Application in the
console navigation
tree and follow
instructions in the
wizard.

Files for all of the
following modules:
* EAR
- EJB
« WAR
« SAR
* RAR
* Application client

Provides one of the
easier ways to install
application files. See
“Preparing foF|
application installation|
settings” on page 42|
for guidance.

For applications that
do not require
changes to the default
after you
specify the application
file, expand Choose
to generate default
bindings and
mappings, select
Generate default
bindings, click the
Summary step, and
then click Finish.

Click Start on the

Enterpris
applications|page

accessed by clicking
Applications »
Application Types -
WebSphere
enterprise
applications in the
console navigation
tree.

wsadmin scripts

Invoke AdminApp
object install
commands in a script
or at a command
prompt.

Files for all of the

following modules:
 EAR

- EJB

« WAR

« SAR

« RAR

= Application client

"Getting started with
scripting” in the Using
the administrative
clients PDF provides
an overview of
wsadmin.

* Invoke the
AdminApp
startApplication
command.

* Invoke the
startApplication
method on an
ApplicationManager
MBean using
AdminControl.

Java application
programming
interfaces

Install programs by
completing the steps
in "Installing an
application through
programming” in the
Using the
administrative clients
PDF.

All EAR files

Use MBeans to install
the application.
"Managing
applications through
programming” in the
Using the
administrative clients
PDF provides an
overview of Java
MBean programming.

Start the application
by calling the
startApplication
method on a proxy.

34  Developing and deploying applications




Table 3. Ways to install application files (continued)

Option Method Modules Comments Starting after install
Rapid deployment Briefly, do the J2EE modules at the |Rapid deployment Use any of the above
tools following: J2EE 1.3 0r 1.4 tools offer the options to start the

Refer to topics under
Rapid deployment of
J2EE applications.

1. Update your J2EE
application files.

2. Set up the rapid
deployment
environment.

3. Create a free-form
project.

4. Launch a rapid
deployment session.

5. Drop your updated
application files into
the free-form project.

specification levels,
including EAR files
and the following
stand-alone modules:
- EJB

« WAR

* SAR

* RAR

* Application client

The rapid deployment
tools do not support
the Java EE 5.0 or
J2EE 1.2 specification
levels.

following advantages:

* You do not need to
assemble your J2EE
application files prior
to deployment.

* You do not need to
use other installation
tools mentioned in
this table to deploy
the files.

application. Clicking
Start on the

Enterpris
applications|page is

the easiest option.

|[Java programs|

Code programs that
use Java EE
DeploymentManager
(JSR-88) methods.

All Java EE modules,
including EAR files
and the following
stand-alone modules:
- EJB

« WAR

* SAR

* RAR

= Application client

* Uses Java EE
Application
Deployment
Specification
(JSR-88).

Call the Java EE
DeploymentManager
(JSR-88) start method
in a program to start
the deployed modules
when the module’s
running environment
initializes.

Note: In the Version 6.1 Feature Pack for Web services and Feature Pack for EJB 3.0, the default is to
scan pre-Java EE 5 Web application modules to identify JAX-WS services and to scan pre-Java EE
5 Web application modules and EJB modules for service clients during application installation. For
Version 7.0, the default is not to scan pre-Java EE 5 modules for annotations during application
installation or server startup. To preserve backward compatibility with either or both feature packs,
you can define Java virtual machine custom properties on servers to request scanning during
application installation and server startup.

* You can define these custom properties using the console. Click Servers > Server Types »
WebSphere application servers > server name » Java and Process Management > Process
definition » Java virtual machine » Custom properties. To request scanning for Feature Pack
for Web services modules, set the com.ibm.websphere.webservices.UseWSFEP61ScanPolicy
custom property to true. To request scanning for Feature Pack for EJB 3.0 modules, set the
com.ibm.websphere.ejb.UseEJB61FEPScanPolicy custom property to true. The default value for
each of these custom properties is false. You must change the setting on each server that

requires a change in the default.

* You can specify values for these custom properties in the META-INF/MANIFEST.MF file of a
module. Values specified in the META-INF/MANIFEST.MF file always take precedence over a

server-level setting.

When using the launchClient tool to run the application client, you need to define these custom
properties using the -CCD option. For example, TaunchClient app.ear -CCD-
CCDcom.ibm.websphere.ejb.UseEJB61FEPScanPolicy=true.
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Installing enterprise application files with the console

Installing Java Platform, Enterprise Edition (Java EE) application files consists of placing assembled
enterprise application, Web, enterprise bean (EJB), or other installable modules on a server or cluster
configured to hold the files. Installed files that start and run properly are considered deployed.

Before you begin

Before installing enterprise application files, ensure that you are installing your application files onto a
|compatible deployment targetl If the deployment target is not compatible, select a different target.

Optionally, determine whether the application that you are installing uses library files that other deployed
applications also use. You can define a shared library for each of these shared files. Using shared libraries
reduces the number of library file copies on your workstation or server.

About this task

To install new enterprise application files to a WebSphere Application Server configuration, you can use
the following options:

* Administrative console

* wsadmin scripts

» Java MBean programs

» Java programs that call Java EE DeploymentManager (JSR-88) methods

This topic describes how to use the administrative console to install an application, EJB component,
Session Initiation Protocol (SIP) module (SAR), or Web module.

Note: After you start performing the steps below, click Cancel to exit if you decide not to install the
application. Do not simply move to another administrative console page without first clicking Cancel
on an application installation page.

1. Click Applications > New application > New Enterprise Application in the console navigation tree.
2. On the first |Preparing for application installation page}

a. Specify the full path name of the source enterprise application file (.ear file otherwise known as an
EAR file).

The EAR file that you are installing can be either on the client machine (the machine that runs the
Web browser) or on the server machine (the machine to which the client is connected). If you
specify an EAR file on the client machine, then the administrative console uploads the EAR file to
the machine on which the console is running and proceeds with application installation.
You can also specify a stand-alone Web application archive (WAR), SAR, or Java archive (JAR)
file for installation.
If the EAR file resides on the server machine, and the server is an iSeries® server, ensure that
user profile QEJBSVR has *R authority to the EAR file and at least *X authority to all the
directories in the path containing the EAR file.
b. Click Next.
3. On the second Preparing for application installation page:
a. Select whether to view all installation options.
Fast Path - Prompt only when additional information is required
Displays the module mapping step as well as any steps that require you to specify needed
information to install the application successfully.
Detailed - Show all installation options and parameters
Displays all installation options.

b. Select whether to generate default bindings.
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Select Generate default bindings to have the product supply default values for incomplete Java
Naming and Directory (JNDI) and other |pindingg in the application. The product does not change
existing bindings.

You do not need to specify JNDI values for EJB bean, local home, remote home, or business
interfaces of EJB 3.0 modules. The product assigns container default values during run time.
Similarly, for any EJB reference within an EJB 3.0, Web 2.4, or Web 2.5 module, you do not need
to specify JNDI values because the product resolves the targets automatically during run time.
Even when you select Generate default bindings, the product does not generate default values
for those JNDI values but it does generate default values for other bindings such as virtual host.

You can customize default values used in generating default bindings. [‘Preparing for application|
|insta||ation binding settings” on page 42| describes available customizations and provides sample
bindings.

Click Next. If security warnings are displayed, click Continue. The Install New Application pages
are displayed. If you chose to generate default bindings, you can proceed to the step.
f‘ExampIe: Installing an EAR file using the default bindings” on page 60| provides sample steps.

4. Specify values for installation options as needed.

You can click on a step number to move directly to that panel instead of clicking Next. The contents of
the application or module that you are installing determines which panels are available.

Panel Description

[Select installation options| On the Select installation options panel, provide values for the settings specific
to the product. Default values are used if you do not specify a value.

IMap modules to servers| On the Map modules to servers panel, specify [deployment targets| where you

want to install the modules contained in your application. Modules can be installed
on the same deployment target or dispersed among several deployment targets.
Each module must be mapped to a target server.

On single-server products, a deployment target can be an application server or
Web server.

[Provide options to compile] If the Precompile JavaServer Pages files setting is enabled on the [Select]

[JSPs]|

linstallation options|panel and your application uses JavaServer Pages (JSP)
files, then you can specify JSP compiler options on the Provide options to
compile JSPs panel.

[Provide JNDI names for beans| | On the Provide JNDI names for beans panel, specify a JNDI name for each

enterprise bean in every EJB 2.1 and earlier module. You must specify a JNDI
name for every enterprise bean defined in the application. For example, for the
EJB module MyBean.jar, specify MyBean.

As to EJB 3.0 modules, you can specify JNDI names, local home JNDI names,
remote home JNDI names, or no JNDI names. If you do not specify a value, the
product provides a default value.

|Bind EJB business On the Bind EJB business panel, you can specify business interface JNDI

names for EJB 3.0 modules. If you specified a JNDI name for a bean on the
Provide JNDI names for beans panel, do not specify a business interface JNDI
name on this panel for the same bean. If you do not specify the JNDI name for a
bean, you can optionally specify a business interface JNDI name. When you do
not specify a business interface JNDI name, the product provides a container
default.

[Map default data sources for| | If your application uses EJB modules that contain Container Managed Persistence

[modules containing 1.x entity] |(CMP) beans that are based on the EJB 1.x specification, for Map default data

|beans|

sources for modules containing 1.x entity beans, specify a JNDI name for the
default data source for the EJB modules. The default data source for the EJB
modules is optional if data sources are specified for individual CMP beans.
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Panel

Description

[Map EJB references to beans|

On the Map EJB references to beans panel, if your application defines EJB
references, you can specify JNDI names for enterprise beans that represent the
logical names specified in EJB references.

If the EJB reference is from EJB 3.0, Web 2.4, or Web 2.5 module, the JNDI
name is optional. For earlier modules, each EJB reference defined in the
application must be bound to an EJB file.

If Allow EJB reference targets to resolve automatically is enabled, the JNDI
name is optional for all modules. The product provides a container default value or
automatically resolves the EJB reference for incomplete bindings.

[Map resource references to|

|resou rce§|

If your application defines resource references, for Map resource references to
resources, specify JNDI names for the resources that represent the logical names
defined in resource references. You can optionally specify login configuration
name and authentication properties for the resource. After specifying
authentication properties, click OK to save the values and return to the mapping
step. You can optionally specify extended data source properties to enable a data
source that uses heterogeneous pooling to connect to a DB2® database. Each
resource reference defined in the application must be bound to a resource defined
in your WebSphere Application Server configuration before clicking on Finish on
the Summary panel.

[Map virtual hosts for Web)|

|modu|e§|

If your application uses Web modules, for Map virtual hosts for Web modules,
select a virtual host from the list that should map to a Web module defined in the
application. The port number specified in the virtual host definition is used in the
URL that is used to access artifacts such as servlets and JSP files in the Web
module. Each Web module must have a virtual host to which it maps. Not
specifying all needed virtual hosts will result in a validation error displaying after
you click Finish on the Summary panel.

ﬁ\/lap security roles to users or|

I_g rou ESl

If the application has security roles defined in its deployment descriptor then, for

Map security roles to users or groups, specify users and groups that are

mapped to each of the security roles. Select Role to select all of the roles or

select individual roles. For each role, you can specify whether predefined users

such as Everyone or All authenticated users are mapped to it. To select specific

users or groups from the user registry:

1. Select a role and click Lookup users or Lookup groups.

2. On the|Lookup users or groups| panel displayed, enter search criteria to extract
a list of users or groups from the user registry.

3. Select individual users or groups from the results displayed.

4. Click OK to map the selected users or groups to the role selected on the Map
security roles to users or groups panel.

[IMap RunAs roles to users|

If the application has Run As roles defined in its deployment descriptor, for Map
RunAs roles to users, specify the Run As user name and password for every
Run As role. Run As roles are used by enterprise beans that must run as a
particular role while interacting with another enterprise bean. Select Role to select
all of the roles or select individual roles. After selecting a role, enter values for the
user name, password, and verify password and click Apply.

|[Ensure all unprotected 1.x|
Imethods have the correct level|

|of Erotection|

If your application contains EJB 1.x CMP beans that do not have method
permissions defined for some of the EJB methods, for Ensure all unprotected
1.x methods have the correct level of protection, specify if you want to leave
such methods unprotected or assign protection with deny all access.

[Bind listeners for
[message-driven beans|

If your application contains message driven enterprise beans, for Bind listeners

for message-driven beans, provide a [listener portiname or an |activation
i

pecification| JNDI name for every message driven bean.
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Panel

Description

IMap default data sources for|
[modules containing 2.x entity|
|beans|

If your application uses EJB modules that contain CMP beans that are based on
the EJB 2.x specification, for Map default data sources for modules containing
2.x entity beans, specify a JNDI name for the default data source and the type of
resource authorization to be used for the default data source for the EJB modules.
You can optionally specify a login configuration name and authentication
properties for the data source. When creating authentication properties, you must
click OK to save the values and return to the mapping step. You can optionally
specify extended data source properties to enable a data source that uses
heterogeneous pooling to connect to a DB2 database. The default data source for
EJB modules is optional if data sources are specified for individual CMP beans.

IMap data sources for all 2.x|
ICMP beans|

If your application has CMP beans that are based on the EJB 2.x specification, on
the Map data sources for all 2.x CMP beans panel, for each of the 2.x CMP
beans specify a JNDI name and the type of resource authorization for data
sources to be used.

You can optionally specify a login configuration name and authentication
properties for the data source. When creating authentication properties, you must
click OK to save the values and return to the mapping step. The data source
attribute is optional for individual CMP beans if a default data source is specified
for the EJB module that contains CMP beans. If neither a default data source for
the EJB module nor a data source for individual CMP beans are specified, then a
validation error is displayed after you click Finish and installation is cancelled.

|[Ensure all unprotected 2.
[methods have the correct
|of protection|

evel|

If your application contains EJB 2.x CMP beans that do not have method
permissions defined in the deployment descriptors for some of the EJB methods,
on the Ensure all unprotected 2.x methods have the correct level of
protection panel, specify whether you want to assign a specific role to the
unprotected methods, add the methods to the exclude list, or mark them as
unchecked. Methods added to the exclude list are marked as uncallable. For
methods marked unchecked no authorization check is performed prior to their
invocation.

|[Provide options to perform thel

If the Deploy enterprise beans setting is enabled on the [Select installation|

|[EJB Deploy|

|0|:_>tion§| panel, then you can specify options for the EJB deployment tool on the
Provide options to perform the EJB Deploy panel. On this panel, you can
specify extra class paths, RMIC options, database types, and database schema
names to be used while running the EJB deployment tool.

You can specify the EJB deployment tool options on this panel when installing or
updating an application that contains EJB modules. The EJB deployment tool runs
during installation of EJB 1.x or 2.x modules. The EJB deployment tool does not
run during installation of EJB 3.0 modules.

Map shared libraries

On the Shared library references and Shared library mapping panels, specify
shared library files for your application or Web modules to use. A defined shared
library must exist to associate your application or module to the library file.

[Map shared library|
[relationships]

On the Map shared library relationships panel, specify relationship identifiers
and composition unit names for shared libraries that modules in your enterprise
application reference.

When installing your enterprise application, the product creates a composition unit
for each shared library relationship in the business-level application that you
specified for Business-level application name on the [Select installation|

panel.

[Provide JSP reloading options|
[for Web modules|

If your application uses Web modules, for Provide JSP reloading options for
Web modules, configure the class reloading of JavaServer Pages (JSP) files.
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Panel

Description

IMap context roots for Web|
|modu|e§|

If your application uses Web modules that are defined in the application XML
deployment descriptor, for Map context roots for Web modules, specify a
context root for each Web module in the application.

The product does not include Web modules from annotations on this panel.

lInitialize parameters for|

|serv|et§|

If your application uses Web modules that support Servlet 2.5, for Initialize
parameters for servlets, specify or override initial parameters that are passed to
the init method of Web module servlet filters.

This panel shows servlets from the module XML deployment descriptor. Servlet
deployment information from annotations is not available on this panel.

IMap environment entries for|

|Web modules|

If your application uses Web modules that support Servlet 2.5, for Map
environment entries for Web modules, configure the environment entries of
Web modules such as servlets and JSP files.

This panel shows environment entries from the module XML deployment
descriptor. Environment entry deployment information from annotations is not
available in this panel.

[Map resource environment|
lentry references to resources|

If your application contains resource environment references, for Map resource
environment entry references to resources, specify JNDI names of resources
that map to the logical names defined in resource environment references. If each
resource environment reference does not have a resource associated with it, after
you click Finish a validation error is displayed.

|Correct use of system identity|

If your application defines Run-As Identity as System Identity, for Correct use of
system identity, you can optionally change it to Run-As role and specify a user
name and password for the Run As role specified. Selecting System Identity
implies that the invocation is done using the WebSphere Application Server
security server ID and should be used with caution as this ID has more privileges.

|Correct isolation levels for all|
[resource references|

If your application has resource references that map to resources that have an
Oracle database doing backend processing, for Correct isolation levels for all
resource references, specify or correct the isolation level to be used for such
resources when used by the application. Oracle databases support
ReadCommitted and Serializable isolation levels only.

[Bind message destination|
[references to administered|

|ob'|ects|

If your application uses message driven beans, for Bind message destination
references to administered objects, specify the JNDI name of the J2C
administered object to bind the message destination reference to the message
driven beans.

If the message destination reference is from a EJB 3.0 module, then the JNDI
name is optional and the run time provides a container default value.

Note: If multiple message destination references link to the same message
destination, only one JNDI name is collected. When a message destination
reference links to the same message destination as a message driven bean and
the destination JNDI name has been collected already, the destination JNDI name
for the message destination reference is not collected.

Provide JNDI names for JCA
objects

If your application contains an embedded .rar file, for Provide JNDI names for
JCA objects, specify the name and JNDI name of each J2C fconnection factory|
J2C [administered object and J2C [activation specification|

[Bind J2C activationspecs to|
|[destination JNDI names|

If your application contains an embedded .rar file, its activationSpec property has
the value Destination, and its introspected type is javax.jms.Destination, for
Bind J2C activationspecs to destination JNDI names, specify the jndiName
value for each activation bound to it.
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Panel Description

Select current backend ID If your application has EJB modules for which deployment code has been
generated for multiple backend databases using an assembly tool, for Select
current backend ID, specify the backend ID representing the backend database
to be used when the EJB module runs.

This step is not shown if the Deploy enterprise beans setting is enabled on the
Select installation options panel and if a database type other than None is
specified on the Provide options to perform the EJB Deploy panel.

[Metadata for modules| If your application has EJB 3.0 or Web 2.5 modules, you can lock deployment
descriptors for one or more of the EJB 3.0 or Web 2.5 modules. If you set the
metadata-complete attribute to true and lock deployment descriptors, the product
writes the complete module deployment descriptor, including deployment
information from annotations, to XML format.

|[Provide options to perform the | If the Deploy Web services setting is enabled on the [Select installation options|
|[Web services deployment| panel and your application uses Web services, then you can specify wsdeploy
command options on the Provide options to perform the Web services
deployment panel. For information on this panel, refer to descriptions of the
|wsdeploy -cp and -jardir options}

5. On the Summary panel, verify the cell, node, and server onto which the application modules will install:
a. Beside Cell/Node/Server, click Click here.
b. Verify the settings.
c. Return to the Summary panel.
d. Click Finish.

Results
Several messages are displayed, indicating whether your application file is installing successfully.

If Validate input off/warn/fail on the Select installation options panel is set to warn, the default, several
validation warnings might be displayed. If the setting is fail, the validation warnings might cause errors.

If you receive an OutOfMemory error and the source application file does not install, your system might not
have enough memory or your application might have too many modules in it to install successfully onto the
server. If lack of system memory is not the cause of the error, package your application again so the .ear
file has fewer modules.

If lack of system memory and the number of modules are not the cause of the error, check the options you
specified on the Java virtual machine page of the application server running the administrative console.
You might increase the maximum heap size. Then, try installing the application file again.

What to do next

After the application file installs successfully, do the following:

1. Save the changes to your configuration.
The application is registered with the administrative configuration and application files are copied to the
target directory, which is |app_server_roo4’instalIedApps/ce//_ name by default or the directory that you
designate.
For a single-server product, application files are copied to the destination directory when the changes
are saved.
If you clicked the Save link in the application installation messages, the Preparing for the application
installation panel displays again. Click Applications » Application Types > WebSphere enterprise
applications to exit the panel and to see your application in the list of installed applications.
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2. [Start the application|

3. Test the application. For example, point a Web browser at the URL for the deployed application and
examine the performance of the application. If necessary, [edit the application configuration|

Preparing for application installation settings
Use this page to specify an application or module to install.

To view this administrative console page, click Applications > New application > New Enterprise
Application.

This page is the first Preparing for the application installation page. On this page, specify an application or
module to install. You can install an enterprise application archive (EAR file), enterprise bean (EJB)
module (JAR file), Session Initiation Protocol (SIP) module (SAR file), or Web module (WAR file).

The second Preparing for the application installation page has more installation options, such as to
generate default bindings for incomplete existing bindings in your application or module.

Path to the new application:
Specifies the fully qualified path to the enterprise application file.
The file can be an .ear, .jar, .sar, or .war file.

During application installation, the product typically uploads application files from a client workstation
running the browser to the server running the administrative console, and then deploys the application files
on the server. In such cases, use the Web browser running the administrative console to select EAR,
WAR, SAR, or JAR modules to upload to the server.

Use Local file system when the browser and application files are on the same computer.

Use Remote file system in the following situations:

* The application file resides on any node in the current cell context. Only .ear, .jar, .sar, or .war files are
shown during the browsing.

* The application file resides on the file system of any of the nodes in a cell.

» The application file already resides on the computer running the application server. For example, the
field value might be profile_root/installableApps/test.ear.

After the product transfers the application file, the Remote file system value shows the path of the
temporary location on the server.

Preparing for application installation binding settings

Use this page to select whether to view all installation options and to change the existing bindings for you
application or module during installation. You can chose to generate default bindings for any incomplete
bindings in the application or module or to assign specific bindings during installation.

This page is the second Preparing for the application installation page.

To view this administrative console page, click Applications > New application > New Enterprise
Application, specify the path for the application or module to install, and then click Next.

The console page might not display all of the binding options listed in this topic. The contents of the
application or module that you are installing determines which options are displayed on the console page.
Also, the Specify bindings to use option displays only when updating an installed application.

How do you want to install the application?:
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Specifies whether to show only installation options that require you to supply information or to show all

installation options.

Option

Description

Fast Path - Prompt only
when additional information
is required

Displays only those options that require your attention, based on the contents of
your application or module. Use the fast path to install your application more easily
because you do not need to examine all available installation options.

Detailed - Show all
installation options and
parameters

Displays all available installation options.

Specify bindings to use:

Specifies whether to merge bindings when you update applications or to use new or existing bindings.

This setting is shown only when you update an installed application, and not when you install a new

application.

Option

Description

Merge new and existing
bindings

Keeps the existing binding values of the installed application and adds new binding

values in the updated application for incomplete bindings. Use merge if your

updated application has binding values that differ from values specified for the

installed application. The product assigns binding values in the following order:

1. Use existing binding values in the installed application.

2. If the installed application does not have a binding value, use the new binding
value.

3. If both the installed application and the updated application do not have a
binding value, use the default value. The product assigns a default value only if
you select Generate default bindings.

Use new bindings

Uses binding values in the updated application. Does not use existing binding
values in the installed application.

Use existing bindings

Uses existing binding values in the installed application. Does not use binding
values in the updated application.

Generate default bindings:

Specifies whether to generate default bindings and mappings. To view this setting, expand Choose to
generate default bindings and mappings. If you select Generate default bindings, then the product
completes any incomplete bindings in the application with default values. The product does not change

existing bindings.

After you select Generate default bindings, you can advance directly to the Summary step and install the
application if none of the steps have a red asterisk (*). A red asterisk denotes that the step has incomplete
data and requires a valid value. On the Summary panel, verify the cell, node, and server on which the

application is installed.

Note: You do not need to specify Java Naming and Directory Interface (JNDI) values for EJB bean, local
home, remote home, or business interfaces of EJB 3.0 modules. The product assigns container
default values during run time. Similarly, for any EJB reference within an EJB 3.0, Web 2.4, or Web
2.5 module, you do not need to specify JNDI values because the product resolves the targets
automatically during run time. Even when you select Generate default bindings, the product does
not generate default values for those JNDI values but it does generate default values for other
bindings such as virtual host.
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If you select Generate default bindings, the product generates bindings as follows:

» Enterprise bean (EJB) JNDI names are generated in the form prefix/ejb-name. The default prefix is ejb,
but can be overridden. The ejb-name is as specified in the deployment descriptors <ejb-name> tag or in
its corresponding annotation for EJB 3.0 modules. The product does not generate default values for
enterprise beans in an EJB 3.0 module because the run time provides container default values.

» EJB references are bound if an <ejb-1ink> is found. Otherwise, if a unique enterprise bean is found
with a matching home (or local home) interface as the referenced bean, the reference is resolved
automatically. The product does not generate default values for EJB reference in an EJB 3.0, Web 2.4,
or Web 2.5 module because the run time provides container default values or automatically resolves the
target references.

» Resource reference bindings are derived from the <res-ref-name> tag or its corresponding annotation
for Java Platform, Enterprise Edition (Java EE) 5 modules. This action assumes that the java:comp/env
name is the same as the resource global JNDI name.

» Connection factory bindings for EJB 2.0 and EJB 2.1 JAR files are generated based on the JNDI name
and authorization information provided. This action results in default connection factory settings for each
EJB 2.0 and EJB 2.1 JAR file in the application being installed. No bean-level connection factory
bindings are generated.

» Data source bindings for EJB 1.1 JAR files are generated based on the JNDI name, data source user
name password options. This action results in default data source settings for each JAR file. No
bean-level data source bindings are generated.

* For EJB 2.0 or later message-driven beans deployed as Java EE Connector Architecture (JCA)
1.5-compliant resources, the JNDI names corresponding to activationSpec instances are generated in
the form eis/MDB_ejb-name. Message destination references are bound if a <message-destination-
Tink> is found, then the JNDI name is set to ejs/message-destination-linkName. Otherwise, the JNDI
name is set to eis/message-destination-refName.

» For EJB 2.0 or later message-driven beans deployed against listener ports, the listener ports are
derived from the message-driven bean <ejb-name> tag with the string Port appended.

* For .war files, the virtual host is set as default_host unless otherwise specified.

The default strategy suffices for most applications or at least for most bindings in most applications.

However, if you experience errors, complete the following actions:

» Control the global JNDI names of one or more EJB files.

« Control data source bindings for container-managed persistence (CMP) beans. That is, you have
multiple data sources and need more than one global data source.

* Map resource references to global resource JNDI names that are different from the java:comp/env
name.

In such cases, you can change the behavior with an XML document, which is a custom strategy. Use the
Specific bindings file setting to specify a custom strategy and see the setting description in this help file
for examples.

Override existing bindings:

Specifies whether generated bindings are to replace existing bindings.

The default is to not override existing bindings. Select Override existing bindings to have generated
bindings replace existing bindings.

Specific bindings file:

Specifies a bindings file that overrides the default binding.

Change the behavior of the default binding with an XML document, which is a custom strategy. Custom
strategies extend the default strategy so you only need to customize those areas where the default

strategy is insufficient. Thus, you only need to describe how you want to change the bindings generated
by the default strategy; you do not have to define bindings for the entire application.
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Use the following examples to override various aspects of the default bindings generator:

Controlling an EJB JNDI name

<?xml version="1.0"7>
<IDOCTYPE dfTtbndngs SYSTEM "dfltbndngs.dtd">
<dfltbndngs>
<module-bindings>
<ejb-jar-binding>
<jar-name>helloEjb.jar</jar-name>
<ejb-bindings>
<ejb-binding>
<ejb-name>HelloEjb</ejb-name>
<jndi-name>com/acme/ejb/HelloHome</jndi-name>
</ejb-binding>
</ejb-bindings>
</ejb-jar-binding>
</module-bindings>
</df1tbndngs>

Note: Ensure that the setting for <ejb-name> matches the ejb-name entry in the EJB JAR deployment
descriptor. Here the setting is <ejb-name>Hel1oEjb</ejb-name>.

Setting the connection factory binding for an EJB JAR file

<IDOCTYPE dfltbndngs SYSTEM "dfltbndngs.dtd">
<dfltbndngs>
<module-bindings>
<ejb-jar-binding>
<jar-name>yourEjbh20.jar</jar-name>
<connection-factory>
<jndi-name>eis/jdbc/YourData_CMP</jndi-name>
<res-auth>Container</res-auth>
</connection-factory>
</ejb-jar-binding>
</module-bindings>
</df1tbndngs>

Setting the connection factory binding for an EJB file

<?xml version="1.0">
<IDOCTYPE dfTtbndngs SYSTEM "dfltbndngs.dtd">
<dfltbndngs>
<module-bindings>
<ejb-jar-binding>
<jar-name>yourEjbh20.jar</jar-name>
<ejb-bindings>
<ejb-binding>
<ejb-name>YourCmp20</ejb-name>
<connection-factory>
<jndi-name>eis/jdbc/YourData_CMP</jndi-name>
<res-auth>PerConnFact</res-auth>
</connection-factory>
</ejb-binding>
</ejb-bindings>
</ejb-jar-binding>
</module-bindings>
</df1tbndngs>

Note: Ensure that the setting for <ejb-name> matches the ejb-name tag in the deployment descriptor. Here
the setting is <ejb-name>YourCmp20</ejb-name>.

Setting the message destination reference JNDI for a specific enterprise bean
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This example shows an XML extract in a custom strategy file for setting message-destination-refs for a
specific enterprise bean.

<?xml version="1.0">
<IDOCTYPE dfltbndngs SYSTEM "dfltbndngs.dtd">
<dfltbndngs>
<module-bindings>
<ejb-jar-binding>
<jar-name>yourEjb21.jar</jar-name>
<ejb-bindings>
<ejb-binding>
<ejb-name>YourSession21</ejb-name>
<message-destination-ref-bindings>
<message-destination-ref-binding>
<message-destination-ref-name>jdbc/MyDataSrc</message-destination-ref-name>
<jndi-name>eis/somA0</jndi-name>
</message-destination-ref-binding>
</message-destination-ref-bindings>
</ejb-binding>
</ejb-bindings>
</ejb-jar-binding>
</module-bindings>
</df1tbndngs>

Note: Ensure that the setting for <ejb-name> matches the ejb-name tag in the deployment descriptor. Here
the setting is <ejb-name>YourSession21</ejb-name>. Also ensure that the setting for
<message-destination-ref-name> matches the message-destination-ref-name tag in the
deployment descriptor. Here the setting is <message-destination-ref-name>jdbc/MyDataSrc</
message-destination-ref-name>.

Overriding a resource reference binding from a WAR, EJB JAR file, or Java EE client JAR file

This example shows code for overriding a resource reference binding from a WAR file. Use similar code to
override a resource reference binding from an enterprise bean (EJB) JAR file or a Java EE client JAR file.

<?xml version="1.0"?>
<IDOCTYPE dfltbndngs SYSTEM "dfltbndngs.dtd">
<dfltbndngs>
<module-bindings>
<war-binding>
<jar-name>hello.war</jar-name>
<resource-ref-bindings>
<resource-ref-binding>
<resource-ref-name>jdbc/MyDataSrc</resource-ref-name>
<jndi-name>war/override/dataSource</jndi-name>
</resource-ref-binding>
</resource-ref-bindings>
</war-binding>
</module-bindings>
</df1tbndngs>

Note: Ensure that the setting for <resource-ref-name> matches the resource-ref tag in the deployment
descriptor. In the previous example, the setting is <resource-ref-name>jdbc/MyDataSrc</resource-
ref-name>.

Overriding the JNDI name for a message-driven bean deployed as a JCA 1.5-compliant resource

This example shows an XML extract in a custom strategy file for overriding the Java Message Service
(JMS) activationSpec JNDI name for an EJB 2.0 or later message-driven bean deployed as a JCA
1.5-compliant resource.

<?xml version="1.0"?>

<IDOCTYPE dfltbndngs SYSTEM "dfltbndngs.dtd">
<dfltbndngs>
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<module-bindings>
<ejb-jar-binding>
<jar-name>YourEjbJar.jar</jar-name>
<ejb-bindings>
<ejb-binding>
<ejb-name>YourMDB</ejb-name>
<activationspec-jndi-name>activationSpecJNDI</activationspec-jndi-name>
</ejb-binding>
</ejb-bindings>
</ejb-jar-binding>
</module-bindings>
</df1tbndngs>

Overriding the JMS listener port name for an EJB 2.0, 2.1, or 3.0 message-driven bean

This example shows an XML extract in a custom strategy file for overriding the JMS listener port name for
an EJB 2.0 or later message-driven bean deployed against a listener port.

<?xml version="1.0"7>
<IDOCTYPE dfltbndngs SYSTEM "dfltbndngs.dtd">
<dfltbndngs>
<module-bindings>
<ejb-jar-binding>
<jar-name>YourEjbhJar.jar</jar-name>
<ejb-bindings>
<ejb-binding>
<ejb-name>YourMDB</ejb-name>
<listener-port>yourMdbListPort</1istener-port>
</ejb-binding>
</ejb-bindings>
</ejb-jar-binding>
</module-bindings>
</df1tbndngs>

Overriding an EJB reference binding from an EJB JAR, WAR file, or EJB file

This example shows code for overriding an EJB reference binding from an EJB JAR file. Use similar code
to override an EJB reference binding from a WAR file or an EJB file.

<?xml version="1.0"?7>
<IDOCTYPE dfltbndngs SYSTEM "dfltbndngs.dtd">
<df1tbndngs>
<module-bindings>
<ejb-jar-binding>
<jar-name>YourEjbJar.jar</jar-name>
<ejb-ref-bindings>
<ejb-ref-binding>
<ejb-ref-name>YourEjb</ejb-ref-name>
<jndi-name>YourEjb/JINDI</jndi-name>
</ejb-ref-binding>
</ejb-ref-bindings>
</ejb-jar-binding>
</module-bindings>
</df1tbndngs>

Specify unique prefix for beans:

Specifies a string that the product applies to the beginning of generated enterprise bean JNDI names. The
prefix must be unique within the cell or node.

The default is to not specify a unique prefix for beans.

Default bindings for EJB 1.1 CMP beans:
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Specifies the default data source JNDI name and other bindings for container-managed persistence (CMP)
1.1 beans.

The default is to not use default bindings for EJB 1.1 CMP beans.

If you select Default bindings for EJB 1.1 CMP beans, specify the JNDI name for the default data
source to be used with the CMP 1.1 beans. Also specify the user name and password for this default data
source.

Default connection factory bindings:
Specifies the default connection factory JNDI name.

The default is to not use default connection factory bindings. Select Default connection factory bindings
to specify bindings for connection factories.

If you select Default connection factory bindings, specify the JNDI name for the default connection
factory to be used. Also specify whether the resource authorization is for the application or container-wide.

Use default virtual host name for Web and SIP modules:

Specifies the virtual host for the Web module (WAR file) or Session Initiation Protocol (SIP) module (SAR
file).

The default is to not use default virtual host name for Web or SIP modules. If you select Use default
virtual host name for Web and SIP modules, specify a default host name.

Select installation options settings

Use this panel to specify options for the installation of a Java Platform, Enterprise Edition (Java EE)
application onto a WebSphere Application Server deployment target. Default values for the options are
used if you do not specify a value. After application installation, you can specify values for many of these
options from an enterprise application settings page.

To view this administrative console panel, click Applications » New application > New Enterprise
Application and then specify values as needed for your application on the Preparing for application
installation pages.

The Select installation options panel is the same for the application installation and update wizards.

Precompile JavaServer Pages files:

Specify whether to precompile JavaServer Pages (JSP) files as a part of installation. The default is not to
precompile JSP files.

For this option, install only onto a Version 6.1 or later deployment target.

If you select Precompile JavaServer Pages files and try installing your application onto an earlier
deployment target such as Version 5.x, the installation is rejected. You can deploy applications to only
those deployment targets that have same version as the product. If applications are targeted to servers
that have an earlier version than the product, then you cannot deploy to those targets.

Data type Boolean
Default false

Directory to install application:
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Specifies the directory to which the enterprise archive (EAR) file will be installed.

By default, the EAR file is installed in the profile_root/installedApps/cell_namelapplication_name.ear
directory.

Setting options include the following:
» Do not specify a value and leave the field empty.

The default value is ${APP_INSTALL_ROQT}/cell_name, where the ${APP_INSTALL_ROQT} variable is
profile_root/installedApps. A directory having the EAR file name of the application being installed is
appended to ${APP_INSTALL_ROQT}/cell_name. Thus, if you do not specify a directory, the EAR file is
installed in the profile_root/installedApps/cell_namelapplication_name.ear directory.

» Specify a directory.
If you specify a directory for Directory to install application, the application is installed in
specified_path/application_name.ear directory. A directory having the EAR file name of the application
being installed is appended to the path that you specify for Directory to install application. For
example, if you are installing Clock.ear and specify C:/myapps on Windows machines, the application is
installed in the myapps/Clock.ear directory. The ${APP_INSTALL_ROOT} variable is set to the specified
path.

» Specify ${APP_INSTALL ROOT}/${CELL} for the initial installation of the application.

If you intend to export the application from one cell and later install the exported application on a
different cell, specify the ${CELL} variable for the initial installation of the application. For example,
specify ${APP_INSTALL ROOT}/${CELL} for this setting. Exporting the application creates an enhanced
EAR file that has the application and its deployment configuration. The deployment configuration retains
the cell name of the initial installation in the destination directory unless you specify the ${CELL}
variable. Specifying the ${CELL} variable ensures that the destination directory has the current cell
name, and not the original cell name.

Note: If an installation directory is not specified when an application is installed on a single-server
configuration, the application is installed in ${APP_INSTALL_ROOT}/cell_name. When the server
is made a part of a multiple-server configuration (using the addNode utility), the cell name of the
new configuration becomes the cell name of the deployment manager node. If the -includeapps
option is used for the addNode ultility, then the applications that are installed prior to the addNode
operation still use the installation directory ${APP_INSTALL_ROOT}/cell_name. However, an
application that is installed after the server is added to the network configuration uses the default
installation directory ${APP_INSTALL_ROQT}/network_cell_name. To move the application to the
${APP_INSTALL_ROOT}/network_cell_name location upon running the addNode operation,
explicitly specify the installation directory as ${APP_INSTALL ROOT}/${CELL} during installation. In
such a case, the application files can always be found under ${APP_INSTALL_ROOT}/
current_cell_name.

 If the application has been exported and you are installing the exported EAR file in a different cell or
location, specify ${APP_INSTALL_ROOT}/cell_namelapplication_name.ear if you did not specify
${APP_INSTALL ROOT}/${CELL} for the initial installation.

The exported EAR file is an enhanced EAR file that has the application and its deployment
configuration. The deployment configuration retains the value for Directory to install application that
was used for the previous installation of the application. Unless you specify a different value for
Directory to install application for this installation, the enhanced EAR file will be installed to the same
directory as for the previous installation.

If you did not specify the ${CELL} variable during the initial installation, the deployment configuration
uses the cell name of the initial installation in the destination directory. If you are installing on a different
cell, specify ${APP_INSTALL_ROQT}/cell_name/application_name.ear, where cell_name is the name of
the cell to which you want to install the enhanced EAR file. If you do not designate the current cell
name, cell_name will be the original cell name even though you are installing the enhanced EAR file on
a cell that has a different name.
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» Specify an absolute path or a use pathmap variable.

You can specify an absolute path or use a pathmap variable such as ${MY_APPS}. You can use a
pathmap variable in any installation.

This Directory to install application field is the same as the Location (full path) setting on an
Application binaries page.

Data type String
Units Full path name

Distribute application:

Specifies whether the product expands application binaries in the installation location during installation
and deletes application binaries during uninstallation. The default is to enable application distribution.
Application binaries for installed applications are expanded to the directory specified.

On single-server products, the binaries are deleted when you uninstall and save changes to the
configuration.

On multiple-server products, the binaries are deleted when you uninstall and save changes to the
configuration and synchronize changes.

If you disable this option, then you must ensure that the application binaries are expanded appropriately in
the destination directories of all nodes where the application runs.

Note: If you disable this option and you do not copy and expand the application binaries to the nodes, a
later saving of the configuration or manual synchronization does not move the application binaries
to the nodes for you.

This Distribute application field is the same as the Enable binary distribution, expansion and cleanup
post uninstallation setting on an Application binaries page.

Data type Boolean
Default true

Use binary configuration:

Specifies whether the application server uses the binding, extensions, and deployment descriptors located
with the application deployment document, the deployment.xml file (default), or those located in the
enterprise archive (EAR) file. Select this setting for applications installed on Version 6.0 or later
deployment targets only. This setting is not valid for applications installed on 5.x deployment targets.

The default (false) is not to use the binding, extensions, and deployment descriptors located in
deployment.xml. To use the binding, extensions, and deployment descriptors located in the EAR file,
enable this setting (true).

This Use binary configuration field is the same as the Use configuration information in binary setting
on an Application binaries page.

Data type Boolean
Default false

Deploy enterprise beans:

50 Developing and deploying applications



Specifies whether the EJBDeploy tool runs during application installation.

The tool generates code needed to run enterprise bean (EJB) files. You must enable this setting in the

following situations:

* The EAR file was assembled using an assembly tool such as Rational Application Developer and the
EJBDeploy tool was not run during assembly.

* The EAR file was not assembled using an assembly tool such as Rational Application Developer.

* The EAR file was assembled using versions of the Application Assembly Tool (AAT) previous to Version
5.0.

The EJB deployment tool runs during installation of EJB 1.x or 2.x modules. The EJB deployment tool
does not run during installation of EJB 3.0 modules.

For this option, install only onto a Version 6.1 or later deployment target.

If you select Deploy enterprise beans and try installing your application onto an earlier deployment target
such as Version 6.0, the installation is rejected. You can deploy applications to only those targets that have
same WebSphere version as the product. If applications are targeted to servers that have an earlier
version than the product, then you cannot deploy to those targets.

Also, if you select Deploy enterprise beans and specify a database type on the Provide options to
perform the EJB Deploy panel, previously defined backend IDs for all of the EJB modules are overwritten
by the chosen database type. To enable backend IDs for individual EJB modules, set the database type to
"" (null) on the Provide options to perform the EJB Deploy panel.

Enabling this setting might cause the installation program to run for several minutes.

Data type Boolean
Default true (false for EJB 3.0 modules)

Application name:

Specifies a logical name for the application. An application name must be unique within a cell and cannot
contain an unsupported character.

An application name cannot begin with a period (.), cannot contain leading or trailing spaces, and cannot
contain any of the following characters:

Unsupported characters

| forward slash $  dollar sign ’ single quote mark

\ backslash = equal sign " double quote mark

* asterisk % percent sign | vertical bar

, comma +  plus sign < left angle bracket
colon @ at sign > right angle bracket

;  semi-colon #  hash mark & ampersand (and sign)

? question mark 11> No specific name exists for this character combination

This Application name field is the same as the Name setting on an Enterprise application settings page.

Data type String

Create MBeans for resources:
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Specifies whether to create MBeans for resources such as servlets or JSP files within an application when
the application starts. The default is to create MBeans.

This field is the same as the Create MBeans for resources setting on a Startup behavior page.

Data type Boolean
Default true

Override class reloading settings for Web and EJB modules:

Specifies whether the product run time detects changes to application classes when the application is
running. If this setting is enabled and if application classes are changed, then the application is stopped
and restarted to reload updated classes.

The default is not to enable class reloading.

This field is the same as the Override class reloading settings for Web and EJB modules setting on
an Class loading and update detection page.

Data type Boolean
Default false

Reload interval in seconds:

Specifies the number of seconds to scan the application’s file system for updated files. The default is the
value of the reloading interval attribute in the IBM extension (META-INF/ibm-application-ext.xmi) file of the
EAR file.

The reloading interval attribute takes effect only if class reloading is enabled.

To enable reloading, specify a value greater than zero (for example, 1 to 2147483647). To disable
reloading, specify zero (0). The range is from 0 to 2147483647.

This Reload interval in seconds field is the same as the Polling interval for updated files setting on a
Class loading and update detection page.

Data type Integer
Units Seconds
Default 3

Deploy Web services:

Specifies whether the Web services deploy tool wsdeploy runs during application installation.

The tool generates code needed to run applications using Web services. The default is not to run the
wsdeploy tool. You must enable this setting if the EAR file contains modules using Web services and has
not previously had the wsdeploy tool run on it, either from the Deploy menu choice of an assembly tool or
from a command line.

For this option, install only onto a Version 6.1 or later deployment target.

If you select Deploy Web services and try installing your application onto an earlier deployment target

such as Version 5.x, the installation is rejected. You can deploy applications to only those targets that have
same version as the product. If applications are targeted to servers that have an earlier version than the
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product, then you cannot deploy to those targets.

Data type Boolean
Default false

Validate input off/warn/fail:

Specifies whether the product examines the application references specified during application installation
or updating and, if validation is enabled, warns you of incorrect references or fails the operation.

An application typically refers to resources using data sources for container managed persistence (CMP)
beans or using resource references or resource environment references defined in deployment descriptors.
The validation checks whether the resource referred to by the application is defined in the scope of the
deployment target of that application.

Select off for no resource validation, warn for warning messages about incorrect resource references, or
fail to stop operations that fail as a result of incorrect resource references.

This Validate input off/warn/fail field is the same as the Application reference validation setting on an
Enterprise application settings page.

Data type String
Default warn

Process embedded configuration:

Specifies whether the embedded configuration should be processed. An embedded configuration consists
of files such as resource.xml and variables.xml. When selected or true, the embedded configuration is
loaded to the application scope from the .ear file. If the .ear file does not contain an embedded
configuration, the default is false. If the .ear file contains an embedded configuration, the default is true.

Data type Boolean
Default false

File permission:

Specifies access permissions for application binaries for installed applications that are expanded to the
directory specified.

The Distribute application option must be enabled to specify file permissions.
You can specify file permissions in the text field. You can also set some of the commonly used file
permissions by selecting them from the multiple-selection list. List selections overwrite file permissions set

in the text field.

You can set one or more of the following file permission strings in the list. Selecting multiple options
combines the file permission strings.

Multiple-selection list option File permission string set
Allow all files to be read but not written to .*x=755
Allow executables to execute .%\.d11=755#.%\.50=755#.*\.a=755#.%\.s1=755

Allow HTML and image files to be read by .x\ . htm=755#.%\.htm1=755#.%\.qgif=755#.*\.jpg=755
everyone
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Instead of using the multiple-selection list to specify file permissions, you can specify a file permission
string in the text field. File permissions use a string that has the following format:

file name_pattern=permission#file _name_pattern=permission

where file_name_pattern is a regular expression file name filter (for example, .*\\.jsp for all JSP files),
permission provides the file access control lists (ACLs), and # is the separator between multiple entries of
file_name_pattern and permission. If # is a character in a file_name_pattern string, use \# instead.

If multiple file name patterns and file permissions in the string match a uniform resource identifier (URI)
within the application, then the product uses the most stringent applicable file permission for the file. For
example, if the file permission string is .*\\.jsp=775#a.*\\.jsp=754, then the abc.jsp file has file
permission 754.

Note: Using regular expressions for file matching pattern compares an entire string URI against the
specified file permission pattern. You must provide more precise matching patterns using regular
expressions as defined by Java programming API. For example, suppose the following directory
and file URIs are processed during a file permission operation:

1 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war

2 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war/MyJsp.jsp

3 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war/META-INF/
MANIFEST.MF

4 /opt/WebSphere/profiles/AppSrv01l/installedApps/MyCell/MyApp.ear/MyWarModule.war/WEB-INF/classes/

MyClass.class

5 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war/mydir/
MyClass2.class

6 /opt/WebSphere/profiles/AppSrv0Ol/installedApps/MyCel1/MyApp.ear/MyWarModule.war/META-INF

The file pattern matching results are:

* MyWarModule.war does not match any of the URIs

» .*MyWarModule.war.* matches all URIs

» .*MyWarModule.war$ matches only URI 1

* .*\\.jsp=755 matches only URI 2

e .*META-INF.* matches URIs 3 and 6

e .*MyWarModule.war/.*/.*\.class matches URIls 4 and 5

If you specify a directory name pattern for File permissions, then the directory permission is set based on
the value specified. Otherwise, the File permissions value set on the directory is the same as its parent.
For example, suppose you have the following file and directory structure:

/opt/WebSphere/profiles/AppSrv0l/installedApps/MyCell/MyApp.ear/MyWarModule.war/MyJdsp.jsp

and you specify the following file pattern string:
.*MyApp.ear$=755#.*\.jsp=644

The file pattern matching results are:
» Directory MyApp.ear is set to 755
» Directory MyWarModule.war is set to 755
» Directory MyWarModule.war is set to 755

Note: Regardless of the operation system, always use a forward slash (/) as a file path separator in file
patterns.
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Access permissions specified here are at the application level. You can also specify access permissions
for application binaries in the node-level configuration. The node-level file permissions specify the
maximum (most lenient) permissions that can be given to application binaries. Access permissions
specified here at application level can only be the same as or more restrictive than those specified at the
node level.

This setting is the same as the File permissions field on the Application binaries page.

Data type String

Application build identifier:
Specifies an uneditable string that identifies the build version of the application.

This Application build identifier field is the same as the Application build level field on the Application
binaries page.

Data type String

Business-level application name:

Specifies whether the product creates a new business-level application with the enterprise application that
you are installing or makes the enterprise application a composition unit of an existing business-level
application.

The default is to create a new business-level application with a setting value of
WebSphere:blaname=Anyasset,blaedition=BASE. When you select to create a new business-level
application from the drop-down list, the product creates a business-level application that has the same
name as your enterprise application.

To add your enterprise application to an existing business-level application, select an existing
business-level application from the drop-down list. The product makes your enterprise application a
composition unit of the existing business-level application.

Data type String
Default Create a new business-level application that has the same name as the
enterprise application that you are installing.

WebSphere:blaname=Anyasset,blaedition=BASE

Asynchronous request dispatch type:

Specifies whether Web modules can dispatch requests concurrently on separate threads and, if so,
whether the server or client dispatches the requests. Concurrent dispatching can improve servlet response
time.

If operations are dependant on each other, do not enable asynchronous request dispatching. Select
Disabled. Concurrent dispatching might result in errors when operations are dependant.

Select Server side to enable the server to dispatch requests concurrently. Select Client side to enable
the client to dispatch requests concurrently.

Data type String
Default Disabled
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Allow EJB reference targets to resolve automatically:

Specifies whether the product assigns default JNDI values for or automatically resolves incomplete EJB
reference targets.

Select this option to enable EJB reference targets to resolve automatically if the references are from EJB

2.1 or earlier modules or from Web 2.3 or earlier modules. If you enable this option, the runtime container
provides a default value or automatically resolves the EJB reference for any EJB reference that does not

have a binding.

If you selected Generate default bindings on the Preparing for application installation page, then you do
not need to select this option. The product generates default values.

If you select Allow EJB reference targets to resolve automatically, all modules in the application must
share one deployment target. If you select this option and all of the application modules do not share a
common server, after you click Finish on the Summary page, the product displays a warning message
and does not install the application. You must deselect this setting before you click Finish to install the
application.

Data type Boolean
Default false

Provide options to perform the EJB Deploy settings

Use this panel to specify options for the enterprise bean (EJB) deployment tool. The tool generates code
needed to run enterprise bean files. You can specify extra class paths, Remote Method Invocation
compiler (RMIC) options, database types, and database schema names to be used while running the EJB
deployment tool.

This administrative console panel is a step in the application installation and update wizards. To view this
panel, you must select Deploy enterprise beans on the Select installation options panel. Thus, to view
this panel, click Applications » New Application > New Enterprise Application » application_path -
Next » Detailed - Show all installation options and parameters > Next > Deploy enterprise beans »
Next » Step: Provide options to perform the EJB Deploy.

You can specify the EJB deployment tool options on this panel when installing or updating an application
that contains EJB modules. The EJB deployment tool runs during installation of EJB 1.x or 2.x modules.
The EJB deployment tool does not run during installation of EJB 3.0 modules.

The options that you specify set parameter values for the ejbdeploy command. The tool, and thus the
ejbdeploy command, is run on the enterprise archive (EAR) file during installation after you click Finish on
the Summary panel of the wizard.

Class path:

Specifies the class path of one or more zipped or Java archive (JAR) files on which the JAR or EAR file
being installed depends.

To specify the class paths of multiple zipped and JAR files, the zipped and JAR file names must be fully
qualified, separated by semicolons, and enclosed in double quotation marks. For example:

path\myJarl.jar;path\myJar2.jar;path\myJar3.jar

Class path is the same as the ejbdeploy command parameter -cp class_path.

Data type String
Default null

56 Developing and deploying applications



RMIC:

Specifies whether the EJB deployment tool passes RMIC options to the Remote Method Invocation
compiler. Refer to RMI Tools documentation for information on the options.

Separate options by a space and enclose them in double quotation marks. For example:
"-nowarn -verbose"

The RMIC setting is the same as the ejbdeploy command parameter -rmic "options".

Data type String
Default null

Database type:

Specifies the name of the database vendor, which is used to determine database column types, mapping
information, Table.sql, and other information. Select a database type or the empty choice from the
drop-down list. The list contains the names of valid database vendors. Selecting the empty choice sets the
database type to "" (null).

If you specify a database type, previously defined backend IDs for all of the EJB modules are overwritten
by the chosen database type. To enable backend IDs for individual EJB modules, select the empty choice
to set the database type to null.

The backend IDs SQL92 (1992 SQL Standard) and SQL99 (1999 SQL Standard) are deprecated. Although
the SQL92 and SQL99 backend IDs are available in the list, they are deprecated.

Database type is the same as the ejbdeploy command parameter -dbvendor name.

Data type String

Default DB2UDB_V82

Database schema:

Specifies the name of the schema that you want to create.

The EJB deployment tool saves database information in the schema document in the JAR or EAR file,
which means that the options do not need to be specified again. It also means that when a JAR or EAR is

generated, the correct database must be defined at that point because it cannot be changed later.

If the name of the schema contains any spaces, the entire name must be enclosed in double quotes. For
example:

"my schema"

Database schema is the same as the ejbdeploy command parameter -dbschema "name".

Data type String
Default null

Database access type:

Specifies the database access type for a DB2 database that supports Structured Query Language for Java
(SQLJ). Use SQLJ to develop data access applications that connect to DB2 databases. SQLJ is a set of
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programming extensions that support use of the Java programming language to embed statements that
provide SQL (Structured Query Language) database requests.

To view this setting, you must select a DB2 backend database that supports SQLJ from the Database
type drop-down list.

Available database access types include JDBC and SQLJ.

Data type String
Default JDBC
SQLJ class path:

Specifies the class path of the DB2 SQLJ tool sqlj.zip file. The product uses this class path to run the DB2
SQLJ tool during application installation and generate SQLJ profiles (.ser files).

To view this setting, you must select a DB2 backend database that supports SQLJ from the Database
type drop-down list.

When you reinstall an application EAR file, the product deletes any existing SQLJ profiles and creates new
profiles.

If you do not specify a class path, the product displays a warning about the missing class path. After you
specify a valid class path, you can continue using the wizard for the application installation.

You can customize or add bindings to the generated SQLJ profile after the product installs the application.
Use the administrative console SQLJ profiles and pureQuery bind files page accessed by clicking
Applications > Application Types > WebSphere enterprise applications > application_name > SQLJ
profiles and pureQuery bind files.

Data type String
Default null

JDK compliance level:

Specifies the Java developer kit compiler compliance level as 1.4, 5.0, or 6.0 when you include application
source files for compilation.

The default is to use whatever developer kit version the ejbdeploy command is using. If your application is
using new functionality defined in Version 5.0 or 6.0 or you are including source files (which is not
recommended), then you must specify the Version 5.0 or 6.0 level.

JDK compliance level is the same as the ejbdeploy command parameter -compliancelLevel "I.4" |

||5.0|| | "6.0".
Data type String
Default null (empty string)

Bind listeners for message-driven beans settings
Use this panel to specify bindings for message-driven beans in your application or module.
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To view this administrative console panel, click Applications » Application Types > WebSphere
enterprise applications > application_name > Message Driven Bean listener bindings. This panel is
the same as the Bind listeners for message-driven beans panel on the application installation and
update wizards.

Each message-driven bean must be bound to a listener port name or to an activation specification Java
Naming and Directory Interface (JNDI) name.

Provide a listener port name if your application uses any of the following Java Message Service (JMS)
providers:

» Version 5 default messaging

* WebSphere MQ

* Generic

Provide an activation specification JNDI name if your application’s resources are configured using the
default messaging provider or any generic J2C resource adapter that supports inbound messaging.

Not providing valid listener port names or activation specification JNDI names results in the following
errors:

 If neither a listener port name or an activation specification JNDI name is specified for a message
driven bean, then a validation error is displayed after you click Finish on the Summary panel.

 If the module containing the message-driven bean is deployed on a 5.x deployment target and a listener
port is not specified, then a validation error is displayed after you click Next.

» If multiple message driven beans are linked to the same destination, specify the same destination JNDI
name for each message driven bean. If you specify different destination JNDI names, a validation error
is displayed and all JNDI specifications after the first one are ignored.

To apply binding changes to multiple mappings:

1. In the list of mappings, select the Select check box beside each EJB module that you want mapped to
a particular binding.

2. Expand Apply Multiple Mappings.
Specify a listener port name or select a target resource JNDI name for an activation specification.

4. If you are defining a binding for an activation specification, optionally specify the following:

Destination JNDI name
For resource adapters that support JMS, specify javax.jms.Destinations so the resource
adapter can service messages from the JMS destination. A destination JNDI name set as part
of application deployment take precedence over properties set on an activation specification
administrative object.

Target resource JNDI Name
Specify the target resource JNDI name when mapping a message-driven bean to an activation
specification.

ActivationSpec authentication alias
Specify an authentication alias that is used to access the user name and password that are set
on the configured J2C activation specification. Authentication alias properties set as part of
application deployment take precedence over properties set on an activation specification
administrative object.

5. Click Apply.
6. Click OK or Next.

w

EJB module:

Specifies the name of the module that contains the enterprise bean.

EJB:
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Specifies name of an enterprise bean in the application.

URI:

Specifies the location of the module relative to the root of the application EAR file.
Messaging type:

Specifies the type of message-driven bean.

Bindings:

Specifies a listener port name or an activation specification JNDI name for the message-driven bean.
When a message-driven enterprise bean is bound to an activation specification JNDI name you can also
specify the destination JNDI name and the authentication alias.

Bindings specify JNDI names for the referenceable and referenced artifacts in an application. An example
JNDI name for a listener port to be used by a Store application might be StoreMdbListener. The binding
definition is stored in IBM bindings files such as ibm-ejb-jar-bnd.xmi.

Example: Installing an EAR file using the default bindings

If application bindings were not specified for all enterprise beans or resources in an enterprise application
during application development or assembly, you can select to generate default bindings. After application
installation, you can modify the bindings as needed using the administrative console.

Before you begin

This topic assumes that the application can run on a Web server.
About this task

This topic describes how to install a simple .ear file using the default bindings. You can follow the steps to
install any application, including applications provided with the product in the samples or installableApps
subdirectory.

1. Click Applications > New application > New Enterprise Application in the console navigation tree.
2. On the first Preparing for application install page, specify the full path name of the EAR file.

a. For Path to the new application, specify the full path name of the .ear file. For this example, the
base file name is my_appl.ear and the file resides on a server at C:\sample_apps.

For this example, the base file name is my_appl.ear and the file resides on a server at
/home/myuserid/myapps. Thus, enter the fully qualified path name for the file, /home/myuserid/
myapps/my_appl.ear.

b. Click Next.

3. On the second Preparing for application install page, choose to generate default bindings.
a. Expand Choose to generate default bindings and mappings.
b. Select Generate default bindings.

Using the default bindings causes any incomplete bindings in the application to be filled in with
default values. the product does not change existing bindings. By choosing this option, you can
skip many of the steps of the application installation wizard and go directly to the Summary step.

c. Click Next.
4. If application security warnings are displayed, read the warnings and click Continue.

5. On the Install New Application page, click the step number for Map modules to servers, and verify
the cell, node, and server onto which the application files will install.
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a. From the Clusters and servers list, select the server onto which the application files will install.
b. Select all of the application modules.
c. Click Next.

On the Map modules to servers panel, you can map modules to other servers such as Web servers.
If you want a Web server to serve the application, use the Ctrl key to select an application server or
cluster and the Web server together in order to have the plug-in configuration file plugin-cfg.xml for that
Web server generated based on the applications which are routed through it.

6. On the Install New Application page, click the step number beside Summary, the last step.
7. On the Summary panel, click Finish.

What to do next

Examine the application installation progress messages. If the application installs successfully, save your
administrative configuration. You can now see the name of your application in the list of deployed
applications on the |Enterprise applications page| accessed by clicking Applications » Application Types -
WebSphere enterprise applications in the console navigation tree.

If the application does not install successfully, read the messages to identify why the installation failed.
Correct problems with the application as needed and try installing the application again.

If the application has a Web module, try opening a browser on the application.
1. Point a Web browser at the URL for the deployed application.

The URL typically has the format http://host_name:9060/Web_module name, where host_name is your
valid Web server and 9060 is the default port number.

2. Examine the performance of the application.

If the application does not perform as desired, edit the application configuration, then save and test it
again.

Example: Installing a Web Services Sample with the console

The product provides a Web Services sample application that you can install on a Version 7.x application
server.

Before you begin

During installation, select to install the sample applications. After installation, ensure that your product
installation has a Version 7.x application server onto which you can install the Web Services Sample.

About this task

Installing the sample applications adds the JaxWSServicesSamples.ear enterprise application and
supporting Java archives (JAR files) to the |app_server_roo4’samples/lib/JaxWSServicesSampIes directory
of your product installation.

This topic describes how to install and start the Jax\WSServicesSamples.ear enterprise application using
an administrative console.

1. Click Applications > New application > New Enterprise Application in the console navigation tree.
2. On the first Preparing for application installation page, specify to install Jax\WSServicesSamples.ear.

a. Click Local file system or Remote file system and specify the full path name of the
JaxWSServicesSamples.ear file.

app_server_root/samples/1ib/JaxWSServicesSamples/JaxWSServicesSamples.ear
b. Click Next.
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On the second Preparing for application installation page, select the fast path option.
a. Select Fast Path - Prompt only when additional information is required.

b. Click Next.

Click Next on each panel until you reach the Summary panel.

Do not go directly from Step 1 to the Summary panel. You must click Next on each panel that has
mandatory settings to enter values for those settings. Simply click Next to enter the default values. You
optionally can change the values to suit your environment.

On the Summary panel, verify the cell, node, and server onto which the application modules will install,
and then click Finish.

Examine the application installation progress messages.

If the application installs successfully, the message Application JaxWSServicesSamples installed
successfully is displayed. Click Save. After the configuration changes are saved, you can see the
name of the application in the list of deployed applications on the Enterprise applications page
accessed by clicking Applications > Application Types » WebSphere enterprise applications in the
console navigation tree.

If the application does not install successfully, read the messages to identify why the installation failed.
Correct problems with the server or application and try installing the application again.

Results

The JaxWSServicesSamples application is in the list of deployed applications on the Enterprise
applications page.

What to do next

After the application installs successfully, do the following:

1.

Start the application.

On the Enterprise applications page, select the check boxes beside JaxWSServicesSamples, and
then click Start.

Test the application. Point your Web browser at:

http://Tocalhost:9080/wssamplesei/demo

If the localhost address does not load, substitute the host name (IP address) of the computer for
localhost; for example, http://9.22.33.44:9080/wssamplesei/demo.

If you have another WebSphere Application Server installation on your machine, the server port
number is likely not 9080. See the Ports table in the administrative console to find the WC_defaulthost

server port number. Click Servers » Server Types > WebSphere application servers -~ server1 -
Ports. The Ports table lists the important ports:

Port name Description

WC_adminhost Port used to open an unsecure administrative console in the URL

http://host_name:administrative_port/ibm/console

WC_adminhost_secure Port used to open a secure administrative console in the URL

http://host_name:administrative port/ibm/console

WC_defaulthost Port used to test running applications in the URL http://host_name:server_port/

servlet_name

WC_defaulthost_secure Port used to securely test running applications in the URL http://

host_name:server_port/servlet_name

You can also view the running Web Services Sample in a Web browser open on the Samples Gallery at
http://localhost:9080/WSsamples. As needed, substitute the host name (IP address) of the computer for
localhost and the port name for 9080. After installation of the Web Services Sample, click Installed
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Samples > Web Services Samples » JAX-WS Web Services Samples.

Installing enterprise modules with JSR-88

You can install Java Platform, Enterprise Edition (Java EE) modules on an application server provided by
a WebSphere Application Server product using the Java EE Application Deployment API specification
(JSR-88).

Before you begin

JSR-88 defines standard application programming interfaces (APIs) to enable deployment of Java EE
applications and stand-alone modules to Java EE product platforms. The Java EE Application Deployment
specification Version 1.1 is available at http://java.sun.com/j2ee/tools/deployment/reference/docs/index.html
as part of the Java 2 Platform, Enterprise Edition (J2EE) 1.4 Application Server Developer Release.

Read about JSR-88 and APIs used to manage applications at http://java.sun.com/j2ee/tools/deployment/.
About this task

JSR-88 defines a contract between a tool provider and a platform that enables tools from multiple vendors
to configure, deploy and manage applications on any Java EE product platform. The tool provider typically
supplies software tools and an integrated development environment (IDE) for developing and assembly of
Java EE application modules. The Java EE platform provides application management functions that
deploy, undeploy, start, stop, and otherwise manage Java EE applications.

WebSphere Application Server is a Java EE specification-compliant platform that implements the JSR-88
APls. Complete the following steps to deploy (install) Java EE modules on an application server provided
by the WebSphere Application Server platform.
1. Code a Java program that can access the JSR-88 DeploymentManager class for the product.
a. Write code that finds the JAR manifest attribute J2EE-DeploymentFactory-Implementation-Class.
Under JSR-88, your code finds the DeploymentFactory using the JAR manifest attribute

J2EE-DeploymentFactory-Implementation-Class. The following product application management
JAR files contain this attribute and provide support:

Environment JAR file containing the manifest attribute

Application server plugins/com.ibm.ws.admin.services.jar
Application client app_client_root/plugins/com.ibm.ws.j2ee.client.jar

Thin application client app_client_root/runtimes/com.ibm.ws.admin.client_7.0.0.jar

After your code finds the DeploymentFactory, the deployment tool can create an instance of the
WebSphere DeploymentFactory and register the instance with its DeploymentFactoryManager.

Example code for the application server environment follows. The example code requires that you
use the development kit shipped with the product or use the pluggable client for deployment of
stand-alone modules. See WebSphere Application Server detailed system requirements at
http://www.ibm.com/support/docview.wss?rs=180&uid=swg27006921 for information on supported
development kits.

import javax.enterprise.deploy.shared.factories.DeploymentFactoryManager;

import javax.enterprise.deploy.spi.DeploymentManager;

import javax.enterprise.deploy.spi.factories.DeploymentFactory;

import java.util.jar.JdarFile;
import java.util.jar.Manifest;

// Get the DeploymentFactory implementation class from the MANIFEST.MF file.
File jsr88Jar = new File(wasHome + "/plugins/com.ibm.ws.admin.services.jar");
JarFile jarFile = new JarFile(jsr88Jar);

Manifest manifest = jarFile.getManifest();
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Attributes attributes = manifest.getMainAttributes();

String key = "J2EE-DeploymentFactory-Implementation-Class";

String className = attributes.getValue(key);

// Get an instance of the DeploymentFactoryManager
DeploymentFactoryManager dfm = DeploymentFactoryManager.getInstance();

// Create an instance of the WebSphere Application Server DeploymentFactory.
Class deploymentFactory = Class.forName(className);
DeploymentFactory deploymentFactorylInstance =

(DeploymentFactory) deploymentFactory.newInstance();

// Register the DeploymentFactory instance with the DeploymentFactoryManager.
dfm.registerDeploymentFactory(deploymentFactoryInstance);

// Provide WebSphere Application Server URL, user ID, and password.

// For more information, see the step that follows.

wsDM = dfm.getDeploymentManager(
"deployer:WebSphere:myserver:8880", null, null);

b. Write code that accesses the DeploymentManager instance for the product The product URL for
deployment has the format

"deployer:WebSphere:host:port"

The example in the previous step, "deployer:WebSphere:myserver:8880”, tries to connect to host
myserver at port 8880 using the SOAP connector, which is the default.

The URL for deployment can have an optional parameter connectorType. For example, to use the
RMI connector to access myserver, code the URL as follows:

"deployer:WebSphere:myserver:2809?connectorType=RMI"

2. Optional: Code a Java program that can [customize or deploy Java EE applications or modules using
the JSR-88 support| provided by the product.

3. Start the deployed Java EE applications or stand-alone Java EE modules using the JSR-88 API used
to start applications or modules.

What to do next

Test the deployed applications or modules. For example, point a Web browser at the URL for a deployed
application and examine the performance of the application. If necessary, update the application.

Customizing modules using DConfigBeans

You can configure Java Platform, Enterprise Edition (Java EE) applications or standalone modules during
deployment using the DConfigBean class in the Java EE Application Deployment API specification
(JSR-88).

Before you begin

This topic assumes that you are deploying (installing) Java EE modules on an application server provided
by the product using the [WebSphere Application Server support for JSR-BBl

Read about the JSR-88 specification and using the DConfigBean class at |http:/java.sun.com/j2ee/tools/|

About this task

The DConfigBean class in JSR-88 provides JavaBeans-based support for platform-specific configuration of
Java EE applications and modules during deployment. Your code can inspect DConfigBean instances to
get platform-specific configuration attributes. The DConfigBean instances provided by WebSphere
Application Server contain a single attribute which has an array of java.util.Hashtable objects. The
hashtable entries contain configuration attributes, for which your code can get and set values.
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1. Write code that finstalls Java EE modules on an application server using JSR-88]

2. Write code that accesses DConfigBeans generated by the product during JSR-88 deployment. You (or
a deployer) can then customize the accessed DConfigBeans instances. The following pseudocode
shows how a Java EE tool provider can get DConfigBean instance attributes generated by the product
during JSR-88 deployment and set values for the attributes.

import javax.enterprise.deploy.model.*;
import javax.enterprise.deploy.spi.*;

DeploymentConfiguration dConfig = __ ; // Get from DeploymentManager
DDBeanRoot ddRoot = __; // Provided by J2EE tool

// Obtain root bean.
DConfigBeanRoot dcRoot = dConfig.getDConfigBeanRoot (dr);

// Configure DConfigBean.
configureDCBean (dcRoot);
}

// Get children from DConfigBeanRoot and configure each child.
method configureDCBean (DConfigBean dcBean)
{
// Get DConfigBean attributes for a given archive.
BeanInfo bInfo = Introspector.getBeanInfo(dcBean.getClass());
IndexedPropertyDescriptor ipDesc =
(IndexedPropertyDescriptor)bInfo.getPropertyDescriptors()[0];

// Get the 0th table.
int index = 0;
Hashtable tb1 = (Hashtable)
ipDesc.getIndexedReadMethod().invoke
(dcBean, new Object[]{new Integer(index)});

while (tbl != null)
{

// Iterate over the hashtable and set values for attributes.

// Set the table back into the DCBean.
ipDesc.getIndexedWriteMethod().invoke
(dcBean, new Object[]{new Integer(index), tb1});

// Get the next entry in the indexed property
tb1 = (Hashtable)
ipDesc.getIndexedReadMethod().invoke
(dcBean, new Object[]{new Integer(++index)});

Enterprise application collection

Use this page to view and manage enterprise applications.

This page lists installed enterprise applications. System applications, which are central to the product, are
not shown in the list because users cannot edit them. Examples of system applications include isclite,
managementEJB and filetransfer.

To view this administrative console page, click Applications > Application Types > WebSphere
enterprise applications.

To view the values specified for an application’s configuration, click the application name in the list. The
displayed application settings page shows the values specified. On the settings page, you can change
existing configuration values and link to additional console pages that assist you in configuring the
application.
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To manage an installed enterprise application, enable the Select check box beside the application name in
the list and click a button:

Button Resulting action

Start Attempts to run the application. After the application starts up successfully, the state of
the application changes to Started if the application starts up on all deployment
targets, else the state changes to Partial Start.

Stop Attempts to stop the processing of the application. After the application stops
successfully, the state of the application changes to Stopped if the application stops on
all deployment targets, else the state changes to Partial Stop.

Install Opens a wizard that helps you deploy an application or a module such as a .jar, .war,
.sar or .rar file onto a server or a cluster.

Uninstall Deletes the application from the product configuration repository and deletes the
application binaries from the file system of all nodes where the application modules
are installed after the configuration is saved and synchronized with the nodes.

Update Opens a wizard that helps you update application files deployed on a server. You can
update the full application, a single module, a single file, or part of the application. If a
new file or module has the same relative path as a file or module already existing on
the server, the new file or module replaces the existing file or module. If the new file or
module does not exist on the server, it is added to the deployed application.

Remove File Deletes a file of the deployed application or module. Remove File deletes a file from
the configuration repository and from the file system of all nodes where the file is
installed.

Export Accesses the Export Application EAR files page, which you use to export an enterprise

application to an EAR file at a location of your choice. Use the Export action to back
up a deployed application and to preserve its binding information.

Export DDL Accesses the Export Application DDL files page, which you use to export DDL files
(Table.ddl) in the EJB modules of an enterprise application to a location of your choice.

Export File Accesses the Export a file from an application page, which you use to export a file of
an enterprise application or module to a location of your choice.

If the browser does not prompt for a location to store the file, click File > Save as and
specify a location to save the file that is shown in the browser.

These buttons are not available when you access this page from an application server settings page.
When this page is accessed from an application server settings page, it is entitled the Installed
applications page.

When security is enabled, a separate application list is shown for each of your administrative roles.
Supported roles include monitor, configurator, operator, administrator, deployer, and administrative security
manager. For example, when you have the administrator role, the statement “You can administer the
following resources” is shown followed by a list of applications that you can administer.

Name

Specifies the name of the installed (or deployed) application. Application names must be unique within a
cell and cannot contain an unsupported character.

Application Status

Indicates whether the application deployed on the application server is started, stopped, or unknown.

=|l} Started Application is running.
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={} Partial Start Application is in the process of changing from a Stopped state to a Started
state. Application is starting to run but is not fully running yet. Or, it cannot fully
start because a server mapped to one or more application modules is stopped.

. 4 Stopped Application is not running.

503 Partial Stop Application is in the process of changing from a Started state to a Stopped
state. Application has not stopped running yet.

@ Unknown Status cannot be determined.

E Pending Status is temporarily unknown pending an event that a user did not initiate,
such as pending an asynchronous call.

Not applicable Application does not provide information as to whether it is running.

The status of an application on a Web server is always Unknown.

Startup order

Specifies the order in which applications are started when the server starts. The application with the lowest
startup order is started first.

This table column is available only when this page is accessed from an application server settings page;
thus when this page is entitled the Installed applications page.

Enterprise application settings
Use this page to configure an enterprise application.

To view this administrative console page, click Applications > Application Types > WebSphere
enterprise applications > application_name.

If you have a JAX-WS Web service application installed, you also can click Services » Service providers
> service_name or Services ~» Service clients > service_name.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

Name

Specifies a logical name for the application. An application name must be unique within a cell and cannot
contain an unsupported character.

An application name cannot begin with a period (.), cannot contain leading or trailing spaces, and cannot
contain any of the following characters:

Unsupported characters

| forward slash $ dollar sign ’ single quote mark

\ backslash = equal sign " double quote mark

* asterisk % percent sign | vertical bar

, comma + plus sign < left angle bracket
colon @ at sign > right angle bracket

;  semi-colon # hash mark & ampersand (and sign)

? question mark 11> No specific name exists for this character combination
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Data type String

Application reference validation
Specifies whether the product examines the application references specified during application installation
or updating and, if validation is enabled, warns you of incorrect references or fails the operation.

An application typically refers to resources using data sources for container managed persistence (CMP)
beans or using resource references or resource environment references defined in deployment descriptors.
The validation checks whether the resource referred to by the application is defined in the scope of the
deployment target of that application.

The resource can be defined on the server, its node, cell or the cluster if the server belongs to a cluster.
Select Don’t validate for no resource validation, Issue warnings for warning messages about incorrect
resource references, or Stop installation if validation fails to stop operations that fail as a result of
incorrect resource references.

This Application reference validation setting is the same as the Validate input off/warn/fail field on the
application installation and update wizards.

Data type String
Default Issue warnings

Configuring enterprise application files

You can change the configuration of a Java Platform, Enterprise Edition (Java EE) application or module
deployed on a server.

Before you begin

You can change the contents of and deployment descriptors for an application or module before
deployment, such as in an fassembly tooll However, it is assumed that the module is already
About this task

Changing an application or module configuration consists of one or more of the following:
» Changing the settings of the application or module.

« [Removing a file| from an application or module.

« [Updating the application|or its modules.

This topic describes how to change the settings of an application or module using the administrative
console.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

» View current settings of the application or module.

Click Applications » Application Types > WebSphere enterprise applications » application_name
to access the fenterprise application settings pagel
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Many application or module settings are available on other console pages that you can access by
clicking links on the settings page for the enterprise application. For detailed information on the settings
and allowed values, examine the online help for the console pages. When you installed the application
or module, you specified most of the settings values.

. |Map each module| of your application to a target server.

Specify the application servers or Web servers onto which to install modules of your application.
|Change how quickly your application startsl compared to other applications or to the server.
Configure the [use of binary files,

« [Change how your application or Web modules use class loaders]

* |Map a virtual host for each Web module| of your application. |Configuring virtual hostsl provides
information on virtual hosts.

* Change |app|ication bindings|or other settings of the application or module.

1. Click Applications » Application Types > WebSphere enterprise applications -
application_name - property_or_item_name. From the |app|ication settings page|, you can access
console pages for further configuring of the application or module.

2. Change the values for settings as needed, and click OK.

« Optional: [Configure the application so it does not start automatically| when the server starts. By default,
an installed application starts when the server on which the application resides starts. You can configure
the target mapping for the application so the application does not start automatically when the server
starts. To start the application, you must then |start it manually}

If the installed application or module uses a resource adapter archive (RAR file), ensure that the
Classpath setting for the RAR file enables the RAR file to find the classes and resources that it needs.
Examine the Classpath setting on the console [Resource adapter settings pagel

Results

The application or module configuration is changed. The application or standalone Web module is
restarted so the changes take effect.

What to do next

Save changes to your administrative configuration.

Application bindings
Before an application that is installed on an application server can start, all enterprise bean (EJB)

references and resource references defined in the application must be bound to the actual artifacts
(enterprise beans or resources) defined in the application server.

When defining bindings, you specify [Java Naming and Directory Interface (JNDI) names| for the
referenceable and referenced artifacts in an application. The jndiName values specified for artifacts must
be qualified . An example referenceable artifact is an EJB defined in an application. An
example referenced artifact is an EJB or a resource reference used by the application.

Binding definitions are stored in the ibm-xxx-bnd.xml or ibm-xxx-bnd.xmi files of an application. Version 7.0
binding definitions support files with the suffix of XML for EJB 3.0 and Web 2.5 modules. Modules earlier
than Java EE 5 continue to use binding definition files with the suffix of XMI as in previous versions of
WebSphere Application Server. The xxx can be ejb-jar, web, application or application-client.

Note: For EJB 3.0 modules, you do not need to specify JNDI binding names for each of the home or
business interfaces on your enterprise beans. If you do not explicitly assign bindings, the EJB
container assigns default bindings. Further, binding definitions are stored in ibm-ejb-jar-bnd.xml.
See [EJB 3.0 application bindings overview|
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This topic provides the following information about bindings:
+ [“Times when bindings can be defined?]

* [‘Required bindings’]

« [“Other bindings that might be needed” on page 74|

Times when bindings can be defined

You can define bindings at the following times:
» During application development

An application developer can create binding definitions in ibm-xxx-bnd.xml files for EJB 3.0 and Web 2.5
modules and in ibm-xxx-bnd.xmi files for pre-dJava EE 5 modules. The application developer can create
the files using a tool such as an IBM Rational developer tool or, for EJB 3.0 or Web 2.5 modules, using
an XML editor or text editor. The developer then gives an enterprise application (.ear file) complete with
bindings to an application assembler or deployer. When assembling the application, the assembler does
not modify the bindings. Similarly, when installing the application onto a server supported by
WebSphere Application Server, the deployer does not modify or override the bindings or generate
default bindings unless changes to the bindings are necessary for successful deployment of the
application.

+ During [application assembly|

An application assembler can define bindings in annotations or deployment descriptors of an
application. Java EE 5 modules contain annotations in the source code. To declare an annotation, an
application assembler precedes a keyword with an @ character ("at” sign). Bindings for pre-Java EE 5
modules are specified in the WebSphere Bindings section of a deployment descriptor editor. Modifying
the deployment descriptors might change the binding definitions in the ibm-xxx-bnd.xmi files created
when developing an application. After defining the bindings, the assembler gives the application to a
deployer. When installing the application onto a server supported by WebSphere Application Server, the
deployer does not modify or override the bindings or generate default bindings unless changes to the
bindings are necessary to deploy the application.

+ During |application installation|

An application deployer or server administrator can modify the bindings when installing the application
onto a server supported by WebSphere Application Server using the administrative console. New
binding definitions can be specified on the installation wizard pages.

Also, a deployer or administrator can select to generate default bindings during application installation.
Selecting Generate default bindings during application installation instructs the product to fill in
incomplete bindings in the application with default values. Existing bindings are not changed.

Note: You cannot define or override bindings during application installation for [application clients| You
must define bindings for application client modules during assembly and store the bindings in the
ibm-application-client-bnd.xmi file.

« During [configuration of an installed application|

After an application is installed onto a server supported by WebSphere Application Server, an

application deployer or server administrator can modify the bindings by changing values in

administrative console pages such as those accessed from the [settings page for the enterprise]

Required bindings

Before an application can be successfully deployed, bindings must be defined for references to the
following artifacts:

EJB JNDI names

For each EJB 2.1 or earlier jenterprise bean (EJB), you must specify a JNDI name. The name is
used to bind an entry in the global JNDI for the EJB home object. An example JNDI
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name for a Product EJB in a Store application might be store/ejb/Product. The binding definition
is stored in the META-INF/ibm-ejb-jar-bnd.xmi file.

If a deployer chooses to generate default bindings when installing the application, the installation
wizard assigns EJB JNDI names having the form prefix' EJB_name to incomplete bindings. The
default prefix is ejb, but can be overridden. The EJB_name is as specified in the deployment
descriptor <ejb-name> tag.

During and after application installation, EJB JNDI names can be specified on the [Provide JNDI
|names for beansl panel. After installation, click Applications > Application Types » WebSphere
enterprise applications > application_name > EJB JNDI names in the administrative console.

You do not need to specify JNDI binding names for each of the EJB 3.0 home or business
interfaces on your enterprise beans because the EJB container assigns default bindings. See
3.0 application bindings overview|

Data sources for entity beans
Entity beans| such as container-managed persistence (CMP) beans |store persistent data in datal
storesi With CMP beans, an EJB container manages the persistent state of the beans. You specify
which data store a bean uses byan EJB module or an individual enterprise bean to a data
source. Binding an EJB module to a data source causes all entity beans in that module to use the
same data source for persistence.

An example JNDI name for a Store data source in a Store application might be store/jdbc/store.
For modules earlier than Java EE 5, the binding definition is stored in IBM binding files such as
ibm-ejb-jar-bnd.xmi. A deployer can also specify whether authentication is handled at the container
or application level.

WebSphere Application Server Version 7.0 supports CMP beans in EJB 2.x or 1.x modules.
Version 7.0 does not support CMP beans in EJB 3.0 modules.

If a deployer chooses to generate default bindings when installing the application, the install wizard

generates the following for incomplete bindings:

» For EJB 2.x .jar files, connection factory bindings based on the JNDI name and authorization
information specified

* For EJB 1.1 jar files, data source bindings based on the JNDI name, data source user name
and password specified

The generated bindings provide default connection factory settings for each EJB 2.x .jar file and
default data source settings for each EJB 1.1 jar file in the application being installed. No
bean-level connection factory bindings or data source bindings are generated unless they are
specified in the custom strategy rule supplied during default binding generation.

During and after application installation, you can map data sources to 2.x entity beans on the
[CMP bean data sources| panel and on the [2.x entity bean data sources|panel. After installation,
click Applications » Application Types » WebSphere enterprise applications -
application_name in the administrative console, then select 2.x CMP bean data sources or 2.x
entity bean data sources. You can map data sources to 1.x entity beans on the Map data
sources for all 1.x CMP beans panel and on the Provide default data source mapping for modules
containing 1.x entity beans panel. After installation, access console pages similar to those for 2.x
CMP beans, except click links for 1.x CMP beans.

Backend ID for EJB modules
If an EJB .jar file that defines CMP beans contains mappings for multiple backend databases,
specify the appropriate backend ID that determines which persister classes are loaded at run time.

Specify the backend ID during application installation. You cannot select a backend ID after the
application is installed onto a server.

To enable backend IDs for individual EJB modules:
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1. During application installation, select Deploy enterprise beans on the [Select installation|
panel. Selecting Deploy enterprise beans enables you to access the Provide options
to perform the EJB Deploy panel.

2. On the Provide options to perform the EJB Deploy panel, set the database type to " (null).

During application installation, if you select Deploy enterprise beans on the Select installation
options panel and specify a database type for the EJB deployment tool on the Provide options to
perform the EJB Deploy panel, previously defined backend IDs for all of the EJB modules are
overwritten by the chosen database type.

The default database type is DB2UDB_V81.
The EJB deployment tool does not run during installation of EJB 3.0 modules.

EJB references
An |enterprise bean (EJB) reference| is a logical name used to locate the home interface of an
enterprise bean. EJB references are specified during deployment. At run time, EJB references are
bound to the physical location (global JNDI name) of the enterprise beans in the target operational
environment. EJB references are made available in the java:comp/env/ejb Java naming
subcontext.

The product assigns default JNDI values for or automatically resolves incomplete EJB 3.0
reference targets.

For each EJB 2.1 or earlier EJB reference, you must specify a JNDI name. An example JNDI
name for a Supplier EJB reference in a Store application might be store/ejb/Supplier. The
binding definition is stored in IBM binding files such as ibm-ejb-jar-bnd.xmi. When the referenced
EJB is also deployed in the same application server, you can specify a server-scoped JNDI nhame.
But if the referenced EJB is deployed on a different application server or if ejb-ref is defined in an
application client module, then you should specify the global cell-scoped JNDI name.

If a deployer chooses to generate default bindings when installing the application, the install wizard
binds EJB references as follows: If an <ejb-1ink> is found, it is honored. If the ejb-name of an
EJB defined in the application matches the ejb-ref name, then that EJB is chosen. Otherwise, if a
unique EJB is found with a matching home (or local home) interface as the referenced bean, the
reference is resolved automatically.

During and after application installation, you can specify EJB reference JNDI names on the Map
EJB references to beans panel. After installation, click Applications » Application Types »
WebSphere enterprise applications > application_name > EJB references in the administrative
console.

Note: To enable EJB reference targets to resolve automatically if the references are from EJB 2.1
or earlier modules or from Web 2.3 or earlier modules, select Generate default bindings
on the Preparing for application installation panel or select Allow EJB reference targets to
resolve automatically on the Select installation options, Map EJB references to beans, or
EJB references console panels.

For more information, refer to [EJB references|.

Resource references
A|resource referencel is a logical name used to locate an external resource for an application.
Resource references are specified during deployment. At run time, the references are bound to the
physical location (global JNDI name) of the resource in the target operational environment.
Resource references are made available as follows:

Resource reference type Subcontext declared in
Java DataBase Connectivity (JDBC) java:comp/env/jdbc
JMS connection factory java:comp/env/jms
[JavaMail connection factory| java:comp/env/mail
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lUniform Resource Locator (URL) connection factory| |java:comp/env/ur|

For each resource reference, you must specify a JNDI name. If a deployer chooses to generate
default bindings when installing the application, the install wizard generates resource reference
bindings derived from the <res-ref-name> tag, assuming that the java:comp/env name is the same
as the resource global JNDI name.

During application installation, you can specify resource reference JNDI names on the Map
resource references to references panel. Specify JNDI names for the resources that represent the
logical names defined in resource references. You can optionally |specify login configuration name|
|and authentication properties| for the resource. After specifying authentication properties, click OK
to save the values and return to the mapping step. Each resource reference defined in an
application must be bound to a resource defined in your WebSphere Application Server
configuration. After installation, click Applications » Application Types > WebSphere enterprise
applications » application_name > Resource references in the administrative console to access
the [Resource references| panel.

Virtual host bindings for Web modules
You must bind each to a specific . The binding informs a Web server
plug-in that all requests that match the virtual host must be handled by the Web application. An
example virtual host to be bound to a Store Web application might be store_host. The binding
definition is stored in IBM binding files such as WEB-INF/ibm-web-bnd.xmi.

If a deployer chooses to generate default bindings when installing the application, the install wizard
sets the virtual host to default_host for each .war file.

During and after application installation, you can map a virtual host to a Web module defined in
your application. On the [Map virtual hosts for Web modules| panel, specify a virtual host. The port
number specified in the virtual host definition is used in the URL that is used to access artifacts
such as servlets and JavaServer Pages (JSP) files in the Web module. For example, an external
URL for a Web artifact such as a JSP file is http://host_name:virtual_host_port/context_root/
jsp_path. After installation, click Applications » Application Types > WebSphere enterprise
applications > application_name > Virtual hosts in the administrative console.

Message-driven beans
For each [nessage-driven bean), you must specify a queue or topic to which the bean will listen. A
message-driven bean is invoked by a Java Messaging Service (JMS) listener when a message
arrives on the input queue that the listener is monitoring. A deployer specifies a listener port or
JNDI name of an activation specification as defined in a connector module (.rar file) under
WebSphere Bindings on the Beans page of an EJB deployment descriptor editor.
An example JNDI name for a listener port to be used by a Store application might be
StoreMdbListener. The binding definition is stored in IBM bindings files such as
ibm-ejb-jar-bnd.xmi.

If a deployer chooses to generate default bindings when installing the application, the install wizard

assigns JNDI names to incomplete bindings.

» For EJB 2.0 or later message-driven beans deployed as JCA 1.5-compliant resources, the
install wizard assigns JNDI names corresponding to activationSpec instances in the form
eis/MDB_ejb-name.

* For EJB 2.0 or later message-driven beans deployed against listener ports, the listener ports
are derived from the message-driven bean <ejb-name> tag with the string Port appended.

During application installation using the administrative console, you can specify a listener port
name or an activation specification JNDI name for every message-driven bean on the Bind
listeners for message-driven beans panel. A listener port name must be provided when using the
JMS providers: Version 5 default messaging, WebSphere MQ, or generic. An activation
specification must be provided when the application’s resources are configured using the default
messaging provider or any generic J2C resource adapter that supports inbound messaging. If
neither is specified, then a validation error is displayed after you click Finish on the Summary
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panel. Also, if the module containing the message-driven bean is deployed on a[5.x deployment
and a listener port is not specified, then a validation error is displayed after you click Next.

After application installation, you can specify JNDI names and configure message-driven beans on
console pages under Resources » JMS > JMS providers or under Resources » Resource
adapters. For more information, refer to |Choosing a messaging provider|

Note: You can only bind message driven-beans that are defined in an EJB 3.0 module to an
activation specification. See |EJB 3.0 application bindings overviewl

Message destination references
A[message destination referencelis a logical name used to locate an enterprise bean in an EJB
module that acts as a message destination. Message destination references exist only in J2EE 1.4
and later artifacts such as--
* J2EE 1.4 application clients
» EJB 2.1 projects
* 2.4 Web applications

If multiple message destination references are associated with a single message destination link,
then a single JNDI name for an enterprise bean that maps to the message destination link, and in
turn to all of the linked message destination references, is collected during deployment. At run
time, the message destination references are bound to the administered message destinations in
the target operational environment.

If a message destination reference and a message-driven bean are linked by the same message
destination, both the reference and the bean should have the same destination JNDI name. When
both have the same name, only the destination JNDI name for the message-driven bean is
collected and applied to the corresponding message destination reference.

If a deployer chooses to generate default bindings when installing the application, the install wizard
assigns JNDI names to incomplete message destination references as follows: If a message
destination reference has a <message-destination-1ink>, then the JNDI name is set to
ejs/message-destination-linkName. Otherwise, the JNDI name is set to eis/message-destination-
refName.

Other bindings that might be needed

Depending on the references in and artifacts used by your application, you might need to define bindings
for references and artifacts not listed in this topic.

Configuring application startup

You can configure the startup behavior of an application. The values set affect how quickly an application
starts and what occurs when an application starts.

Before you begin

This topic assumes that your application or module is already |dep|oyed on a served

This topic also assumes that your application or module is |configured to start automatically| when the
server starts. By default, an installed application starts when the server on which the application resides
starts.

About this task

This topic describes how to change the settings of an application or module using the administrative
console.
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Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

1. Click Applications > Application Types > WebSphere enterprise applications » application_name

> Startup behavior in the console navigation tree.
The [Startup behavior settings pagelis displayed.

2. Specify the startup order for the application.

If your application [starts automatically| when its server starts, the value for Startup order on the
Startup behavior settings page specifies the order in which applications are started when the server
starts. The application with the lowest startup order, or starting weight, is started first. For example,
specify 1 for Startup order for applications that you want started first, specify 2 for applications to be
started next, and so.

Note: For Session Initiation Protocol (SIP) applications, the <load-on-startup> tag in the sip.xml file
affects the order in which applications are started. The value that you set for Startup order on
the Startup behavior settings page determines the importance or weight of an application within
a composition of SIP applications. For example, for the most important SIP application within a
SIP application composition, specify 1 for Startup order. For the next most important SIP
application within the composition, specify 2 for Startup order, and so on.

3. Specify whether the application must initialize fully before its server is considered started.

If your application starts automatically when its server starts, Launch application before server
completes startup specifies whether the application must initialize fully before its server is considered
started. Background applications can be initialized on an independent thread, thus allowing the server
startup to complete without waiting for the application. This setting applies only if the application is run
on a Version 6.0 or later application server.

4. Specify whether to create MBeans for resources such as servlets or JavaServer Pages (JSP) files
within an application when the application starts.

The default for Create MBeans for resources is to create MBeans.
Results

The application or module configuration is changed. The application or standalone Web module is
restarted so the changes take effect.

What to do next

Save changes to your administrative configuration.

Startup behavior settings
Use this page to configure when an application starts compared to other applications and to the server,
and to configure whether MBeans for resources are created when an application starts.

To view this administrative console page, click Applications > Application Types > WebSphere
enterprise applications ~» application_name ~ Startup behavior.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

Startup order:

Chapter 5. Deploying and administering enterprise applications 75



Specifies the order in which applications are started when the server starts. The startup order is like a
starting weight. The application with the lowest starting weight is started first.

Note: For Session Initiation Protocol (SIP) applications, the <load-on-startup> tag in the sip.xml file
affects the order in which servlets within applications are started. The value that you set for Startup
order on this Startup behavior console page determines the importance or weight of an application
within a composition of SIP applications. For example, for the most important SIP application within
a SIP application composition, specify 1 for Startup order. For the next most important SIP
application within the composition, specify 2 for Startup order, and so on. For more information,
see the JSR 116 specification.

Data type Integer
Default 1
Range 0 to 2147483647

Launch application before server completes startup:
Specifies whether the application must initialize fully before the server starts.
The default setting of false indicates that server startup will not complete until the application starts.

A setting of true informs the product that the application might start on a background thread and thus
server startup might continue without waiting for the application to start. Thus, the application might not be
ready for use when the application server starts.

This setting applies only if the application is run on a Version 6.0 or later application server.

Data type Boolean
Default false

Create MBeans for resources:

Specifies whether to create MBeans for various resources, such as servlets or JavaServer Pages (JSP)
files, within an application when the application starts. The default is to create MBeans.

Data type Boolean
Default true

Configuring binary location and use

You can designate where binary files (binaries) used by your application reside, whether the product
distributes binaries for you automatically, and otherwise configure the use of binaries.

Before you begin

This topic assumes that your application or module is already |dep|oyed on a served

About this task

This topic describes how to change the settings of an application or module using the administrative
console.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
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where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

1. Click Applications > Application Types » WebSphere enterprise applications > application_name
> Application binaries in the console navigation tree. The [Application binaries pagel is displayed.

2. Specify the directory to hold the application binaries.
The default is ${APP_INSTALL_ROQT}/cell_name, where the ${APP_INSTALL_ROOT} variable is

installedApps. For example:
profile_root/installedApps/cell _name

Refer to f‘AppIication binary settings’1 for a detailed description of the Location (full path) setting.
3. Specify the bindings, extensions, and deployment descriptors that an application server uses.

By default, an application server uses the|bindings, extensions, and deployment descriptors| located
with the application deployment document, the deployment.xml file.

To specify that the application server use the bindings, extensions, and deployment descriptors located
in the application archive (EAR) file, select Use configuration information in binary. Select this
setting for applications installed on 6.x or later deployment targets. This setting is not valid for
applications installed on 5.x deployment targets.

4. Specify whether the product distributes application binaries automatically to other nodes on the cell.

By default, Enable binary distribution, expansion and cleanup post uninstallation is selected and
binaries are distributed automatically.

If you disable this option, then you must ensure that the application binaries are expanded
appropriately in the destination directories of all nodes where the application runs.

Note: If you disable this option and you do not copy and expand the application binaries to the nodes,
a later saving of the configuration or manual synchronization does not move the application
binaries to the nodes for you.

5. Specify access permissions for binaries.

a. Ensure that the Enable binary distribution, expansion and cleanup post uninstallation option
is enabled. That option must be enabled to specify access permissions for binaries.

b. For File permissions, specify a string that defines access permissions for binaries that are
expanded in the named location.

You can specify file permissions in the text field. You can also set some of the commonly used file
permissions by selecting them from the multiple-selection list. List selections overwrite file
permissions set in the text field.

For details on File permissions, refer to [‘Application binary settings.”]
6. Click OK.

Results

The application or module configuration is changed. The application or stand-alone Web module is
restarted so the changes take effect.

What to do next

Save changes to your administrative configuration.

Application binary settings
Use this page to configure the location and distribution of application binary files.

To view this administrative console page, click Applications > Application Types > WebSphere
enterprise applications > application_name > Application binaries.
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Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

Location (full path):

Specifies the directory to which the enterprise application archive (EAR) file is installed. This Location
setting is the same as the Directory to install application field on the application installation and update
wizards.

By default, an EAR file is installed in the profile_root/installedApps/cell_name/application_name.ear
directory.

Setting options include the following:
* Do not specify a value and leave the field empty.

The default value is ${APP_INSTALL_ROQT}/cell_name, where the ${APP_INSTALL_ROQT} variable is
profile_root/installedApps. A directory having the EAR file name of the application being installed is
appended to ${APP_INSTALL_ROQT}/cell_name. Thus, if you do not specify a directory, the EAR file is
installed in the profile_root/installedApps/cell_name/application_name.ear directory.

» Specify a directory.
If you specify a directory, the application is installed in specified_path/application_name.ear directory. A
directory having the EAR file name of the application being installed is appended to the path that you
specified for Directory to install application when installing the application. For example, if you
installed Clock.ear and specify C:/myapps on Windows machines, the application is installed in the
myapps/Clock.ear directory. The ${APP_INSTALL_ROQT]} variable is set to the specified path.

» Specify ${APP_INSTALL_ROOT}/${CELL} for the initial installation of the application.

If you intend to export the application from one cell and later install the exported application on a
different cell, specify the ${CELL} variable for the initial installation of the application. For example,
specify ${APP_INSTALL ROOT}/${CELL} for this setting. Exporting the application creates an enhanced
EAR file that has the application and its deployment configuration. The deployment configuration retains
the cell name of the initial installation in the destination directory unless you specify the ${CELL}
variable. Specifying the ${CELL} variable ensures that the destination directory has the current cell
name, and not the original cell name.

Note: If an installation directory is not specified when an application is installed on a single-server
configuration, the application is installed in ${APP_INSTALL_ROOT}/cell_name. When the server
is made a part of a multiple-server configuration (using the addNode utility), the cell name of the
new configuration becomes the cell name of the deployment manager node. If the -includeapps
option is used for the addNode uitility, then the applications that are installed prior to the addNode
operation still use the installation directory ${APP_INSTALL_ROOT}/cell_name. However, an
application that is installed after the server is added to the network configuration uses the default
installation directory ${APP_INSTALL_ROQOT}/ network_cell_name. To move the application to the
${APP_INSTALL_ROQT}/network_cell_name location upon running the addNode operation,
explicitly specify the installation directory as ${APP_INSTALL ROOT}/${CELL} during installation. In
such a case, the application files can always be found under ${APP_INSTALL_ROOT}/
current_cell_name.

 If the application has been exported and you want to install the exported EAR file in a different cell or
location, specify ${APP_INSTALL_ROOT}/cell_namelapplication_name.ear if you did not specify
${APP_INSTALL_ROOT}/${CELL} for the initial installation.

The exported EAR file is an enhanced EAR file that has the application and its deployment
configuration. The deployment configuration retains the value for Directory to install application that
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was used for the previous installation of the application. Unless you specify a different value, the
enhanced EAR file will be installed to the same directory as for the previous installation.

If you did not specify the ${CELL} variable during the initial installation, the deployment configuration
uses the cell name of the initial installation in the destination directory. If you are installing on a different
cell, specify ${APP_INSTALL_ROQT)}/cell_name/application_name.ear, where cell_name is the name of
the cell to which you want to install the enhanced EAR file. If you do not designate the current cell
name, cell_name will be the original cell name even though you are installing the enhanced EAR file on
a cell that has a different name.

» Specify an absolute path or a use pathmap variable.

You can specify an absolute path or use a pathmap variable such as ${MY_APPS}. You can use a
pathmap variable in any installation.

Data type String
Units Full path name

Use configuration information in binary:

Specifies whether the application server uses the binding, extensions, and deployment descriptors located
with the application deployment document, the deployment.xml file (default), or those located in the EAR
file.

The default (false) is to use the binding, extensions, and deployment descriptors located in
deployment.xml. To use the binding, extensions, and deployment descriptors located in the EAR file,
enable this setting (true).

This Use configuration information in binary setting is the same as the Use binary configuration field
on the application installation and update wizards. Select this setting for applications installed on 6.x or
later deployment targets only. This setting is not valid for applications installed on 5.x deployment targets.

Data type Boolean
Default false

Enable binary distribution, expansion and cleanup post uninstallation:

Specifies whether the product expands application binaries in the installation location during installation
and deletes application binaries during uninstallation. The default is to enable application distribution.
Application binaries for installed applications are expanded to the directory specified.

On single-server installations, the binaries are deleted when you uninstall and save changes to the
configuration.

If you disable this option, then you must ensure that the application binaries are expanded appropriately in
the destination directories of all nodes where the application runs.

Note: If you disable this option and you do not copy and expand the application binaries to the nodes, a
later saving of the configuration or manual synchronization does not move the application binaries
to the nodes for you.

This Enable binary distribution, expansion and cleanup post uninstallation setting is the same as the
Distribute application field on the application installation and update wizards.

Data type Boolean
Default true
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File permissions:

Specifies access permissions for application binaries for installed applications that are expanded to the
directory specified.

The Enable binary distribution, expansion and cleanup post uninstallation option must be enabled to
specify file permissions.

You can specify file permissions in the text field. You can also set some of the commonly used file
permissions by selecting them from the multiple-selection list. List selections overwrite file permissions set
in the text field.

You can set one or more of the following file permission strings in the list. Selecting multiple options
combines the file permission strings.

Multiple-selection list option File permission string set
Allow all files to be read but not written to .*=755
Allow executables to execute .*\.d11=755#.%\.s0=755#.%\.a=755#.%\.s1=755

Allow HTML and image files to be read by .x\ . htm=755#.%\.htm1=755#.%\.qgif=755#.*\.jpg=755
everyone

Instead of using the multiple-selection list to specify file permissions, you can specify a file permission
string in the text field. File permissions use a string that has the following format:

file_name_pattern=permission#file_name_pattern=permission

where file_name_pattern is a regular expression file name filter (for example, .*\\.jsp for all JSP files),
permission provides the file access control lists (ACLs), and # is the separator between multiple entries of
file_name_pattern and permission. If # is a character in a file_name_pattern string, use \# instead.

If multiple file name patterns and file permissions in the string match a uniform resource identifier (URI)
within the application, then the product uses the most stringent applicable file permission for the file. For
example, if the file permission string is .*\\.jsp=775#a.*\\.jsp=754, then the abc.jsp file has file
permission 754.

Note: Using regular expressions for file matching pattern compares an entire string URI against the
specified file permission pattern. You must provide more precise matching patterns using regular
expressions as defined by Java programming API. For example, suppose the following directory
and file URIs are processed during a file permission operation:

1 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war

/opt/WebSphere/profiles/AppSrv0l/installedApps/MyCell/MyApp.ear/MyWarModule.war/MyJsp.jsp

/opt/WebSphere/profiles/AppSrv0l/installedApps/MyCell/MyApp.ear/MyWarModule.war/META-INF/
MANIFEST.MF

4 /opt/WebSphere/profiles/AppSrv0Ol/installedApps/MyCell/MyApp.ear/MyWarModule.war/WEB-INF/classes/
MyClass.class

5 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war/mydir/
MyCTass2.class

6 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCell/MyApp.ear/MyWarModule.war/META-INF

The file pattern matching results are:
* MyWarModule.war does not match any of the URIs
* .*MyWarModule.war.* matches all URls
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e .xMyWarModule.war$ matches only URI 1

* .*\\.jsp=755 matches only URI 2

e .*META-INF.* matches URIs 3 and 6

e .xMyWarModule.war/.*/.*\.class matches URIs 4 and 5

If you specify a directory name pattern for File permissions, then the directory permission is set based on
the value specified. Otherwise, the File permissions value set on the directory is the same as its parent.
For example, suppose you have the following file and directory structure:

/opt/WebSphere/profiles/AppSrv0l/installedApps/MyCell/MyApp.ear/MyWarModule.war/Mydsp.jsp

and you specify the following file pattern string:
.*MyApp.ear$=755#.%\.jsp=644

The file pattern matching results are:
» Directory MyApp.ear is set to 755
* Directory MyWarModule.war is set to 755
» Directory MyWarModule.war is set to 755

Note: Regardless of the operation system, always use a forward slash (/) as a file path separator in file
patterns.

Access permissions specified here are at the application level. You can also specify access permissions
for application binaries in the node level configuration. The node level file permissions specify the
maximum (most lenient) permissions that can be given to application binaries. Access permissions
specified here at application level can only be the same as or more restrictive than those specified at the
node level.

This setting is the same as the File permission field on the application installation and update wizards.

Data type String

Application build level:

Specifies an uneditable string that identifies the build version of the application.

Data type String

Configuring the use of class loaders by an application

You can configure whether your application and Web modules use their own class loaders to load classes
or use different class loaders, as well as configure the reloading of classes when application files are
updated. Class loaders enable an application to access repositories of available classes and resources.

Before you begin

This topic assumes that your application or module is already |dep|oyed on a served

About this task

Class loaders affect whether your application and its modules find the resources that they need to run
effectively. You can select whether your application and Web modules use their own class loaders to load
classes, or use a parent class loader.
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An application class loader groups enterprise bean (EJB) modules, shared libraries, resource adapter
archives (RAR files), and dependency Java archive (JAR) files associated to an application. Dependency
JAR files are JAR files that contain code which can be used by both enterprise beans and servlets.

An application class loader is the parent of a Web application archive (WAR) class loader. By default, a
Web module has its own WAR class loader to load the contents of the Web module. The WAR
class-loader policy value of an application class loader determines whether the WAR class loader or the
application class loader is used to load the contents of the Web module.

You can also select whether classes are reloaded when application files are updated. For enterprise bean
(EJB) modules or any non-Web modules, enabling class reloading causes the application server run time
to stop and start the application to reload application classes. For Web modules such as servlets and
JavaServer Pages (JSP) files, a Web container reloads a Web module only when the IBM extension
reloadingEnabled in the ibm-web-ext.xmi file is set to true.

To configure use of class loaders by your application and Web modules, use the |Class loading and update|
page of the administrative console.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

1. Click Applications > Application Types > WebSphere enterprise applications »> application_name
> Class loading and update detection to access the [settings page for an application class loader

2. Specify whether to reload application classes when the application or its files are updated.

By default, class reloading is not enabled. Select Override class reloading settings for Web and
EJB modules to choose to reload application classes. You might specify different values for EJB
modules and for Web modules such as servlets and JavaServer Pages (JSP) files.

3. Specify the number of seconds to scan the application’s file system for updated files.

The value specified for Polling interval for updated files takes effect only if class reloading is
enabled. The default is the value of the reloading interval attribute in the IBM extension
(META-INF/ibm-application-ext.xmi) file of the enterprise application (EAR file). You might specify
different values for EJB modules and for Web modules such as servlets and JSP files.

To enable reloading, specify an integer value that is greater than zero (for example, 1 to 2147483647).
To disable reloading, specify zero (0).
4. Specify the class loader order for the application.

The application class loader order specifies whether the class loader searches in the parent class
loader or in the application class loader first to load a class. The default is to search in the parent class
loader before searching in the application class loader to load a class.

Select either of the following values for Class loader order:

Option Description

Classes loaded with parent class loader first Causes the class loader to search in the parent class
loader first to load a class. This value is the standard for
Development Kit class loaders and WebSphere
Application Server class loaders.
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Option

Description

Classes loaded with local class loader first (parent
last)

Causes the class loader to search in the application class
loader first to load a class. By specifying Classes loaded
with Tocal class Toader first (parent last), your
application can override classes contained in the parent
class loader.

Note: Specifying the Classes loaded with local class
Toader first (parent last) value might result in
LinkageErrors or ClassCastException messages if you
have mixed use of overridden classes and non-overridden
classes.

5. Specify whether to use a single or multiple class loaders to load Web application archives (WAR files)

of your application.

By default, Web modules have their own WAR class loader to load the contents of the
WEB-INF/classes and WEB-INF/lib directories. The default WAR class loader value is Class Toader
for each WAR file in application, which uses a separate class loader to load each WAR file. Setting
the value to Single class loader for application causes the application class loader to load the
Web module contents as well as the EJB modules, shared libraries, RAR files, and dependency JAR
files associated to the application. The application class loader is the parent of the WAR class loader.

Select either of the following values for WAR class loader policy:

Option

Description

Class loader for each WAR file in application

Uses a different class loader for each WAR file.

Single class loader for application

Uses a single class loader to load all of the WAR files in
your application.

6. Click OK.

Results

The application or module configuration is changed. The application or standalone Web module is

restarted so the changes take effect.

What to do next

Save changes to your administrative configuration.

Class loading and update detection settings
Use this page to configure use of class loaders by an application.

To view this administrative console page, click Applications > Application Types > WebSphere
enterprise applications » application_name - Class loading and update detection.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

Override class reloading settings for Web and EJB modules:

Specifies whether to enable class reloading when application files are updated.
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Select Override class reloading settings for Web and EJB modules to set reloadEnabled to true in the
deployment.xml file for the application. If an application’s class definition changes, the application server
run time stops and starts the application to reload application classes.

Reloading settings in the deployment.xml file override the reloading settings for all Web and EJB modules
that can be defined in ibm-web-ext.xmi and META-INF/ibm-application-ext.xmi files.

For JavaServer Pages (JSP) files in a Web module, a Web container reloads JSP files only when the IBM
extension jspReloadingEnabled in the jspAttributes of the ibm-web-ext.xmi file is set to true. You can
enable JSP reloading during deployment on the JSP Reload Options panel.

Data type Boolean
Default false

Polling interval for updated files:

Specifies the number of seconds to scan the application’s file system for updated files. The default is the
value of the reloading interval attribute in the IBM extension (META-INF/ibm-application-ext.xmi) file of the
EAR file.

This Polling interval for updated files setting is the same as the Reload interval in seconds field on
the application installation and update wizards.

To enable reloading, specify a value greater than zero (for example, 1 to 2147483647). To disable
reloading, specify zero (0). The range is from 0 to 2147483647.

The reloading interval attribute takes effect only if class reloading is enabled.

Data type Integer
Units Seconds
Default 3

Class loader order:

Specifies whether the class loader searches in the parent class loader or in the application class loader
first to load a class. The standard for development kit class loaders and WebSphere Application Server
class loaders is Classes loaded with parent class Toader first. By specifying Classes Toaded with
local class loader first (parent last), your application can override classes contained in the parent
class loader, but this action can potentially result in ClassCastException or LinkageErrors if you have
mixed use of overridden classes and non-overridden classes.

The options are Classes Toaded with parent class loader first and Classes loaded with Tocal class
Toader first (parent last). The default is to search in the parent class loader before searching in the
application class loader to load a class.

For your application to use the default configuration of Jakarta Commons Logging in WebSphere
Application Server, set this application class loader mode to Classes Toaded with parent class loader
first. For your application to override the default configuration of Jakarta Commons Logging in
WebSphere Application Server, your application must provide the configuration in a form supported by
Jakarta Commons Logging and this class loader mode must be set to Classes Toaded with Tocal class
Toader first (parent last). Also, to override the default configuration, set the class loader mode for
each Web module in your application so that the correct logger factory loads.

Data type String
Default Classes loaded with parent class loader first
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WAR class loader policy:

Specifies whether to use a single class loader to load all WAR files of the application or to use a different
class loader for each WAR file.

The options are Class loader for each WAR file in application and Single class loader for
application. The default is to use a separate class loader to load each WAR file.

Data type String
Default Class loader for each WAR file in application

Manage modules settings

Use this panel to specify deployment targets where you want to install the modules that are contained in
your application. Modules can be installed on the same deployment target or dispersed among several
deployment targets.

On single-server products, a deployment target can be an application server or Web server.

To view this administrative console panel, click Applications » Application Types > WebSphere
enterprise applications » application_name » Manage modules. This panel is the similar to the Map
modules to servers panel on the application installation and update wizards.

On this panel, each Module must map to one or more targets, identified under Server. To change a
mapping:

1. In the list of mappings, select each module that you want mapped to the same target or targets.

2. From the Clusters and servers list, select one or more targets. Select only appropriate deployment

targets for a module. You cannot install modules that use WebSphere Application Server Version 7.x
features on a Version 6.x or 5.x target server.

Use the Citrl key to select multiple targets. For example, to have a Web server serve your application,
press the Ctrl key and then select an application server and the Web server together. The product
generates the plug-in configuration file, plugin-cfg.xml, for that Web server based on the applications
which are routed through it.

3. Click Apply.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

If you accessed this Manage modules panel from a console enterprise application page for an already
installed application, you can also use this panel to view and manage modules in your application.

To view the values specified for a module configuration, click the module name in the list. The displayed

module settings page shows the values specified. On the settings page, you can change existing
configuration values and link to additional console pages that assist you in configuring the module.
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To manage a module, select the module name in the list and click a button:

Button Resulting action

Remove Removes the selected module from the deployed application. The module is deleted
from the application in the configuration repository and also from all of the nodes
where the application is installed and running or expected to run.

Update Opens a wizard that helps you update modules in an application. If a module has the
same URI as a module already existing in the application, the new module replaces
the existing module. If the new module does not exist in the application, it is added to
the deployed application.

Remove File Deletes a file from a module of a deployed application.

Export File Accesses the Export a file from an application page, which you use to export a file of
an enterprise application or module to a location of your choice.

If the browser does not prompt for a location to store the file, click File > Save as and
specify a location to save the file that is shown in the browser.

Clusters and servers
Lists the names of available deployment targets. This list is the same for every application that is installed
in the cell.

From this list, select only appropriate deployment targets for a module. You must install an application,
enterprise bean (EJB) module, Session Initiation Protocol (SIP) module (SAR), or Web module on a
Version 7.x target under any of the following conditions:

* The module supports Java Platform, Enterprise Edition (Java EE) 5.

* The module calls a 7.x runtime application programming interface (API).

* The module uses a 7.x product feature.

If a module supports J2EE 1.4, then you must install the module on a Version 6.x or 7.x deployment
target. Modules that call a 6.1.x API or use a 6.1.x feature can be installed on a 6.1.x or 7.x deployment
target. Modules that call a 6.0.x APl or use a 6.0.x feature can be installed on a 6.0.x, 6.1.x or 7.x
deployment target. Modules that require 6.1.x feature pack functionality can be installed on a 6.1.x
deployment target that has been enabled with that feature pack or on a 7.x deployment target.

You can install an application or module developed for a Version 5.x product on a 5.x, 6.x or 7.x
deployment target.

Module
Specifies the name of a module in the installed (or deployed) application.

URI
Specifies the location of the module relative to the root of the application (EAR file).

Module type
Specifies the type of module, for example, a Web module or EJB module.

This setting is shown on the Manage modules panel accessed from a console enterprise application page.

Server
Specifies the name of each deployment target to which the module currently is mapped.

To change the deployment targets for a module, select one or more targets from the Clusters and
servers list and click Apply. The new mapping replaces the previous mapping.
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Mapping modules to servers

Each module of a deployed application must be mapped to one or more target servers. The target server
can be an application server or Web server.

Before you begin
You can map modules of an application or stand-alone Web module to one or more target servers during

or after|app|ication installation using the consolel. This topic assumes that the module is already installed
on a server and that you want to change the mappings.

Before you change a mapping, check the deployment targets. You must specify an |appropriate deploymentl
for a module. Modules that use Version 7.x features cannot be installed onto Version 6.x or 5.x
target servers.

About this task
During application installation, different deployment targets might have been specified.
You use the Manage modules panel of the administrative console to view and change mappings. This

panel is displayed during fapplication installation using the console|and, after the application is installed,
can be accessed from the fenterprise application settings page}

On the Manage modules panel, specify target servers where you want to install the modules contained in
your application. Modules can be installed on the same application server or dispersed among several
application servers. Also, specify the Web servers as targets that will serve as routers for requests to your
application. The plug-in configuration file, plugin-cfg.xml, for each Web server is generated based on the
applications which are routed through it.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

1. Click Applications > Application Types > WebSphere enterprise applications » application_name
> Manage modules in the console navigation tree.

The [Manage modules panel|is displayed.
2. Examine the list of mappings.
Ensure that each Module entry is mapped to one or more targets, identified under Server.
3. Change a mapping as needed.
a. Select each module that you want mapped to the same targets.
In the list of mappings, select check boxes for the modules.
b. From the Clusters and servers list, select one or more targets.

Select only appropriate deployment targets for a module. You cannot install modules that use
WebSphere Application Server Version 7.x features on a Version 6.x or 5.x target server.

Use the Citrl key to select multiple targets. For example, to have a Web server serve your
application, use the Ctrl key to select an application server and the Web server together to have
the plugin-cfg.xml plug-in configuration file for that Web server generated based on the applications
that are routed through it.

c. Click Apply.
4. Repeat steps 2 and 3 until each module maps to the desired targets.
5. Click OK.
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Results

The application or module configurations are changed. The application or stand-alone Web module is
restarted so the changes take effect.

Example

To install an application that has modules which support Java Platform, Enterprise Edition (Java EE) 5 to
two servers, do the following:

1. Click the Select All icon to select all of the modules in the application.

2. While pressing Citrl, select two Version 7 application servers from the Clusters and servers list.
3. Click Apply.

4. Click OK.

What to do next

Save changes to your administrative configuration.

Mapping virtual hosts for Web modules

A virtual host must be mapped to each Web module of a deployed application. Web modules can be
installed on the same virtual host or dispersed among several virtual hosts.

Before you begin

You can map a virtual host to a Web module during or after [application installation using the console] This
article assumes that the Web module is already installed on a server and that you want to change the
mappings.

Before you change a mapping, check the definitions. You can install a Web module on any
defined virtual host. To view information on previously defined virtual hosts, click Environment » Virtual
hosts in the administrative console. Virtual hosts enable you to associate a unique port with a module or
application. The aliases of a virtual host identify the port numbers defined for that virtual host. A port
number specified in a virtual host alias is used in the URL that is used to access artifacts such as servlets
and JavaServer Pages (JSP) files in a Web module. For example, the alias myhost:8080 is the
host_name:port_number portion of the URL http://myhost:8080/servlet/snoop.

About this task

During application installation, a virtual host other than the one you want mapped to your Web module
might have been specified.

The default virtual host setting usually is default_host, which provides several port numbers through its
aliases:

80 An internal, insecure port used when no port number is specified

9080 An internal port

9443 An external, secure port

Unless you want to isolate your Web module from other modules or resources on the same node (physical
machine), default_host is a suitable virtual host for your Web module.

In addition to default_host, the product provides admin_host, which is the virtual host for the

administrative console system application. admin_host is on port 9060. Its secure port is 9043. Do not
select admin_host unless the Web module relates to system administration.
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Use the Virtual hosts page of the administrative console to view and change mappings. This page is
displayed during |application installation using the console and, after the application is installed, can be
accessed from the [settings page for an enterprise application}

On the Virtual hosts page, specify a virtual host for each Web module. Web modules of an application can

be installed on the same virtual host or on different virtual hosts.

1. Click Applications > Application Types > WebSphere enterprise applications » application_name
> Virtual hosts in the console navigation tree. The |Virtual hosts pagelis displayed.

2. Examine the list of mappings. Ensure that each Web module entry has the desired virtual host
mapped to it, identified under Virtual host.

3. Change the mappings as needed.
a. Select each Web module that you want mapped to a particular virtual host. In the list of mappings,
place a check mark in the Select check boxes beside the Web modules.

b. From the Virtual host drop-down list, select the desired virtual host. If you selected more than one
virtual host in step 1:
1) Expand Apply Multiple Mappings.
2) Select the desired virtual host from the Virtual host drop-down list.
3) Click Apply.
4. Repeat steps 2 and 3 until a desired virtual host is mapped to each Web module.
5. Click OK.

Results

The application or Web module configurations are changed. The application or standalone Web module is
restarted so the changes take effect.

What to do next

After mapping virtual hosts, do the following:

1. Regenerate the plug-in configuration file.
a. Click Servers » Server Types > Web servers.
b. Select the Web server for which you want to generate a plug-in.
c. Click Generate Plug-in.

2. Save changes to your administrative configuration.

Virtual hosts settings
Use this panel to specify virtual hosts for Web modules contained in your application. Web modules can
be installed on the same virtual host or dispersed among several virtual hosts.

To view this administrative console panel, click Applications » Application Types > WebSphere
enterprise applications » application_name > Virtual hosts. This panel is the same as the Map virtual
hosts for Web modules panel on the application installation and update wizards.

On this panel, each Web module must map to a previously defined virtual host, identified under Virtual
host. You can see information on previously defined virtual hosts by clicking Environment > Virtual hosts
in the administrative console. Virtual hosts enable you to associate a unique port with a module or
application. The aliases of a virtual host identify the port numbers defined for that virtual host. A port
number specified in a virtual host alias is used in the URL that is used to access artifacts such as servlets
and JavaServer Pages (JSP) files in a Web module. For example, the alias myhost:8080 is the

host _name:port_number portion of the URL http://myhost:8080/servlet/snoop.

The default virtual host setting usually is default_host, which provides several port numbers through its
aliases:
80 An internal, insecure port used when no port number is specified
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9080 An internal port
9443 An external, secure port

Unless you want to isolate your Web module from other modules or resources on the same node (physical
machine), default_host is a suitable virtual host for your Web module.

In addition to default_host, the product provides admin_host, which is the virtual host for the
administrative console system application. admin_host is on port 9060. Its secure port is 9043. Do not
select admin_host unless the Web module relates to system administration.

To change a mapping:

1. In the list of mappings, select the Select check box beside each Web module that you want mapped to
a particular virtual host.

2. From the Virtual host drop-down list, select the desired virtual host. If you selected more than one
virtual host in step 1:
a. Expand Apply Multiple Mappings.
b. Select the desired virtual host from the Virtual Host drop-down list.
c. Click Apply.

3. Click OK.

Note: If an application is running, changing an application setting causes the application to restart. On
stand-alone servers, the application restarts after you save the change. On multiple-server
products, the application restarts after you save the change and files synchronize on the node
where the application is installed. To control when synchronization occurs on multiple-server
products, deselect Synchronize changes with nodes on the Console preferences page.

Web module:

Specifies the name of a Web module in the application that you are installing or that you are viewing after
installation.

Virtual host:
Specifies the name of the virtual host to which the Web module is currently mapped.

Expanding the drop-down list displays a list of previously defined virtual hosts. To change a mapping,
select a different virtual host from the list.

Do not specify the same virtual host for different Web modules that have the same context root and are
deployed on targets belonging to the same node even if the Web modules are contained in different
applications. Specifying the same virtual host causes a validation error.

Mapping properties for a custom login or trusted connection
configuration

Use this page to view and manage the mapping properties for a custom login configuration or a trusted
connection configuration.

To access the administrative console panel, complete the following steps:
1. Click Applications > Application types> WebSphere enterprise applications > application_name.
2. From Enterprise JavaBeans™ Properties, click Map data sources for all 2.x CMP beans.

3. For container authorization, modify the authorization type by selecting your Enterprise JavaBeans(EJB)
module and selecting Container from the Resource authorization menu.

4. Click Apply.
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5. From Specify authentication method, select Use custom login configuration or Use trusted
connections and the name of the application login configuration.

6. Select the name of your EJB module.

Click Apply.

8. Click Mapping properties in the Resource authorization column. This property is not available until
after you click Apply in the previous step.

N

Name
Specifies the name for the mapping property.

Do not use the MAPPING_ALIAS property name because the name is reserved by the product.

Value
Specifies the value paired with the specified name.

Description
Specifies additional information about the name and value pair.

Viewing deployment descriptors

A deployment descriptor is an extensible markup language (XML) file that specifies configuration and
container options for an application or module.

Before you begin

This topic assumes that you have [installed|an application or module on a server and that you want to view
its deployment descriptor.

About this task

When you create a Java 2 Platform, Enterprise Edition (J2EE) application or module in an[assembly tool}
the assembly tool creates deployment descriptor files for the application or module. Java Platform,
Enterprise Edition (Java EE) 5 applications or modules might use annotations instead of deployment
descriptors.

After an application or module is installed on a server, you can view its deployment descriptor in the
administrative console. You cannot view Java EE 5 annotations.

Unless an application supports Java EE 5, an enterprise archive (EAR) file must contain an application.xml
file. The application.xml identifies each module of an application. A Java EE 5 application is not required to
provide an application.xml file in the EAR file. When an application.xml file does not exist, the product
examines the Java archive (JAR) file contents to determine whether the JAR file is an enterprise bean
(EJB) module or an application client module. A JAR file should not contain more than one deployment
descriptor in it. When an ejb-jar.xml file is found in a JAR file, the product considers it an EJB module. If
an ejb-jar.xml file is not found and an application-client.xml is found, the product considers the JAR file to
be an application client module. If both ejb-jar.xml and application-client.xml files exist in the JAR file, the
product might consider a JAR file intended to be an application client module to be an EJB module or a
JAR file intended to be an EJB module to be an application client module. A JAR file should not contain
more than one kind of deployment descriptor.

1. Access a deployment descriptor view.

Click the navigational option stated in Accessing a console view to view the deployment descriptor
for a given module:
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Module

Deployment descriptor file

Accessing a console view

Enterprise
application

application.xml

Applications » Application Types > WebSphere enterprise
applications > application_name -~ View deployment
descriptor

Web application

WEB-INF/web.xml

Applications » Application Types > WebSphere enterprise
applications » application_name » Manage modules >
module_name > View deployment descriptor

WEB-INF/portlet.xml

Applications » Application Types > WebSphere enterprise
applications » application_name » Manage modules >
module_name - View portlet deployment descriptor

Enterprise bean

ejb-jar.xml

Applications » Application Types > WebSphere enterprise
applications » application_name » Manage modules »
module_name > View deployment descriptor

Application client

application-client.xml

No console view

Web service

webservices.xml

Applications > Application Types > WebSphere enterprise

applications » application_name > Manage modules >

module_name >

* View Web services client deployment descriptor
extension

* View Web services server deployment descriptor

* View Web services server deployment descriptor
extension

Viewing Web services deployment descriptors in the|

ladministrative console| describes the views.

Resource adapter

ra.xml

Resources » Resource Adapters » Resource adapters »
module_name > View deployment descriptor

2. Click Expand All to view the deployment descriptor contents.

Results

The deployment descriptor for the application or module is displayed.

Example

The deployment descriptor for the product DefaultApplication follows:

<application id="Application_ID" >
<display-name> DefaultApplication.ear</display-name>
<description> This is the IBM WebSphere Application Server Default Application.</<description>
<module id="WebModule 1" >

<web>

<web-uri> DefaultWebApplication.war</web-uri>
<context-root> /</context-root>

</web>
</module>

<module id="EjbModule_1" >
<ejb> Increment.jar</ejb>

</module>

<security-role id="SecurityRole 1204342979281" >
<description> A11 Authenticated users role.</description>
<role-name> A11 Role</role-name>

</security-role>

</application>

What to do next

After displaying a deployment descriptor on the console page, do the following:
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1. Examine the deployment descriptor contents, including any configurations that it has for |bindingsl
security roles, references to other resources, or[Java Naming and Directory Interface (JNDI) names|

For example, examine the JAR files of your Java EE 5 module to ensure that each JAR file does not
contain more than one kind of deployment descriptor. If a JAR file contains more than one kind of
deployment descriptor, proceed to the next step and remove the extraneous deployment descriptor.
Thus, if both ejb-jar.xml and application-client.xml files exist in a JAR file, remove the deployment
descriptor that your module does not need.

2. Change a deployment descriptor as needed.

You can edit a deployment descriptor file manually. However, it is preferable to edit a deployment
descriptor |using the console| or in an assembly tool deployment descriptor editor to ensure that the
deployment descriptor has valid properties and that its references contain appropriate values.

If your EJB 3.0 or Web 2.5 module does not have a metadata-complete attribute or the metadata-complete
attribute is set to false, you can instruct the product to write the entire module deployment descriptor,
including deployment information from annotations, to XML format. On the Metadata for modules page,
select metadata-complete attribute.

Note: If your Java EE 5 application uses annotations and a shared library, do not select
metadata-complete attribute. When your application uses annotations and a shared library, setting
the metadata-complete attribute to true causes the product to incorrectly represent an @EJB
annotation in the deployment descriptor as <ejb-ref> rather than <ejb-1ocal-ref>. For Web
modules, setting the metadata-complete attribute to true might cause InjectionException errors. If
you must set the metadata-complete attribute to true, avoid errors by not using a shared library, by
placing the shared library in either the classes or lib directory of the application server, or by fully
specifying the metadata in the deployment descriptors.

Metadata for module settings

Use this page to instruct a Java Platform, Enterprise Edition (Java EE) 5 enterprise bean (EJB) or Web
module deployment descriptor to ignore annotations that specify deployment information.

To view this administrative console page, click Applications > Application Types > WebSphere
enterprise applications » application_name » Metadata for modules. This page is the same as the
Metadata for modules page on the application installation and update wizards.

Note: If your application contains EJB 3.0 or Web 2.5 modules, you can select to lock the deployment
descriptor of one or more of the EJB 3.0 or Web 2.5 modules on the Metadata for modules page. If
you set the metadata-complete attribute to true and lock deployment descriptors, the product writes
the complete module deployment descriptor, including deployment information from annotations, to
XML format.

Annotations are a standard mechanism of adding metadata to Java classes. You can use metadata to
simplify development and deployment of Java EE 5 artifacts. Prior to the introduction of Java language
annotations, deployment descriptors were the standard mechanism used by Java EE components. These
deployment descriptors were mapped to XML format, which facilitated their persistence. If you select to
lock deployment descriptors, the product merges Java EE 5 annotation-based metadata with the
XML-based existing deployment descriptor metadata and persists the result.

Module
Specifies the name of a module in the installed (or deployed) application.

Data type String

URI

Specifies the location of the module relative to the root of the application (EAR file).
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Data type String

metadata-complete attribute
Specifies whether to write the complete module deployment descriptor, including deployment information
from annotations, to extensible markup language (XML) format.

The default is not to write out a module deployment descriptor.

If your EJB 3.0 or Web 2.5 module does not have a metadata-complete attribute or the metadata-complete
attribute is set to false, you can select a check box and instruct the product to write out a module
deployment descriptor.

Note: If your Java EE 5 application uses annotations and a shared library, do not select
metadata-complete attribute. When your application uses annotations and a shared library, setting
the metadata-complete attribute to true causes the product to incorrectly represent an @EJB
annotation in the deployment descriptor as <ejb-ref> rather than <ejb-1local-ref>. For Web
modules, setting the metadata-complete attribute to true might cause InjectionException errors. If
you must set the metadata-complete attribute to true, avoid errors by not using a shared library, by
placing the shared library in either the classes or lib directory of the application server, or by fully
specifying the metadata in the deployment descriptors.

After you select a check box, you cannot deselect (clear) the check box and the module is no longer
shown in the list of modules on this page. If you select all of the check boxes, the link to this page is no
longer shown on the enterprise application settings page.

Data type Boolean
Default false (deselected)

Starting or stopping enterprise applications

You can start an application that is not running (has a status of Stopped) or stop an application that is
running (has a status of Started).

Before you begin

This topic assumes that the Java Platform, Enterprise Edition (Java EE) application is|installed on a
By default, the application starts automatically when the server starts.

About this task

You can start and stop applications manually using the following:

» Administrative console

 startApplication and stopApplication attributes of the AdminControl object with the wsadmin tool

 startApplication and stopApplication administrative jobs of the AdminTask.submitJob -jobType object with
the wsadmin tool

» Java programs that use ApplicationManager or AppManagement MBeans

This topic describes how to use the administrative console to start or stop an application.
Note: This topic applies to applications that do not contain Java Application Programming Interface (API)
for XML-Based Web Services (JAX-WS) service providers. To stop or start applications that contain

JAX-WS service providers, use the Service providers page accessed by clicking Services -
Service providers. To start a service provider application, select a service and click Start
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Application. To stop a service provider application, select a service and click Stop Application.
Then, on the Stop application page, click OK to stop all modules in the application, including other
services such as enterprise beans and servlets.

Go to the [Enterprise applications page} Click Applications » Application Types > WebSphere
enterprise applications in the console navigation tree.

2. Select the check box for the application you want started or stopped.
3. Click a button:
Option Description
Start Runs the application and changes the state of the application to Started. The status is
changed to partially started if not all servers on which the application is deployed are
running.
Stop Stops the processing of the application and changes the state of the application to
Stopped.
To restart a running application, select the application you want to restart, click Stop and then click
Start.
Results

The status of the application changes and a message stating that the application started or stopped
displays at the top the page.

What to do next

You can |configure an application so it does not start automatically] when the server on which it resides
starts. You then start the application manually using options described in this article.

If you want your application to start automatically when its server starts, you can adjust values that control
how quickly the application or its server starts:

1.

4.

Go the|settings page for your enterprise application|. Click Applications » Application Types -
WebSphere enterprise applications > application_name > Startup behavior.

Specify a different value for Startup order.

This setting specifies the order in which applications are started when the server starts. The default
value is 1 in a range from 0 to 2147483647. The application with the lowest starting weight is started
first.

Specify a different value for Launch application before server completes startup.

This setting specifies whether the application must initialize fully before its server starts. The default
value of false prevents the server from starting completely until the application starts. To reduce the

amount of time it takes to start the server, you can set the value to true and have the application start
on a background thread, thus allowing server startup to continue without waiting for the application.

Save the changes to the application configuration.

Disabling automatic starting of applications

You can enable and disable the automatic starting of an application. By default, an installed application
starts automatically when the server on which the application resides starts.

Before you begin

This topic assumes that the application is|instal|ed on an application server| and that the application starts
automatically when the server starts.
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This topic also assumes that you jnapped the installed application|to a server and that you have an
administrative role with an authority higher than monitor.

About this task

You might want an application to run only after you start it manually and not to run every time after the
server starts. The target mapping for an application controls whether an application starts automatically
when the server starts or requires you to start the application manually.

You must have an administrative role with an authority higher than monitor to change the automatic
starting setting.

1. Go to the |Target specific application status page| for your application.

Click Applications > Application Types » WebSphere enterprise applications » application_name
> Target specific application status.

2. Select the target server on which the application resides.
3. Click Disable Auto Start.
4. Save changes to the administrative configuration.

Results

The application does not start when its server starts. You must [start the application manually|

What to do next

To enable automatic starting of the application, do the following:

1. On the Target specific application status page for the application, select the target on which the
application resides.

2. Click Enable Auto Start.

3. Save changes to the configuration.

Target specific application status
Use this page to view mappings of deployed applications or modules to servers.

Also use this page to enable or disable the automatic starting of an application when the server on which
the application resides starts.

To view this administrative console page, click Applications > Application Types > WebSphere
enterprise applications > application_name - Target specific application status.

When security is enabled, a separate application list is shown for each of your administrative roles.
Supported roles include monitor, configurator, operator, administrator, deployer, and administrative security
manager. For example, when you have the administrator role, the statement “You can administer the
following resources” is shown followed by a list of servers that you can administer.

Target
States the name of the target server to which the application or module maps. You specify the target on
the Manage modules page accessed from the settings for an application.

Node
Specifies the node name if the target is a server.

Version
Specifies the version level of the target. The target can be a Version 7.x, 6.x or 5.x deployment target.
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A 7.x deployment target is a server with all members on a WebSphere Application Server Version 7.0 or
later product.

A 6.x deployment target is a server with all members on a WebSphere Application Server Version 6
product.

A 5.x deployment target is a server with at least one member on a WebSphere Application Server Version
5 product.

An application, enterprise bean (EJB) module, Session Initiation Protocol (SIP) module (SAR), or Web
module must be installed on a Version 7.x target under any of the following conditions:

* The module supports Java Platform, Enterprise Edition (Java EE) 5.

* The module calls a 7.x runtime application programming interface (API).

* The module uses a 7.x product feature.

If a module supports Java 2 Platform, Enterprise Edition (J2EE) 1.4, then you must install the module on a
Version 6.x or 7.x deployment target. Modules that call a 6.1.x APl or use a 6.1.x feature can be installed
on a 6.1.x or 7.x deployment target. Modules that call a 6.0.x API or use a 6.0.x feature can be installed
on a 6.0.x, 6.1.x or 7.x deployment target. Modules that require 6.1.x feature pack functionality can be
installed on a 7.x deployment target or on a 6.1.x deployment target that has been enabled with that
feature pack.

If JavaServer Pages (JSP) precompilation, EJB deployment (ejbdeploy), or Web Services deployment
(wsdeploy) are enabled, then you can deploy applications to only those targets that have same product
version as the deployment manager. If applications are targeted to servers that have an earlier version
than the deployment manager, then you cannot deploy to those targets. Thus, if JSP precompilation,
ejbdeploy, or wsdeploy are enabled, then you must deploy the application on a 6.1.x or 7.x target.

You can install an application or module developed for a Version 5.x product on a 7.x, 6.x or 5.x
deployment target.

Similarly, a resource adapter (connector) module, or RAR file, developed for a Version 5.x product can
reside on a 7.x, 6.x or 5.x target, provided the module does not support Java Cryptography Architecture
(JCA) 1.5 and does not call any 7.x or 6.x runtime application programming interfaces (APIs). If the
module supports JCA 1.5 or calls a 7.x or 6.x API, then the module must reside on a 7.x or 6.x target.

Auto Start

Specifies whether the application modules installed on the target server are started (or enabled) when the
server starts. This setting specifies the initial state of application modules. A Yes value indicates that the
corresponding modules are enabled and thus are accessible when the server starts. A No value indicates
that the corresponding modules are not enabled and thus are not accessible when the server starts.

By default, Auto Start is enabled. Thus, by default an installed application starts automatically when the
server on which the application resides starts.

If you have an administrative role with an authority higher than monitor, you can enable and disable the
automatic starting of the application. To disable the automatic starting of the application, enable the Select
check box beside the target server and click Disable Auto Start. When automatic starting is disabled, the
application does not start when its server starts. To enable the automatic starting of the application, select
the target and click Enable Auto Start.

Application Status
Indicates whether the application deployed on the application server is started, stopped, or unknown.

=f} Started Application is running.
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={} Partial Start Application is in the process of changing from a Stopped state to a Started
state. Application is starting to run but is not fully running yet. The application
might be in the Partial Start state because one of its application servers is not

started.

. 4 Stopped Application is not running.

o Partial Stop Application is in the process of changing from a Started state to a Stopped
state. Application has not stopped running yet.

'E:' Unknown Status cannot be determined.

An application with an unknown status might, in fact, be running but have an
unknown status because the server running the administrative console cannot
communicate with the server running the application.

E Pending Status is temporarily unknown pending an event that a user did not initiate, such
as pending an asynchronous call.
Not applicable Application does not provide information as to whether it is running.

The status of an application on a Web server is always Unknown.

Exporting enterprise applications

You can export an enterprise application to a location of your choice.
About this task

Exporting applications enables you to back up your applications and preserve binding information for the
applications. You might export your applications before updating installed applications or migrating to a
later version of the product.

To export applications, use the Export button on the Enterprise applications page. Using Export produces
an enhanced enterprise archive (EAR) file that contains the application as well as the deployment
configuration. The deployment configuration consists of the deployment.xml and other configuration files
that control the application behavior on a deployment target.

1. Click Applications » Application Types > WebSphere enterprise applications in the console
navigation tree to access the [Enterprise applications page]

2. Select the check box beside the application and click Export.
3. On the Export application EAR files page, click on the link to download the exported EAR file.
4. Use the browser dialogue to specify a location at which to save the exported EAR file.

User profile QEJBSVR must have *WX authority to the directory and at least *X authority to all
directories in the path specified for the location.

5. Click Back to return to the Enterprise applications page.

Results

The file containing binding information is exported to the specified node and directory, and has the name
enterprise_application_name.ear.

Using the Export button to export applications does not export any manual changes that were made to

applications in the installedApps directory. To export those changes, you must copy and move the
application files manually.
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What to do next

You can edit your exported enhanced EAR file and then reinstall it. By default, installation expands an
EAR file in the installedApps/ce/I_name directory. If you specified the $(CELL) variable for

Directory to install application on the Select installation options panel of the application installation

wizard when you first installed the application, the cell_name directory is the current cell name.

To reinstall the enhanced EAR file, do either of the following:

» Use the Update operation available from the Enterprise applications page to upgrade the existing
application installation.

The Update operation adds the application files to the installedApps/ce//_ name directory,
where cell_name is the current cell name or the name of the cell that you specified for Directory to
install application when you first installed the application on a deployment target. The Directory to
install application setting is on the Select installation options panel of the application installation
wizard. If you specified the § (CELL) variable for Directory to install application when you first installed
the application, the cell_name directory is the current cell name.

» Use the Applications » New application » New Enterprise Application operation to install the
exported EAR file.

If you specified the $(CELL) variable for Directory to install application when you first installed the
application, the cell_name directory is the current cell name. That is, if the file is originally installed on
Cell1 with $(CELL) variable in the destination directory and you reinstall the enhanced EAR file on Cell2,
the cell_name directory is Cell2, the current cell name.

If the $(CELL) variable was not specified for the first installation, using New Enterprise Application to
reinstall an enhanced EAR file installs the application in the cell_name directory of the exported
application. That is, if the application is originally installed on and exported from Cell1 and you reinstall
the enhanced EAR file on Cell2, the cell_name directory is Cell1. The enhanced EAR file expands in
the Cell1 directory even though the current cell name is Cell2. By default, the application destination
directory contains Cell1 in its path because the deployment.xml file in the exported application has Cell1
in it.

If you exported the application from Cell1 and did not specify the $(CELL) variable when first installing
the application, and you want to install the enhanced EAR file on a different cell, deselect Process
embedded configuration on the Select installation options panel of the application installation wizard to
expand the enhanced EAR file in the current cell name directory, which is not Cell1.

Exporting enterprise application files

You can export individual files of a Java Platform, Enterprise Edition (Java EE) application or module.
Before you begin

This topic assumes that you have installed an application or module on a server and that you want to
export a file in the application or module.

About this task
Exporting a file in a deployed application or module downloads the file to a location of your choice.

To export a file using the administrative console, use Export File.

To export an entire application, use Export. For information on Export, see |“Expor1ing enterprise|
|app|ications” on page 98.| The exported enterprise archive (EAR) file contains application configuration
data as well as the application.

1. Click Applications > Application Types » WebSphere enterprise applications in the administrative
console navigation tree to access the [Enterprise applications page]
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2. Place a check mark in the check box beside the application and click Export File. A drop-down list of
exportable files is displayed.

3. Select a file from the list and click Export. A dialog in which you select a target location is displayed.

If the browser does not prompt for a location to store the file, click File » Save as and specify a
location to save the file that is shown in the browser.

4. Specify the location to which to download the file.

User profile QEJBSVR must have *WX authority to the directory and at least *X authority to all
directories in the path specified for the location.

Results
The file is downloaded to the specified location.
What to do next

Click Back to return to the Enterprise applications page.

Exporting DDL files

You can export data definition language (DDL) files in the enterprise bean (EJB) modules of an
application.

About this task

Exporting DDL (Table.ddl) files in the EJB modules of an application downloads the DDL files to a location

of your choice.

1. Click Applications > Application Types > WebSphere enterprise applications in the administrative
console navigation tree to access the [Enterprise applications page}

2. Place a check mark in the check box beside the application and click Export DDL. If the application
has no DDL files in any of its EJB modules, then the message No DDL files were found is displayed at
the top of the page. If the application has DDL files in its EJB modules, then a page listing DDL files in
the format application_name.ear/_module.jar_Table.dd1 is displayed.

3. Click on a file in the list and specify the location to which to download the file.

User profile QEJBSVR must have *WX authority to the directory and at least *X authority to all
directories in the path specified for the location.

Note: For Firefox browsers, right-click the file name, select Save Link As, and specify the location to
which to download the file.

Mozilla browsers might display the contents of the Table.ddl file instead of saving the file to disk.
To save the file, edit the Helper Application preference settings of the Mozilla browser by
adding a new type for DDL and specifying that you want to save DDL files to disk. That is, set
MIME type = dd1 and Extension = ddl.

Results

The product downloads the DDL file to the specified location.

Updating enterprise application files

You can update Java Platform, Enterprise Edition (Java EE) application files deployed on a server.
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Before you begin

Update your Java EE application or modules and [reassemble them using an assembly tooll Typical tasks
include adding or editing assembly properties, adding or importing modules into an application, and adding
enterprise beans, Web components, and files.

Also, determine whether the updated files can be installed to your|dep|oyment targetsl WebSphere
Application Server Version 7.x and later supports Java EE 5 enterprise applications and modules.

If you are deploying Java EE 5 modules, ensure that the deployment target supports Version 7.x. You can
deploy Java EE 5 modules to Version 7.x servers only. You cannot deploy Java EE 5 modules to Version
6.x deployment targets.

About this task

Updating consists of adding a new file or module to an installed application, or replacing or removing an
installed application, file or module. After replacement of a full application, the old application is uninstalled.
After replacement of a module, file or partial application, the old installed module, file or partial application
is removed from the installed application.

1. Determine which method to use to update your application files. The product provides several
[update modules|

2. Update the application files using
+ |Administrative console]
* wsadmin scripts
» Java application programming interfaces
* WebSphere rapid deployment of Java EE applications
In some situations, you can update applications or modules without restarting the application server
using . Do not use hot deployment unless you are an experienced user and are
updating applications in a development or test environment.

3. Start the deployed application files using
« |Administrative console]
* wsadmin startApplication
» Java programs that use ApplicationManager or AppManagement MBeans

What to do next
Save the changes to your administrative configuration.

Next, test the application. For example, point a Web browser at the URL for a deployed application
(typically http://hostname:9060/Web_module_name, where hostname is your valid Web server and 9060 is
the default port number) and examine the performance of the application. If the application does not
perform as desired, |edit the application configurationl then save and test it again.

Ways to update enterprise application files

You can update Java Platform, Enterprise Edition (Java EE) application files deployed on a server in
several ways.
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Table 4. Ways to update application files

Option

Method

Comments

Starting after update

Administrative
console update
wizard

[page 103.

To remove a
single file from
a Java EE
application or
module, see

Briefly, do the following:

1. Go to the [Enterprise Applications|
page. Click Applications -
Application Types » WebSphere
enterprise applications in the
console navigation tree.

2. Select the application to update
and click Update.

3. On the |Preparing for application|
|u9datg| page, identify the application,
module or files to update and click
Next.

4. Complete steps in the update
wizard and click Finish.

On the [Preparing for application|

On the |Enterprise|

update] page:
lupdate]

» Use Full application to update an
.ear file.

* Use Single module to update a
.war, .sar, enterprise bean .jar, or
connector .rar file.

* Use Single file to update a file
other than an .ear, .war, .sar, EJB
Jar, or .rar file.

» Use Partial application to update
or remove multiple files.

pplications| page,
9

select the updated
application and click
Start.

wsadmin scripts

Use the update command or the
updatelnteractive command in a
script or at a command prompt.

"Getting started with scripting” in the
Using the administrative clients PDF
provides an overview of wsadmin.

Start the application
using the invoke
command and the
startApplication

attribute.
Java application | Update deployed applications by Update an application in the * Invoke the
programming completing the steps in "Managing following ways: AdminApp
interfaces applications through programming” in ) o startApplication
the Using the administrative clients | * Update the entire application command.
PDF.
» Add to, replace or delete multiple « Invoke the
files in an application startApplication
L method on an
* Add a module to an application ApplicationManager
. . o MBean using
Update a module in an application AdminControl.
* Delete a module in an application
» Add a file to an application
» Update a file in an application
* Delete a file in an application
Rapid Briefly, do the following: Rapid deployment tools offer the Use any of the above
deployment o following advantages: options to start the
tools 1. Update your J2EE application application. Clicking
files. * You do not need to assemble your |Start on the
See topics ) J2EE application files prior to Enterprise
under Rapid 2. Set up the rapld deployment deployment. app”cation page is

deployment of
J2EE
applications.

environment.
3. Create a free-form project.

4. Launch a rapid deployment
session.

5. Drop your updated application files
into the free-form project.

* You do not need to use other
installation tools mentioned in this
table to deploy the files.

the easiest option.
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Table 4. Ways to update application files (continued)

Option Method Comments Starting after update
Hot deployment| | Briefly, do the following: If you are new to WebSphere Use any of the above
| Application Server, use the options to start the
reloading 1. Update your application (.ear), administrative console to update] application. Clicking
Web module (.war), enterprise bean |[applicationg That option is easier. | Start on the
.jar or HTTP plug-in configuration file. Enterprise
) . . Hot deployment and dynamic @' page is
2. Follow instructions in [Hot] reloading is more difficult to the easiest option.
[deployment and dynamic reloading| | complete. You must directly
to update your file. manipulate the application or module
file on the server where the
application is deployed.

You can update .ear, enterprise bean .jar, Web module .war, Session Initiation Protocol (SIP) module
(.sar), connector .rar, application client .jar, and any other files used by an installed application.

If the application is updated while it is running, WebSphere Application Server automatically stops the
application, updates the application logic and restarts the application. If the application does not start
automatically, start it manually using one of the Starting options. For more information on the restarting of
updated applications, refer to "Fine-grained recycle behavior” in IBM WebSphere Developer Technical
Journal: System management for WebSphere Application Server V6 -- Part 5 Flexible options for updating
deployed applications.

Updating enterprise applications with the console

Updating enterprise applications consists of adding a new file or module to an installed Java Platform,
Enterprise Edition (Java EE) application, or replacing or removing an installed application, file or module.

Before you begin

Before iou update the application files on a server, ensure that the files are |assembled in deployablel

Next, refer to ['Ways to update enterprise application files” on page 101 and decide how to update your
application files. You can update enterprise applications or modules using the administrative console, the
wsadmin tool, or Java MBean programming. These ways provide similar updating capabilities.

Further, ensure that the updated files can be installed to your [deployment targets;.

About this task

This topic describes how to update deployed applications or modules using the administrative console.
1. Back up the installed application or module.
a. Go to the [Enterprise applications page of the administrative console. Click Applications -
Application Types » WebSphere enterprise applications in the console navigation tree.
b. [Export the application|to an EAR file or in the application. Select the application you
want to export and click Export or Export File. Exporting preserves the binding information.
2. With the application selected on the [Enterprise applications page} click Update. The Preparing for
application update page is displayed.
3. Under Specify the EAR, WAR, SAR or JAR module to upload and install:
a. Ensure that Application to be updated refers to the application to be updated.

b. Under Application update options, select the installed application, module, or file that you want to
update.
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The online help |Preparing for application update settingg provides detailed information on the
options.

Note: You cannot add, remove, or modify a Java Application Programming Interface (API) for
XML-Based Web Services (JAX-WS) annotation using the Replace or add a single file or
Replace, add, or delete multiple files update options. These options change a single file
or a partial application. If you change a JAX-WS annotation using either of these options,
the product does not return an error. However, you might encounter problems deploying
annotated Web services.
4. If you selected the Replace the entire application or Replace or add a single module option:
a. Click Next to display a wizard for updating application files.
b. Complete the steps in the update wizard.
This update wizard, which is similar to the installation wizard, provides fields for specifying or
editing application binding information. Refer to information on |insta||ing applications| and on the
|app|ication installation binding settings page| for guidance.
Note that the installation steps have the merged binding information from the new version and the
old version. If the new version has bindings for application artifacts such as Enterprise JavaBeans
(EJB) Java Naming and Directory Interface (JNDI) names, EJB references or resource references,
then those bindings will be part of the merged binding information. If new bindings are not present,
then bindings are taken from the installed (old) version. If bindings are not present in the old
version and if the default binding generation option is enabled, then the default bindings will be part
of the merged binding information.
You can select whether to ignore bindings in the old version or ones in the new version.
5. Click Finish.
6. If you did not use the Manage modules page of the update wizard, after updating the application, map
the installed application or module to servers.
Use the page accessed from the Enterprise Applications page.
a. Go to the Manage modules page. Click Applications > Application Types > WebSphere
enterprise applications » application_name » Manage modules.
b. Specify the application server where you want to install modules contained in your application and
click OK.
You can deploy Java 2 Platform, Enterprise Edition (J2EE) 1.4 modules to servers on Version 6 or
later nodes. You can deploy Java Platform, Enterprise Edition (Java EE) 5 modules to servers on
Version 7.x nodes only.

Results

After replacement of a full application, the product uninstalls the old application. After replacement of a
module, file or partial application, the product removes the old installed module, file or partial application
from the installed application.

What to do next

After the application file or module installs successfully, do the following:
1. Save the changes to your configuration.
2. If needed, [restart the application| manually so the changes take effect.

If the application is updated while it is running, the product automatically stops the application or only
its changed components, updates the application logic, and restarts the stopped application or its
components.

3. If the application you are updating is deployed on a server that has its application class loader policy
set to Single on the application server settings page, restart the server.
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Preparing for application update settings
Use this page to update enterprise applications, modules or files already installed on a server.

To view this administrative console page, do the following:

1. Click Applications » Application Types > WebSphere enterprise applications.
2. Select the installed application or module that you want to update.

3. Click Update.

Clicking Update displays a page that helps you update application files deployed in the cell. You can
update the full application, a single module, a single file, or part of the application. If a new file or module
has the same relative path as a file or module already existing on the server, the new file or module
replaces the existing file or module. If the new file or module does not exist on the server, it is added to
the deployed application.

Application to be updated
Specifies the name of the installed (or deployed) application that you selected on the Enterprise
applications page.

Replace the entire application
Under Application update options, specifies to replace the application already installed on the server
with a new (updated) enterprise application .ear file.

After selecting this option, do the following:

1. Specify whether the .ear file is on a local or remote file system and the full path name of the
application. The path provides the location of the updated .ear file before installation.

Use Local file system if the browser and the updated files or modules are on the same machine,
whether or not the server is on that machine too. Local file system is available for all update options.

Use Remote file system if the application file resides on any node in the current cell context.

Also use the Remote file system option to specify an application file already residing on the machine
running the application server. For example, the field value might be app_server _install_root/
installableApps/test.ear. If you are installing a standalone WAR module, then specify the context root
as well.

Note: During application installation, application files typically are uploaded from a client machine
running the browser to the server machine running the administrative console, where they are
deployed. In such cases, use the Web browser running the administrative console to select
modules to upload to the server machine. In some cases, however, the application files reside
on the file system of any of the nodes in a cell. To have the application server install these files,
use the Remote file system option.

2. If you are installing a standalone Web application (WAR) or a Session Initiation Protocol (SIP) module
(SAR), specify the context root of the WAR or SAR file.

The context root is combined with the defined servlet mapping (from the WAR file) to compose the full
URL that users type to access the servlet. For example, if the context root is /gettingstarted and the
servlet mapping is MySession, then the URL is http://host:port/gettingstarted/MySession.

3. Click Next to display a wizard for updating application files. The update wizard, which is similar to the
installation wizard, provides fields for specifying or editing application binding information. Complete the
steps in the update wizard as needed.

When the full application is updated, the old application is uninstalled and the new application is installed.
When the configuration changes are saved and subsequently synchronized, the application files are
expanded on the node where application will run. If the application is running on the node while it is
updated, then the application is stopped, application files are updated, and application is started.
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Replace or add a single module
Under Application update options, specifies to replace a module in or add a module to an installed
application.

The module can be a Web module (.war file), enterprise bean module (EJB .jar file), SIP module (.sar file),
or resource adapter module (connector .rar file).

After selecting this option, specify whether the module is on a local or remote file system and the full path
name of the module. The path provides the location of the updated module before installation. For
information on Local file system and Remote file system, refer to the previous description of Replace
the entire application .

To replace a module, the specified relative path (module URI) must match the path of the module to be
updated in the installed application.

To add a new module to the installed application, the specified relative path must not match the path of a
module in the installed application. The value specifies the desired path for the new module.

If you are installing a standalone Web or SIP module, specify a value for Context root. The context root is
combined with the defined servlet mapping (from the .war file) to compose the full URL that users type to
access the servlet. For example, if the context root is /gettingstarted and the servlet mapping is
MySession, then the URL is http://host:port/gettingstarted/MySession.

Next, specify whether to show only installation options that require you to supply information or to show all
installation options.

After specifying the required information on the module, click Next to display a wizard for updating
application files. The update wizard, which is similar to the installation wizard, provides fields for specifying
or editing module binding information. Complete the steps in the update wizard as needed.

After a single module is added or updated, when configuration changes are saved, the new or updated

module is stored in the deployed application in the product configuration repository. When these changes

are synchronized with the node, the module is added or updated to the node’s file system. If the

application is running on the node when the module is added or updated, then one of the following occurs:

* For updates to a Web module, the running Web module is stopped, Web module files are updated, and
then the Web module is started.

* For module additions, the added module is started on the application servers where the application is
running after it is expanded on the node. An application restart is not necessary.

* If the class loader policy for the application is set to Single so that all modules share a class loader,
then the entire application is stopped and restarted for module level changes.

« |f the security provider configured with the product does not support dynamic updates, then the entire
application is stopped and restarted for module level changes.

» For all other updates to a module, the entire application is stopped, the module files are updated, then
the entire application is started.

Replace or add a single file
Under Application update options, specifies to replace a file in or add a file to an installed application.

Use this option to update a file used by the application that is not an .ear, .war, .sar, .rar or, in some
instances, a .jar file. You can use this option to add or update .jar files that are not defined as modules in
the application. To update an .ear, file use the Replace the entire application option. To update a .war
file, .sar file, .rar file, or .jar file that is defined as a module in the application, use the Replace or add a
single module option.
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After selecting this option, specify whether the file is on a local or remote file system and the full path
name of the file. The path provides the location of the updated file before installation. For information on
Local file system and Remote file system, refer to the description of Replace the entire application.

For the relative path, specify a relative path to the file that starts from the root of the .ear file. For example,
if the file is located at com/company/greeting.class in module hello.jar, specify a relative path of
hello.jar/com/company/greeting.class.

To replace a file, the relative path must match the path of the file to be updated in the installed application.

To add a new file to the installed application, the must not match the path of a file in the installed
application. The value specifies the desired path for the new file.

After you specify the file system and relative paths, click Next.

After a single file is added or updated, when configuration changes are saved, the new or updated file is
stored in the deployed application in the product configuration repository. When these changes are
synchronized with the node, the file is added or updated to the node’s file system. If the application is
running on the node when the file is added or updated, then one of the following occurs:

* When files are added at application metadata scope (META-INF directory) or updated at any application
scope or in non-Web modules, the entire application is stopped, the file is added or updated, and then
the entire application is restarted.

* When files are added at application non-metadata scope (outside of META-INF directory but not in any
module), the changes are saved in the file system without restarting the running application.

* When files are added or updated to Web module metadata (META-INF or WEB-INF directory), the
running Web module is stopped, the Web module file is added or updated, and then the Web module is
started.

* For all other files in Web modules, the file is added or updated on the node’s file system without
stopping the application or any of its components.

Replace, add, or delete multiple files

Under Application update options, specifies to update multiple files of an installed application by
uploading a compressed file. Depending on the contents of the compressed file, a single use of this option
can replace files in, add new files to, and delete files from the installed application. Each entry in the
compressed file is treated as a single file and the path of the file from the root of the compressed file is
treated as the relative path of the file in the installed application.

After selecting this option, specify whether the compressed file is on a local or remote file system and the
full path name of the compressed file. You will likely use Local file system because you are uploading a
compressed file and remote browsing only works for .ear, .sar, .war or .jar files. Specify a valid
compressed file format such as .zip or .gzip. The path provides the location of the compressed file before
installation. This option unzips the compressed file into the installed application directory.

Use Local file system if the browser and the updated files or modules are on the same machine, whether
or not the server is on that machine too. Local file system is available for all update options.

To replace a file, a file in the compressed file must have the same relative path as the file to be updated in
the installed application.

To add a new file to the installed application, a file in the compressed file must have a different relative
path than the files in the installed application.

The relative path of a file in the installed application is formed by concatenation of the relative path of the

module (if the file is inside a module) and the relative path of the file from the root of the module
separated by /.
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To remove a file from the installed application, specify metadata in the compressed file using a file named
META-INF/ibm-partialapp-delete.props at any archive scope. The ibm-partialapp-delete.props file must be
an ASCII file that lists files to be deleted in that archive with one entry for each line. The entry can contain
a string pattern such as a regular expression that identifies multiple files. The file paths for the files to be
deleted must be relative to the archive path that has the META-INF/ibm-partialapp-delete.props file.

Level of files to
delete Metadata .props file to include in compressed file

Application Include META-INF/ibm-partialapp-delete.props in the compressed file. In the metadata .props
file, list files to be deleted. File paths are relative to the location of the META-INF/ibm-
partialapp-delete.props file.

For example, to delete a file named utils/config.xmi from the root of the my.ear file, include
the line utils/config.xmi in the META-INF/ibm-partialapp-delete.props file.

Module Include module_uriiMETA-INF/ibm-partialapp-delete.props in the compressed file.

To delete one file from a module, include the file path relative to the module in the metadata
.props file. For example, to delete a/b/c.jsp from the my.jar module, include a/b/c.jsp in
my.jar/META-INF/ibm-partialapp-delete.props file in the compressed file.

To delete multiple files within a module, list the files to be deleted in the metadata .props file
with one entry on each line. For example, to delete all JavaServer Pages (.jsp files) from the
my.war file, include the line .*jsp in the my.war/META-INF/ibm-partialapp-delete.props file.
The line uses a regular expression, .*jsp, to identify all .jsp files in my.war.

You can use a single partial application file to add, delete and update multiple files.
After you specify a file system path, click Next.

After a partial application update, when configuration changes are saved, the new or updated application
file is stored in the deployed application in the WebSphere Application Server configuration repository.
When these changes are synchronized with the node, the files are added or updated to the node’s file
system. Because the partial application option updates multiple files, the application components that are
restarted are determined using individual files in the partial application.

An example of entries in a partial application compressed file follows:

util.jar

META-INF/ibm-partialapp-delete.props
foo.jar/com/mycomp/xyz.class
xyz.war/welcome.jsp

Xyz.war/WEB-INF/web.xml
webmod.war/META-INF/ibm-partialapp-delete.props

For this example, the META-INF/ibm-partialapp-delete.props file contains the .*.dat and tools/test.jar files.
The webmod.war/META-INF/ibm-partialapp-delete.props file contains the com/test/.*.jsp and
WEB-INF/test.xmi files.

The partial application update option does the following:

» Adds or replaces util.jar in the deployed application.

» Adds or replaces com/mycomp/xyz.class inside the foo.jar file of the deployed application.
* Deletes *.dat files from the application, but not from any modules.

* Deletes tools/test.jar from the application.

* Adds or replaces welcome. jsp inside the xyz.war module of the deployed application.

* Replaces WEB-INF/web.xm1 inside the xyz.war module of the deployed application.

* Deletes com/test/*.jsp from the webmod.war module.

* Deletes WEB-INF/test.xmi from the webmod.war module.
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Hot deployment and dynamic reloading

You can make various changes to applications and their modules without having to stop the server and
start it again. Making these types of changes is known as hot deployment and dynamic reloading.

Before you begin

This topic assumes that your application files are |deployed|on a server and you want to upgrade the files.

See |“Ways to update enterprise application files” on page 101| and determine whether hot deployment is
the appropriate way for you to update your application files. Other ways are easier and hot deployment is
appropriate only for experienced users.

Do not use hot deployment if you intend to export your application, generate a plug-in based on the
application configuration, or perform other application management in the future. Changes that you make
to your application files using hot deployment are not recognized by administrative console or wsadmin
application management functions. Those functions recognize only the application files that administrative
programs such as the console or wsadmin present during application installation, update or other
management functions. The application management functions do not recognize files changed by hot
deployment.

About this task

Hot deployment is the process of adding new components (such as WAR files, EJB Jar files, enterprise
Java beans, servlets, and JSP files) to a running server without having to stop the application server
process and start it again.

Dynamic reloading is the ability to change an existing component without needing to restart the server in

order for the change to take effect. Dynamic reloading involves:

» Changes to the implementation of a component of an application, such as changing the implementation
of a servlet

» Changes to the settings of the application, such as changing the deployment descriptor for a Web
module

As opposed to the changes made to a deployed application described in[‘Updating enterprise application|
fiiles” on page 100,|changes made using hot deployment or dynamic reloading do not use the
administrative console or a wsadmin scripting command. You must directly manipulate the application files
on the server where the application is deployed.

If the application you are updating is deployed on a server that has its application class loader policy set to
Single, you might not be able to dynamically reload your application. At minimum, you must restart the
server after updating your application.

1. Locate your expanded application files.

The application files are in the directory you specified when installing the application or, if you did not
specify a custom target directory, are in the default target directory, |app_server_rood/ installedApps/
cell _name. Your EAR file, ${APP_INSTALL ROOT}/cell name/application_name.ear, points to the target
directory. The variables.xml file for the node defines ${APP_INSTALL_ROOT}.

It is important to locate the expanded application files because, as part of installing applications, a
WebSphere application server unjars portions of the EAR file onto the file system of the computer that
will run the application. These expanded files are what the server looks at when running your
application. If you cannot locate the expanded application files, look at the binariesURL attribute in the
deployment.xml file for your application. The attribute designates the location the run time uses to find
the application files.

For the remainder of this information on hot deployment and dynamic reloading, application_root
represents the root directory of the expanded application files.
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2. Locate application metadata files. The metadata files include the deployment descriptors (web.xm1,
application.xml, ejb-jar.xml, and the like), the bindings files (ibm-web-bnd.xmi, ibm-app-bnd.xmi,
and the like), and the extensions files (ibm-web-ext.xmi, ibm-app-ext.xmi, and the like).

Metadata XML files for an application can be loaded from one of two locations. The metadata files can
be loaded from the same location as the application binary files (such as application _root/META-INF)
or they can be loaded from the WebSphere configuration tree, ${CONFIG_RO0T}/cells/cell name/
applications /application EAR name/deployments/application name/. The value of the
useMetadataFromBinary flag specified during application installation controls which location is used. If
specified, the metadata files are loaded from the same location as the application binary files. If not
specified, the metadata files are loaded from the application deployment folder in the configuration
tree.

Note: You can have useMetadataFromBinaries=true, change an extracted copy of your application
using hot deployment, and have the changes take effect at run time by following the procedure
in this topic. However, changes that you make to your application files using hot deployment are
not recognized by console or wsadmin application management functions. Those functions
recognize only the original application files and not the files changed by hot deployment. Do not
use hot deployment if you intend to export your application, generate a plug-in based on the
application configuration, or perform other application management in the future. Hot
deployment enables you to quickly change application files; it does not support the full
management lifecycle of an application.

For the remainder of this information, metadata_root represents the location of the metadata files for
the specified application or module.

3. Optional: Examine the values specified for Reload classes when application files are updated and
Polling interval for updated files on the [settings page for your application’s class loade

If reloading of classes is enabled and the polling interval is greater than zero (0), the application files
are reloaded after the application is updated. For JavaServer Pages (JSP) files in a Web module, a
Web container reloads JSP files only when the IBM extension jspReloadingEnabled in the jspAttributes
of the ibm-web-ext.xmi file is set to true. You can set jspReloadingEnabled to true when editing your
Web module’s extended deployment descriptors in an assembly tool.

4. Change or add the following components or modules as needed:
+ |Application files|

* [WAR files
 [EJB Jar files
« |HTTP plug-in configuration files|

5. For changes to take effect, you might need to start, stop, or restart an application.

[‘Starting or stopping enterprise applications” on page 94| provides information on using the
administrative console to start, stop, or restart an application.

Results
The application files are updated on the server.

Because you directly manipulated the application files on the server, you might not be able to later use the
administrative console or a wsadmin scripting command to work with the files. For example, if you try
exporting a manually changed application using Export on an Enterprise applications console page, your
manual changes to an application in the installedApps directory are not exported. To export those
changes, you must copy and move the application files manually.

Changing or adding application files
You can change or add application files on application servers without having to stop the server and start it
again.
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About this task

There are several changes that you can make to deployed application files without stopping the server and
starting it again.

Note: See [‘Ways to update enterprise application files” on page 101|and determine whether hot

deployment is the appropriate way for you to update your application files. Other ways are easier
and hot deployment is appropriate only for experienced users. You can |use the update wizard of
the administrative console to make the changes without having to stop and restart the server.

The following table lists the changes that you can make by manipulating an application file on the server
where the application is deployed. The table also states whether you use hot deployment or dynamic
reloading to make the changes.

Change Hot deployment Dynamic reloading
[Update an existing application on a running server by providing a new| | Yes Yes

[EAR file.|

|Add a new application to a running server) Yes No

IIRemove an existing application from a running server) Yes No

ilChange or add files to existing EJB or Web modules.| Yes No

ilChange the application.xml file for an application.| Not applicable Yes

ilChange the ibm-app-ext.xmi file for an application.| Not applicable Yes

ilChange the ibm-app-bnd.xmi file for an application.| Not applicable Yes

ilChange a non-module Jar file contained in the EAR file.| Yes Yes

Update an existing application on a running server by providing a new EAR file.

Reinstall an updated application using the [administrative console| or the wsadmin $AdminApp install
command with the -update option.

Both reinstallation methods enable you to update an existing application using any of the other steps
listed in this file, including changing classes, adding modules, removing modules, changing modules, or
changing metadata files. The application reinstallation methods detect the changes in your application
and prompt you for additional binding data that might be needed to install the application. The
reinstallation process automatically stops and restarts your application on the appropriate servers.

Add a new application to a running server.

Install an application using the jadministrative console|or the wsadmin install command.

Remove an existing application from a running server.

Stop the application and then uninstall it from the server. Use the administrative console to |stop the

[application]| and then Or use the stopApplication attribute of the AdminControl object with

the wsadmin tool and then run the uninstall command.
Change or add files to existing EJB or Web modules.

1. Update the application files in the application_root location.
2. Restart the application.

Use the administrative console to |restart the applicationl Or use the startApplication and
stopApplication attributes of the AdminControl object with the wsadmin tool.

Change the application.xml file for an application.

Restart the application. Automatic reloading will not detect the change. Use the administrative console
to [restart the application| Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

Change the ibm-app-ext.xmi file for an application.
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Restart the application. Automatic reloading will not detect the change. Use the administrative console
to [restart the application| Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

* Change the ibm-app-bnd.xmi file for an application.

Restart the application. Automatic reloading will not detect the change. Use the administrative console

to [restart the application| Or use the startApplication and stopApplication attributes of the

AdminControl object with the wsadmin tool.

* Change a non-module Jar file contained in the EAR file.

1. Update the non-module Jar file in the application_root location.

2. If automatic reloading is not enabled, restart the application. Use the administrative console to
[restart the application] Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

If automatic reloading is enabled, you do not need to take further action. Automatic reloading will
detect the change.

Changing or adding WAR files
You can change Web application archives (WAR files) on application servers without having to stop the
server and start it again.

About this task

There are several changes that you can make to WAR files without stopping the server and starting it
again.

Note: See[‘Ways to update enterprise application files” on page 101 and determine whether hot
deployment is the appropriate way for you to update your WAR files. Other ways are easier and hot
deployment is appropriate only for experienced users. You can |use the update wizard of the
administrative console to make the changes without having to stop and restart the server.

The following table lists the changes that you can make by manipulating a WAR file on the server where
the application is deployed. The table also states whether you use hot deployment or dynamic reloading to
make the changes.

Change Hot deployment Dynamic reloading
|Change an existing JavaServer Pages (JSP) file | Not applicable Yes

|IAdd a new JSP file to an existing application.| Yes Yes

IIChange an existing servlet class by editing and recompiling Not applicable Yes

IChange a dependent class of an existing servlet class.| Not applicable Yes

|IAdd a new servlet using the Invoker (Serve Servlets by class name)| Yes Not applicable
[facility or add a dependent class to an existing application

|Add a new servlet, including a new definition of the servlet in the| Yes Not applicable
IIweb.xm] deployment descriptor for the application |

[Change the web.xm1 file of a WAR file] Yes Yes

iIChange the ibm-web-ext.xmi file of a WAR file Not applicable Yes

iIChange the ibm-web-bnd.xmi file of a WAR file. Not applicable Yes

* Change an existing JavaServer Pages (JSP) file.

Place the changed JSP file directly in the application_root/module_name directory or the appropriate
subdirectory. The change will be automatically detected and the JSP will be recompiled and reloaded.

* Add a new JSP file to an existing application.
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Place the new JSP file directly in the application_root/module_name directory or the appropriate
subdirectory. The new file will be automatically detected and compiled on the first request to the page.
Change an existing servlet class by editing and recompiling.

1. Place the new version of the servlet .class file directly in the application_root/module_name/WEB-
INF/classes directory. If the .class file is part of a Jar file, you can place the new version of the Jar
file directly in application_root/module_name/WEB-INF/1ib. In either case, the change will be
detected, the Web application will be shut down and reinitialized, picking up the new class.

2. If automatic reloading is not enabled, restart the application. Use the administrative console to
|restart the application| Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

If automatic reloading is enabled, you do not need to take further action. Automatic reloading will
detect the change.

Change a dependent class of an existing servlet class.

1. Place the new version of the dependent .class file directly in the application_root/module_name/
WEB-INF/classes directory. If the .class file is part of a Jar file, you can place the new version of the
Jar file directly in application_root/module_name/WEB-INF/11ib. In either case, the change will be
detected, the Web application will be shut down and reinitialized, picking up the new class.

2. If automatic reloading is not enabled, restart the application. Use the administrative console to
[restart the application| Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

If automatic reloading is enabled, you do not need to take further action. Automatic reloading will
detect the change.

Add a new servlet using the Invoker (Serve Servlets by class name) facility or add a dependent class to

an existing application.

1. Place the new .class file directly in the application_root/module name/WEB-INF/classes directory.
If the .class file is part of a Jar file, you can place the new version of the Jar file directly in
application _root/module _name/WEB-INF/1ib. In either case, the change will be detected, the Web
application will be shut down and reinitialized, picking up the new class.

This case is treated the same as changing an existing class. The difference is that adding the
servlet or class does not immediately cause the Web application to reload because the class has
never been loaded before. The class simply becomes available for execution.

2. If automatic reloading is not enabled, restart the application. Use the administrative console to
[restart the application] Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

If automatic reloading is enabled, you do not need to take further action. Automatic reloading will
detect the change.

Add a new servlet, including a new definition of the servlet in the web.xm1 deployment descriptor for the

application.

1. Place the new .class file directly in the application_root/module_name/WEB-INF/classes directory.
If the .class file is part of a Jar file, you can place the new version of the Jar file directly in
application_root/module_name/WEB-INF/1ib.

You can edit the web.xm1 file in place or copy it into the application root/module _name/WEB-INF/
classes directory. The new .class file will not trigger a reloading of the application.

2. Restart the application.

Use the administrative console to frestart the application| Or use the startApplication and
stopApplication attributes of the AdminControl object with the wsadmin tool. After the application
restarts, the new servlet is available for service.

Change the web.xm1 file of a WAR file.

1. Edit the web.xml file in place or copy it into the metadata _root/module name/WEB-INF directory.

2. Restart the application.
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Use the administrative console to [restart the applicationl Or use the startApplication and
stopApplication attributes of the AdminControl object with the wsadmin tool.
* Change the ibm-web-ext.xmi file of a WAR file.
Edit the extension settings as needed. You can change all of the extension settings. The only warning is
if you set the reloadInterval property to zero (0) or the reloadEnabled property to false, the application
no longer automatically detects changes to class files. Both of these changes disable the automatic
reloading function. The only way to re-enable automatic reloading is to change the appropriate property
and restart the application. See other task descriptions in this file for information on restarting an
application.

* Change the ibm-web-bnd.xmi file of a WAR file.

1. Edit the bindings as needed. You can change all of the values but ensure that the entities you are
binding to are present in the configuration of the server.

2. Restart the application.

Use the administrative console to restart the application| Or use the startApplication and
stopApplication attributes of the AdminControl object with the wsadmin tool.

Changing or adding EJB Jar files
You can change enterprise bean (EJB) Jar files on application servers without having to stop the server
and start it again.

About this task

There are several changes that you can make to EJB Jar files without stopping the server and starting it
again.

Note: See[‘Ways to update enterprise application files” on page 101 and determine whether hot
deployment is the appropriate way for you to update your EJB Jar files. Other ways are easier and
hot deployment is appropriate only for experienced users. You can|use the update wizard|of the
administrative console to make the changes without having to stop and restart the server.

The following table lists the changes that you can make to EJB Jar files by manipulating an EJB file on the
server where the application is deployed. The table also states whether you use hot deployment or
dynamic reloading to make the changes.

Change Hot deployment Dynamic reloading
IIChange the ejb-jar.xml file of an EJB Jar file] Not applicable Yes

[Change the ibm-ejb-jar-ext.xmi or ibm-ejb-jar-bnd.xmi file of an EJB|| Not applicable Yes

|Jar fiIe.|

IIChange the Table.dd] file for an EJB Jar file] Not applicable Not applicable
iIChange the Map.mapxmi or Schema.dbxmi file for an EJB Jar file.| Not applicable Yes

iIUpdate the implementation class for an EJB file or a dependent class of| | Not applicable Yes

!Ithe implementation class for an EJB file

'IUpdate the Home/Remote interface class for an EJB file | Not applicable Yes

[Add a new EJB file to an existing EJB Jar file] Yes Yes

* Change the ejb-jar.xml file of an EJB Jar file.

Restart the application. Automatic reloading will not detect the change. Use the administrative console
torestart the application| Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

* Change the ibm-ejb-jar-ext.xmi or ibm-ejb-jar-bnd.xmi file of an EJB Jar file.
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Restart the application. Automatic reloading will not detect the change. Use the administrative console
to [restart the application| Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

* Change the Table.dd1 file for an EJB Jar file.

Rerun the DDL file on the user database server. Changing the Table.dd1 file has no effect on the
application server and is a change to the database table schema for the EJB files.

» Change the Map.mapxmi or Schema.dbxmi file for an EJB Jar file.
1. Change the Map.mapxmi or Schema.dbxmi file for an EJB Jar file.
2. Regenerate the deployed code artifacts for the EJB file.
3. Apply the new EJB Jar file to the server.
4

Restart the application. Use the administrative console to |restart the applicatiorl. Or use the
startApplication and stopApplication attributes of the AdminControl object with the wsadmin tool.

* Update the implementation class for an EJB file or a dependent class of the implementation class for an
EJB file.

1. Update the class file in the application_root/module_name.jar file.

2. If automatic reloading is enabled, you do not need to take further action. Automatic reloading will
detect the change.

If automatic reloading is not enabled, restart the application of which the EJB file is a member. If the
updated module is used by other modules in other applications, restart those applications as well.
Use the administrative console to festart the application| Or use the startApplication and
stopApplication attributes of the AdminControl object with the wsadmin tool.

» Update the Home/Remote interface class for an EJB file.

1. Update the interface class of the EJB file.

2. Regenerate the deployed code artifacts for the EJB file.
3. Apply the new EJB Jar file to the server.
4

If automatic reloading is enabled, you do not need to take further action. Automatic reloading will
detect the change.

If automatic reloading is not enabled, restart the application of which the EJB file is a member. Use
the administrative console to|restart the application| Or use the startApplication and
stopApplication attributes of the AdminControl object with the wsadmin tool.

* Add a new EJB file to an existing EJB Jar file.
1. Apply the new or updated Jar file to the application_root location.

2. If automatic reloading is enabled, you do not need to take further action. Automatic reloading will
detect the change.

If automatic reloading is not enabled, restart the application. Use the administrative console to
[restart the application] Or use the startApplication and stopApplication attributes of the
AdminControl object with the wsadmin tool.

Changing the HTTP plug-in configuration
You can change the HTTP plug-in configuration without having to stop the server and start it again.

About this task

There are several change that you can make to the HTTP plug-in configuration without stopping the server
and starting it again.

Note: See |“Ways to update enterprise application files” on page 101| and determine whether hot
deployment is the appropriate way for you to update your HTTP plug-in configuration. Other ways
are easier and hot deployment is appropriate only for experienced users.
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The following table lists the changes that you can make to the HTTP plug-in configuration. The table also
states whether you use hot deployment or dynamic reloading to make the changes.

Change Hot deployment Dynamic reloading
IChange the application.xml file to change the context root of a Web| Yes No

!Iapplication archive (WAR file).|

iIChange the web.xml file to add, remove, or modify a servlet mapping| Yes Yes

[Change the server.xml file to add, remove, or modify an HTTP] Yes Yes

[transport or change the virtualhost.xm! file to add or remove a virtual|
(lhost or to add, remove, or modify a virtual host alias.|

» Change the application.xml file to change the context root of a WAR file.
1. Change the application.xml file.

2. If the plug-in configuration property Automatically propagate plug-in configuration file is selected
for this plug-in, it is automatically regenerated whenever the application.xml file changes.
See documentation on the Web server plug-in properties for information on how to set this property.
You can also run the GenPluginCfg.bat/sh script, or issue a wsadmin command to regenerate the
plug-in configuration file.

* Change the web.xm1 file to add, remove, or modify a servlet mapping.

1. Change the web.xm1 file.

2. If the plug-in configuration property Automatically propagate plug-in configuration file is selected
for this plug-in, it is automatically regenerated whenever the web.xml file changes.
See documentation on the Web server plug-in properties for information on how to set this property.
You can also run the GenPluginCfg.bat/sh script, or issue a wsadmin command to regenerate the
plug-in configuration file.
If the Web application has file serving enabled or has a servlet mapping of /, the plug-in
configuration does not have to be regenerated. In all other cases a regeneration is required.

* Change the server.xml file to add, remove, or modify an HTTP transport or change the
virtualhost.xml file to add or remove a virtual host or to add, remove, or modify a virtual host alias.

1. Change the server.xml file or the virtualhost.xml file.

2. If the plug-in configuration property Automatically propagate plug-in configuration file is selected
for this plug-in, it is automatically regenerated whenever the server.xml file changes.
See documentation on the Web server plug-in properties for information on how to set this property.
You can also run the GenPluginCfg.bat/sh script, or issue a wsadmin command to regenerate the
plug-in configuration file.

Uninstalling enterprise applications

After an application no longer is needed, you can uninstall it.
About this task

Uninstalling an application deletes the application from the product configuration repository and deletes the
application binaries from the file system of all nodes where the application modules are installed.

1. Click Applications > Application Types » WebSphere enterprise applications in the administrative
console navigation tree to access the |Enterprise applications pagel

2. If you need to retain a copy of the application, back up the application.
a. Select the application to uninstall.
b. Click Export.

The product exports the application to an enterprise application (.ear) file, preserving the binding
information.
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3. Uninstall the application.
a. Select the application to uninstall.
b. Click Uninstall.
c. On the Uninstall application panel, click OK.
4. Save changes made to the administrative configuration.

Results

On single-server products, application binaries are deleted after you save the changes.

Removing enterprise files

After a file is no longer needed, you can remove the file from a Java Platform, Enterprise Edition (Java
EE) application or module deployed on a server.

About this task

Removing a file deletes the file from the product configuration repository and deletes the file from the file
system of all nodes where the file is installed.

You can use the administrative console to remove a file from an application or module.
* Remove a file from an application.

1. Go to the [Enterprise applications page. Click Applications > Application Types > WebSphere
enterprise applications in the console navigation tree.

Select the application that contains a file you want removed.

Click Remove File. The Remove a file page is displayed

Select the URI of the file that you want removed from the application.
Back up the application.

Under Export before removing file, select the application name and then specify the location to
which you want the file exported.

6. Click OK to remove the file.
* Remove a file from a module.
1. Go to the Manage modules page}

Click Applications » Application Types » WebSphere enterprise applications -
application_name ~» Manage modules in the console navigation tree.

Select the module from which you want to delete a file.

Click Remove File. The Remove a file from a module page is displayed.
Select the URI of the file that you want removed from the module.

Back up the application.

Under Export before removing file, select the application name and then specify the location to
which you want the file exported.

6. Click OK to remove the file.

o k0D

o k0D

Results

The file is exported to the designated location and removed from the application or module. The
application or standalone Web module that had a file removed is restarted so the changes take effect.
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What to do next
Save the changes to your administrative configuration.

On single-server products, application binaries are deleted after you save the changes.

Deploying and administering applications: Resources for learning

Use the following links to find relevant supplemental information about deploying and administering
applications using the administrative console. The information resides on IBM and non-IBM Internet sites,
whose sponsors control the technical accuracy of the information.

These links are provided for convenience. Often, the information is not specific to the IBM WebSphere
Application Server product, but is useful all or in part for understanding the product. When possible, links
are provided to technical papers and Redbooks that supplement the broad coverage of the release
documentation with in-depth examinations of particular product areas.

View links to additional information about:

* [“Programming model and decisions’]

* [“Programming instructions and examples’|
+ [“Administration’]

Programming model and decisions

+ Designing Enterprise Applications with the Java™ 2 Platform, Enterprise Edition, Second Edition,
http://java.sun.com/blueprints/guidelines/designing_enterprise_applications_2e/

« Java EE Tutorials, http://java.sun.com/javaee/reference/tutorials/

* Recommended reading list: J2EE and WebSphere Application Server, http://www.ibm.com/
developerworks/websphere/library/techarticles/0305_issw/recommendedreading.html

» Java EE 5: Power and productivity with less complexity — An overview of Java EE 5 features and
developer-productivity enhancements, http://www.ibm.com/developerworks/java/library/j-jee5/
index.html?ca=drs-

» Rational Application Developer V7 Programming Guide, SG24-7501-00, http://www.redbooks.ibm.com/
abstracts/sg247501.htmI?Open

* IBM WebSphere Developer Technical Journal: The top Java EE best practices, http://www.ibm.com/
developerworks/websphere/techjournal/0701_botzum/0701_botzum.html

Programming instructions and examples

* IBM WebSphere: Deployment and Advanced Configuration, Roland Barcia, et al., ISBN 0131468626
(Prentice Hall, 2004)

* WebSphere Application Server - Express V6 Developers Guide and Development Examples,
http://www.redbooks.ibm.com/abstracts/sg246500.html

* IBM WebSphere Developer Technical Journal: Co-hosting multiple versions of J2EE applications,
http://www.ibm.com/developerworks/websphere/techjournal/0405_poddar/0405_poddar.htmi

» Automated Deployment of Enterprise Application Updates: Part 1 - Basic concepts,
http://websphere.sys-con.com/read/47889.htm

Administration

* IBM WebSphere Developer Technical Journal: System management for WebSphere Application Server
V6 -- Part 1 Overview of system management enhancements, http://www.ibm.com/developerworks/
websphere/techjournal/0501_williamson/0501_williamson.html

* IBM WebSphere Developer Technical Journal: System management for WebSphere Application Server
V6 -- Part 5: Flexible options for updating deployed applications, http://www.ibm.com/developerworks/
websphere/techjournal/0510_apte/0510_apte.html
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* WebSphere Application Server V6.1: System Management Configuration Handbook, SG24-7304-00,
http://www.redbooks.ibm.com/abstracts/SG247304.html?Open
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Chapter 6. Managing applications through programming

Through Java MBean programming, you can install, update, and delete a Java Platform, Enterprise Edition
(Java EE) application on a WebSphere Application Server deployment target.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming,
see MBean Java application programming interface (APl) documentation.

For information on the restarting of updated applications, refer to|Fine-grained recycle behavior in IBM
WebSphere Developer Technical Journal: System management for WebSphere Application Server V6 --
Part 5 Flexible options for updating deployed applications.

Before you can install or change an application on a deployment target, you must first create or update
your application and assemble it using an assembly tool.

About this task

Besides installing, uninstalling, and updating applications through programming, you can additionally
install, uninstall, and update Java EE applications through the administrative console or the wsadmin tool.
All three ways provide identical updating capabilities.

1. Perform any or all of the following tasks to manage your Java EE applications through programming.
Access the application management function.|

This topic provides examples to access the application management functionality:

— From WebSphere Application Server code

— From outside WebSphere Application Server

— When WebSphere Application Server is not running

[Install an application |

This topic provides an example for initially installing an application on a deployment target such as a
server .

[Uninstall an application.|
This topic provides an example for uninstalling an application that resides on a deployment target.
[Manipulate additional attributes for a deployed application.|

This topic provides an example for manipulating attributes that are not exposed through the
AppDeploymentTask object.

+ |Share sessions for application management|

This topic provides an example for saving application-specific updates for a deployed application to
a session, and then to the configuration repository.

[Update an application

This topic provides an example for updating the installed application on a server with a new
application. When you completely update an application, the deployed application is uninstalled and
the new enterprise archive (EAR) file is installed.

[Add to, update, or delete part of an application.|

This topic provides an example that you can use to add, update, or delete part of an application on
a server .

+ |Edit an application)
This topic provides an example that you can use to edit an application on a server .

¢ |Add a module.
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This topic provides an example for adding a module to an application that resides on a server .

+ |[Update a module.|
This topic provides an example for updating a module that resides on a server . When you update a
module, the deployed module is uninstalled and the updated module is installed.

+ |Delete a module.|

This topic provides an example for deleting a module that resides on a server . When you delete a
module, the deployed module is uninstalled.

y

This topic provides an example for adding a file to an application that resides on a server .

* |Update a file.

This topic provides an example for updating a file on a server . When you update a file, the
deployed file is uninstalled and the updated file is installed.

¢ |Delete a file.

This topic provides an example for deleting a file on a server . When you delete a file, the deployed
file is uninstalled.

2. Save your changes to the master configuration repository.

What to do next

If you have further application updates, you can do the updates through programming, the administrative
console, or the wsadmin tool.

You can use the common deployment framework to add additional logic to application management

operations. See [‘Extending application management operations through programming” on page 155]The
tasks that the extensions provide are available through all the administrative clients, such as the wsadmin
tool, the administrative console, or through programmatic APIs that the AppManagement MBean provides.

Application management

Java 2 Platform, Enterprise Edition (J2EE) applications and modules include an Extensible Markup
Language (XML)-based deployment descriptor that specifies various J2EE artifacts that pertain to
applications or modules. The J2EE artifacts include Enterprise JavaBeans (EJB) definitions, security role
definitions, EJB references, resource references, and so on. These artifacts define various unresolved
references that the application logic uses. The J2EE specification requires that these artifacts map to J2EE
platform-specific information, such as that found in WebSphere Application Server, during deployment of
J2EE applications.

The application assembly tools that WebSphere Application Server supports, as well as the application
management support that is provided with the product, facilitate collection of certain WebSphere
Application Server information. The collected information is used to resolve references that are defined in
various deployment descriptors in a J2EE application. This information is stored in the application EAR file
in conjunction with the deployment descriptors. The following diagram shows the structure of an Enterprise
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Archive (EAR) file that is populated with deployment information that is specific to WebSphere Application

<&
>

META-INF / application.xml EJB module Web module RAR module Client module
META-INF / ibm-appl-bnd.xmi
META-INF / ibm-appl-ext.xmi
META-INF / was.policy

META-INF ejb-jar.xml META-INF /ra.xml
META-INF / ibm-ejb-bnd.xmi libraries
META-INF / ibm-ejb-ext.xmi

EJB classes

META-INF /application-client.xml
META-INF / ibm-application-client-bnd.xmi
WEB-INF / web.xml Client classes

WEB-INF / ibm-web-bnd.xmi
WEB-INF / ibm-web-ext.xmi
Servlets, JSP files, libraries

Server.

The application management architecture provides a set of classes with which deployers can collect
WebSphere Application Server deployment information. This information is also referred to as binding
information, and is stored in the application EAR file. The deployer can install the EAR file into a
WebSphere Application Server configuration by using the AppManagement interface.

The application management support in WebSphere Application Server provides functions such as
installing and uninstalling applications, editing binding information for installed applications, updating the
entire application or part of the application, exporting the application, and so on. The
com.ibm.websphere.management.application.AppManagement interface, which is exposed as a Java
Management Extensions (JMX)-based AppManagement MBean in WebSphere Application Server, provides
this functionality. Code that runs on the server or in a stand-alone administrative client program can
access the interface. Access to the application management functions is also possible in the absence of
WebSphere Application Server. This mode, known as local mode, is particularly useful for installing J2EE
applications as part of product installation.

Accessing the application management function

The com.ibm.websphere.management.application.AppManagementProxy class provides uniform access to
application management functionality, regardless of whether the functionality is accessed from the server
process, administrative client process, or a stand-alone Java program in the absence of WebSphere
Application Server. This topic provides code excerpts that demonstrate how to obtain an
AppManagementProxy instance in a variety of cases.

Before you begin

This task assumes a basic familiarity with WebSphere Application Server programming interfaces and
MBean programming. Read about WebSphere Application Server programming interfaces and MBean
programming in the application programming interfaces documentation.

About this task

Perform any of the following tasks to access application management functionality through programming.

» To access application management functionality from WebSphere Application Server code, for example,
as a custom service, create the AppManagementProxy class.

AppManagement appMgmt =
AppManagementProxy. getJMXProxyForServer();
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» To access application management functionality from outside WebSphere Application Server through the
AppManagement MBean, create an administrative client to establish a connection to WebSphere
Application Server and then create the AppManagementProxy class.

AdminClient adminClient = ....
// create AppManagement proxy object
AppManagement appMgmt = AppManagementProxy. getJMXProxyForClient (adminClient);

» To access application management functionality when WebSphere Application Server is not running
(local mode), create the AppManagementProxy class.
AppManagement appMgmt = AppManagementProxy. getlLocalProxy ();
— When running in local mode set the com.ibm.ws.management.standalone system property to true. If
you want to modify configuration documents in a non-default location, set the location of the
configuration directory through the was.repository.root system property.

— Although you can use application management functions with or without WebSphere Application
Server running, do not access application management functions concurrently through local mode
and the AppManagement MBean. Otherwise, updates that are made using these modes can collide
and break the integrity of the WebSphere Application Server configuration.

Results

After you successfully create the AppManagementProxy class, you have access to application
management functionality.

What to do next

You can perform various management tasks such as installing, uninstalling, editing, and so on.

Installing an application through programming

You can install an application through the administrative console, the wsadmin tool, or programming. Use
this example to install an application through programming.

Before you begin

This task assumes a basic familiarity with MBean programming. Read about MBean programming in the
application programming interfaces documentation.

Before you can install an application on WebSphere Application Server, you must first create or update
your application and assemble it using an assembly tool.

About this task

The AppDeploymentController instance contains meta-data defined in XMLI-based deployment descriptors
as well as annotations defined in Java classes within the input enterprise archive (EAR) file.

Perform the following tasks to install an application through programming.
1. Populate the EAR file with WebSphere Application Server-specific binding information.
a. Create the controller and populate the EAR file with appropriate options.
b. Optionally run the default binding generator.
c. Save and close the EAR file.
d. Retrieve the saved options table that will be passed to the installApplication MBean API.
2. Connect to WebSphere Application Server.
3. Create the application management proxy.
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4. If the preparation phase (population of the EAR file) is not performed, the do the following actions:
a. Create an options table to be passed to the installApplication MBean API.
b. Create a table for module to server relations and add the table to the options table.

Refer to the com.ibm.websphere.management.application.AppManagement class in the
application programming interfaces documentation to understand various options that can be
passed to the installApplication MBean API.

5. Create the notification filter for listening to installation events.

6. Add the listener.

7. Install the application.

8. Wait for some timeout so that the program does not end.

9. Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
10. When the installation is done, remove the listener and quit.
Results

After you successfully run the code, the application is installed.
Example

The following example shows how to install an application based on the previous steps. Some statements
are split on multiple lines for printing purposes.

import java.lang.x*;

import java.io.*;

import java.util.*;

import java.lang.reflect.*;

import com.ibm.websphere.management.application.x*;

import com.ibm.websphere.management.application.client.*;
import com.ibm.websphere.management.*;

import javax.management.*;
public class Install {
public static void main (String [] args) {
try {

String earFile
String appName

"C:/test/test.ear";
"MyApp" 5

// Preparation phase: Begin

// Through the preparation phase you populate the enterprise archive (EAR) file with

// WebSphere Application Server-specific binding information. For example, you can specify
// Java Naming and Directory Interface (JNDI) names for enterprise beans, or virtual hosts
// for Web modules, and so on.

// First, create the controller and populate the EAR file with the appropriate options.
Hashtable prefs = new Hashtable();
prefs.put(AppConstants.APPDEPL_LOCALE, Locale.getDefault());

// You can optionally run the default binding generator by using the following options.
// Refer to Java documentation for the AppDeploymentController class to see all the
// options that you can set.

Properties defaultBnd = new Properties();

prefs.put (AppConstants.APPDEPL_DFLTBNDG, defaultBnd);

defaultBnd.put (AppConstants.APPDEPL_DFLTBNDG_VHOST, "default_host");

// Create the controller.
AppDeploymentController controller = AppDeploymentController
.readArchive(earFile, prefs);
AppDeploymentTask task = controller.getFirstTask();
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while (task != null)

{
// Populate the task data.
String[][] data = task.getTaskData();
// Manipulate task data which is a table of stringtask.
task.setTaskData(data);
task = controller.getNextTask();
}

controller.saveAndClose();

Hashtable options = controller.getAppDeploymentSavedResults();
// The previous options table contains the module-to-server relationship if it was set by
// using tasks.
//Preparation phase: End

// Get a connection to WebSphere Application Server.
String host = "Tocalhost";
String port = "8880";
String target = "WebSphere:cell=cel1Name,node=nodeName,server=serverl";

Properties config = new Properties();
config.put (AdminClient.CONNECTOR_HOST, host);
config.put (AdminClient.CONNECTOR_PORT, port);
config.put (AdminClient.CONNECTOR_TYPE, AdminClient.CONNECTOR_TYPE_SOAP);
System.out.printin ("Config: " + config);
AdminClient _soapClient = AdminClientFactory.createAdminClient(config);

// Create the application management proxy, AppManagement.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (_soapClient);

// 1f code for the preparation phase has been run, then you already have the options table.
// If not, create a new table and add the module-to-server relationship to it by uncommenting
// the next statement.
//Hashtable options = new Hashtable();

options.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());

// Uncomment the following statements to add the module to the server relationship table if
// the preparation phase does not collect it.

//Hashtable module2server = new Hashtable();

//module2server.put ("x", target);

//options.put (AppConstants.APPDEPL_MODULE_TO_SERVER, module2server);

//Create the notification filter for listening to installation events.
NotificationFilterSupport myFilter = new NotificationFilterSupport();
myFilter.enableType (AppConstants.NotificationType);

//Add the Tlistener.
NotificationListener Tistener = new AListener(_soapClient,
myFilter, "Install: " + appName, AppNotification.INSTALL);

// Install the application.
proxy.installApplication (earFile, appName, options, null);
System.out.printin ("After install App is called..");

// Wait for some timeout. The installation application programming interface (API) is
// asynchronous and so returns immediately.
// If the program does not wait here, the program ends.

Thread.s1leep(300000); // Wait so that the program does not end.

catch (Exception e) {
e.printStackTrace();
}

126 Developing and deploying applications



}

// Specify the Java Management Extensions (JMX) notification Tistener for JMX events.
class AlListener implements NotificationListener
{

AdminClient _soapClient;

NotificationFilterSupport myFilter;

Object handback;

ObjectName on;

String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{

_soapClient = cl;
myFilter = f1;

handback = h;
eventTypeToCheck = eType;

Iterator iter = _soapClient.queryNames (new ObjectName(
"WebSphere:type=AppManagement,*"), null).iterator();

on = (ObjectName)iter.next();

System.out.printin ("ObjectName: " + on);

_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)
{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//When the installation is done, remove the listener and quit.

if (ev.taskName.equals (eventTypeToCheck) &&
(ev.taskStatus.equals (AppNotification.STATUS COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS_FAILED)))

try
{

_soapClient.removeNotificationListener (on, this);

1
catch (Throwable th)
{

1
System.exit (0);

System.out.printin ("Error removing listener: " + th);

}
What to do next

Once you install the application, you must explicitly start the application or you must stop and restart the
server. For information on starting an application, see the Starting an application through programming
topic in the Using the administrative clients PDF. For information on stopping or restarting the server, see
the Stopping an application server topic or the Starting an application server topic, respectively, in the
Setting up the application serving environment PDF.

Starting an application through programming

You can start an application through the administrative console, the wsadmin tool, or programming. Use
this example to start an application through programming.
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Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (APl) documentation.

Before you can start an application on WebSphere Application Server, you must first install your
application.

About this task

Perform the following tasks to start an application through programming.
1. Connect the administrative client to WebSphere Application Server.
2. Create the application management proxy.

3. Call the startApplication method on the proxy by passing the application name and optionally the list of
targets on which to start the application.

Results
After you successfully run the code, the application is started.
Example

The following example shows how to start an application following the previously listed steps. Some
statements are split on multiple lines for printing purposes.

//Do a get of the administrative client to connect to
//WebSphere Application Server.

AdminClient client = ...;

String appName = "myApp";

Hashtable prefs = new Hashtable();

// Use the AppManagement MBean to start and stop applications on all or some targets.

// The AppManagement MBean is on serverl in WebSphere Application Server.
// Query and get the AppManagement MBean.

ObjectName on = new ObjectName ("WebSphere:type=AppManagement,*");
Iterator iter = client.queryNames (on, null).iterator();

ObjectName appmgmtON = (ObjectName)iter.next();

//Start the application on all targets.

AppManagement proxy = AppManagementProxy.getJMXProxyForClient(client);
String started = proxy.startApplication(appName, prefs, null);
System.out.printin("Application started on folloing servers: " + started);

//Start the application on some targets.

//String targets = "WebSphere:cell=cellname,node=nodename,
server=servernamet+WebSphere:cell=cellname,cluster=clusterName";

//String startedl = proxy.startApplication(appName, targets, prefs, null);
//System.out.printin("Application started on following servers: " + startedl)

Uninstalling an application through programming

You can uninstall an application through the administrative console, the wsadmin tool, or programming.
Use this example to uninstall an application through programming.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (API) documentation.
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Before you can uninstall an application on WebSphere Application Server, you must first install it.

About this task

Perform the following tasks to uninstall an application through programming.

1. Get a connection to WebSphere Application Server.

2. Get the application management proxy.

3. Create the notification filter for listening to uninstallation events.

4. Add the listener.

5. Uninstall the application.

6. Wait for some timeout so that the program does not end.

7. Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
8. When the uninstallation is done, remove the listener and quit.

Results

After you successfully run the code, the application is uninstalled.

Example

The following example shows how to uninstall an application based on the previous steps. Some
statements are split on multiple lines for printing purposes.

import java.lang.*;

import java.io.*;

import java.util.=*;

import java.lang.reflect.*;

import com.ibm.websphere.management.application.x*;

import com.ibm.websphere.management.application.client.*;
import com.ibm.websphere.management.*;

import javax.management.x;

public class Uninstall {

public static void main (String [] args) {

try {

// Get a connection to the server.

String host = "Tocalhost";
String port = "8880";
String target = "WebSphere:cell=cellName,node=nodeName,server=serverl";

Properties config = new Properties();
config.put (AdminClient.CONNECTOR HOST, host);
config.put (AdminClient.CONNECTOR_PORT, port);
config.put (AdminClient.CONNECTOR_TYPE, AdminClient.CONNECTOR_TYPE_SOAP);
System.out.printin ("Config: " + config);
AdminClient _soapClient = AdminClientFactory.createAdminClient(config);

// Get the application management proxy.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (_soapClient);

String appName = "MyApp";

Hashtable options = new Hashtable();
options.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());

//Create the notification filter.
NotificationFilterSupport myFilter = new NotificationFilterSupport();

Chapter 6. Managing applications through programming

129



myFilter.enableType (AppConstants.NotificationType);

//Add the Tistener.
NotificationListener Tistener = new AListener(_soapClient,
myFilter, "Install: " + appName, AppNotification.UNINSTALL);

// Uninstall the application.
proxy.uninstallApplication (appName, options, null);
System.out.printin ("After uninstall App is called..");

// Wait for some timeout. The installation application programming interface (API) is
// asynchronous and so returns immediately.
// 1f the program does not wait here, the program ends.

Thread.s1eep(300000); // Wait so that the program does not end.

}

catch (Exception e) {
e.printStackTrace();

1

}

// Specify the Java Management Extensions (JMX) notification listener for JMX events.
class AListener implements NotificationListener
{

AdminClient _soapClient;

NotificationFilterSupport myFilter;

Object handback;

ObjectName on;

String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{
_soapClient = cl;
myFilter = f1;
handback = h;
eventTypeToCheck = eType;

Iterator iter = soapClient.queryNames (new ObjectName(
"WebSphere:type=AppManagement,*"), null).iterator();

on = (ObjectName)iter.next();

System.out.printin ("ObjectName: " + on);

_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)
{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//When the unistallation is done, remove the listener and quit

if (ev.taskName.equals (eventTypeToCheck) &&
(ev.taskStatus.equals (AppNotification.STATUS COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS_FAILED)))

try
{

_soapClient.removeNotificationListener (on, this);

1
catch (Throwable th)
{
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System.out.printin ("Error removing listener: " + th);

1
System.exit (0);

Manipulating additional attributes for a deployed application

You can manipulate attributes for a deployed application through the administrative console, the wsadmin
tool, or by programming. Use this example to manipulate attributes that are not exposed during or after
application installation through the AppDeploymentTask object.

Before you begin

This task assumes a basic familiarity with MBean programming and the ConfigService interfaces. Read
about MBean programming and ConfigService interfaces in the application programming interfaces
documentation.

About this task

Perform the following tasks for your deployed application to manipulate attributes that are not exposed
through the AppDeploymentTask object. The attributes are saved in the deployment.xml file that is created
in the configuration repository for each deployed application.

1. Create a session.

Connect to WebSphere Application Server.
Locate the ApplicationDeployment object.
Manipulate the attributes.

Save your changes.

Clean up the session.
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Results

After you successfully run the code, the attributes are updated in the deployment.xml file for the deployed
application.

Example

The following example shows how to manipulate the startingWeight, warClassLoaderPolicy, and
classloader attributes based on the previous steps.

import java.util.Properties;

import javax.management.Attribute;
import javax.management.Attributelist;
import javax.management.ObjectName;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.configservice.ConfigService;
import com.ibm.websphere.management.configservice.ConfigServiceHelper;
import com.ibm.websphere.management.configservice.ConfigServiceProxy;
import com.ibm.websphere.management.exception.ConfigServiceException;
import com.ibm.websphere.management.exception.ConnectorException;

public class AppManagementSamplel {

public static void main(String[] args) {
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String hostName = "localhost";
String port = "8880";
String appName = "ivtApp";

ConfigService configService = null;

// create a session.
Session session = new Session();

// establish connection to the server.
try {
Properties props = new Properties();
props.setProperty(AdminClient.CONNECTOR_TYPE,
AdminCTient.CONNECTOR_TYPE_SOAP) ;
props.setProperty(AdminClient.CONNECTOR_HOST, hostName);
props.setProperty(AdminClient.CONNECTOR_PORT, port);
AdminCTlient adminClient =
AdminClientFactory.createAdminClient (props);

// create a config service proxy object.
configService = new ConfigServiceProxy(adminClient);

// Locate the application object.

ObjectName rootID = configService.resolve(session,
"Deployment="+appName) [0] ;

System.out.printin ("rootID is: " + rootID);

// Locate the ApplicationDeployment object from the root.
ObjectName appDeplPattern = ConfigServiceHelper.createObjectName
(nu11, "ApplicationDeployment");

/*

ObjectName appDeplID = configService.queryConfigObjects(session,
rootID, appDeplPattern, null)[0];

*

/

AttributelList 1istl = configService.getAttributes(session,
rootID, new String[]{"deployedObject"}, false);

ObjectName appDepl1ID = (ObjectName)
ConfigServiceHelper.getAttributeValue(listl, "deployedObject");

System.out.printin ("appDeplID: " + appDepl1ID);

// Locate the class Toader.

// Change the starting weight through the startingWeight attribute. The starting weight
// affects the order in which applications start.

AttributeList attrList = new AttributeList();

Integer newWeight = new Integer (10);

attrList.add(new Attribute("startingWeight", newWeight));

// Change the WAR class loader policy through the warClassLoaderPolicy attribute by
// specifying SINGLE or MULTIPLE.

// SINGLE=one classloader for all WAR modules

attrList.add(new Attribute("warClassLoaderPolicy", "SINGLE"));

// Set the class loader mode to PARENT_FIRST or PARENT_LAST.

AttributeList clList = (AttributeList) configService.getAttribute
(session, appDepl1ID, "classloader");

ConfigServiceHelper.setAttributeValue (clList, "mode",
"PARENT_LAST");

attrList.add (new Attribute ("classloader", clList));

// Set the new values.
configService.setAttributes(session, appDeplID, attrList);

// Save your changes.
configService.save(session, false);

} catch (Exception ex) {
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ex.printStackTrace();
} finally {
// Clean up the session.
try {
configService.discard(session);
1
catch (ConfigServiceException csEx)
{
csEx.printStackTrace();
}
catch (ConnectorException cnEx)
{
cnEx.printStackTrace();
}
}
}
1

Sharing sessions for application management

With the configuration service interface, ConfigService, you can create a session that is a temporary
staging area, where you can save all the configuration modifications. Saving the session saves all the
updates from the session into the WebSphere Application Server configuration repository. The application
management logic supports session sharing with the configuration service. You can perform all the
application management functions in the same session as the one that the configuration service creates.
Saving such a session saves all the updates, including the ones that are application-specific.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming,
see MBean Java application programming interface (APl) documentation.

About this task

Perform the following tasks for your deployed application to share and save application-specific updates
through the configService configuration service.

1. Create a configuration service proxy object.
2. Create a session.
3. Pass the session information to the AppManagement MBean.

Every method on the AppMangement interface takes session ID (workspace ID) as the last parameter.
If the session information is passed in this parameter, the application management function uses the
session. If you set the parameter to a null value:

* No session sharing occurs

» The configuration changes are always saved in the configuration repository if the operation
succeeds.
4. Save the session after all the necessary changes are made.
The following example outlines the general steps for session sharing through the configService
configuration service. For a detailed example, see |“Manipulating additional attributes for a deployed|
[application” on page 131
public void installApplication (String localEarPath,

String appName, Hashtable properties, String workspacelD)
throws AdminException;

AdminClient adminClient = ....;

// Create a configuration service proxy object.
ConfigService configService = new ConfigServiceProxy(adminClient);
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// Create a session.
Session session = new Session();

// Pass the session information to AppManagement MBean.
appMgmt = ...
appMgmt.installApplication

(earPath, appName, properties, session.toString());
//Save the session after all necessary changes are made.
configService.save(session, false);

Results

After you successfully complete the steps, you have saved application-specific updates for a deployed
application to a session, and then to the configuration repository.

Updating an application through programming

You can update an existing application through the administrative console, the wsadmin tool, or
programming. Use this example to completely update an application through programming.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (APIl) documentation.

Before you can update an application on WebSphere Application Server, you must first install your
application.

About this task

Perform the following tasks to completely update an application through programming.

Connect to WebSphere Application Server.

Create the application management proxy.

Create the noatification filter for listening to events.

Add the listener.

Prepare the enterprise archive (EAR) file by populating it with binding information.

Update the application.

Wait for some timeout so that the program does not end.

Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
When the update is done, remove the listener and quit.
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Results
After you successfully run the code, the application is updated.
Example

The following example shows how to update an application based on the previous steps. Some statements
are split on multiple lines for printing purposes.

import java.lang.=*;

import java.io.*;

import java.util.=*;

import java.lang.reflect.*;

import com.ibm.websphere.management.application.x*;

import com.ibm.websphere.management.application.client.x*;
import com.ibm.websphere.management.=*;
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import javax.management.*;
public class aa {
public static void main (String [] args) {

try {

// Connect to WebSphere Application Server.

String host = "Tocalhost";

String port = "8880";

String target = "WebSphere:cell=cellName,node=nodeName,server=serverl";

Properties config = new Properties();
config.put (AdminClient.CONNECTOR HOST, host);
config.put (AdminClient.CONNECTOR_PORT, port);
config.put (AdminC]1ent.CONNECTOR_TYPE, AdminC]1ent.CONNECTOR_TYPE_SOAP);
System.out.printin ("Config: " + config);
AdminClient _soapClient = AdminClientFactory.createAdminClient(config);

// Create the application management proxy, AppManagement.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (_soapClient);

String appName = "MyApp";
String fileContents = "/test/test.ear";

// Create the notification filter.

NotificationFilterSupport myFilter = new NotificationFilterSupport();

myFilter.enableType (NotificationConstants.TYPE_APPMANAGEMENT);

//Add the Tistener.

NotificationListener Tistener = new AListener(_soapClient, myFilter,
"Install: " + appName, AppNotification.INSTALL);

// Refer to the installation example to see how you can prepare the enterprise archive (EAR)
// file by populating it with binding information.
// 1f code for the preparation phase has started, then you already have the options table.
// If not, create a new table and add the module-to-server relationship to it by uncommenting
// the next statement.
//Hashtable options = new Hashtable();

options.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());

options.put ((AppConstants.APPUPDATE CONTENTTYPE, AppConstants.APPUPDATE_CONTENT APP);

// Uncomment the following statements to add the module to the server relationship table if
// the preparation phase does not collect it
//Hashtable module2server = new Hashtable();
//module2server.put ("x", target);
//options.put (AppConstants.APPDEPL_MODULE_TO SERVER, module2server);
// Update the application.
proxy.updateApplication (  appName,
null,
fileContents,
AppConstants.APPUPDATE_UPDATE,
options,
null);

// Wait for some timeout. The installation application programming interface (API) is
// asynchronous and so returns immediately.
// If the program does not wait here, the program ends.

Thread.sleep(300000); // Wait so that the program does not end.

}

catch (Exception e) {
e.printStackTrace();
}
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}

// Specify the Java Management Extensions (JMX) notification Tistener for JMX events.
class AListener implements NotificationListener
{

AdminClient _soapClient;

NotificationFilterSupport myFilter;

Object handback;

ObjectName on;

String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{
_soapClient = cl;
myFilter = f1;
handback = h;
eventTypeToCheck = eType;

Iterator iter = _soapClient.queryNames (new ObjectName(
"WebSphere:type=AppManagement,*"), null).iterator();

on = (ObjectName)iter.next();

System.out.printin ("ObjectName: " + on);

_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)
{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//When the installation is done, remove the Tistener and quit
if (ev.taskName.equals (eventTypeToCheck) &&

(ev.taskStatus.equals (AppNotification.STATUS COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS FAILED)))

try
{
_soapClient.removeNotificationListener (on, this);
}
catch (Throwable th)
{

System.out.printin ("Error removing listener: " + th);

}
System.exit (0);

Adding to, updating, or deleting part of an application through
programming

You can add to, update, or delete part of an existing application through the administrative console, the
wsadmin tool, or programming. This example changes part of an application through programming. You
can use this example whether you add to, update, or delete part of an existing application. Multiple
changes to an application can be packaged in a single .zip file.

Before you begin

To learn about the structure of the .zip file, see the Updating applications topic in the Developing and
deploying applications PDF.
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This task assumes a basic familiarity with MBean programming. For information on MBean programming

see MBean Java application programming interface (API) documentation.

Before you can add to, update, or delete part of an application on WebSphere Application Server, you
must first install your application.

About this task

Perform the following tasks to add to, update, or delete part of an application through programming.
Connect to WebSphere Application Server.

Create the application management proxy.

Create the notification filter.

Add the listener.

Partially change the existing application.

Wait for some timeout so that the program does not end.
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When the update is done, remove the listener and quit.

Results

After you successfully run the code, you have changed the application.
Example

The following example shows how to add to, update, or delete part of an application based on the
previous steps. Some statements are split on multiple lines for printing purposes.

//Inputs:
//partialApp specifies the Tocation of the partial application.
//appName specifies the name of the application.

String partialApp = "/apps/partial.zip";
String appName = "MyApp";

//Do a get of the administrative client to connect to
//WebSphere Application Server.

AdminClient client = ...;

//Create the application management proxy.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (client);

// Create the notification filter.

NotificationFilterSupport myFilter = new NotificationFilterSupport();
myFilter.enableType (NotificationConstants.TYPE_APPMANAGEMENT);

//Add the listener.

NotificationListener Tistener = new AListener(_soapClient, myFilter,
"Install: " + appName, AppNotification.UPDATE);

//Partially change the existing application, MyApp.

Hashtable options = new Hashtable();
options.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());
options.put (AppConstants.APPUPDATE_CONTENTTYPE, AppConstants.APPUPDATE_CONTENT PARTIALAPP);

proxy.updateApplication ( appName,
null,
partialApp,
null,
options,
null);
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// Wait for some timeout. The installation application programming interface (API) is
// asynchronous and so returns immediately.
// If the program does not wait here, the program ends.

Thread.s1leep(300000); // Wait so that the program does not end.

catch (Exception e) {
e.printStackTrace();
}

// Specify the Java Management Extensions (JMX) notification listener for JMX events.
class AListener implements NotificationListener
{

AdminClient _soapClient;

NotificationFilterSupport myFilter;

Object handback;

ObjectName on;

String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{
_soapClient = cl;
myFilter = f1;
handback = h;
eventTypeToCheck = eType;

Iterator iter = soapClient.queryNames (new ObjectName(
"WebSphere:type=AppManagement,*"), null).iterator();

on = (ObjectName)iter.next();

System.out.printin ("ObjectName: " + on);

_soapClient.addNotificationListener (on, this, myFilter, handback);

1
public void handleNotification (Notification notf, Object handback)
{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);
//When the installation is done, remove the listener and quit
if (ev.taskName.equals (eventTypeToCheck) &&
(ev.taskStatus.equals (AppNotification.STATUS_COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS_FAILED)))
{
try
{
_soapClient.removeNotificationListener (on, this);
1
catch (Throwable th)
System.out.printin ("Error removing listener: " + th);
}
System.exit (0);
}
1

Editing applications

You can edit deployed applications through the administrative console, the wsadmin tool, or by
programming. Use this example to edit a deployed application through programming.
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Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming,

see MBean Java application programming interface (APl) documentation.

Before you can edit an application on WebSphere Application Server, you must first install the application.

About this task

Perform the following tasks to edit your deployed application.
1. Connect to WebSphere Application Server.

2. Create the application management proxy.

3. Get information about an installed application.
4. Manipulate task data as necessary.

5. Save changes for the installed application.
Results

After you successfully run the code, the application is edited.
Example

The following example shows how to edit an application, based on the previous steps.

import java.lang.=*;

import java.io.*;

import java.util.*;

import java.lang.reflect.*;

import com.ibm.websphere.management.application.x*;

import com.ibm.websphere.management.application.client.*;
import com.ibm.websphere.management.*;

import javax.management.=*;
public class aa {
public static void main (String [] args) {

try {

// Connect to WebSphere Application Server.

String host = "Tocalhost";

String port = "8880";

String target = "WebSphere:cell=cel1Name,node=nodeName,server=serverl";

Properties config = new Properties();
config.put (AdminClient.CONNECTOR_HOST, host);
config.put (AdminClient.CONNECTOR PORT, port);
config.put (AdminClient.CONNECTOR_TYPE, AdminClient.CONNECTOR_TYPE_SOAP);
System.out.printin ("Config: " + config);
AdminClient _soapClient = AdminClientFactory.createAdminClient(config);

// Create the application management proxy, AppManagement.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (_soapClient);

String appName = "MyApp";
// Get information for an application with name appName:
// Pass Locale information as the preference.
Hashtable prefs = new Hashtable();
prefs.put(AppConstants.APPDEPL_LOCALE, Locale.getDefault());
Vector allTasks = appMgmt.getApplicationInfo (appName, prefs, null);
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// Manipulate task data as necessary.
if (task.getName().equals ("MapRolesToUsers") && !task. isTaskDisabled())
{
// find out column index for role and user column
// refer to the previous table to find the column names
int roleColumn = -1;
int userColumn = -1;
String[] colNames = task.getColumnNames();
for (int i=0; i < colNames.length; i++)
{
if (colNames[i].equals ("role"))
roleColumn = i;
else if (colNames[i].equals ("role.user"))
userColumn = i;

}

// iterate over task data starting at row 1 as row0 is
// column names
String[][]data = task.getTaskData();
for (int i=1; i < data.length; i++)
{

if (data[i][roleColumn].equals ("Rolel"))

{

data[i] [userColumn]="Userl|User2";

break;
}

}

// now that the task data is changed, save it back
task.setTaskData (data);
1

// Save changes back into the installed application:

// Set information for an application with name appName.

// Pass Locale information as the preference.

prefs = new Hashtable();
prefs.put(AppConstants.APPDEPL_LOCALE, Locale.getDefault());
appMgmt.setApplicationInfo (appName, prefs, null, allTasks);

catch (Exception e) {
e.printStackTrace();
}

Preparing a module and adding it to an existing application through
programming

You can add a module to an existing application through the administrative console, the wsadmin tool, or
programming. Use this example to add a module through programming.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (API) documentation.

Before you can add a module to an application on WebSphere Application Server, you must install the
application.
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About this task

Perform the following tasks to add a module to an application through programming.

1. Create an application deployment controller instance to populate the module file with binding
information.
2. Save the binding information in the module.
3. Get the installation options.
4. If the preparation phase (population of the EAR file) is not performed, the do the following actions:
a. Create an options table to be passed to the updateApplication MBean API.
b. Create a table for module to server relations and add the table to the options table.
5. Connect to WebSphere Application Server.
6. Create the application management proxy.
7. Create the notification filter.
8. Add the listener.
9. Add the module to the application.
10. Specify the target for the new module.
11. Wait for some timeout so that the program does not end.
12. Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
13. When the module addition is done, remove the listener and quit.
Results

After you successfully run the code, the module is added to the application.

Example

The following example shows how to add a module to an application based on the previous steps. Some
statements are split on multiple lines for printing purposes.

//Inputs:

//moduleName specifies the name of the module that you add to the application.
//moduleURI specifies a URI that gives the target location of the module

// archive contents on a file system. The URI provides the location of the new
// module after installation. The URI is relative to the application URL.
//uniquemoduleURI specfies the URI that gives the target location of the

// deployment descriptor file. The URI is relative to the application URL.
//target specifies the cell, node, and server on which the module is installed.

String moduleName = "/apps/foo.jar";

String moduleURI = "Increment.jar";
String uniquemoduleURI = "Increment.jar+META-INF/ejb-jar.xml";
String target = "WebSphere:cell=cellname,node=nodename,server=servername";

//Create an application deployment controller instance, AppDeploymentController,
//to populate the Java Archive (JAR) file with binding information.
//The binding information is WebSphere Application Server-specific deployment information.

Hashtable preferences = new Hashtable();

preferences.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());

preferences.put (AppConstants.APPUPDATE_CONTENTTYPE, AppConstants.APPUPDATE_CONTENT_MODULEFILE);
AppDeploymentController controller = AppManagementFactory.readArchiveForUpdate(

moduleName,

moduleURI,
AppConstants.APPUPDATE_ADD,
preferences,

null);
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If the module that you add to the application lacks any bindings, add the bindings so that the module
addition works. Collect and add the bindings by using the public APIs provided with WebSphere
Application Server. Refer to Java documentation for the
com.ibm.websphere.management.application.client. AppDeploymentController instance to learn more about
how to collect and populate tasks with WebSphere Application Server-specific binding information. The
AppDeploymentController instance contains meta-data defined in XML-based deployment descriptors as
well as annotations defined in Java classes within the input module.

//After you collect all the binding information, save it in the module.
controller.saveAndClose();

//Get the installation options.
Hashtable options = controller. getAppDeploymentSavedResults();

//Connect the administrative client, AdminClient, to WebSphere Application Server.
AdminClient client = ...;

//Create the application management proxy.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (client);

//Update the existing application, MyApp, by adding the module.
String appName = "MyApp";

options.put (AppConstants.APPUPDATE_CONTENTTYPE,
AppConstants. APPUPDATE_CONTENT_MODULEFILE);

//Create the notification filter.
NotificationFilterSupport myFilter = new NotificationFilterSupport();
myFilter.enableType (NotificationConstants.TYPE_APPMANAGEMENT);
//Add the Tistener.
NotificationListener Tistener = new AListener(_soapClient, myFilter,
"Install: " + appName, AppNotification.UPDATE);

//Specify the target for the new module.
Hashtable mod2svr = new Hashtable();
options.put (AppConstants.APPDEPL_MODULE_TO SERVER, mod2svr);
mod2svr.put (uniquemoduleURI, target);
proxy.updateApplication ( appName,

moduleURI,

moduleName,

AppConstants.APPUPDATE_ADD,

options,

null);

// Wait for some timeout. The installation application programming interface (API) is
// asynchronous and so returns immediately.
// If the program does not wait here, the program ends.

Thread.s1eep(300000); // Wait so that the program does not end.

catch (Exception e) {
e.printStackTrace();
}

}
// Specify the Java Management Extensions (JMX) notification listener for JMX events.
class AListener implements NotificationListener
{
AdminClient _soapClient;
NotificationFilterSupport myFilter;
Object handback;
ObjectName on;
String eventTypeToCheck;
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public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{
_soapClient = cl;
myFilter = f1;
handback = h;
eventTypeToCheck = eType;

Iterator iter = soapClient.queryNames (new ObjectName(
"WebSphere:type=AppManagement,*"), null).iterator();

on = (ObjectName)iter.next();

System.out.printin ("ObjectName: " + on);

_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)

{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//When the installation is done, remove the listener and quit

if (ev.taskName.equals (eventTypeToCheck) &&
(ev.taskStatus.equals (AppNotification.STATUS COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS_FAILED)))

try
{

1
catch (Throwable th)

{

1
System.exit (0);

_soapClient.removeNotificationListener (on, this);

System.out.printin ("Error removing listener: " + th);

Preparing and updating a module through programming

You can update a module for an existing application through the administrative console, the wsadmin tool,
or programming. When you update a module, you replace the existing module with a new version. Use
this example to update a module through programming.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (API) documentation.

Before you can update a module on WebSphere Application Server, you must first install the application.
About this task

Perform the following tasks to update a module through programming.

1. Create an application deployment controller instance to populate the Java archive file with binding
information.

2. Save the binding information in the module.
3. Get the installation options.
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4. If the preparation phase (population of the EAR file) is not performed, the do the following actions:
a. Create an options table to be passed to the updateApplication MBean API.
b. Create a table for module to server relations and add the table to the options table.
Connect to WebSphere Application Server.

Create the application management proxy.

Create the notification filter.
Add the listener.

9. Replace the module in the application.
10. Specify the target for the new module.
11. Wait for some timeout so that the program does not end.
12. Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
13. When the module addition is done, remove the listener and quit.
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Results
After you successfully run the code, the existing module is replaced with the new one.
Example

The following example shows how to add a module to an application based on the previous steps. Some
statements are split on multiple lines for printing purposes.

//Inputs:

//moduleName specifies the name of the module that you add to the application.
//moduleURI specifies a URI that gives the target location of the module

// archive contents on a file system. The URI provides the location of the new
// module after installation. The URI is relative to the application URL.
//uniquemoduleURI specfies the URI that gives the target location of the

// deployment descriptor file. The URI is relative to the application URL.
//target specifies the cell, node, and server on which the module is installed.
//appName specifies the name of the application to update.

String moduleName = "/apps/foo.jar";

String moduleURI = "Increment.jar";

String uniquemoduleURI = "Increment.jar+META-INF/ejb-jar.xml1";

String target = "WebSphere:cell=cellname,node=nodename,server=servername";
String appName = "MyApp";

//Get the administrative client to connect to

//WebSphere Application Server.

AdminClient client = ...;

AppManagement proxy = AppManagementProxy. getJMXProxyForClient (client);

Vector tasks = proxy.getApplicationInfo (appName, new Hashtable(), null);

//Create an application deployment controller instance, AppDeploymentController,
//to populate the Java archive (JAR) file with binding information.
//The binding information is WebSphere Application Server-specific deployment information.

Hashtable preferences = new Hashtable();
preferences.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());
preferences.put (AppConstants.APPUPDATE_CONTENTTYPE, AppConstants.APPUPDATE_CONTENT_MODULEFILE);
AppDeploymentController controller = AppManagementFactory.readArchiveForUpdate(
moduleName,
moduleURI,
AppConstants.APPUPDATE_UPDATE,
preferences,
tasks);
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If the module that you update for the application lacks any bindings, add the bindings so that the module
update works. Collect and add the bindings by using the public APIs that are provided with WebSphere
Application Server. Refer to Java documentation for the AppDeploymentController instance to learn more
about how to collect and populate tasks with WebSphere Application Server-specific binding information.
The AppDeploymentController instance contains meta-data defined in XML-based deployment descriptors

as well as annotations defined in Java classes within the input module.

//After you collect all the binding information, save it in the module.
controller.saveAndClose();

//Create the notification filter.
NotificationFilterSupport myFilter = new NotificationFilterSupport();
myFilter.enableType (NotificationConstants.TYPE_APPMANAGEMENT);
//Add the Tlistener.
NotificationListener listener = new AListener(_soapClient, myFilter,
"Install: " + appName, AppNotification.UPDATE);

//Get the installation options.
Hashtable options = controller. getAppDeploymentSavedResults();

//Update the existing application by adding the module.

options.put (AppConstants.APPUPDATE_CONTENTTYPE,
AppConstants. APPUPDATE_CONTENT MODULEFILE);

//Specify the target for the new module

Hashtable mod2svr = new Hashtable();

options.put (AppConstants.APPDEPL_MODULE_TO SERVER, mod2svr);
mod2svr.put (uniquemoduleURI, target);

proxy.updateApplication ( appName,
moduleURI,
moduleName,
AppConstants.APPUPDATE_UPDATE,
options,
null);
// Wait. The installation application programming interface (API) is
// asynchronous and so returns immediately.
// 1f the program does not wait here, the program ends.
Thread.sleep(300000); // Wait so that the program does not end.
}

catch (Exception e) {
e.printStackTrace();
}

1
// Specify the Java Management Extensions (JMX) notification Tistener for JMX events.
class AListener implements NotificationListener
{
AdminClient _soapClient;
NotificationFilterSupport myFilter;
Object handback;
ObjectName on;
String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception

_soapClient = cl;

myFilter = f1;

handback = h;

eventTypeToCheck = eType;

Iterator iter = _soapClient.queryNames (new ObjectName(
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"WebSphere:type=AppManagement,*"), null).iterator();
on = (ObjectName)iter.next();
System.out.printin ("ObjectName: " + on);
_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)

{
AppNotification ev = (AppNotification) notf.getUserData();

System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//When the installation is done, remove the listener and quit

if (ev.taskName.equals (eventTypeToCheck) &&
(ev.taskStatus.equals (AppNotification.STATUS_COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS FAILED)))

try
{

1
catch (Throwable th)

{

_soapClient.removeNotificationListener (on, this);

System.out.printin ("Error removing listener: " + th);

}
System.exit (0);

Deleting a module through programming

You can delete a module from an existing application through the administrative console, the wsadmin
tool, or programming. Use this example to delete a module through programming.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (API) documentation.

Before you can delete a module from an application on WebSphere Application Server, you must first
install the application.

About this task

Perform the following tasks to delete a module through programming.

Connect to WebSphere Application Server.

Create the application management proxy.

Create the notification filter for listening to events.

Add the listener.

Delete the module.

Wait for some timeout so that the program does not end.

Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
When the module is deleted, remove the listener and quit.
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Results
After you successfully run the code, the existing module is deleted from the application.
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Example

The following example shows how to delete a module from an application based on the previous steps.

Some statements are split on multiple lines for printing purposes.

//moduleURI specifies a URI that gives the target location of the module.
//appName specifies the name of the application to update.

String moduleURI = "Increment.jar";

String appName = "MyApp";

//Get the administrative client to connect to
//WebSphere Application Server.
AdminClient client = ...;

//Create the application management proxy.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (client);

//Create the notification filter.
NotificationFilterSupport myFilter = new NotificationFilterSupport();
myFilter.enableType (NotificationConstants.TYPE_APPMANAGEMENT);
//Add the Tlistener.
NotificationListener listener = new AListener(_soapClient, myFilter,
"Install: " + appName, AppNotification.UPDATE);

//Update the existing application, MyApp, by deleting the module.

Hashtable options = new Hashtable();

options.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());

options.put (AppConstants.APPUPDATE CONTENTTYPE, AppConstants.APPUPDATE CONTENT MODULEFILE);

proxy.updateApplication ( appName,
moduleURI,
null,
AppConstants.APPUPDATE_DELETE,
options,
null);

// Wait; the installation application programming interface (API) is
// asynchronous and so returns immediately.
// 1f the program does not wait here, the program ends.
Thread.sleep(300000); // Wait so that the program does not end.
}
catch (Exception e) {
e.printStackTrace();
}

1
// Specify the Java Management Extensions (JMX) notification listener for JMX events.
class AListener implements NotificationListener
{
AdminClient _soapClient;
NotificationFilterSupport myFilter;
Object handback;
ObjectName on;
String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{

_soapClient = cl;
myFilter = f1;

handback = h;
eventTypeToCheck = eType;

Iterator iter = _soapClient.queryNames (new ObjectName(
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"WebSphere:type=AppManagement,*"), null).iterator();
on = (ObjectName)iter.next();
System.out.printin ("ObjectName: " + on);
_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)

{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//When the installation is done, remove the listener and quit

if (ev.taskName.equals (eventTypeToCheck) &&
(ev.taskStatus.equals (AppNotification.STATUS_COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS FAILED)))

try
{

1
catch (Throwable th)

{

_soapClient.removeNotificationListener (on, this);

System.out.printin ("Error removing listener: " + th);

}
System.exit (0);

Adding a file through programming

You can add a file to an existing application through the administrative console, the wsadmin tool, or
programming. This example describes how to add a file through programming.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (API) documentation.

Before you can add a file to an application on WebSphere Application Server, you must first install the
application.

About this task

Perform the following tasks to add a file to an application through programming.

Connect to WebSphere Application Server.

Create the application management proxy.

Create the notification filter for listening to events.

Add the listener.

Add the file to the application.

Wait for some timeout so that the program does not end.

Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
When the file is added to the application, remove the listener and quit.
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Results

After you successfully run the code, the file is added to the application.
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Example

The following example shows how to add a file to an application based on the previous steps. Some
statements are split on multiple lines for printing purposes.

import java.lang.=*;

import java.io.*;

import java.util.*;

import java.lang.reflect.x*;

import com.ibm.websphere.management.application.x*;

import com.ibm.websphere.management.application.client.x*;
import com.ibm.websphere.management.x*;

import javax.management.*;
public class FileAdd {
public static void main (String [] args) {

try {

// Get a connection to WebSphere Application Server.
String host = "Tocalhost";
String port = "8880";
String target = "WebSphere:cell=cel1Name,node=nodeName,server=serverl";

Properties config = new Properties();
config.put (AdminClient.CONNECTOR_HOST, host);
config.put (AdminClient.CONNECTOR_PORT, port);
config.put (AdminClient.CONNECTOR_TYPE, AdminClient.CONNECTOR_TYPE_SOAP);
System.out.printin ("Config: " + config);
AdminClient _soapClient = AdminClientFactory.createAdminClient(config);

// Create the application management proxy, AppManagement.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (_soapClient);

String appName = "MyApp";
String fileURI = "test.war/com/acme/abc.jsp";

String fileContents = "/temp/abc.jsp";

//Create the notification filter.
NotificationFilterSupport myFilter = new NotificationFilterSupport();
myFilter.enableType (NotificationConstants.TYPE_APPMANAGEMENT);

//Add the Tlistener.
NotificationListener listener = new AListener(_soapClient, myFilter,
"Install: " + appName, AppNotification.UPDATE);

Hashtable options = new Hashtable();
options.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());
options.put (AppConstants.APPUPDATE_CONTENTTYPE, AppConstants.APPUPDATE_CONTENT_ FILE);

// Update the application
proxy.updateApplication (  appName,
fileURI,
fileContents,
AppConstants.APPUPDATE_ADD,
options,
null);

// Wait; the installation Application Programming Interface (API) is

// asynchronous and so returns immediately.

// 1f the program does not wait here, the program ends.
Thread.sleep(90000); // Wait so that the program does not end.

}

catch (Exception e) {
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e.printStackTrace();

// Specify the Java Management Extensions (JMX) notification listener for JMX events.
class AListener implements NotificationListener
{

AdminClient _soapClient;

NotificationFilterSupport myFilter;

Object handback;

ObjectName on;

String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{

_soapClient = cl;
myFilter = f1;

handback = h;
eventTypeToCheck = eType;

Iterator iter = _soapClient.queryNames (new ObjectName(
"WebSphere:type=AppManagement,*"), null).iterator();

on = (ObjectName)iter.next();

System.out.printin ("ObjectName: " + on);

_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)
{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//When the installation is done, remove the Tistener and quit

if (ev.taskName.equals (eventTypeToCheck) &&
(ev.taskStatus.equals (AppNotification.STATUS_COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS FAILED)))

try
{

_soapClient.removeNotificationListener (on, this);

catch (Throwable th)
{

}
System.exit (0);

System.out.printin ("Error removing listener: " + th);

Updating a file through programming

You can update a file for an existing application through the administrative console, the wsadmin tool, or
programming. This example describes how to update a file through programming.
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Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (APl) documentation.

Before you can update a file for an application on WebSphere Application Server, you must first install the
application.

About this task

Perform the following tasks to update a file through programming.

Connect to WebSphere Application Server.

Create the application management proxy.

Create the notification filter for listening to events.

Add the listener.

Update the file in the application.

Wait for some timeout so that the program does not end.

Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
When the installation is done, remove the listener and quit.
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Results
After you successfully run the code, the file is updated for the application.
Example

The following example shows how to add a file to an application based on the previous steps. Some
statements are split on multiple lines for printing purposes.

//Inputs:

//fileContents specifies the name of the file that you add to the application.

//appName specifies the name of the application.

//fileURI specifies a URI that gives the target Tocation of the file. The URI

// provides the Tocation of the new module after installation. The URI is

// relative to the application URL.

String fileContents = "/apps/test.jsp";

String appName = "MyApp";
String fileURI = "SomeWebMod.war/com/foo/abc.jsp";

//Get the administrative client to connect to
//WebSphere Application Server.
AdminClient client = ...;

//Create the application management proxy.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (client);

//Create the notification filter.
NotificationFilterSupport myFilter = new NotificationFilterSupport();
myFilter.enableType (NotificationConstants.TYPE_APPMANAGEMENT);
//Add the listener.
NotificationListener Tistener = new AListener(_soapClient, myFilter,
"Install: " + appName, AppNotification.UPDATE);

Hashtable options = new Hashtable();
options.put (AppConstants.APPDEPL_LOCALE, Locale.getDefault());
options.put (AppConstants.APPUPDATE_CONTENTTYPE, AppConstants.APPUPDATE_CONTENT FILE);

proxy.updateApplication ( appName,
fileURI,
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fileContents,
AppConstants.APPUPDATE_UPDATE,
options,

null);

// Wait; the installation application programming interface (API) is
// asynchronous and so returns immediately.
// If the program does not wait here, the program ends.
Thread.s1eep(300000); // Wait so that the program does not end.
}

catch (Exception e) {
e.printStackTrace();
1

1
// Specify the Java Management Extensions (JMX) notification Tistener for JMX events.
class AListener implements NotificationListener
{
AdminClient _soapClient;
NotificationFilterSupport myFilter;
Object handback;
ObjectName on;
String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{
_soapClient = cl;
myFilter = f1;
handback = h;
eventTypeToCheck = eType;

Iterator iter = _soapClient.queryNames (new ObjectName(
"WebSphere:type=AppManagement,*"), null).iterator();

on = (ObjectName)iter.next();

System.out.printin ("ObjectName: " + on);

_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)
{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//When the installation is done, remove the listener and quit.
if (ev.taskName.equals (eventTypeToCheck) &&

(ev.taskStatus.equals (AppNotification.STATUS COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS_FAILED)))

{
try
{
_soapClient.removeNotificationListener (on, this);
}
catch (Throwable th)
{

System.out.printin ("Error removing listener: " + th);

}
System.exit (0);
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Deleting a file through programming

You can delete a file from an existing application through the administrative console, the wsadmin tool, or
programming. Use this example to delete a file through programming.

Before you begin

This task assumes a basic familiarity with MBean programming. For information on MBean programming
see MBean Java application programming interface (API) documentation.

Before you can delete a file from an application on WebSphere Application Server, you must first install the
application.

About this task

Perform the following tasks to delete a file through programming.

Connect to WebSphere Application Server.

Create the application management proxy.

Create the notification filter for listening to events.

Add the listener.

Delete the file from the application.

Wait for some timeout so that the program does not end.

Listen to Java Management Extensions (JMX) notifications to understand completion of the operation.
When the file is deleted from the application, remove the listener and quit.
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Results
After you successfully run the code, the file is deleted from the application.
Example

The following example shows how to delete a file based on the previous steps. Some statements are split
on multiple lines for printing purposes.

//Inputs:

//fileURI specifies a URI that gives the target Tocation of the file. The URI
// provides the location of the new module after installation. The URI is

// relative to the application URL.

//appName specifies the name of the application.

String fileURI
String appName

"Increment.jar/com/acme/Foo.class";
"MyApp";

//Get the administrative client to connect to
//WebSphere Application Server.
AdminClient client = ...;

//Create the application management proxy.
AppManagement proxy = AppManagementProxy. getJMXProxyForClient (client);

//Create the notification filter.
NotificationFilterSupport myFilter = new NotificationFilterSupport();
myFilter.enableType (NotificationConstants.TYPE_APPMANAGEMENT);
//Add the Tistener.
NotificationListener listener = new AListener(_soapClient, myFilter,
"Install: " + appName, AppNotification.UPDATE);

//Update the existing application, MyApp, by deleting the file.
Hashtable options = new Hashtable();
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options.put (AppConstants.APPDEPL _LOCALE, Locale.getDefault());
options.put (AppConstants.APPUPDATE_CONTENTTYPE, AppConstants.APPUPDATE_CONTENT_FILE);

proxy.updateApplication ( appName,
fileURI,
null,
AppConstants.APPUPDATE_DELETE,
options,
null);

// Wait for some timeout. The installation Application Programming Interface (API) is
// asynchronous and so returns immediately.
// If the program does not wait here, the program ends.
Thread.sleep(300000); // Wait so that the program does not end.
1

catch (Exception e) {
e.printStackTrace();
1

1
// Specify the Java Management Extensions (JMX) notification Tistener for JMX events.
class AListener implements NotificationListener
{
AdminClient _soapClient;
NotificationFilterSupport myFilter;
Object handback;
ObjectName on;
String eventTypeToCheck;

public AListener(AdminClient c1, NotificationFilterSupport f1,
Object h, String eType) throws Exception
{

_soapClient = cl;
myFilter = f1;

handback = h;
eventTypeToCheck = eType;

Iterator iter = _soapClient.queryNames (new ObjectName(
"WebSphere:type=AppManagement,*"), null).iterator();

on = (ObjectName)iter.next();

System.out.printin ("ObjectName: " + on);

_soapClient.addNotificationListener (on, this, myFilter, handback);

}

public void handleNotification (Notification notf, Object handback)
{
AppNotification ev = (AppNotification) notf.getUserData();
System.out.printin ("!! JMX event Recd: (handback obj= " + handback+ "): " + ev);

//Once the installation is done, remove the listener and quit

if (ev.taskName.equals (eventTypeToCheck) &&
(ev.taskStatus.equals (AppNotification.STATUS_COMPLETED) ||
ev.taskStatus.equals (AppNotification.STATUS FAILED)))

try
{

_soapClient.removeNotificationListener (on, this);

catch (Throwable th)
{

}

System.out.printin ("Error removing listener: " + th);
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System.exit (0);

Extending application management operations through programming

You can use the common deployment framework to add additional logic to application management
operations. The additional logic can do such tasks as code generation, configuration operations, additional
validation, and so on. This topic demonstrates, through programming, how to plug into the common
deployment framework to extend application management operations.

Before you begin

This task assumes a basic familiarity with Java application programming interfaces (APIs). Read about the
Java APIs in the application programming interfaces documentation.

Before you can extend application management operations, you must first install WebSphere Application
Server.

About this task

Use this example to extend application management through programming. The tasks that the extensions
provide are available through all the administrative clients, such as the wsadmin tool, the administrative
console, or through programmatic APIs that the AppManagement MBean provides.

1. Define your extension as an Eclipse plug-in and add a pTugin.xml file to register your extension
provider with the deployment framework.

a. Inthe plugin.xml file, provide an extension provider implementation class for the
common-deployment-framework-extensionprovider extension point.

b. Put the plug-in Java archive (JAR) file in the plugins directory of your WebSphere Application
Server installation.
<?xml version="1.0" encoding="UTF-8"?>
<plugin
id="com.ibm.myproduct.MyExtensionProvider"
name="My Extension"
version="1.0.0">

<extension point="common-deployment-framework-extensionprovider">
<action class="com.acme.MyExtendProviderImpl"/>
</extension>
</plugin>

2. Provide an extension provider.

An extension provider class provides steps for a given operation on an application Enterprise archive
(EAR) file. Before an operation runs, the deployment framework queries all the registered extension
providers for additional steps. A single list of steps is passed to each provider. Each provider can add
steps to the list. The default provider that the deployment framework provides is called first to populate
the list with default steps. Other extension providers are called next.

Various operations that you can extend through the common deployment framework are defined as
constants in the DeploymentConstants class. These operations are described in the following table.
Some operations are split on multiple lines for printing purposes.

Table 5. Extensible DeploymentConstants operations

Operation Description
DeploymentConstants.CDF_OP_INSTALLJ2EE Installs a Java Platform, Enterprise Edition (Java EE)
EAR file
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Table 5. Extensible DeploymentConstants operations (continued)

Operation Description
DeploymentConstants.CDF_OP_EDITJ2EE Edits a deployment application configuration
DeploymentConstants.CDF_OP_UPDATEJ2EE Applies a fine-grained update to an application such as

addition, removal, or update of a file or a module; or
partial update of an application

DeploymentConstants.CDF_OP_UNINSTALLJ2EE Uninstalls a Java EE application
DeploymentConstants. Wraps the contents input to the application installation
CDF_OP_CREATE_EAR_WRAPPERJ2EE into an EAR file

The AppManagement MBean, which is responsible for deploying and managing Java EE applications
on WebSphere Application Server, runs all the operations except the
CDF_OP_CREATE_EAR_WRAPPERJ2EE operation. Deploy the extensions that extend these
operations in the plugins directory of the stand-alone Application Server .

Either the wsadmin utlity or the administrative console runs the
CDF_OP_CREATE_EAR_WRAPPERJ2EE operation when the input contents that are supplied to the
CDF_OP_INSTALLJ2EE operation are not packaged as an EAR file. Deploy an extension that extends
the CDF_OP_CREATE_EAR_WRAPPERJ2EE operation in the plugins directory of the wsadmin
installation.

The following example provides an extension provider that does the following tasks:
a. Adds two additional steps for the application installation operation

b. Adds one step for wrapping input contents into an EAR file

package com.acme;

import com.ibm.websphere.management.deployment.registry.ExtensionProvider;
import com.ibm.websphere.management.deployment.core.DeploymentConstants;

public class MyExtensionProviderImpl extends ExtensionProvider {
public void addSteps (String type, String op, String phase,
List steps)

{
if (op.equals (DeploymentConstants.CDF_OP_INSTALLJ2EE))

// Add a code generation step.

steps.add (0, new com.acme.CodeGenStep());
// Add a configuration step.

steps.add (new com.acme.ConfigStep());

}
else if (op.equals (DeploymentConstants.CDF_OP_CREATE_EAR WRAPPERJ2EE))

// Add an ear-wrapper step.
steps.add (new com.acme.EarWrapperStep());
}
}
}

3. Provide the deployment step implementation.

An extension provider adds a deployment step. The step contains logic that performs additional
processing in an application management operation. The logic provides the step access to the
deployment context and the deployable object. The deployment context provides information, such as
the name of the operation, the configuration session ID, a temporary location for creating temporary
files, operation parameters, and so on. The deployable object wraps the deployment content input to
the operation. For example, the deployable object wraps the Java EE EAR file for the installation
operation or a file, a module, or a partial application for the update operation.

* The following example illustrates how an extension during installation entirely changes an EAR file
that is input to the installation operation. The example provides a deployment step during the
installation operation that does the following tasks:
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a. Runs code generation to generate a new EAR file.

b. Calls the setContentPath method in the DeployableObject class to set the new EAR file path.
The default installation logic, such as steps that the default installation logic adds, uses this new
EAR file for installation in the configuration repository.

package com.acme;

import com.ibm.websphere.management.deployment.core.DeploymentStep;
import com.ibm.websphere.management.deployment.core.DeployableObject;

public class CodeGenStep extends DeploymentStep

{
public void execute (DeployableObject dObject)

{

EARFile earFile = (EARFile)dObject.getHandle();

String newEARPath = null;

// Use step specific logic to create another EAR file after code generation.

newEARPath = context.getTempDir() + "new.ear";

dObject.setContentPath (newEARPath);
1
}

The following example provides a deployment step that:
a. Reads the contents of the input EAR file.

b. Manipulates the configuration session accessed through the context instance, _context.
package com.acme;

public class ConfigStep extends DeploymentStep
{
public void execute (DeployableObject dObject)

EARFile earFile = (EARFile) dObject.getHandle();

// Use the following example code to perform the configuration.
String sessionID = _context.getSessionID();
com.ibm.websphere.management.Session session = new
com.ibm.websphere.management.Session (sessionID, true);

// Use the configuration service to perform the configuration steps.

// Read the application configuration.
Application appDD = earFile.getDeploymentDescriptor();

String newEARPath = null;

}
}
The following example provides a deployment step to wrap arbitrary content around an EAR file.
Application management logic accepts only the EAR file for deployment. An extension is required if
you want to input anything other than an EAR file to the deployment process.

package com.acme;

import com.ibm.websphere.management.deployment.core.DeploymentStep;
import com.ibm.websphere.management.deployment.core.DeployableObject;

pubTic class EarWrapperStep extends DeploymentStep
{
public void execute (DeployableObject dObject)

{
Archive archive = (Archive) dObject.getHandle();

String newEARPath = null;
// provide your logic to wrap the jar with the ear
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newEARPath = //;

// Set the new ear path back into DeploymentContext

this.getContext().getContextData()
.put(DeploymentContext.RETURN_Object_key, newEARPath);

}
}

Results

Through programming, you have plugged into the common deployment framework to extend application
management operations.

What to do next

You can extend other application management operations, or do any other administrative operations you
choose.
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Chapter 7. Deploying and administering business-level
applications

Deploying a business-level application consists of creating the business-level application on a Version 7.0
or later server.

Before you begin

Note: A business-level application is an administration model that provides the entire definition of an
application as it makes sense to the business. It is a WebSphere configuration artifact, similar to a
server, that is stored in the product configuration repository. A business-level application can contain
artifacts such as Java Platform, Enterprise Edition (Java EE) applications or modules, shared
libraries, data files, and other business-level applications. You might use a business-level
application to group related artifacts or to add capability to an existing application. For example,
suppose you want to add capability provided in a Java archive (JAR) to a Java EE application
already deployed on a product server. You can add that capability by creating a new business-level
application and adding the JAR file and the deployed Java EE application to the business-level
application. In some cases, you do not even need to change the deployed Java EE application
configuration to add the capability.

Before creating a business-level application, you must develop the artifacts to go in the application and
configure the target server. Before choosing a deployment target for the application, ensure that the target
version is 7.0 or later.

About this task

When creating a business-level application, you can configure the application enough to enable it to run on
the server. Later, you can configure the application and its contents further, start or stop the application,
and otherwise manage its activity.

The topics in this section describe how to deploy and administer a business-level application or its
contents using the administrative console. You can also use programming or wsadmin scripting.

. to a repository.

+ [View, delete, update, or export assets|

+ [Create a business-level application|

+ [Start the application}

« [Stop the application]

[Update the application|and its configuration units.
[Delete the application]

What to do next

After making changes to administrative configurations of your applications in the administrative console,
ensure that you save the changes.

Business-level applications

A business-level application is an administration model that provides the entire definition of an application
as it makes sense to the business. A business-level application is a WebSphere configuration artifact,
similar to a server or cluster, that is stored in the product configuration repository.

* |Business-level application characteristics|

« [Comparisons to Java EE applications|
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Business-level application characteristics

A business-level application has the following characteristics:

* A business-level application is an administration model of the definition of an enterprise-level application
that consists of WebSphere and non-WebSphere artifacts. The business-level application might not
explicitly manage the lifecycle of every artifact. It is a model for defining an application.

* A business-level application does not represent or contain application binary files. It is a configuration
that lists one or more composition units, which represent the application binary files. A business-level
application uses the binary files to run the application business logic. Administration of binary files is
separate from administration of the application definition.

* A business-level application supports recursive composition by reference that facilitates hierarchical
assembly of business-level applications and individual deployed artifacts within or outside a WebSphere
product. The composition at its lowest level consists of configured instances of application binary files
that run in a specific runtime environment such as an application server. Installable packages or
archives, such as Java archives (JAR) or enterprise archive (EAR) files, typically deliver the business
logic that these configured instances represent to corresponding runtime platforms.

The following diagram shows the composition model for business-level applications:

C iti
omposition Application
Al Application
Application
Configuration
> : : .
EJB \ A .
module A/ v
Library Web Enterprise
module application

Business Loglc .
Java
I|brary
EJB JAR

A business-level application does not introduce new programming, runtime, or packaging models:

* You do not need to change your application business logic. The business-level application function does
not introduce new application programming interfaces (APIs).

* You do not need to change your application runtime settings. The product supports all of the runtime
characteristics, such as security, class loading and isolation, required by individual programming models
to which business components are written.

* You do not need to change your application packaging. There is no specific unique packaging model
that provides a business-level application definition.

Typically, you first create an empty business-level application and then add composition units to it. The
business-level application name must be unique within a cell. The business level application itself has
minimal configuration data associated with it, solely the list of composition units, but individual composition
units might save application-specific configuration data.

A business-level application is defined in the product configuration repository under [app_server_roojcells/
cell_name/blas/business_level_application_name/bver/BASE/bla.xml.
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Comparisons to Java EE applications

Business-level applications can consist of or aggregate Java Platform, Enterprise Edition (Java EE)
applications and modules with non-Java EE artifacts. The contents of Java EE applications integrate with
business-level application concepts for deployment and management of applications. Existing Java EE
application management APIs continue to work after you add Java EE application or modules to a
business-level application. The business-level application management API accepts Java EE contents and
configurations and delegates to existing Java EE management APIs. Control operations such as starting
and stopping a Java EE composition unit are delegated to ApplicationManager MBean on application
servers that start and stop Java EE applications.

Table 6. Java EE concepts compared to business-level application concepts

Java EE concept

Business-level application
concept

Description

EAR or stand-alone
module for
deployment

Asset

Java EE application contents are assets.

Java EE application
created at the end of
application install

Composition unit

A Java EE application is in an enterprise archive (EAR)
file. The product saves the EAR file in the product
repository as a composition unit.

Java EE modules
within the EAR file

Deployable units in the asset

Each module in the EAR file is a deployable unit that you
can install on independent deployment targets. The EAR
file is still managed as a single asset in its entirety.

Java EE application
installation using the
administrative
console,
programming, or
wsadmin commands

Multiple business-level
application management
commands

During Java EE application
deployment, you can specify the
name of the business-level
application to include the Java
EE application. If the
business-level application name
is not set, the product creates a
default business-level
application with the same name
as the Java EE application
name. The product adds a
composition unit with the same
name as the Java EE
application name under the
business-level application. You
can deploy multiple Java EE
applications under a single
business-level application.

You can make a Java EE application a business-level
application and add it to another business-level application:

1. Install the Java EE application (EAR file) using the
enterprise application installation console wizard,
programming, or wsadmin. Keep the default selection
to create a business-level application that has the
same name as the Java EE application.

2. Create an empty business-level application.
3. Add the EAR file business-level application to the
empty business-level application. The EAR file

business-level application is a composition unit of the
containing business-level application.

Or, you can make a Java EE application an asset and add
it to another business-level application:

1. Import an EAR file as an asset. It has an asset type
aspect of Java EE ear.

Create an empty business-level application.

Add the Java EE application asset to the business-level
application. The EAR file asset is a composition unit of
the containing business-level application.

4. Collect targets for each deployable unit (Java EE
module).

Uninstall Java EE
application

Multiple business-level
application management
commands

You delete the Java EE application composition unit from
the business-level application:

1. Remove the composition unit for the Java EE
application from the business-level application.

2. If the EAR file is an asset, delete the asset.

Start the Java EE
application.

Start the composition unit.

Starting a business-level application starts any Java EE
application in it.
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Table 6. Java EE concepts compared to business-level application concepts (continued)

Business-level application
Java EE concept concept Description
Stop the Java EE Stop the composition unit. Stopping a business-level application stops any Java EE
application. application in it.
Assets

An asset represents one or more application binary files that are stored in an asset repository. Typical
assets include application business logic such as Java Platform, Enterprise Edition (Java EE) archives,
library files, and other resource files.

An asset repository stores the binary files for the asset. The product configuration repository provides a
default asset repository.

Assets in the configuration repository are managed by the product management domain. The configuration
repository stores asset binary files in|app_server_roofconfig/cells/cell_namelassets/asset_namelaver/
BASE/bin/.

An asset name must be unique within a cell, the product administrative domain.

The product creates an asset.xml file when an asset is registered with the product configuration. The file
contains information about the asset such as its name, destination location, and dependencies on other
assets.

You must register files as assets before you can add them to one or more business-level applications. At
the time of asset registration, you can import the physical application files into the product configuration
repository or you can specify an external location where the asset resides.

Composition units

A composition unit represents a configured asset in a business-level application. A composition unit
enables the asset contents to interact with other assets in the application. It also enables the product run
time to load and run asset contents.

The product supports three types of composition units:

Asset composition units
Composition units created from assets by configuring each deployable unit of the asset to run on
deployment targets.

Shared library composition units
Composition units created from JAR-based assets by ignoring all the deployable objects from the
asset and treating the asset JAR file as a library of classes.

Business-level application composition units
Composition units created from business-level applications that are added to existing
business-level applications.

A composition unit contains the following information:

» Configuration information that binds contents of an asset with a specific hosting run time and adds the
configuration necessary for the run time to load and run the asset

* References to external services, components, or other resources that the asset uses
» Customized configurations for service definitions, references and other relevant configuration data
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» Alist of deployment targets or runtime environments along with the runtime environment-specific
configuration where the composition unit runs.

For example, a composition unit for an enterprise bean (EJB) Java archive (JAR) asset is an EJB module
instance that contains necessary EJB binding information, such as EJB Java Naming and Directory

Interface (JNDI) names and ejb-ref resolutions, along with a list of application servers where the EJB
JAR runs.

The product creates a composition unit from only one asset. However, multiple composition units can
share a single asset. This is particularly useful in scenarios where different configurations use the same
application binary files to provide different runtime behavior.

The following rules apply to a composition unit:
* A composition unit can exist only in a business-level application.

» Because a composition unit contains application-specific configuration and wiring information, multiple
business-level applications cannot share an asset or shared library composition unit.

The following graphic shows the use of composition units in business-level applications. Assume that you
have unprocessed files, such as archives, that you want to use in business-level applications. Before you
can add the files to business-level applications, you must first import the files as assets, which adds the
files to the product repository. Next, you add the assets to business-level applications, which creates
composition units for the assets. Business-level applications can contain asset composition units, shared
library composition units, or business-level composition units.

Unprocessed Asset Composition Business level application
files repository unit composition
Asset » Composition unit ~—— )
Axis2 archive Business
level
JAX-WS instance spipliestion
Axis2
archive
P» Composition unit .

EJB JAR file Asset Business
level
application

EJB module instance E
JAR file
Asset Composition unit
Business
level
Shared library instance application
JAR file
Composition

unit

Importing assets

You must register application business logic such as Java Platform, Enterprise Edition (Java EE) archives,
libraries, and other resource files with the product configuration as assets before you can add the assets
to one or more business-level applications. Importing an asset registers it with the product configuration.

Before you begin

This topic assumes that you have one or more application binary files that you want to add to a

business-level application. You must register those binary files as assets before you can add them to the
business-level application.
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About this task

Before a business-level application that uses an asset can be started on the target run time, the asset
binaries must be extracted to a deployer-defined location on the file system that is local to the target run
time. Importing an asset extracts binaries to a location that is local to the target run time.

The application server run time that reads the asset binaries either at application start time or while
serving an incoming client request determines the extraction format of the asset binaries. The extraction
format might include unzipping of Java archive (JAR) or compressed (zip) files.

This topic describes how to import an asset using the administrative console. Alternatively, you can use
the wsadmin tool or programming.

1. Click Applications > New Application > New Asset in the console navigation tree.
2. On the |Up|oad asset page|, specify the asset package to import.

a.
b.

Specify the full path name of the asset.
Click Next.

3. On the[Select options for importing an asset panel|, specify asset settings.
You typically can click Next and use the default values.

a.
b.

g.

Optional: For Asset description, specify a brief description of the asset.
Optional: For Asset binaries destination URL, specify the target location of the asset.

This setting specifies the location to which the product extracts the asset. After an asset is
imported, the product looks for the asset in this location when a running application uses the asset.

If you do not specify a value, the product installs the asset to the default location,
${orofile_roof/installedAssets/asset_name/BASE/.

Optional: For Asset type aspects, examine the asset content type and version specified by the
product. You cannot change this setting value.

The type aspect typically denotes the type of application contents, such as a specification to which
the application is written. For example, an enterprise bean (EJB) that supports the EJB Version 2.0
specification has the aspects type=EJB,version=2.0.

If the type aspect is none and if the asset is a JAR file, then the product associates a javarchive
type aspect with the asset by default.

For File permissions, specify any file permissions that are set on asset binary files so the target
run time can read or run the asset. Importing the asset extracts its binary files on the disk local to
the target runtime environment.

Try importing the asset using the default value. For detailed information on the File permissions
setting, refer to the [Select options for importing an asset panell online help.

For Current asset relationships, add assets that the asset you are importing needs to run or
remove assets that are not needed.

When the product imports a JAR asset, the product detects asset relationships automatically by
matching the dependencies defined in the JAR manifest with the assets that are already imported
into the administrative domain.

For Validate asset, specify whether the product validates the asset.

The setting is deselected by default. This false (no) value is appropriate for most assets. Only
select true (yes) to validate an asset when needed.

The product does not save the value specified for Validate asset. Thus, if you select to validate the
asset (yes) now and later update the asset, when you update the asset you must enable this
setting again for the product to validate the updated files.

Click Next.

4. On the Summary page, click Finish.
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Results
Several messages are displayed, indicating whether your asset is imported successfully.

An asset can contain multiple deployable objects as defined by the application contents of that asset. A

deployable object is a part of the asset that you can map to a deployment target such as an application

server. If the product imports the asset successfully, then appropriate deployable objects are identified in
the asset and are further used when a composition unit is created from that asset.

If the asset importing is not successful, read the messages and try importing the asset again. Correct the
values noted in the messages.

What to do next

If the product imports the asset successfully and displays the list of assets on the |Assets page), then click
Save.

Add a composition unit to a business-level application using the asset that you imported. An asset included
in a business-level application is represented by a composition unit.

Upload asset settings

Use this panel to specify the asset to register with the asset repository. You can add registered assets to a
business-level application.

To view this administrative console panel, click Applications > New application > New Asset.
Importing an asset registers the asset with the asset repository.

The product manages the contents of a registered asset as a single entity. The contents of a registered
asset must be accessible to application servers, Web servers and other runtime environments that use the
asset.

During asset importing, asset files typically are uploaded from a client workstation running the browser to
the server running the administrative console, where they are registered. In such cases, use the Web
browser running the administrative console to select files to upload to the server.

Path to the asset
Specifies the fully qualified path to the asset.

Specify one of the following supported assets:

» Asingle file, such as an enterprise bean (EJB) file

* An archive of files, such as a Java archive (JAR) or a compressed (zip) file

» An archive of archives, such as an enterprise archive (EAR) or shared library file

Use Local file system if the browser and asset files are on the same machine (whether or not the server
is on that machine, too).

Use Remote file system if the asset file resides on any node in the current cell context. Only supported
assets are shown during the browsing. Also use Remote file system to specify an asset file that is
already residing on the machine running the application server. For example, the field value might be
profile_root/installableApps/my_bean.ejb. After the asset file is transferred, the Remote file system value
shows the path of the temporary location on the server.

Chapter 7. Deploying and administering business-level applications 165



Asset settings

Use this page to specify options for the registration of an asset with the asset repository. Default values for
the options are used if you do not specify a value.

To view this administrative console page, click Applications > Application Types » Assets -
asset_name. This page is similar to the Select options for importing an asset panel on the asset import
and update wizards.

Asset name

Specifies a logical name for the asset. An asset name must be unique within a cell and cannot contain an
unsupported character.

An asset name cannot begin with a period (.), cannot contain leading or trailing spaces, and cannot
contain any of the following characters:

Unsupported characters

| forward slash $  dollar sign ’single quote mark

\ backslash = equal sign " double quote mark

* asterisk % percent sign | vertical bar

, comma +  plus sign < left angle bracket
colon @ at sign > right angle bracket

;  semi-colon #  hash mark & ampersand (and sign)

? question mark 11> No specific name exists for this character combination

This Asset name field is the same as the Name setting on an Assets page.

Data type String

Asset description
Specifies a description for the asset.

Asset binaries destination URL
Specifies the directory to which the product imports the asset file.

Data type String
Units Full path name

Asset type aspects

Specifies the type of asset content. Examples of asset type include Java archive (JAR) files, shared
libraries, and enterprise application archive (EAR) files.

The asset type suggests the content of the asset. For example, an asset packaged as a JAR file might
contain a Web module, portlet and Web service.

This setting is read-only. You cannot edit this setting.

Data type String
Units File type
Default none
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File permissions
Specifies access permissions for asset binaries that the product expands to the asset binaries destination
URL.

You can specify file permissions in the text field. You can also set some of the commonly used file
permissions by selecting them from the list. List selections overwrite file permissions set in the text field.

You can set one or more of the following file permission strings in the list. Selecting multiple options
combines the file permission strings.

List option File permission string set

Allow all files to be read but not written to .*=755

Allow executables to execute .*\.d11=755#.%\.s0=755#.%\.a=755#.%\.s1=755
Allow HTML and image files to be read by .*x\ . htm=755#.%\.htm1=755#.%\.gif=755#.*%\.jpg=755
everyone

Instead of using the list to specify file permissions, you can specify a file permission string in the text field.
File permissions use a string that has the following format:

file_name_pattern=permission#file_name_pattern=permission

where file_name_pattern is a regular expression file name filter (for example, .*\\.jsp for all JSP files),
permission provides the file access control lists (ACLs), and # is the separator between multiple entries of
file_name_pattern and permission. If # is a character in a file_name_pattern string, use \# instead.

If multiple file name patterns and file permissions in the string match a uniform resource identifier (URI)
within the asset, then the product uses the most stringent applicable file permission for the file. For
example, if the file permission string is .*\\.jsp=775#a.*\\.jsp=754, then the abc.jsp file has file
permission 754.

Note: Using regular expressions for file matching pattern compares an entire string URI against the
specified file permission pattern. You must provide more precise matching patterns using regular
expressions as defined by Java programming API. For example, suppose the product processes the
following directory and file URIs during a file permission operation:

1 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war

2 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCell/MyApp.ear/MyWarModule.war/Mydsp.jsp

3 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war/META-INF/
MANIFEST.MF

4 /opt/WebSphere/profiles/AppSrv01/installedApps/MyCel1/MyApp.ear/MyWarModule.war/WEB-INF/classes/
MyClass.class

5 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCell/MyApp.ear/MyWarModule.war/mydir/
MyClass2.class

6 /opt/WebSphere/profiles/AppSrv0l/installedApps/MyCell/MyApp.ear/MyWarModule.war/META-INF

The file pattern matching results are:

* MyWarModule.war does not match any of the URIs

* .*MyWarModule.war.* matches all URls

» .xMyWarModule.war$ matches only URI 1

* .*\\.jsp=755 matches only URI 2

e .*META-INF.* matches URIs 3 and 6

e .*MyWarModule.war/.*/.*\.class matches URIls 4 and 5
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If you specify a directory name pattern for File permissions, then the directory permission is set based on
the value specified. Otherwise, the File permissions value set on the directory is the same as its parent.
For example, suppose you have the following file and directory structure:

/opt/WebSphere/profiles/AppSrv0l/installedApps/MyCel1/MyApp.ear/MyWarModule.war/MyJsp.jsp

and you specify the following file pattern string:
.*MyApp.ear$=755#.*\.jsp=644

The file pattern matching results are:
» Directory MyApp.ear is set to 755
» Directory MyWarModule.war is set to 755
» Directory MyWarModule.war is set to 755

Note: Regardless of the operation system, always use a forward slash (/) as a file path separator in file
patterns.

Access permissions specified here are at the asset level. You can also specify access permissions for
asset binaries in the node-level configuration. The node-level file permissions specify the maximum (most
lenient) permissions that can be given to asset binaries. Access permissions specified here at asset level
can only be the same as or more restrictive than those specified at the node level.

Data type String

Current asset relationships
Specifies the assets to which this asset is related.

To add or remove a relationship, use the Manage relationships panel:

1. Click Manage Relationships to access the Manage relationships panel. The Selected list on the right
lists the current asset relationships.

2. To add a relationship, select an asset in the Available list on the left and click >>.
3. To remove a relationship, select an asset in the Selected list on the right and click <<.
4. Click OK.

Data type String
Default none

Validate asset
Specifies whether the product examines the asset references specified during asset importing or updating
and, if validation is enabled, warns you of incorrect references or fails the operation.

An asset typically refers to resources using data sources for container-managed persistence (CMP) beans
or using resource references or resource environment references defined in deployment descriptors. The
validation checks whether the resource referred to by the asset is defined in the scope of the deployment
target of that asset.

Select true (enable the check box) for resource validation and to stop operations that fail as a result of
incorrect resource references. Select false (empty check box) for no resource validation.

Data type String
Default false (empty check box)
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Managing assets

After application binary files are imported and registered with the product management domain as assets,
you can view, update and export those assets.

Before you begin

Import one or more assets. The name of each imported assets is shown on the list of assets on the
administrative console |Assets pagel

About this task

You can view the contents of assets, update assets, remove assets from the product management
domain, or export copies of assets to a target location. This topic describes how to perform these asset
management operations from the administrative console Assets page. Alternatively, you can use
programming or the wsadmin tool.

* View or edit asset settings.
1. Go to the administrative console Assets page.
Click Applications » Application Types » Assets.

2. Click the asset name in the list of assets. The |Asset settings page] displays the values that are
specified for the asset.

3. Optional: Change the asset settings as needed and click OK to save the changes.
+ [Remove one or more assets| from the product management domain.
[Update the contents of an asset
+ [Export an asset|to a target location.

What to do next

Create a business level application and add the asset to the business-level application.

Asset collection

Use this page to view a list of assets in the asset repository and to manage those assets. After importing
an asset, you can add the asset to a business-level application.

Assets include Java archive (JAR) and compressed files that are used by applications installed on a
server.

To view this administrative console page, click Applications » Application Types > Assets.

To view the values specified for an asset, click the asset name in the list. The displayed asset settings
page shows the values specified. On the settings page, you can change existing asset values.

To manage an asset, enable the Select check box beside the asset name in the list and click a button:

Button Resulting action
Import Opens a wizard that helps you add an asset to the asset repository.
Delete Removes the asset from the asset repository and deletes the asset binaries from the file

system of all nodes where the assets are installed.

On single-server installations, deletion occurs after the configuration is saved.
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Button Resulting action

Update Opens a wizard that helps you update asset files. You can replace a file or module that
exists on the server with a file or module that has the same name. Or you can add a
new file or module, provided the new file or module does not have the same name as an
asset that already exists on the server.

Export Accesses the Export asset page, which you use to export an asset to a file at a location
of your choice. Use the Export action to back up an asset.

Name
Specifies the name of the asset. Asset names must be unique within a cell and cannot contain an
unsupported character.

Description
Specifies a description for the asset.

Updating assets
You can update application binary files that are assets registered with the product management domain.

Before you begin

Import one or more assets. The file name of each deployable object in the imported assets is shown on
the list of assets on the administrative console Assets page.

About this task

You can update all of part of the contents of assets that are in the product management domain. This topic
describes how to update an asset using the administrative console Update asset wizard. Alternatively, you
can update assets using programming or the wsadmin tool.
1. Go to the Update asset wizard.
a. Click Applications » Application Types > Assets to access the Assets page.
b. Select the check box beside the asset that you want to update.
c. Click Update.
2. On the Update asset panel, specify whether you want replace an entire asset or update its contents
and, as needed, the replacement file or module.
a. Select an update option.
You can update asset contents by adding, deleting, or updating a single file or module in the asset,
or by merging multiple files or modules. Update options include the following:
* Replace entire asset
* Replace specific asset contents
* Add module or file to asset

* Remove file or module from asset
* Merge asset contents

The online help for the |Update asset panel| describes the options.

b. If you are updating specific asset contents or removing a file or module, specify the path beginning
with the asset archive file.
For Specify the path beginning with the asset archive file, specify a relative path to the file that
starts from the root of the asset file. For example, if the file is located at com/company/
greeting.class in module hello.jar, specify a relative path of hello.jar/com/company/greeting.class.
c. If you are updating the entire asset, updating an asset file or module, or merging asset contents,
specify the full path name of the new file or module.

d. Click Next.
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3. On the Select options for updating an asset page, specify asset settings and click Next.
The online help for the [Select options for importing an asset panell describes the settings.
4. On the Summary page, click Finish.

Results

If you update an asset packaged as a library JAR file that is not a Java Platform, Enterprise Edition (Java
EE) archive, then the product automatically distributes the updated asset to all of the composition units
that use the asset.

However, if you update a Java EE asset, then the product does not automatically distribute the updated
Java EE archive to composition units created from that asset, which are Java EE applications. You must
select every Java EE application created from that asset and use the Update button to update the Java
EE application individually by specifying the update contents.

What to do next

Create a business-level application and add the asset to the business-level application.

Update asset settings

Use this panel to select whether you want replace an entire asset or update its contents. You can update

asset contents by adding, deleting, or updating a single file or module in the asset, or by merging multiple
files or modules into an asset. Updating an asset registers the updated files with the product management
domain.

To view this administrative console panel, click Applications » Application Types > Assets, select the
asset to update, and then click Update.

The product manages the contents of a registered asset as a single entity. The contents of a registered
asset must be accessible to application servers, Web servers and other runtime environments that use the
asset.

When you replace an asset or update an asset by adding a file or module, asset files typically are
uploaded from a client workstation running the browser to the server machine running the administrative
console, where they are registered. In such cases, use the Web browser running the administrative
console to select files to upload to the server machine.

The specified asset that you are installing must be one of the following supported assets:
* Asingle file, such as an enterprise bean (EJB) file

* An archive of files, such as a Java archive (JAR) or a compressed (zip) file

* An archive of archives, such as an enterprise archive (EAR) or shared library file

Replace entire asset:

Under Select the type of update to perform, specifies to replace the entire asset installed on the server
with a new (updated) asset.

After selecting this option, specify whether the asset is on a local or remote file system and the full path
name of the asset. The path provides the location of the updated asset before installation.

Use Local file system if the browser and asset files are on the same machine (whether or not the server
is on that machine, too).

Use Remote file system if the asset file resides on any node in the current cell context. Only supported
assets are shown during the browsing. Also use Remote file system to specify an asset file that is
already residing on the machine running the application server. For example, the field value might be
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profile_root/installableApps/my_bean.ejb. After the asset file is transferred, the Remote file system value
shows the path of the temporary location on the server.

Replace specific asset contents:

Under Select the type of update to perform, specifies to replace a file or module of the asset installed
on the server.

After selecting this option, do the following:

1. For Specify the path beginning with the asset archive file, specify a relative path to the file that
starts from the root of the asset file. For example, if the file is located at com/company/greeting.class in
module hello.jar, specify a relative path of hello.jar/com/company/greeting.class.

2. Specify whether the asset is on a local or remote file system and the full path name of the asset. The
path provides the location of the updated asset before installation.

3. Click Next.

The Replace entire asset description describes options for specifying the full path name of an asset or
file to add using Local file system and Remote file system options.

Add a module or file to an asset:
Under Select the type of update to perform, specifies to add a file to the asset installed on the server.

After selecting this option, do the following:

1. For Specify the path beginning with the asset archive file, specify a relative path to the file that
starts from the root of the asset file. For example, if the file is located at com/company/greeting.class in
module hello.jar, specify a relative path of hello.jar/com/company/greeting.class.

2. Specify whether the asset is on a local or remote file system and the full path name of the asset. The
path provides the location of the updated asset before installation.

The Replace entire asset description describes options for specifying the full path name of an asset or
file to add using Local file system and Remote file system options.

Remove a file or module from an asset:

Under Select the type of update to perform, specifies to remove a file or module from the asset installed
on the server.

After selecting this option, do the following:

1. For Specify the path beginning with the asset archive file, specify a relative path to the file to be
removed that starts from the root of the asset file. For example, if the file is located at
com/company/greeting.class in module hello.jar, specify a relative path of hello.jar/com/company/
greeting.class.

2. Click Next.

Merge asset contents:

Under Select the type of update to perform, specifies to compare the new file or module with the file or
module of the asset installed on the server. If the file or module exists, it is replaced. Otherwise, it is
added to the installed asset.

After selecting this option, specify whether the new file or module is on a local or remote file system and

the full path name of the file or module. The path provides the location of the updated asset before
installation.
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The Replace entire asset description describes options for specifying the full path name of a file or
module to merge using Local file system and Remote file system options.

Deleting assets

You can remove application binary files that are registered as assets from the product management
domain.

Before you begin

Import one or more assets. The name of each imported asset is shown on the list of assets on the
administrative console Assets page.

About this task

You can remove assets from the product management domain, provided the asset does not have an
existing composition unit. If an asset has one or more composition units defined in the management
domain, then you cannot delete that asset until those composition units are removed.

This topic describes how to delete assets using the administrative console. Alternatively, you can use
programming or the wsadmin tool.

1. Go to the Delete asset page.
a. Click Applications » Application Types > Assets to access the Assets page.
b. Select the check box beside the asset that you want to delete.
c. Click Delete.

2. On the Delete asset page, click OK to confirm that you want the specified asset removed from the
product management domain.

Click Cancel to return to the Assets page and not delete the asset.
Results
The product deletes the asset from the product management domain.
What to do next

On the Assets page, verify that the deleted asset is no longer in the list of imported assets.

Exporting assets

After application binary files are imported and registered with the product management domain as assets,
you can export those assets.

Before you begin

Import one or more assets. The file name of each deployable object in the imported assets is shown on
the list of assets on the administrative console Assets page.

About this task
You can export copies of assets to a target location. Exporting stores application binary files, enabling you
to back up the files or edit them. The file resulting from exporting an asset contains configuration

information for the asset.

This topic describes how to export an asset from the administrative console Assets page. Alternatively, you
can use programming or the wsadmin tool.
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1. Go to the Export asset page.
a. Click Applications > Application Types > Assets to access the Assets page.
b. Select the check box beside the asset that you want to export.
c. Click Export.
2. On the Export asset page, click the asset name or identifier.
To cancel the export operation and return to the Assets page, click Back.
3. Specify the target location for the asset file.

What to do next

Examine the target file to verify that the asset exported correctly. You can later edit this file and import the
edited asset.

Creating business-level applications

You can create an empty business-level application and then add assets, shared libraries, business-level
applications, and other artifacts as composition units to the empty business-level application.

Before you begin

Configure each target application server as needed. You must deploy a business-level application to a
Version 7.0 server.

Optionally, determine what assets or other files that you want to add to your business-level application and
whether your application files can run on your deployment targets.

About this task

You can create business-level applications using the administrative console, programming, or the wsadmin
tool.

1. Select a way to create your business level application.

Table 7. Ways to create business level applications

Option Method

Administrative console Click Applications > New application - New Business-level Application and
business-level application creation |follow instructions in the wizard.

wizard

See|‘Creating business-level|
lapplications with the console” on|

|page 175.|

Administrative console Java Click Applications » New application > New Enterprise Application and
Platform, Enterprise Edition (Java |follow instructions in the wizard.

EE) application installation wizard
The product creates a new business-level application with the enterprise

See[“Installing enterprise| application that you install or makes the enterprise application a composition unit
lapplication files with the console’-'l of an existing business-level application. See the Business-level application
||on page 36.| name setting on the Select installation options wizard panel.

2. Create your business-level application using the administrative console, programming or wsadmin.
3. Save the changes to your administrative configuration.
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Results

The name of the application is shown in the list on the [Business-level applications pagel

What to do next

After you create a business-level application, you can do the following to add composition units to it:
1. [Import any assetsl needed by your business-level application.

2. |Add assets, shared libraries, or other business-level applications| as composition units.

3. Save the changes to your administrative configuration.

4. [Start the business-level application]

If the application does not run as desired, [edit the application configuration} then save and run it again.

Creating business-level applications with the console

You can create an empty business-level application and then add assets or business-level applications as
composition units to the empty business-level application.

Before you begin

Before you create a business-level application, decide upon an application name. Optionally, determine
which assets, shared libraries, or business-level applications that the new business-level application
needs.

About this task

This topic describes how to create an empty business-level application and then add assets as
composition units to the application using the administrative console. Alternatively, you can use
programming or the wsadmin tool.

You can add an asset or shared library composition unit to multiple business-level applications. However,
each composition unit for the same asset must have a unique composition unit name. You can add a
business-level application composition unit to more than one business-level application.

1. Create an empty business-level application.
a. Click Applications > New application > New Business Level Application.

b. On the [New business-level application panel, specify a unique name for the application and a
description, and then click OK.

c. On the|business-level application settings page} click Save.

The name and description are shown in the list of applications on the [Business-level applications page.
Because the application is empty, its status is Unavailable.

2. Optional: Add one or more assets, non-Java EE shared libraries, or business-level applications to a
business-level application. The product adds these assets as composition units of your business-level
application.

If the asset that you want to add to your business-level application is a Java Platform, Enterprise
Edition (Java EE) application or module that is not yet deployed, see . If the asset is a Java EE
shared library, see

a. |Import the assetslor create the business-level applications that you want to add to the
business-level application.

b. Go to the business-level application settings pagel
Click Applications » Application Types » Business-level applications » application_name.
c. On the business-level application settings page, specify the type of composition unit to add.
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* To add an asset, under Deployed assets, click Add » Add Asset.

» To add a shared library, under Deployed assets, click Add » Add Shared Library.

» To add a business-level application, under Business-level applications, click Add.
d. On the Add panel, select a unit from the list of available units, and then click Continue.

If you are adding one or more deployable unit assets and you have multiple imported assets
available, you can select more than one deployable unit.

e. On the |Set options panel|, change the composition unit settings as needed, and then click Next.

This panel is not shown when you add a Java EE asset as a shared library or if you have multiple
deployable unit assets. If the application installation or update wizard displays and you want to add
a Java EE asset as a shared library, see .

On the |Map composition unit to a target panel|, change the deployment target as needed, and then
click Next.

This panel is not shown when you add a business-level application.
g. If you are adding one or more deployable unit assets, specify composition unit relationship options.
See [‘Deployable unit relationship settings” on page 183.|

h. On the Summary page, click Finish. Several messages are displayed, indicating whether the
product adds the unit to the business-level application successfully. A message having the format
Completed res=[WebSphere:cuname=unit_name,cuedition=version] indicates that the addition is
successful. Click Manage application.

If the product adds the unit successfully, the name of the unit is shown on the list of composition
units on the [Adding composition unit to the business-level application pagel.

If the unit addition is not successful, read the messages and try adding the unit again. Correct the
problems noted in the messages.

i. On the Adding composition unit to the business-level application page, click Save.

—

The product creates composition units for the asset, shared library, or business-level application. The
unit names are shown in lists of composition units on the settings page of your business-level
application. To view the settings page, click Applications > Application Types » Business-level
applications » your_application_name.

3. Optional: Install a Java EE application or module, and add it as a composition unit to your
business-level application.

When installing an enterprise archive (EAR) file or a stand-alone Java EE module using the application
installation wizard, you can specify a business-level application to which to add the EAR file or module.
You can also specify relationships to any shared libraries that your Java EE application or module
uses. The product creates composition units that represent those relationships.

a. Click Applications > New application > New Enterprise Application.

b. On the first Preparing for the application installation panel, specify the Java EE application or
module to install and click Next.

c. On the second Preparing for the application installation panel, select Detailed - Show all
installation options and parameters, specify whether to generate default bindings and mappings
as needed for the application or module, and click Next.

d. On the Select installation options panel of the wizard, select your business-level application for
Business-level application name and click Next. The product creates a composition unit that has
the same name as the Java EE application or module and adds the unit to your business-level
application.

If you do not specify a value for Business-level application name, then the product creates a
default business-level application that has the same name as the Java EE application that you are
installing. The product does not add the Java EE application as a composition unit to the
business-level application that you created in .
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e. Optional: On the [Map shared library relationship panel| of the wizard, specify relationship identifiers
and composition unit names for shared libraries that modules in your Java EE application use. The
product creates a composition unit for each shared library relationship in your business-level
application.

You can map shared library relationships when installing your Java EE application or module or,
after installation, return to the Map shared library relationship panel and specify shared library
relationships. See

f. Complete the other application installation wizard options as needed to install the Java EE
application or module.

The product creates composition units for the application, module, or shared library relationships. The
unit names are shown in lists of composition units on the settings page of your business-level
application. To view the settings page, click Applications > Application Types » Business-level
applications » your_application_name.

4. Optional: After installation of a Java EE application or module, specify composition units for
relationships to shared libraries used by your business-level application on the Map shared library
relationship panel of the application installation or update wizard.

a. If you have not done so already, import a Java EE assef| such as an enterprise bean (EJB) or Web
module (WAR) that uses a shared library file.

If the product displays javaarchive for Asset type aspects on the asset settings page, continue to
i.

If the product does not display javaarchive for Asset type aspects on the asset settings page,
then the asset is not a Java EE asset. Use to add a shared library to your business-level
application.

b. Go to a settings page for your business-level application.

Click Applications » Application Types > Business-level applications >
your_application_name.

c. Under Deployed assets, click Add » Add Shared Library.

d. On the|Add composition unit panel| select the Java EE asset that you imported and then click
Continue.

The Java EE application installation or update wizard displays. Select the Java EE application or
module that uses the asset, and complete the steps in the wizard.

e. On the Select installation options panel of the wizard, select your business-level application for
Business-level application name.

f. On the Map shared library relationship panel of the wizard, specify a relationship identifier and
composition unit name for the asset.

g. Complete the other wizard options as needed.

The product creates a composition unit for the shared library relationship. The unit name is shown in
the list of deployed asset composition units on the settings page of your business-level application.

Results

The name of your business-level application is shown on the Business-level applications page in the list of
applications.

What to do next

After you create the application, save the changes to your configuration and |start the application| as
needed.

Business-level application collection
Use this page to view and manage business-level applications.
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To view this administrative console page, click Applications > Application Types » Business-level
applications.

To view the values specified for an application configuration, click the application name in the list. The
displayed application settings page shows the values specified. On the settings page, you can change
existing configuration values and link to additional console pages that assist you in configuring the

application.

To manage a business-level application, enable the Select check box beside the application name in the
list and click a button:

Button Resulting action

Start Attempts to run the application. After the application starts successfully, the state of the
application changes to Started if the application starts on all deployment targets, else the
state changes to Partial Start.

Stop Attempts to stop the processing of the application. After the application stops
successfully, the state of the application changes to Stopped if the application stops on
all deployment targets, else the state changes to Partial Stop.

New Opens a wizard that helps you add assets, shared libraries, or business-level
applications as composition units to your application.

Delete Deletes the application from the product configuration repository and deletes the
application binaries from the file system of all nodes where the application modules are
installed.

On single-server installations, deletion occurs after the configuration is saved.

Name:

Specifies the name of the business-level application. Application names must be unique within a cell and
cannot contain an unsupported character.

Description:

Specifies a description for the business-level application.

Status:

Indicates whether the application deployed on the application server is started, stopped, or unknown.

™
a

G4 =

Started

Partial start

Stopped

Partial stop

Unknown

Pending

Not applicable

Application is running.

Application is in the process of changing from a Stopped state to a Started
state. Application is starting to run but is not fully running yet. Or, it cannot fully
start because a server mapped to one or more application modules is stopped.
Application is not running.

Application is in the process of changing from a Started state to a Stopped
state. Application has not stopped running yet.
Status cannot be determined.

Status is temporarily unknown pending an event that a user did not initiate,
such as pending an asynchronous call.

Application does not provide information as to whether it is running.

The status of an application on a Web server is always Unknown.
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New business-level application settings
Use this panel to name and describe a new business-level application.

To view this administrative console panel, click Applications > New application - New Business-level
Application.

Name:

Specifies a logical name for the business-level application. An application name must be unique within a
cell and cannot contain an unsupported character.

An application name cannot begin with a period (.), cannot contain leading or trailing spaces, and cannot
contain any of the following characters:

Unsupported characters

| forward slash $  dollar sign ’ single quote mark

\ backslash = equal sign " double quote mark

* asterisk % percent sign | vertical bar

, comma +  plus sign < left angle bracket
colon @ at sign > right angle bracket

;  semi-colon #  hash mark & ampersand (and sign)

? question mark 11> No specific name exists for this character combination

Data type String

Description:

Specifies a description for the application.

This field is the same as the Description setting on a Business-level applications page.

Shared library relationship and mapping settings

Use the Shared library relationship and Shared library relationship mapping pages to specify relationship
identifiers and composition unit names for shared libraries that modules in your enterprise application
reference. When installing your enterprise application, the product creates a composition unit for each
shared library relationship in the business-level application that you specified on the Select installation
options panel of the application installation wizard.

To view this console panel in a wizard, click Applications - Install new application > New Enterprise
Application » application_path > Next > Detailed - Show all installation options and parameters -
Next » application_name > Step: Map shared library relationships.

After installation, click Applications > Application Types > WebSphere enterprise applications »
Shared library relationships

To map library files used in a business-level application with an application or Web module, use the
Shared library relationship mapping page:

1. Click Reference shared libraries.

2. Note the application or module in Map libraries to the application or module listed. You are
associating library files with that application or module.

3. From the Available list, select one or more libraries that the application or module uses.
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4. Click >> to add them to the Selected list.
5. To remove an association, select one or more libraries in the Selected list and click <<.
6. Click OK.

Module:

Specifies the name of the module associated with the shared libraries.

URI:

Specifies the location of the module relative to the root of the application EAR file.
Relationship identifers:

Specifies an identifier for a module shared library relationship. The product assigns an identifier to the
composition unit that it creates for the shared library relationship in the business-level application.

Composition unit names:

Specifies a composition unit name for the shared library relationship. The product uses this value to name
the composition unit that it creates for the shared library relationship in the business-level application that
you specified on the Select installation options panel of this wizard.

This setting is only in the application installation and update wizards.

Match target:

Specifies whether the product maps the composition unit for the shared library relationship to the same
deployment target as the business-level application.

Add composition unit settings
Use this panel to specify options for the composition unit to be added to the business-level application.
The product assigns a default value for an option when you do not specify a value.

To view this administrative console panel, click Applications » Application Types » Business-level
applications » business-level_application_name > Add > Add unit_type.

Name:

Specifies the name of the composition unit to be added to the business-level application.
The table lists available composition units. Select a unit from this list.

Description:

Specifies a description for the composition unit.

Add asset settings
Use this panel to add one or more assets to a business-level application.

To view this administrative console panel, click Applications » Application Types > Business-level
applications > application_name > Add > Add Asset.

Deployable units:
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Specifies the imported assets available for use in a business-level application. The list of deployable units
includes only imported assets, and not shared libraries or business-level applications.

From this list, select one or more deployable units to add as composition units to your business-level
application.

Set options settings

Use this panel to specify options for the composition unit to be added to the business-level application.
The product supplies default values for the options if you do not specify a value.

To view this administrative console panel, click Applications » Application Types » Business-level
applications » application_name. On the business-level application settings page, specify the type of
composition unit to add:

* To add an asset, under Deployed assets, click Add > Add Asset.
» To add a shared library, under Deployed assets, click Add » Add Shared Library.
» To add a business-level application, under Business-level applications, click Add.

Backing identifier:

Specifies a unique identifier for a composition unit that is registered in the application management
domain.

The identifier has the format: WebSphere:unit_typename=unit_name,unit_typeversion=version_number. For
example, for the MyApp.jar asset, the backing identifier might be WebSphere:assetname=MyApp. jar.

Data type String
Units Composition unit identifier
Name:

Specifies the name of the composition unit.
For example, for the MyApp.jar asset, the name might be MyApp.jar.

A unit name cannot begin with a period (.), cannot contain leading or trailing spaces, and cannot contain
any of the following characters:

Unsupported characters

| forward slash $  dollar sign ’ single quote mark

\ backslash = equal sign " double quote mark

* asterisk % percent sign | vertical bar

, comma +  plus sign < left angle bracket
colon @ at sign > right angle bracket

;  semi-colon #  hash mark & ampersand (and sign)

? question mark 11> No specific name exists for this character combination

Data type String

Description:

Specifies a description for the composition unit.
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Starting weight:

Specifies the order in which composition units are started when the server starts. The starting weight is
like the startup order. The composition unit with the lowest starting weight is started first.

The value that you set for Starting weight determines the importance or weight of a composition unit
within the business-level application. For example, for the most important composition unit within a
business-level application, specify 1 for Starting weight. For the next most important composition unit
within the business-level application, specify 2 for Starting weight, and so on.

Data type Integer
Default 1
Range 0 to 2147483647

Start composition unit upon distribution:

Specifies whether to start the composition unit after the product distributes the composition unit to other
locations.

The default is not to start the composition unit.

Data type Boolean
Default false

Restart behavior on update:
Specifies whether the product restarts deployment targets after updates to the composition unit.

Usually, a composition unit is mapped to one or more deployment targets. This setting determines whether
the product restarts those targets after editing the composition unit.

Option Description

ALL The product restarts each target node of the composition unit after editing the composition unit.
DEFAULT The product restarts the nodes controlled by the sync plug-ins after editing the composition unit.
NONE The product does not restart nodes after editing the composition unit.

Map target settings

Use this panel to map a composition unit to a deployment target. The product assigns a default target
when you do not specify a target.

To view this administrative console panel, click Applications » Application Types » Business-level
applications -~ application_name » composition_unit_name > Modify Target. The Map target page is
similar to the Map composition unit to a target panel in the add composition unit wizard.

On single-server products, a deployment target can be an application server or Web server.

On this panel, map a composition unit to one or more desired targets.

Current targets:

Specifies the existing deployment targets for the composition unit.

Available:
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Lists the names of available deployment targets. This list is the same for every composition unit that is
registered in the cell.

From this list, select only appropriate deployment targets for a composition unit.

If the unit calls a Version 7.x application programming interface (API) or uses a 7.x feature, then you must
map the unit to a 7.x deployment target. If the unit supports Java Platform, Enterprise Edition (Java EE) 5,
then you must map the unit to a 7.x deployment target. If the unit supports Java 2 Platform, Enterprise
Edition (J2EE) 1.4, then you must map the unit to a 6.x or 7.x deployment target. You can map units that
call a 6.x APl or use a 6.x feature to a 6.x or 7.x deployment target.

To map a composition unit to a deployment target, select a target from the Available list and click >>. The
target name is displayed in the Selected list.

Selected:
Lists the names of desired deployment targets.
When you click OK, the product maps the composition unit to the deployment targets in the Selected list.

To remove a deployment target from the Selected list, select the target and click <<.

Deployable unit relationship settings

Use this panel to specify relationship options for deployable units in an asset deployed as part of a
business-level application. Specifying a relationship declares a dependency relationship that a deployable
unit has on another asset deployed as a shared library in the same business-level application.

To view this administrative console panel, click Applications » Application Types » Business-level
applications » application_name > deployed_asset_name > Manage Relationships. This help also
pertains to both the Relationship options panel and the Composition unit relationship options panel that are
shown when you add multiple deployable unit assets to a business-level application. These panels are
shown for the Define relationship with existing composition units and Options for creating new
composition units to satisfy asset relationships wizard steps.

A business-level application consists of composition units. When you add an asset to a business-level
application, the product creates a composition unit for the asset. The composition unit name can be
different from the name of the asset being deployed. The list of deployed assets shown for a
business-level application consists of the composition unit names for the deployed assets. The
relationships defined in this panel are composition unit relationships. The deployable units listed for a
composition unit are those you chose from the associated asset when adding the asset. Composition unit
relationships are expressed as deployable unit dependencies on other composition units belonging to the
same business-level application. Only a composition unit for an asset deployed as a shared library can be
specified as a dependency. You can map each deployable unit to a target independently from the others.
Modifying relationships in this panel only affects the composition unit, not the associated asset.

To specify relationship options, select a deployable unit and click a button.

Button Resulting action

Set Relationships Displays a panel through which you can add or change relationships for the
deployable unit. Specify a relationship if a deployable unit depends on another asset
deployed as a shared library in order to run.

This button is on the Set relationship options panel.

Enable Match Targets If the deployable unit has a dependency relationship defined, click Enable Match
Targets to map the related deployed assets to the same deployment targets as the
dependent deployable unit.
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Button Resulting action

Disable Match Targets If the deployable unit has a dependency relationship defined, click Disable Match
Targets if the related deployed assets do not need to be deployed to the same targets
as the deployable unit.

Deployable unit name:

Specifies the name of the deployable unit of the selected deployed asset.

Relationship:

Specifies the composition unit names for all relationships defined for the associated deployable unit.
This setting is on the Set relationship options panel.

By default, a deployable unit has no relationships. To add or change related composition units, do the

following:

1. Select the deployable unit.

2. Click Set Relationships.

3. Select the composition units that the deployable unit requires by moving them from the Available list
to the Selected list.

4. Click OK.

Match targets:
Indicates the match targets value selected for the associated deployable unit. The default value is true.

A match targets value of true maps the composition units listed under Relationship to the same
deployment targets as the associated deployable unit. Typically, you must deploy related composition units
to the same targets as the dependent deployable unit in order for the deployable unit to run.

A false value indicates that the related composition unit can map to deployment targets which are
different from the deployment targets of the deployable unit.

To set the value to true, select the deployable unit and click Enable Match Targets. To set the value to
false, select the deployable unit and click Disable Match Targets. To set this value, the deployable unit
must have a related composition unit.

Business-level application settings
Use this page to configure a business-level application.

To view this administrative console page, click Applications » Application Types » Business-level
applications » application_name.

This page is the same as the Adding composition unit to the business-level application page.

Name
Specifies a logical name for the application. An application name must be unique within a cell and cannot
contain an unsupported character.

An application name cannot begin with a period (.), cannot contain leading or trailing spaces, and cannot
contain any of the following characters:
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Unsupported characters

| forward slash $ dollar sign ’ single quote mark

\ backslash = equal sign " double quote mark

* asterisk % percent sign | vertical bar

, comma + plus sign < left angle bracket
colon @ at sign > right angle bracket

;  semi-colon # hash mark & ampersand (and sign)

? question mark

11> No specific name exists for this character combination

Data type

Description

String

Specifies a description for the business-level application.

Deployed assets

Specifies the asset and shared library composition units in the business-level application. A composition
unit is a registered asset or shared library that has additional configuration information, which you specify
when adding the asset to the application.

For each composition unit, the table provides a name, description, asset type, and the runtime status of

the composition unit.

Button

Resulting action

Add > Add Asset

For assets that contain Java Platform, Enterprise Edition (Java EE) applications or modules,
opens the application installation wizard. On the Select installation options panel of this wizard,
you can specify a Business-level application name value that identifies the target
business-level application. On the Map shared library relationships panel, you can identify the
shared library files that individual modules need to run and specify composition unit names for
the module-shared library relationships.

For non-Java EE assets, opens a wizard that helps you add an asset as a composition unit to
your business-level application.

Add > Add Shared
Library

Opens a wizard that helps you add a library file as a composition unit to your business-level
application.

Delete

Deletes the composition unit from the product configuration repository and deletes the
application binaries from the file system of all nodes where the application modules are
installed.

On single-server installations, deletion occurs after the configuration is saved.

Business-level applications
Specifies the business-level applications in this business-level application.

The table provides a name, description, and the runtime status of each contained business-level

application.

Button Resulting action

Add Opens a wizard that helps you add a business-level application to your business-level
application.
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Button Resulting action

Delete Deletes the business-level application from the product configuration repository and deletes
the application binaries from the file system of all nodes where the application modules are
installed.

On single-server installations, deletion occurs after the configuration is saved.

Composition unit settings
Use this page to view composition unit settings and to change the deployment target of a composition unit.

To view this administrative console page, click Applications > Application Types » Business-level
applications » application_name > composition_unit_name.

Name
Specifies a logical name for the composition unit. You cannot change the name on this page.

Description
Specifies a description for the composition unit. You cannot change the description on this page.

Backing identifier
Specifies a unique identifier for a composition unit that is registered in the application management
domain.

The identifier has the following format: WebSphere:unit_typename=unit_name. For example, for the
MyApp.jar asset, the backing identifier might be WebSphere:assetname=MyApp.jar.

You cannot change the identifier on this page.

Data type String
Units Configuration unit identifier

Starting weight
Specifies the order in which composition units are started when the server starts. The starting weight is
like the startup order. The composition unit with the lowest starting weight is started first.

The value that you set for Starting weight determines the importance or weight of a composition unit
within the business level application. For example, for the most important composition unit within a
business-level application, specify 1 for Starting weight. For the next most important composition unit
within the business-level application, specify 2 for Starting weight, and so on.

Data type Integer
Default 1
Range 0 to 2147483647

Start on distribution
Specifies whether to start the composition unit when the product distributes the composition unit to other
locations.

The default is not to start the composition unit.

This setting applies to asset or shared library composition units. This setting does not apply when the
composition unit is a business-level application.

Data type Boolean
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Default false

Recycle behavior on update
Specifies whether the product restarts the composition unit after the composition unit is updated.

The default is to restart the composition unit after partial updating of the composition unit.

This setting applies to asset or shared library composition units. This setting does not apply when the
composition unit is a business-level application.

Option Description

ALL Restarts the composition unit after the entire composition unit is updated
DEFAULT Restarts the composition unit after the part of the composition unit is updated
NONE Does not restart the composition unit after the composition unit is updated

Current target
Specifies the existing deployment target for the composition unit.

To change the deployment target, click Modify target and select a different deployment target from the list
of available clusters and servers.

Example: Creating a business-level application

You can add many different types of artifacts to business-level applications. For example, you can add
Java Platform, Enterprise Edition (Java EE) applications or modules, Java archives (JAR files), data in
compressed files, and other business-level applications.

About this task

An example of creating a simple business-level application follows. This example assumes that you have a
compressed file, such as a zip file, or other archive available on your computer or on a remote server that
you can use to complete the example.

If you do not have a compressed file available, look in product directories. Installing the product samples
adds several sample files to the /samples directory. You can use these sample files in a business-level
application.

1. Import assets.
a. Click Applications » New application » New Asset in the console navigation tree.
b. On the Upload asset page, specify the asset package to import and click Next.
For example, specify a compressed file such as a zip file and click Next.
c. On the Select options for importing an asset panel, click Next.
d.
e. On the Summary panel, click Finish.

f. On the Adding asset to repository panel, if messages show that the operation completed, click
Manage assets.

g. On the Assets page, click Save.

The file name displays in the list of assets.
2. Create an empty business-level application named MySamp1eBLA.
a. Click Applications > New application > New Business Level Application.
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b. On the New business-level application panel, specify a unique name such as MySampleBLA and a
description, and then click OK.

c. On the business-level application settings page, click Save.
The name and description are shown in the list of applications on the Business-level applications page.
Because the application is empty, its status is Unavailable.
3. Add the asset composition unit to your business-level application.
a. On the Business-level applications page, click the application name in the list of applications.
b. On the business-level application settings page, click Add » Add Asset.

c. On the Add composition unit panel, select an asset composition unit from the list of available units,
and then click Continue.

For example, select the compressed file asset and then click Continue.
On the Set options panel, click Next.

On the Map composition unit to a target panel, change the target server as needed, and then click
Next.

f. On the Summary panel, click Finish. Several messages are displayed. A message having the
format Completed res=[WebSphere:cuname=unit_name] indicates that the addition is successful.

g. If the addition is successful, click Manage application.
h. On the business-level application settings page, click Save.

The asset name and type displays in the list of deployed assets.
4. Start the business-level application.
a. Click Applications » Application Types » Business-level applications.
b. On the Business-level applications page, select the check box beside your application.
c. Click Start.
When the business-level application is running, a green arrow displays for Status. If the business-level

application does not start, ensure that the deployment target to which the application maps is running
and try starting the application again.

What to do next

You can add other assets to your business-level application.

Starting business-level applications

You can start a business-level application that is not running (has a status of Stopped). The application
must contain code that can run on a server to start.

Before you begin

The application must be |insta||ed on a server| By default, the application starts automatically when the
server starts.

About this task

You can start and stop business-level applications manually using the administrative console or wsadmin
commands.

This topic describes how to use the administrative console to start a business-level application.
1. Go to the [Business-level applications page}

Click Applications > Application Types » Business-level applications in the console navigation
tree.
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2. Select the check box for the application you want started.
3. Click Start. The product runs the application and changes the state of the application to Started. The

status is changed to partially started if not all servers on which the application is deployed are
running.

Results

A message stating that the application started displays at the top the page.

What to do next

To restart a running application, select the application you want to restart, click Stop and then click Start.

Stopping business-level applications

You can stop a business-level application that is running and has a status of Started).
Before you begin

The application must be running on a product server.

About this task

You can stop applications manually using the administrative console or wsadmin commands.

This topic describes how to use the administrative console to stop a business-level application.
1. Go to the |[Business-level applications page]

Click Applications » Application Types > Business-level applications in the console navigation
tree.

2. Select the check box for the application you want stopped.

3. Click Stop. The product stops the processing of the application and changes the state of the
application to Stopped.

Results

The status of the application changes and a message stating that the application stopped displays at the
top the page.

What to do next

To restart a stopped application, select the application you want to restart, and then click Start.

Updating business-level applications

You can update business-level applications by deleting or changing composition units, or by mapping
composition units to different deployment targets.

Before you begin

Determine what changes that you want to make to your application. Also, determine whether the changed
application can run on your deployment targets.
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About this task

Updating consists of adding new composition units to an application, replacing or removing composition
units, or mapping composition units to different deployment targets.

You can add an asset or shared library composition unit to multiple business-level applications. However,
each composition unit for the same asset must have a unique composition unit name. You can add a
business-level application composition unit to more than one business-level application.

This topic describes how to update business-level applications using the administrative console.
Alternatively, you can use programming or the wsadmin tool.

* Delete composition units from your business-level application.

1.

2.
3.
4.

Go to the business-level application settings pagel

Click Applications » Application Types > Business-level applications > application_name in the
console navigation tree.

Select each composition unit of the application that you want to delete.
Click Delete.

On the Delete composition unit from business-level application panel, confirm the deletion and click
OK.

* Add new or updated assets, shared libraries, or other business-level applications to your business-level
application.

1.
2.

3.
4.

10.
11.

Update asset binary files or shared libraries as needed.

If you are adding new assets that are not registered with the product management domain,

If you are updating existing assets, [use the Update option to update asset files}

On the business-level application settings page, specify the type of composition unit to add.
— To add an asset, under Deployed assets, click Add > Add Asset.

— To add a shared library, under Deployed assets, click Add » Add Shared Library.

— To add a business-level application, under Business-level applications, click Add.

On the|New composition unit panell select a unit from the list of available units, and then click
Continue.

On the[Set options panell change the composition unit settings as needed, and then click Next.

On the|Map composition unit to a target panel} change the deployment target as needed, and then
click Next.

This panel is not shown when you add a business-level application.
On the Summary page, click Finish.
If the product adds the unit successfully, click Manage application.

If the unit addition is not successful, read the messages, and try adding the unit again. Correct the
errors noted in any messages.

On the IAdding composition unit to the business-level application pagel click Save.

Repeat these steps to add any other assets, shared libraries, or applications needed by the
business-level application.

The business-level application settings page displays the configuration unit names.
* Map composition units to different deployment targets.

1.
2.
3.
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On the |composition unit settings page} select the composition unit that you want to change.
Under Current targets, click Modify Target.

On the [Map targets page} change the target.
a. From the list of available clusters and servers, select a different deployment target.
b. Click >> to add the deployment target to the Selected list.
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c. To remove a deployment target from the Selected list, select the target and click <<.
d. Click OK.

The business-level application settings page displays the selected deployment target.
What to do next

Save the changes to your administrative configuration.

Deleting business-level applications

After an application no longer is needed, you can delete it.
About this task

Deleting a business-level application removes the application from the product configuration repository and
it deletes the application binaries from the file system of all nodes where the application files are installed.

1. Go to the [Business-level applications page}

Click Applications » Application Types » Business-level applications in the console navigation
tree.

2. If you need to retain a copy of the application, back up composition units of the application.
3. Delete composition units of the application.

a. On the Business-level applications page, click the name of the business-level application that you
want to delete.

On the business-level application settings page, select each composition unit of the application.
Click Delete.

d. On the Delete composition unit from Business-level application panel, confirm the deletion and click
OK.

Deleting a configuration unit removes the configuration from the config/cells/ce/l_ name/cus

directory.

4. Delete the business-level application.
a. Select the application that you want to delete.
b. Click Delete.

Unless the application is used by another business-level application, deleting a business-level
application removes the configuration from the config/cells/cell_name/blas directory.

5. On the Delete business-level application panel, confirm the deletion and click OK.
6. Save changes made to the administrative configuration.

Results

On single-server products, application binaries are deleted after you save the changes.
What to do next

If using the administrative console Delete options does not fully delete a business-level application or its

configuration units, you can delete the business-level application and its configuration units manually from
a stand-alone server. Suppose you want to delete a business-level application named ExampleBLA, and

ExampleBLA is not used by another business-level application. Complete the following steps to manually

delete the ExampleBLA configurations from the blas and cus directories:

1. Delete the config/cells/cell_ name/blas/ExampleBLA directory.
2. Delete the config/cells/cell_ name/cus/ExampleBLA directory.
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3. Save changes made to the administrative configuration.
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Chapter 8. Administering business-level applications using
programming

You can use the command framework programming to create, edit, update, start, stop, delete, export,
import, and query information about business-level applications. A business-level application defines an
enterprise-level application.

Before you begin

This task assumes a basic familiarity with the command framework. Read about the command framework
in the application programming interfaces documentation.

About this task

Besides creating, editing, updating, starting, stopping, deleting, exporting, importing, and querying
information about business-level applications using programming, you can do these tasks using the
administrative console or the wsadmin scripting tool.

1. Perform any of the following tasks to administer your business-level applications using programming.
a. [Create an empty business-level application |

You typically create an empty business-level application and then add assets or business-level
applications as composition units to the empty business-level application.

b. [Import an asset)

You can import an asset to register the asset with the product and optionally store the asset in the
product repository so that you can later use the asset in a business-level application. An asset
represents at least one binary file that implements business logic.

c. |Add a composition unit.|

You can add an asset to a business-level application by creating a composition unit for the asset. A
composition unit is typically created from an asset and contains configuration information that
makes the asset runnable.

d. [Start a business-level application)

You can start a business-level application, which starts each composition unit in that business-level
application. Each composition unit is started on the respective targets on which the business-level
application is deployed.

e. [Stop a business-level application.|

You can stop a business-level application, which stops each composition unit in that business-level
application. Each composition unit is stopped on the respective targets on which the business-level
application is deployed.

f. |Check the status of a business-level application.|
You can check the status of an entire business-level application. You can also limit the status to a
particular composition unit of a business-level application, a specific deployment target, or check the
status of the composition unit and the deployment target at the same time.

g. |Delete a business-level application

You can delete a business-level application using programming. You might delete a business-level
application if the application is not functioning correctly, no longer needed, and so on.

h. |Delete an asset)

You can delete an asset from a business-level application using programming if the asset is not
functioning corrctly, the asset is no longer needed, and so on. An asset represents at least one
binary file that implements business logic.

i. [Delete a composition unit)|

© Copyright IBM Corp. 2008 193



You can delete a composition unit from a business-level application if the composition unit is not
functioning correctly, the composition unit is no longer needed, and so on. A composition unit is

typically created from a business-level application or an asset and contains configuration information
that makes the asset runnable.

. [Export an asset|

You can export an asset from the current session so that you can back up the asset, import the
asset to another session, and so on. An asset represents at least one binary file that implements
business logic.

You can list the assets that have been imported to the current workspace so that you can do
further asset administration, such as deleting or exporting assets. An asset represents at least one
binary file that implements business logic.

. |List composition units |

You can list the composition units for a specific business-level application in a session so that you
can do further composition unit administration, such as deleting or adding composition units. A
composition unit is typically created from a business-level application or an asset and contains
configuration information that makes the asset runnable.

. |List business-level applications.|

You can list the business-level applications of a session so that you can do further business-level
application administration such as deleting a business-level application. A business-level
application is an administrative model that captures the definition of an enterprise-level application
so that you can perform specific business functions, such as accounting.

. |Edit a composition unit.|

You can edit the configuration information in a composition unit of a business-level application if,
for example, you want to change which modules in the composition unit are configured to run in
which targets. A composition unit is typically created from a business-level application or an asset
and contains configuration information that makes the asset runnable.

Edit an asset.

You can edit the information of an asset, for example, its destination location, its relationship with
other assets, and so on. An asset represents at least one binary file that implements business logic

. |Edit a business-level application]

You can edit the information of a business-level application such as its description. A business-level

application is an administrative model that captures the entire definition of an enterprise-level
application.

. |Update an asset.|

You can update an asset by adding, deleting, or updating a single file or Java Platform, Enterprise
Edition (Java EE) module, or by merging multiple files or Java EE modules into an asset. You can
also update an asset by replacing the entire asset.

. |View a composition unit,

You can view the composition unit information so that you can do other tasks associated with the
composition unit, such as editing an asset or deleting a composition unit. A composition unit is
typically created from a business-level application or an asset and contains configuration
information that makes the asset runnable.

iew an asset,

You can view the asset information so that you can do other tasks associated with the asset, such

as editing or exporting an asset. An asset represents at least one binary file that implements
business logic.

t. [View a business-level application|
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You can view business-level application information such as the description so that you can do
other tasks associated with the business-level application, such as editing the business-level
application. A business-level application is an administrative model that captures the entire definition
of an enterprise-level application.

u. [List control operations.|

You can list the control operations of a business-level application or a composition unit for a
session. You use control operations, such as start or stop, to change or query the runtime
environment of a business-level application or a composition unit.

2. Save your changes to the master configuration repository.
3. Synchronize changes to the master configuration across the nodes for the changes to take effect.

Results

Depending on which tasks you complete, you have created, edited, updated, started, stopped, deleted,
exported, imported, or queried information about business-level applications.

What to do next

If you have further business-level application updates, you can do the updates through programming, the
administrative console, or the wsadmin scripting tool.

Creating an empty business-level application using programming

You can create an empty business-level application, and then add assets or business-level applications as
composition units to the empty business-level application.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

You can create an empty business-level application using programming, the administrative console, or the
wsadmin tool.

About this task

Perform the following steps to create an empty business-level application using programming. In your code
that creates the empty business-level application, you must provide the name parameter. The name
parameter specifies the name of the business-level application that you create.

1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
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passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
creates an empty business-level application.

The command name is createEmptyBLA. The name parameter is a required parameter that you use to
specify the name of the business-level application. You can optionally provide the description
parameter to provide a description of the newly created business-level application.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.

7. Call the execute method in the asynchronous command client to run the command that creates an
empty business-level application.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, the empty business-level application is created.
Example

The following example shows how to create an empty business-level application based on the previous
steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.exception.AdminException;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class CreateEmptyBLA {
public static void main(String[] args) {

try {

// Connect to the application server.

// This step is optional if you use the Tocal

// command manager. Comment out the Tines to and including
// CommandMgr cmdMgr = CommandMgr.getClientCommandMgr (

// soapClient);

// to get the soapClient soap client if you use the local
// command manager.

String host = "localhost";

String port = "8880";

// Change to your port number if it is
// not 8880.
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Properties config = new Properties();
config.put(AdminClient.CONNECTOR_HOST, host);
config.put(AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR _TYPE,

AdminClient.CONNECTOR TYPE_SOAP);
System.out.printin("Config: " + config);
AdminClient soapClient =

AdminClientFactory.createAdminClient (config);

// Create the command manager.

CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following Tine to create a local command

// manager:

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler

// for listening to command notifications.

// Comment out the following line if no further handling
// of command notification is required:
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the listener with
// null for the AsyncCommandClient object that follows.

AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient(session, listener);
System.out.printIn("\nCreated async command client");

// Create the command that creates an empty
// business-level application.
String cmdName = "createEmptyBLA";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // Create an empty
// business-Tevel application using
// the session created.

System.out.printIn("\nCreated " + cmdName);

// Set the name command parameter.
String blaName = "blal";
cmd.setParameter("name", blaName);

System.out.printin("\nSet name parameter to "
+ cmd.getParameter("name"));

// Uncomment the following lines to set the description of
// the business-level application being created:

/!

// String blaDescription = "description for blal";

// cmd.setParameter("description", blaDescription);

// System.out.printIn("\nSet description parameter to " +
// cmd.getParameter("description"));

// Call the asynchronous command client to
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// process the command parameters.

try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +

"parameters");

} catch (Throwable th) {

System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");

th.printStackTrace();
System.exit(-1);

1

// Call the asynchronous command client to run the command.
asyncCmdClientHelper.execute(cmd);
System.out.printIn("\nCompleted command execution");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());
} else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}

} catch (Exception e) {
e.printStackTrace();

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification.
System.out.printIn("\nEXAMPLE: notification received: " +
notification);
1
What to do next

You can add business-level applications or assets as composition units into the newly created
business-level application. Alternatively, you can add the newly created business-level application to other
business-level applications.

Importing an asset using programming

You can import an asset to register the asset with the product and optionally store the asset in the product
repository so that you can later use that asset in a business-level application. An asset represents at least
one binary file that implements business logic.
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Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

You can import an asset using programming, the administrative console, or the wsadmin tool.
About this task

When you import an asset, you register the asset with the product and optionally store the asset in the
product repository.

You must provide a file path to the source that you are importing. Specify an absolute path name to the
source, as the behavior for a relative path is unpredictable.

You can specify a destination location from where the application server reads the asset file while starting
a composition unit created from the asset. The asset is copied to this location when the configuration
session is saved after the asset is imported. The default asset destination is installedAssets/
asset_name.

You can optionally specify a storage type of FULL, METADATA, or NONE. The default value is FULL,
which means that the asset and associated meta data are stored in the product asset repository. If you
specify a storage type of METADATA, the asset is not copied to the product repository, but associated
meta data is stored in the product repository. If you specify a storage type of NONE, neither the asset nor
the asset meta data is stored in the product asset repository. For storage types of METADATA and NONE,
the asset is expected to reside at the destination file path. Storage types of METADATA and NONE are
typically used by development tools which enable iterative development on the copy of the asset in the
directory structure of the tool.

Perform the following steps to import an asset using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to set up the command that imports an
asset.

The command name is importAsset. The source parameter is a required parameter that you use to
specify the path to the asset. You can optionally provide the storageType parameter to specify how to
save the asset in the configuration repository.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
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7. Set up the command step parameters.

You can set parameters in the AssetOptions step that contains data about the asset such as its

description, file permission, and relationship with other assets.
8. Call the asynchronous command client to run the command that imports an asset.
You might have created an asynchronous command handler to implement the

AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler

performs any necessary actions while waiting for the command to complete.
9. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by

calling the command.getCommandResult method.
Results
After you successfully run the code, the asset is imported.
Example
The following example shows how to import an asset based on the previous steps.

Some statements are split on multiple lines for printing purposes.
package com.ibm.ws.management.application.task;

import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;
import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.UploadFile;

import com.ibm.websphere.management.exception.AdminException;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class ImportAsset {
public static void main (String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the Tines to and including
// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (

// soapClient);

// to get the soapClient soap client if you use the Tocal
// command manager.

String host = "localhost";
String port = "8880"; //Change to your port number if it is not
//8880.

Properties config = new Properties();
config.put (AdminClient.CONNECTOR_HOST, host);
config.put (AdminClient.CONNECTOR_PORT, port);
config.put (AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);
System.out.printin ("Config: " + config);
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AdminClient soapClient =
AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a Tocal command

// manager:

//

//CommandMgr cmdMgr = CommandMgr.getCommandMgr();

System.out.printIn("\nCreated command manager");

// Optionally create the asynchronous command handler.

// Comment out the following 1ine if no further handling
// of command notification is required:
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Setup the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the following Tistener with
// null for the AsyncCommandClient object.

AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient(session, Tistener);
System.out.printin("\nCreated async command client");

String cmdName = "importAsset";
UploadFile assetSource = new

UploadFile("/sources/test5.zip"); //Change to the directory of your sources.

// Create the command to import an asset.

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); //import the asset using
//the session created

System.out.printin("\nCreated " + cmdName);

// Set the source command parameter.

cmd.setParameter("source", assetSource);

System.out.printin("\nSet source parameter to " +
cmd.getParameter("source"));

// Uncomment the following line to set the storage type to
// a value of STORAGETYPE_META or STORAGETYPE_NONE instead of
// the default of STORAGETYE_FULL:

//
//cmd.setParameter("storageType,
// CommandConstants.STORAGETYPE_NONE) ;

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
}
catch(Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
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System.exit(-1);
}

// Set up the step parameters for the AssetOptions step.
String stepName = "AssetOptions";
CommandStep step = ((TaskCommand) cmd).gotoStep(stepName);

// The new asset name must contain the
// same extension as the original .zip file name.
String assetNewName = "assetl.zip";

// If you override the default destination, include the
// entire path with the file name for the new destination.

String destName = "/websphere/asset/installDir/assetl.zip";

for (int i = 0; i < step.getNumberOfRows(); i++) {
// The following lines change the name and destination
// step parameters. Other step parameters that you can
// use follow, but are commented out.
// Change your set
// of step parameters as required by your scenario.

// Set the name.

step.setParameter("name", assetNewName, 1);

System.out.printin("\nSet name parameter to " +
step.getParameter("name", 1i));

// Set the destination.

step.setParameter("destination", destName, i);

System.out.printin("\nSet destination parameter to " +
step.getParameter("destination", 1i));

// Set the description.

//String desc = "description for assetl.zip";
//step.setParameter("description", desc, i);
//System.out.printin("\nSet description parameter to " +
// step.getParameter("description", i));

// Set the validation.

//String validate = "Yes";
//step.setParameter("validate", validate, 1);
//System.out.printin("\nSet validate parameter to " +
// step.getParameter("validate", i));

// Set the file permission.

//String filePermission = ".*\\.d11=755";
//step.setParameter("filePermission", filePermission, 1);
//System.out.printin("\nSet filePermission parameter to " +
// step.getParameter("filePermission", 1));

// Set the type aspect parameter value.

// Format for a typeAspect: WebSphere:spec=xxx,version=n.n+
// Websphere:spec=xxx,version=n.n.

//String typeAspect = "";

//step.setParameter("typeAspect", typeAspect, i);
//System.out.printin("\nGet typeAspect: " +

// step.getParameter("typeAspect", i));

// Set the relationship parameter.

// The relationship parameter declares dependency

// relationships on other assets. The parameter value

// is a list which contains the ID of each asset declared
// as a dependency. Each ID in the list is separated by

// a ||p'|us|| Sign (||+|| .

//

// Only assets which are Java archives can be referenced in
// dependency relationships. An asset is a Java archive if
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// it has a type aspect identifying it as such.

// If an asset declared as a dependency does not exist or
// does not have a Java archive type aspect, it is ignored
// and no dependency on the asset is registered in the

// asset's configuration.

//
//String relationship =
// "assetname=shared.zip+assetname=shared2.zip";

//step.setParameter("relationship", relationship, i);
//System.out.printin("\nGet relationship: " +
// step.getParameter("relationship", 1));

}

// Call the asynchronous command client that imports the asset.
asyncCmdClientHelper.execute(cmd) ;
System.out.printin("\nCompleted running of command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand ran successfully " +
"with result\n" + result.getResult());
} else {
System.out.printIn("\nCommand ran with " +
"exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification
System.out.printin("\nEXAMPLE: notification received: " +
notification);
1
What to do next

Add a composition unit to a business-level application using the asset that you imported. An asset included
in a business-level application is represented by a composition unit.

Adding a composition unit using programming

You can add an asset to a business-level application by creating a composition unit for the asset. A
composition unit is typically created from a business-level application or an asset and contains
configuration information that makes the asset runnable.
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Before you begin

Before you can add a composition unit to a business-level application, you must have created an empty
business-level application and imported an asset.

You can add a composition unit to a business-level application using programming, the administrative
console, or the wsadmin tool.

About this task

When you add a composition to a business-level application, the composition unit is configured for the
specified business-level application. The composition unit cannot be shared with other business-level
applications.

Perform the following steps to add a composition unit to a business-level application using programming.

1.

Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

Use the command manager that you created in a previous step to create and set up the command that
adds a composition unit.

The command name is addCompUnit. The blalD and cuSourcelD parameters are required parameters
that you use to specify composition unit source to be added to the business-level application.
Examples of composition unit source are an asset or a business-level application. You can optionally
provide deployable units for the composition unit through the deplUnit parameter. If the cuSourcelD
parameter is a Java Platform, Enterprise Edition (Java EE) asset, you can optionally use the
cuConfigStrategyFile parameter or the defaultBindingOptions parameter to specify the default bindings.
The defaultBindingOptions parameter must match the binding options available for this Java EE asset.
To view a list of binding options available for this Java EE asset, look at the AssetOptions step in the
viewAsset command. Specify each binding option in an option_name=option_value pair, with multiple
pairs separated by a # character.

Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.

Set up the command step parameters.

You can set up composition unit information through various steps. The CUOptions step contains data
about the composition unit such as its description, starting weight, and start and restart behavior. The
MapTargets step contains target information about where the composition unit is to be deployed. The

RelationshipOptions step contains shared library composition units on which this composition unit has
dependencies. The ActivationPlanOptions step allows you to specify runtime components for each
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deployable unit. The CreateAuxCUOptions step contains assets on which this composition unit has
dependencies. You can set up parameters in these steps.

8. Call the asynchronous command client to run the command that adds a composition unit to a
business-level application.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

9. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, the composition unit is added to the business-level application.
Example

The following example shows how to import an asset based on the previous steps. Some statements are
split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class AddCompUnit {
public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local command
// manager. Comment out the lines to and including

// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (
// soapClient);

// to get the soapClient soap client if you use the

// local command manager.

String host = "Tocalhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();

config.put(AdminClient.CONNECTOR_HOST, host);

config.put(AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR TYPE,
AdminClient.CONNECTOR _TYPE_SOAP);

System.out.printin("Config: " + config);

AdminClient soapClient =
AdminClientFactory.createAdminClient (config);

// Create the command manager
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CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous Tines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager:

/!

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();

System.out.printIn("\nCreated command manager");

// Optionally create the asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required:
AsyncCmdTaskHandler Tistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the following Tistener with
// null for the AsyncCommandClient object.

AsyncCommandClient asyncCmdClientHelper = new

AsyncCommandClient (session, listener);

System.out.printIn("\nCreated async command client");

// Create the command to add a composition unit to a business-level application.
String cmdName = "addCompUnit";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // Add the composition unit using

// the session created.
System.out.printIn("\nCreated " + cmdName);

// Set the blaID command parameter.

// Examples of valid formats for the blaID parameter are:
// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an

// incomplete ID as long as the incomplete

// 1D can resolve to a unique business-level application.
String blaID = "blal";

cmd.setParameter("blaID", blalD);

System.out.printIn("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));

// Set the cuSourceID command parameter.

// Examples of valid formats for the cuSourcelID parameter:
// 1f the source is an asset, examples are:

// - aName

// - assetname=aName

// - WebSphere:assetname=aName

// 1f the source is another business-level application,

// examples are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// The cuSourcelID command parameter

// accepts an incomplete ID as Tong as the incomplete

// 1D can resolve to a unique asset or business-Tevel application.
String cuSourceID = "assetname=assetl.zip";
cmd.setParameter("cuSourceID", cuSourcelD);
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System.out.printIn("\nSet cuSourceID parameter to "
+ cmd.getParameter("cuSourceID"));

// Set the deplUnits command parameter.

// 1f the deployable units of an asset are, for example, a.jar and

// b.jar, then when you run the addCompUnit command you can

// specify deplUnits as a.jar+b.jar. You can specify the whole

// list, a subset of that list, or "default" to create this composition
// unit as a shared library. If the deplUnits parameter is not specified,
// the deployable units are set the same as that of their asset.

String deplUnits = "default";

cmd.setParameter("deplUnits", deplUnits);

System.out.printIn("\nSet deplUnits parameter to "
+ cmd.getParameter("deplUnits"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Set up the step parameters for the CUOptions step.

// The CUOptions step contains the following arguments:

// description - description for the composition unit

// startingWeight - starting weight for the composition

// unit within the business-Tevel application. The default is 1.

// startedOnDistributed - to start composition unit upon distribution
// to target nodes. The default is false.

// restartBehaviorOnUpdate - restart behavior for a composition unit when
// updating the composition unit.

// The default is DEFAULT. Valid values are DEFAULT, ALL, and NONE.
String stepName = "CUOptions";

CommandStep step = ((TaskCommand) cmd).gotoStep(stepName);

// Composition unit name:
String name = "cul";

// Composition unit description:
String description = "cul description”;

for(int i = 0; i < step.getNumberOfRows(); i++) {
// The following lines change the composition unit name and
// description step parameters of the CUOptions step. Change
// your set of step parameters as required for your
// scenario.

// Set the name.

step.setParameter("name", name, i);

System.out.printin("\nSet name parameter to " +
step.getParameter("name", 1i));

// Set the description.

step.setParameter("description", description, i);

System.out.printin("\nSet description parameter to " +
step.getParameter("description”, i));

}

// Set up the step parameters for the MapTargets step.
stepName = "MapTargets";
step = ((TaskCommand) cmd).gotoStep(stepName);
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// Specify the targets to deploy the composition unit.
// The default is serverl. Use the + character to

// specify multiple targets.

String server = "serverl";

for(int i = 0; i < step.getNumberOfRows(); i++)
// The following lines change the composition unit and
// server step parameters of the
// MapTargets step. Change your set of step parameters
// as required for your scenario.

// Set the server.

step.setParameter("server", server, i);

System.out.printin("\nSet server parameter to " +
step.getParameter("server", i));

}

// The addCompUnit command might contain the

// CreateAuxCUOptions, RelationshipOptions and ActivationPlanOptions
// steps, depending on the asset content of the assets imported.

// The CreateAuxCUOptions step is available if the cuSourceID value
// is an asset. The asset includes an asset relationship to an

// asset that does not have a matching composition unit in the

// business-level application.

/l

// 1f the CreateAuxCUOptions step is available, the selected

// deployable units of the source asset of the "primary" composition
// unit (that is, the composition unit being added) have dependencies
// on other assets for which there are no matching composition units
// in the business-level application. A "secondary" composition unit will be created for each
// of those asset dependencies.

// Each CreateAuxCUOptions row corresponds to one dependency

// relationship declaration. Each row consists of parameter values

// for the dependency relationship. Some parameters are read-only and
// some of them are editable. To edit parameter values, use the same
// approach as that used to edit parameter values in the CUOptions step.

//

// The parameters for this step include:

//

// deplUnit - The name of the deployable unit which has the

// dependency. (Read-only.)

// inputAsset - The asset ID for the source asset of the primary
// composition unit. (Read-only.)

// culD - The name of the secondary composition unit to create.
// matchTarget - Specifies whether the server target for the secondary

// composition unit is to match the server target for

// the primary composition unit. The default value

// is "true". If the value is set to "false", the

// secondary composition unit will be created with no

// target. The target on the secondary composition unit
// can be set at a later time with the editCompUnit

// command.

//

// If the RelationshipOptions step is available, the selected

// deployable units of the source asset of the "primary" composition

// unit (that is, the composition unit being added) have dependencies
// on other assets for which there are matching "secondary" composition
// units in the business-level application. The RelationshipOptions step is much Tike
// CreateAuxCUOptions except that the required secondary composition

// units already exist. Also, each RelationshipOptions row maps one

// deployable unit to one or more secondary composition units, whereas,
// each CreateAuxCUOptions row maps one deployable unit to one

// asset dependency.

/1

// Each RelationshipOptions row corresponds to one deployable unit
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// with one or more dependency relationships and consists of

// parameter values for the dependency relationships. Some parameters
// are read-only and some of them are editable. To edit parameter

// values, use the same approach as that used to edit parameter values
// in the CUOptions step.

//

// The parameters for this step include:

//

// deplUnit - The name of the deployable unit which has the

// dependency. (Read-only.)

// relationship - Composition unit dependencies in the form of a

// 1ist of composition unit IDs. Composition unit

// IDs are separated by a "plus" sign ("+"). Each ID
// can be fully or partially formed as shown with the
// following examples:

// WebSphere:cuname=SharedLibl.jar

// WebSphere:cuname=SharedLib.jar

// SharedLib.jar

// matchTarget - Specifies whether the server target for the secondary
// composition units are to match the server target for
// the primary composition unit. The default value

// is "true". If the value is set to "false", the

// secondary composition unit will be created with no
// target. The target on the secondary composition unit
// can be set at a later time with the editCompUnit

// command.

// The addCompUnit command contains the ActivationPlanOptions step.
// The user can set the ActivationPlanOptions step parameters

// similar to the step parameters for the CUOptions step in

// the previous examples. The arguments for this step include:

// deplUnit — deployable unit URI (read only parameter)

// activationPlan - specifies a Tist of runtime components in the
// format of specname=xxxx

//

// Run the command to add the composition unit.
asyncCmdClientHelper.execute(cmd) ;
System.out.printin("\nCompleted running of command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}
1

} catch (Exception e) {

e.printStackTrace();

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {

public void handleNotification(CommandNotification notification) f{
// Add your own code here to handle the received notification
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System.out.printin("\nEXAMPLE: notification received: " +
notification);

}
What to do next

Start the business-level application to which you added the composition unit. Complete administrative
tasks such as viewing or deleting the composition unit.

Starting a business-level application using programming

You can start a business-level application, which starts each composition unit in that business-level
application. Each composition unit is started on the respective targets on which the business-level
application is deployed.

Before you begin

Before you can start a business-level application, you must have created an empty business-level
application, imported an asset, and added a composition unit to the business-level application.

You can start a business-level application using programming, the administrative console, or the wsadmin
tool.

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

About this task
You must specify the blalD parameter of the business-level application that you start.

Perform the following steps to start a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to set up the command that starts a
business-level application.

The command name is startBLA. The blalD parameter is a required parameter to specify the
business-level application to start.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.
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The command framework asynchronous command model requires this call.
7. Call the asynchronous command client to run the command that starts a business-level application.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, the business-level application is started.
Example

The following example shows how to start a business-level application based on the previous steps. Some
statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class startBLA {
public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local command
// manager. Comment out the lines to and including

// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (
// soapClient);

// to get the soapClient soap client if

// you use the Tocal command manager.

String host = "Tocalhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();
config.put(AdminClient.CONNECTOR_HOST, host);
config.put(AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR TYPE,

AdminClient.CONNECTOR _TYPE_SOAP);
System.out.printin("Config: " + config);
AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);
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// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following Tine to create a local command

// manager:

/1

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler

// for Tistening to command notifications.

// Comment out the following Tine if no further handling
// of command notification is required:
AsyncCmdTaskHandler Tlistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// If no command handler is used, replace the listener with
// null for the AsyncCommandClient object that follows.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printin("\nCreated async command client");

// Create the command that starts the business-level application.

String cmdName = "startBLA";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // Start a business-Tevel
//application using the session created.

System.out.printin("\nCreated " + cmdName);

// (required) Set the blalD parameter.

// Examples of valid formats for the blaID parameter are:
// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter

// accepts an incomplete ID as long as the incomplete

// 1D can resolve to a unique business-level application.
String blaID = "blal";

cmd.setParameter("blaID", blalD);

System.out.printin("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));

// Call asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printIn("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printIn("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
1

// Call the asynchronous command client to run the command command.
asyncCmdClientHelper.execute(cmd);
System.out.printIn("\nCompleted running the command");

// Check the command result.

CommandResult result = cmd.getCommandResult();
if (result != null) {
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if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());

else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();

1
}
} catch (Exception e) {
e.printStackTrace();
}

}
1
package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) f{
// Add your own code here to handle the received notification
System.out.printin("\nEXAMPLE: notification received: " +
notification);

}
What to do next

Your users can access the business-level application that you started.

Stopping a business-level application using programming

You can stop a business-level application, which stops each composition unit in that business-level
application. Each composition unit is stopped on the respective targets on which the business-level
application is deployed.

Before you begin

Before you can stop a business-level application, you must have created an empty business-level
application, imported an asset, added a composition unit to the business-level application, and started the
business-level application.

About this task

You can stop a business-level application using programming, the administrative console, or the wsadmin
tool. This topic describes how to stop a business-level application using programming.

Perform the following steps to stop a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.
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Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

Use the command manager that you created in a previous step Create and set up the command that
stops a business-level application.

The command name is stopBLA. The blalD parameter is a required parameter to specify the
business-level application to stop.

Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
Call the asynchronous command client to run the command that stops a business-level application.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results

After you successfully run the code, the business-level application is stopped.
Example

The following example shows how to stop a business-level application based on the previous steps. Some

statements are split on multiple lines for printing purposes.
package com.ibm.ws.management.application.task;

import

import
import
import
import
import
import
import
import
import

public

java.util.Properties;

com.
com.
com.
com.
com.
com.
com.
com.
com.

ibm.

ibm
ibm

ibm.
ibm.
ibm.
ibm.
ibm.

ibm

websphere.
.websphere.
.websphere.
websphere.
websphere.
websphere.
websphere.
websphere.
.websphere.

class stopBLA {

management.AdminClient;
management.AdminClientFactory;
management.Session;
management.cmdframework.AdminCommand;
management.cmdframework.CommandMgr;
management.cmdframework.CommandResult;
management.cmdframework.CommandStep;
management.cmdframework.TaskCommand;
management.async.client.AsyncCommandClient;

public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the Tocal command
// manager. Comment out the Tines to and including

// CommandMgr cmdMgr =
// soapClient);

CommandMgr.getC1ientCommandMgr (
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// to get the soapClient soap client if
// you use the Tocal command manager.

String host = "Tocalhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();

config.put(AdminClient.CONNECTOR_HOST, host);

config.put(AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printIn("Config: " + config);

AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manage:.

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler

// for listening to command notifications.

// Comment out the following line if no further handling
// of command notification is required.
AsyncCmdTaskHandler Tistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the listener with
// null for the AsyncCommandClient object that follows.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printIn("\nCreated async command client");

// Create the command that stops the business-level application.

String cmdName = "stopBLA";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // Stop a business-level
//application that is using the session created.

System.out.printIn("\nCreated " + cmdName);

// (required) Set the blalD parameter.

// Examples of valid formats for the blaID parameter are:
// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter

// accepts an incomplete ID as long as the incomplete

// 1D can resolve to a unique business-level application.
String blaID = "blal";

cmd.setParameter("blaID", blalD);

System.out.printin("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));
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// Call asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Call the asynchronous command client to run the command command.
asyncCmdClientHelper.execute(cmd) ;
System.out.printin("\nCompleted running of command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}

}
} catch (Exception e) {
e.printStackTrace();
1

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

Complete administrative tasks on the business-level application, such as editing an asset or a composition
unit that is contained in the business-level application.

Checking the status of a business-level application using
programming

You can check the status of an entire business-level application. You can also limit the status to a
particular composition unit of a business-level application, a specific deployment target, or check the status
of the composition unit and the deployment target at the same time.
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Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interface documentation.

Before you can check the status of a business-level application or a composition unit, you must have
created the business-level application.

You can check the status of a business-level application using programming, the administrative console, or
the wsadmin tool.

About this task

You must provide the blalD parameter to specify the business-level application that you are viewing.

Perform the following tasks to view a business-level application using programming.

1.

Connect to the application server.
The command framework allows the administrative command to be created and run with or without

being connected to the application server. This step is optional if the application server is not running.

Create the command manager.

The command manager provides the functionality to create a new administrative command or query

existing administrative commands.
Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive

notifications that the command generates.
Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

Create and set up the getBLAStatus command to check the status of a business-level application.
a. Set the blalD parameter for the business-level application whose status you want to check.

b. Optionally set the culD parameter if you want to narrow the scope of the query to a single
composition unit.

c. Optionally set the targetID if you want to narrow the scope of the query to a single target server

process or cluster.

Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.

Call the asynchronous command client to run the command to check the status of the business-level

application.
You could have created an asynchronous command handler to implement the

AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command

client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by

calling the command.getCommandResult method.
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Results

After you successfully run the code, you can check the status of an entire business-level application, if you
chose not to limit the status. If you chose options to limit the status, you could check the status to a
particular composition unit of a business-level application, a specific deployment target, or check the status
of the composition unit and the deployment target at the same time.

The smallest unit of status data that the system maintains is for a single composition unit in a single server
or cluster member process. Business-level application status can be based on one or more composition
units, each having one or more targets, with targets potentially consisting of clusters with multiple member
processes. Therefore, the single status value returned from the getBLAStatus command is a compilation of
individual status data for all composition units on all target process within the scope of the status query.
The following table describes how individual status data is compiled into a single status value. The term
composition unit instance used in the table refers to a composition unit on a single server or single cluster
member process.

Status Description

ExecutionState.STARTED All composition unit instances within the scope of the
query have been started.

ExecutionState. STOPPED All composition unit instances within the scope of the
query have not been started or have been stopped.

ExecutionState.PARTIAL_START Some composition unit instances within the scope of the
query have a status of ExecutionState. STARTED and
some have a status of ExecutionState. STOPPED.

ExecutionState. UNKNOWN Status data for at least one composition instance within
the scope of the query cannot be obtained for some
reason.

Example

The following example shows how to check the status of a business-level application based on the
previous steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class EditBLA {
public static void main(String[] args) {

try {

// Connect to the application server.

// This step is optional if you use the Tocal command manager.

// Comment out the following Tines to get the soapClient soap client if
// you are going to use the Tocal command manager. You would

// comment out the Tines to and including

// CommandMgr cmdMgr =

// CommandMgr.getClientCommandMgr(soapClient);
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String host = "localhost"; // Change to your host if it is not localhost.
String port = "8880"; // Change to your port number if it is not 8880.

Properties config = new Properties();

config.put(AdminClient.CONNECTOR_HOST, host);

config.put(AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printin("Config: " + config);

AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous Tines to create a client command
// manager if you are using a local command manager.

// Uncomment the following Tine to create a Tocal command

// manager.

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();

System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required.
AsyncCmdTaskHandler Tistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

// This example creates a new session. You can replace the
// following code to use an existing session that has been
// created.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the listener with
// null for the following AsyncCommandClient object.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printIn("\nCreated async command client");

// Create the command.

String cmdName = "getBLAStatus";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // Check the status
// using the session
// created

System.out.printIn("\nCreated " + cmdName);

// Set the required blalD parameter

// Examples of valid formats for the blalD parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

String blaID = "MyBLA"; // Replace the MyBLA value with your
// blalD value.

cmd.setParameter("blaID", blalD);

System.out.printIn("\nSet blaID parameter to "

+ cmd.getParameter("blaID"));

// Optionally set the culD parameter.
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String culD = "myCU.zip"; // Replace the myCU.zip value with your

// culD value.
cmd.setParameter("cuID", culD);
System.out.printIn("\nSet culD parameter to "
+ cmd.getParameter("culD"));

// Optionally set the targetID parameter.
// The format of the targetID parameter for a cluster
// is WebSphere:cluster=clusterl
String targetID = "WebSphere:node=nodel,server=serverl"; // Replace
// this with your targetID value.
cmd.setParameter("targetID", targetID);

System.out.printin("\nSet targetID parameter to "
+ cmd.getParameter("targetID"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted processCommandParameters");
} catch (Throwable th) {
System.out.printIn("Throwing an exception from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Run the command to check the status of the

// business-level application.
asyncCmdClientHelper.execute(cmd) ;
System.out.printin("\nCompleted command execution");

CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand executed successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand executed with " +
"Exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
}

}
package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification.

System.out.printIn("\nEXAMPLE: notification received: " +
notification);
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What to do next

You can use the results of the status check to perform other tasks. For instance, if the results indicate that
none of the composition units is started, you could start the business-level application.

Deleting a business-level application using programming

You can delete a business-level application using programming. You might delete a business-level
application if it is not functioning correctly, it is no longer needed, and so on.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

Before you can delete a business-level application, you must have created an empty business-level
application. You can optionally have added assets or business-level applications as composition units to
the empty business-level application. All the composition units in the business-level application must be
deleted using the deleteCompUnit command before you delete the business-level application. Other
business-level applications cannot reference the business-level application that you are deleting.
Otherwise, the deletion fails.

You can delete a business-level application using programming, the administrative console, or the
wsadmin tool.

About this task

You must specify the blalD parameter of the business-level application that you are deleting. You might
delete a business-level application if it is not functioning correctly, no longer needed, and so on.

Perform the following steps to delete a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager you created in a previous step to create and set up the command that
deletes the business-level application.

The command name is DeleteBLA. The blalD parameter is a required parameter to specify the
business-level application to delete.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
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7. Call the asynchronous command client to run the command that deletes the business-level application.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, the business-level application is deleted.
Example

The following example shows how to delete a business-level application based on the previous steps.
Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class DeleteBLA {
public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the Tines to and including
// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (

// soapClient);

// to get the soapClient soap client if you use the Tocal
// command manager.

String host = "localhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();

config.put (AdminClient.CONNECTOR_HOST, host);

config.put(AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printin("Config: " + config);

AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous Tines to create a client command
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// manager if you are using a local command manager.

// Uncomment the following line to create a Tocal command
// manager:

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printIn("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required:
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Setup the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace Tistener with
// null for the following AsyncCommandClient object:
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printIn("\nCreated async command client");

// Create the command that deletes the business-level application.
String cmdName = "deleteBLA";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // Delete the business-level

// application using the session created.
System.out.printIn("\nCreated " + cmdName);

// Set the blaID parameter to the business-level application to delete.
// Examples of valid formats for the blaID parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an incomplete ID as long as the incomplete
// 1D can resolve to a unique business-level application.

String blaID = "blal";
cmd.setParameter("blaID", blalD);
System.out.printin("\nSet blaID parameter to "

+ cmd.getParameter("blaID"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Call the asynchronous command client to run the command.
asyncCmdClientHelper.execute(cmd) ;
System.out.printIn("\nCompleted running of the command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand ran successfully "
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+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
1

}
} catch (Exception e) {
e.printStackTrace();
}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

You can complete other tasks associated with business-level applications, such as creating other
business-level applications, stopping and starting business-level applications, and so on.

Deleting an asset using programming

You can delete an asset from a business-level application using programming if the asset is not
functioning correctly, the asset is no longer needed, and so on. An asset represents at least one binary file
that implements business logic.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interface documentation.

Before you can delete an asset, you must have imported the asset. All the composition units associated
with the asset must be deleted using the deleteCompUnit command before you delete the asset.
Otherwise, you have to force the deletion. If you do not force the deletion, the deletion fails. If any other

composition units have a dependency on a composition unit being deleted with the force option, the
deletion fails. After all dependencies on the composition unit are removed, the force option succeeds.

About this task

You can delete an asset using programming, the administrative console, or the wsadmin tool. Use this
topic to delete an asset using programming.

You must specify the assetlD parameter of the asset that you are deleting. You might delete an asset if it
is not functioning correctly, it is no longer needed, and so on.

Perform the following tasks to delete an asset using programming.
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1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
deletes an asset.
The command name is deleteAsset. The assetlD parameter is a required parameter to specify the
asset to delete. You can optionally specify the delete parameter to force deletion of an asset if
composition units are still associated with the asset.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
7. Call the asynchronous command client to run the command that deletes an asset.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, the asset is deleted.
Example

The following example shows how to delete an asset from a business-level application based on the
previous steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;
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public class DeleteAsset {
public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the Tines to and including
// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (

// soapClient);

// to get the soapClient soap client if you use the Tocal
// command manager.

String host = "localhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();
config.put (AdminClient.CONNECTOR HOST, host);
config.put (AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR_TYPE,

AdminClient.CONNECTOR TYPE_SOAP);
System.out.printin("Config: " + config);
AdminClient soapClient =

AdminClientFactory.createAdminClient (config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous Tines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager.

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printIn("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required.
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace listener with
// null for the following AsyncCommandClient object:
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printIn("\nCreated async command client");

// Create the command that deletes the asset.
String cmdName = "deleteAsset";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // Delete the asset from the

// business-Tevel application using the session created.
System.out.printin("\nCreated " + cmdName);

// Set the assetID parameter to the asset that is to be

// deleted.
// Examples of valid formats for the assetID parameter are:
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// - aName
// - assetname=aName
// - WebSphere:assetname=aName
// This parameter will accept an incomplete ID as long as
// the incomplete ID can resolve to a unique asset
// in the business-level application.
String assetID = "asl";
cmd.setParameter("assetID ", assetID );
System.out.printIn("\nSet assetID parameter to "

+ cmd.getParameter("assetID "));
// Uncomment the following line of code to set the force parameter
// to force the deletion even if there are composition units
// associated with this asset.
//

// cmd.setParameter("force", "true");

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Call the asynchronous command client to run the command.
asyncCmdClientHelper.execute(cmd) ;
System.out.printIn("\nCompleted running the command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
}

}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) f{
// Add your own code here to handle the received notification

System.out.printin("\nEXAMPLE: notification received: " +
notification);
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What to do next

You can complete other steps associated with assets in business-level applications, such as adding or
deleting other assets, listing assets, exporting assets, and so on.

Deleting a composition unit using programming

You can delete a composition unit from a business-level application if the composition unit is not
functioning correctly, the composition unit is no longer needed, and so on. A composition unit is typically
created from a business-level application or an asset and contains configuration information that makes
the asset runnable.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

Before you can delete a composition unit, you must have created an empty business-level application,
imported an asset, and added a composition unit to the business-level application. If other composition
units depend on the composition unit that you are deleting and you do not use the force option, the
deletion fails.

About this task

You can delete a composition unit using programming, the administrative console, or the wsadmin tool.
This topic describes how to delete a composition unit using programming.

You must provide the blalD and culD parameters to specify the composition unit that you are deleting from
the business-level application.

Perform the following tasks to delete a composition unit using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
deletes a composition unit.

The command name is deleteCompUnit. The blalD and culD parameters are required parameters. The
culD parameter is used to specify the composition unit to delete from the business-level application,
which is specified with the blalD. You can optionally provide the force parameter to force the deletion if
other composition units depend on this composition unit.
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6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
7. Call the asynchronous command client to run the command that deletes a composition unit.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, the composition unit is deleted.
Example

The following example shows how to delete a composition unit from a business-level application based on
the previous steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class DeleteCompUnit {
public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the lines to and including

// CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);
// to get the soapClient soap client if

// you use the Tocal command manager.

String host = "Tocalhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();

config.put(AdminClient.CONNECTOR_HOST, host);

config.put(AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printin("Config: " + config);

AdminClient soapClient =

AdminClientFactory.createAdminClient (config);
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// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager:

/!

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following Tine if no further handling
// of command notification is required:
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace Tistener with
// null for the following AsyncCommandClient object:
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient(session, Tistener);
System.out.printIn("\nCreated async command client");

// Create the command that deletes the composition unit.

String cmdName = "deleteCompUnit";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // Delete the composition unit from
// the business-Tevel application
// using the session created.

System.out.printin("\nCreated " + cmdName);

// Set the blalD parameter to the business-Tevel application with
// the composition unit to delete.

// Examples of valid formats for the blaID parameter are:
// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an incomplete ID as long as

// the incomplete ID can resolve to a unique

// business-level application.

String blaID = "blal";

cmd.setParameter("blaID", blalD);

System.out.printin("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));

// Set the culD parameter to the composition unit that is to be
// deleted.

// Examples of valid formats for the culD parameter are:

// - name

// - cuname=name

// - WebSphere:cuname=name

// This parameter accepts an incomplete ID as Tong as the

// incomplete ID can resolve to a unique composition unit

// within the business-Tevel application.
String culD = "cul";
cmd.setParameter("cuID", culD);
System.out.printIn("\nSet culD parameter to "

+ cmd.getParameter("culD"));
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// Uncomment the following 1ine of code to set the force parameter
// to force the deletion even if other composition units depend

// on this composition unit.

//

// cmd.setParameter("force", "true");

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Call the asynchronous command client to run the command.
asyncCmdClientHelper.execute(cmd) ;
System.out.printIn("\nCompleted running of the command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());
1
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}
1
} catch (Exception e) {
e.printStackTrace();
1

}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) f{
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

You can complete other tasks associated with the business-level application, such as adding or deleting

other composition units, listing composition units, and so on.
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Exporting an asset using programming

You can export an asset from the current session so that you can back up the asset, import the asset to
another session, and so on. An asset represents at least one binary file that implements business logic.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

This task assumes that you have already imported an asset.

About this task

You can export an asset using programming, the administrative console, or the wsadmin tool. This topic
describes how to export an asset using programming.

You must provide an assetlD parameter value and a file name parameter value to export an asset. The
assetlD parameter identifies the asset you want to export. An asset ID can take a number of forms. The
list below shows various forms for an asset named asset1.jar.

» assetl.jar
» assetname=asseti.jar
» WebSphere:assetname=asset1.jar

The filename parameter specifies a file system file name and location for the exported asset. Specify a
fully qualified file path for the file name parameter because the results with relative path names are
unpredictable. If you specify a file name parameter of a file that already exists, the file is overwritten with
the exported asset.

Perform the following tasks to export an asset from a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
exports an asset.

The command name is exportAsset. The assetlD and filename parameters are required parameters to
specify the asset to export and the file name and directory where the asset is exported.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
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7. Call the asynchronous command client to run the command that exports an asset.
You might have created an asynchronous command handler to implement the

AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command

client listens to command notifications and forwards the notifications to the handler. The handler

performs any necessary actions while waiting for the command to complete.
8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by

calling the command.getCommandResult method.
Results
After you successfully run the code, the asset is exported.

Example

The following example shows how to export an asset from a business-level application based on the

previous steps.

Some statements are split on multiple lines for printing purposes.
package com.ibm.ws.management.application.task;

import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class ExportAsset {
public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the lines to and including
// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (

// soapClient);

// to get the soapClient soap client if you use the Tocal
// command manager.

String host = "Tocalhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();
config.put(AdminClient.CONNECTOR_HOST, host);
config.put(AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR TYPE,

AdminClient.CONNECTOR _TYPE_SOAP);
System.out.printin("Config: " + config);
AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);
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// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager:

/!

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following Tine if no further handling
// of command notification is required:
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the following Tistener with
// null for the AsyncCommandClient object.

AsyncCommandClient asyncCmdClientHelper = new

AsyncCommandClient (session, listener);

System.out.printin("\nCreated async command client");

// Create command that exports the asset.
String cmdName = "exportAsset";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // Export as asset

// using the session created.
System.out.printin("\nCreated " + cmdName);

// (required) Set the assetID parameter to the composition
// unit that you are exporting.

// Examples of valid formats for the assetID parameter are:
// - aName

// - assetname=aName

// - WebSphere:assetname=aName

// This parameter accepts an incomplete ID as long as

// the incomplete ID can resolve to a unique asset

// within the business-level application.

String assetID = "test5.zip";

cmd.setParameter("assetID", assetID);

System.out.printin("\nSet assetID parameter to "
+ cmd.getParameter("assetID"));

// Set the file name for the asset to be exported. Use a
// fully qualified path name. An existing file with the specified
// name will be overwritten.

DownloadFile filename = new DownloadFile("/assets/assetl.zip");

cmd.setParameter("filename", filename);

System.out.printin("\nSet filename parameter to "
+ cmd.getParameter("filename"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printIn("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
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"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Call the asynchronous command client to run the command.
asyncCmdClientHelper.execute(cmd) ;
System.out.printIn("\nCompleted running of the command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand ran successfully "
+ "with result\n" + result.getResult());
1
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
1

}
} catch (Exception e) {
e.printStackTrace();
}

}
package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) f{
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);
1
What to do next

You can import the asset to another session. You can complete other tasks associated with assets, such
as listing assets, and editing assets.

Listing assets using programming

You can list the assets that have been imported so that you can do further asset administration, such as
deleting or exporting assets. An asset represents at least one binary file that implements business logic.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

You can list assets using programming, the administrative console, or the wsadmin tool.
About this task

You can list assets using programming, the administrative console, or the wsadmin tool. This topic
describes how to list assets using programming.
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When you list assets, all the assets are listed unless you set the assetID to specify the asset that you
want to list. You can optionally include deployable units or a description of the assets when you list the
assets. After you list the assets, you can use the information to do further administration, such as deleting
or exporting assets.

Perform the following tasks to list assets using programming.

1.

Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.
Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
lists assets.

The command name is listAssets. You can optionally set the assetlD parameter to query for assets
that match the ID. You can also optionally set the includeDescription parameter and the
includeDeplUnit parameter to include the display of the asset description and its deployable units.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.

7. Call the asynchronous command client to list the asset.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results

After you successfully run the code, a list of assets is displayed.

Example

The following example shows how to list the assets based on the previous steps. Some statements are
split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;

import java.util.Properties;

import com.ibm.websphere.management.AdminClient;
import com.ibm.websphere.management.AdminClientFactory;
import com.ibm.websphere.management.Session;
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import com
import com
import com
import com

.ibm.websphere.management.cmdframework.AdminCommand;
.ibm.websphere.management.cmdframework.CommandMgr;
.ibm.websphere.management.cmdframework.CommandResult;
.ibm.websphere.management.async.client.AsyncCommandClient;

public class ListAssets {

public

static void main(String[] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the lines to and including
// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr(

// soapClient);

// to get the soapClient soap client if you use the local
// command manager.

String host = "Tocalhost";
String port = "8880"; // Change to your port number if
// it is not 8880.

Properties config = new Properties();
config.put(AdminClient.CONNECTOR_HOST, host);
config.put(AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR TYPE,
AdminClient.CONNECTOR TYPE_SOAP);
System.out.printin("Config: " + config);
AdminClient soapClient =
AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous Tines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a Tocal command

// manager:

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required.
AsyncCmdTaskHandler Tistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// If no command handler is used, replace Tistener with
// null for the AsyncCommandClient object.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printIn("\nCreated async command client");

// Create the command that lists the assets.
String cmdName = "listAssets";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // Tist all the assets
// using the session created.
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System.out.printIn("\nCreated " + cmdName);

// Optionally set the assetID parameter.

// Uncomment the following code to set the assetID parameter to

// only list the asset with the ID specified, otherwise all

// assets are listed. Change the assetID parameter according to your
// scenario.

// Examples of valid formats for the assetID parameter are:

// - aName

// - assetname=aName

// - WebSphere:assetname=aName

// A11 assets that match the ID specification are listed.

// The ID must include at least the asset name.
// String assetID = "assetl.zip";

// cmd.setParameter("assetID", assetID);
//System.out.printin("\nSet assetID parameter to "

// + cmd.getParameter("assetID"));

// Optionally include a description by setting

// the includeDescription parameter to true or false.
String includeDescription = "true";
cmd.setParameter("includeDescription”, includeDescription);

System.out.printin("\nSet includeDescription parameter to "
+ cmd.getParameter("includeDescription"));

// Optionally include deployable units by setting

// the includeDeplUnit parameter to true or false.
String includeDeplUnit = "false";
cmd.setParameter("includeDeplUnit", includeDeplUnit);

System.out.printin("\nSet includeDeplUnit parameter to "
+ cmd.getParameter("includeDeplUnit"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Run the command to list assets.
asyncCmdClientHelper.execute(cmd) ;
System.out.printIn("\nCompleted running of the command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
1

238 Developing and deploying applications



package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) f{
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

You can complete other tasks associated with assets, such as deleting, editing, and exporting assets.

Listing composition units using programming

You can list the composition units for a specific business-level application so that you can complete further
composition unit administration, such as deleting or adding composition units. A composition unit is
typically created from a business-level application or an asset and contains configuration information that
makes the asset runnable.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

Before you can list composition units, you must have imported an asset, created an empty business-level
application, and added a composition unit to the business-level application.

About this task

You can list composition units using programming, the administrative console, or the wsadmin tool. This
topic describes how to list composition units using programming.

You must provide the blalD parameter to specify the business-level application to list the composition unit.
When you list composition units for a business-level application, you can optionally list the type for each
composition unit and the description for each composition unit that has a description. You can use the list
to complete further administration, such as deleting or exporting composition units.

Perform the following tasks to list composition units for a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.
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Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.
An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
lists composition units.
The command name is listCompUnits. The blalD parameter is a required parameter that you use to
specify the business-level application to list the composition units. You can optionally set the
includeDescription parameter to display the composition unit descriptions. You can also optionally set
the includeType parameter to display the composition unit types.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
7. Call the asynchronous command client to list the composition units.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, a list of composition units for a business-level application is displayed.
Example

The following example shows how to list the composition units of a specific business-level application
based on the previous steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class ListCompUnits {
public static void main(String[] args) {
try {
// Connect to the application server.
// This step is optional if you use the Tocal
// command manager. comment out the lines to and including

// CommandMgr cmdMgr = CommandMgr.getClientCommandMgr (
// soapClient);
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// to get the soapClient soap client if you use the local
// command manager.

String host = "Tocalhost";
String port = "8880"; // Change to your port number if
// it is not 8880.

Properties config = new Properties();

config.put(AdminClient.CONNECTOR_HOST, host);

config.put(AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,

AdminClient.CONNECTOR TYPE_SOAP);

System.out.printIn("Config: " + config);

AdminClient soapClient =
AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager:

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required:
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1If no command handler is used, replace the Tistener with
// null for the AsyncCommandClient object.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printin("\nCreated async command client");

// Create the command that lists the composition units.
String cmdName = "TlistCompUnits";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // List all the compostion units
// for the business-Tlevel application
// with this session ID.
System.out.printIn("\nCreated " + cmdName);

// Set the blaID parameter to the business-level application

// whose composition units are listing.

// Examples of valid formats for the blalD parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an incomplete ID as long as the incomplete
// 1D can resolve to a unique business-level application.

String blaID = "blal";

cmd.setParameter("blaID", blalD);

System.out.printin("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));
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// Optionally include descriptions for each composition unit
// that has a description by setting

// the includeDescription parameter to true or false.

String includeDescription = "true";
cmd.setParameter("includeDescription", includeDescription);

System.out.printin("\nSet includeDescription parameter to "

+ cmd.getParameter("includeDescription"));
// Optionally include types for each composition unit
// by setting the includeType parameter to true or false.
String includeType = "true";
cmd.setParameter("includeType", includeType);

System.out.printIn("\nSet includeType parameter to "
+ cmd.getParameter("includeType"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Run the command to Tist the composition units.
asyncCmdClientHelper.execute(cmd);
System.out.printIn("\nCompleted running of command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification

System.out.printin("\nEXAMPLE: notification received: " +
notification);
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What to do next

Now that you have listed the composition units for a business-level application, you can complete other
tasks associated with composition units, such as adding or deleting composition units.

Listing business-level applications using programming

You can list the business-level applications of a session so that you can complete further business-level
application administration such as deleting a business-level application. A business-level application is an
administrative model that captures the definition of an enterprise-level application so that you can perform
specific business functions, such as accounting.

Before you begin

Before you can list business-level applications of a session, you must have created an empty
business-level application.

About this task

You can list business-level applications of a session using programming, the administrative console, or the
wsadmin tool. This topic describes how to list business-level applications using programming.

List all the business-level applications of a session unless you set the blatlD parameter to specify the
business-level application that you want to list. You can optionally list the business-level applications with a
description for those that have a description if you set the includeDescription parameter to true. After you
list the business-level applications, you can use the information to do further administration, such as
starting or deleting business-level applications.

Perform the following tasks to list business-level applications of a session using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
lists business-level applications of a session.

The command name is listBLAs. You can optionally set the blalD parameter to query for business-level
applications that match the ID. You can optionally set the includeDescription parameter to display the
business-level application descriptions.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
7. Call the asynchronous command client to list the business-level applications of a session.
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You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, a list of business-level applications for a session is displayed.
Example

The following example shows how to list the business-level applications of a session based on the
previous steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class ListBLAs {
public static void main(String[] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the lines to and including
// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (

// soapClient);

// to get the soapClient soap client if you use the Tocal
// command manager.

String host = "Tocalhost";
String port = "8880"; // Change to your port number if
// it is not 8880.

Properties config = new Properties();
config.put(AdminClient.CONNECTOR_HOST, host);
config.put(AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR TYPE,
AdminClient.CONNECTOR TYPE_SOAP);
System.out.printin("Config: " + config);
AdminClient soapClient =
AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager:

/1
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// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following 1ine if no further handling
// of command notification is required:
AsyncCmdTaskHandler Tistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace Tistener with
// null for the AsyncCommandClient object.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, Tistener);
System.out.printin("\nCreated async command client");

// Create the command that 1ists the business-level applications.

String cmdName = "1istBLAs";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // list all the business-Tevel applications
// using the session created.

System.out.printin("\nCreated " + cmdName);

// Optionally set the blaID parameter.

// Uncomment the following code to set the blaID parameter to

// only list the business-level applications with the ID specified. Otherwise all
// business-level applications are listed. Change the blaID parameter according
// to your scenario.

// Examples of valid formats for the blalD parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// A11 business-level applications that match the ID specification

// are listed. The ID must include at Teast the business-Tevel

// application name.

// String blaID = "blal";

// cmd.setParameter("blaID", blalD);

//System.out.printin("\nSet blaID parameter to "
// + cmd.getParameter("blaID"));

// Optionally include a description by setting

// the includeDescription parameter to true instead of false.
String includeDescription = "true";
cmd.setParameter("includeDescription”, includeDescription);

System.out.printIn("\nSet includeDescription parameter to "
+ cmd.getParameter("includeDescription"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters(cmd) ;
System.out.printIn("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
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// Run the command to list business-level applications.
asyncCmdClientHelper.execute(cmd) ;
System.out.printin("\nCompleted running of the command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());

else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
1
}
} catch (Exception e) {
e.printStackTrace();
}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

You can complete other tasks associated with business-level applications, such as deleting, starting, or
stopping business-level applications.

Editing a composition unit using programming

You can edit the configuration information in a composition unit of a business-level application if, for
example, you want to change certain modules in the composition unit that are configured to run in specific
targets. A composition unit is typically created from a business-level application or an asset and contains
configuration information that makes the asset runnable.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

Before you can edit a composition unit of a business-level application, you must have created an empty

business-level application, imported an asset, and added a composition unit to the business-level
application.
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About this task

You can edit a composition unit of a business-level application using programming, the administrative
console, or the wsadmin tool. This topic describes how to edit a composition unit of a business-level
application using programming.

You must provide the blalD and culD parameters to specify the composition unit of the business-level
application that you are editing.

Perform the following tasks to edit a composition unit of a business-level application using programming.
1. Connect to the application server.
The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.
2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
edits a composition unit of a business-level application.

The command name is editCompUnit. Use the required blalD and culD parameters to specify the
composition unit of the business-level application that you are editing.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
7. Set up the command step parameters.

You can edit various composition unit information through steps. The CUOptions step contains data
about the composition unit such as its description, starting weight, and start and restart behavior. The
MapTargets step contains target information about where to deploy the composition unit. The
RelationshipOptions step contains shared library composition units on which this composition unit has
a dependency. The ActivationPlanOptions step allows you to change runtime components for each
deployable unit. You can edit parameters in these steps.

8. Call the asynchronous command client to run the command that edits a composition unit of a
business-level application.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

9. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.
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Results
After you successfully run the code, the composition unit of a business-level application is edited.
Example

The following example shows how to edit a composition unit of a business-level application based on the
previous steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class EditCompUnit {
public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the Tines to and including
// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (

// soapClient);

// to get the soapClient soap client if you use the Tocal
// command manager.

String host = "localhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();

config.put (AdminClient.CONNECTOR_HOST, host);

config.put (AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printin("Config: " + config);

AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a Tocal command manager.

// Uncomment the following line to create a local command

// manager:

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printIn("\nCreated command manager");

// Optionally create an asynchronoous command handler.

// Comment out the following Tine if no further handling
// of command notification is required:
AsyncCmdTaskHandler Tlistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.
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// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the listener with
// null for the following AsyncCommandClient object:
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printin("\nCreated async command client");

// Create the command that edits the composition unit.
String cmdName = "editCompUnit";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // Edit a certain composition
// unit of a business-level using the session created.
System.out.printIn("\nCreated " + cmdName);

// Set the blaID parameter.

// Examples of valid formats for the blaID parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an incomplete ID as Tong as the

// incomplete ID can resolve to a unique business-level application.
String blaID = "blal";

cmd.setParameter("blaID", blalD);

System.out.printin("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));

// Set the culD parameter.

// Examples of valid formats for the culD parameter are:
// - name

// - cuname=name

// - WebSphere:cuname=name

// This parameter accepts an incomplete ID as long as the
// incomplete ID can resolve to a unique composition unit
// within the business-level application.

String culD = "cul";

cmd.setParameter("cuID", culD);

System.out.printin("\nSet culD parameter to "
+ cmd.getParameter("culD"));

// Call the asynchronous client helper to process the command parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printIn("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Set up the step parameters for the CUOptions step.

// The CUOptions step contains the following arguments that can be edited:
// description - description for the composition unit

// startingWeight - starting weight for the composition unit

// within the business-Tevel application.
// startedOnDistributed - to start composition unit upon distribution
// to target nodes.

// Valid values are true, false.
// restartBehaviorOnUpdate - restart behavior for the composition
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// unit when the compostion unit is updated.
// Valid values are DEFAULT, ALL, NONE

String stepName = "CUOptions";

CommandStep step = ((TaskCommand) cmd).gotoStep(stepName);

// Composition Unit description:
String description = "cul description changed in editCompUnit";

for(int i = 0; i < step.getNumberOfRows(); i++)
// Use the following code to change the composition unit step parameters
// of the CUOptions step. Change your set of step parameters
// as required by your scenario.

// For example, set the description.

step.setParameter("description”, description, 1i);

System.out.printin("\nSet description parameter to " +
step.getParameter("description”, i));

}

// Set up the step parameters for the MapTargets step
stepName = "MapTargets";
step = ((TaskCommand) cmd).gotoStep(stepName);

// In this step the server parameter is required.
// server - target(s) to deploy the composition unit. The default is serverl.

// To add an additional target to the existing

// target, add a prefix to the target with a "+". To

// delete an existing target, add a prefix to the

// target with a "#". To replace the existing

// target, use the regular syntax as in the addCompUnit example.

// Example: server = "#serverl+server2";
String server = "serverl";

for(int i = 0; i < step.getNumberOfRows(); i++) {
// Use the following code to set the server parameter of the MapTargets step.
// Change your set of step parameters as required by your
// scenario.

// For example, set the server.

step.setParameter("server", server, 1i);

System.out.printin("\nSet server parameter to " +
step.getParameter("server", i));

}

// 1f the RelationshipOptions step is available, the selected

// deployable units of the source asset of the "primary" composition

// unit (that is, the composition unit being added) have dependencies

// on other assets for which there are matching "secondary" composition

// units in the business-Tevel application. The RelationshipOptions step is much Tike
// CreateAuxCUOptions except that the required secondary composition

// units already exist. Also, each RelationshipOptions row maps one

// deployable unit to one or more secondary composition units, whereas,

// each CreateAuxCUOptions row maps one deployable unit to one

// asset dependency.

// Each RelationshipOptions row corresponds to one deployable unit

// with one or more dependency relationships and consists of

// parameter values for the dependency relationships. Some parameters
// are read-only and some of them are editable. To edit parameter

// values, use the same approach as that used to edit parameter values
// in the CUOptions step.

//

// The parameters for this step include:

//

// deplUnit — The name of the deployable unit which has the
// dependency. (Read-only.)

// relationship — Composition unit dependencies in the form of a
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// 1ist of composition unit IDs. Composition unit

// IDs are separated by a "plus" sign ("+"). Each ID
// can be fully or partially formed as shown with the
// following examples:

// WebSphere:cuname=SharedLibl.jar

// WebSphere:cuname=SharedLib. jar

// SharedLib.jar

// matchTarget - Specifies whether the server target for the secondary
// composition units are to match the server target for
// the primary composition unit. The default value

// is "true". If the value is set to "false", the

// secondary composition unit will be created with no

// target. The target on the secondary composition unit
// can be set at a Tater time with the editCompUnit

// command.

// for(int i = 0; i < step.getNumberOfRows(); i++) {
// Use the following if statement to set the relationship and matchTarget parameters
// of the RelationshipOptions step. Change your set of
// step parameters as required by your scenario.

// Uncomment the following code to match the deplUnit and then set
// the relationship differently.

//String deplUnit = (String) step.getParameter("deplUnit",

// i)s

//if (deplUnit.equals("al.jar") {
// For example, change the relationship for the al.jar file.
//step.setParameter("relationship", relationship, i);
//System.out.printin("\nSet relationship parameter " +
// "to " + step.getParameter("relationship", i));

// For example, change matchTarget.
//step.setParameter("matchTarget", matchTarget, i);
//System.out.printin("\nSet matchTarget parameter to "+
// step.getParameter("matchTarget", i));
/1}
/1}

// The addCompUnit command contains thr ActivationPlanOptions step.

// The user can set the ActivationPlanOptions step parameters similar to
// the step parameters for the CUOptions step in the previous examples.
// The arguments for this step include:

// deplUnit — deployable unit URI (read only parameter)

// activationPlan - specifies a Tist of runtime components in the

// format of specname=xxxx

// Run the command command to edit the composition unit.
asyncCmdClientHelper.execute(cmd) ;
System.out.printin("\nCompleted running of the command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}
1
} catch (Exception e) {
e.printStackTrace();
!

}
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package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

After you edit the composition unit, you can run the updated business-level application.

Editing an asset using programming

You can edit the information of an asset such as its destination location, its relationship with other assets,
and so on. An asset represents at least one binary file that implements business logic.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

Before you can edit an asset, you must have imported an asset.

You can edit an asset of a business-level application using programming, the administrative console, or
the wsadmin tool.

About this task

You can edit an asset of a business-level application using programming, the administrative console, or
the wsadmin tool. This topic describes how to edit an asset of a business-level application using
programming.

You must provide the assetID parameter to specify the asset that you are editing.

Perform the following tasks to edit an asset of a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.
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An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command that
edits an asset.

The command name is editAsset. The assetlD parameter is a required parameter to specify the asset
that you are editing.

6. Call the asynchronous command client to process the command parameters.
7. Set up the command step parameters.

The AssetOptions step contains data about the asset such as its description, file permission, and
relationship with other assets. You can edit various parameters in the AssetOptions step.

8. Call the asynchronous command client to run the command that edits an asset of a business-level
application.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

9. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, the asset of a business-level application is edited.
Example

The following example shows how to edit an asset of a business-level application based on the previous
steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class EditAsset {
public static void main(String [] args) {
try {
// Connect to the application server.
// This step is optional if you use the Tocal
// command manager.
// Comment out the Tines to and including get the
// soapClient soap client if you use the local command manager.

// Comment out the lines to and including
// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (
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// soapClient);

// to get the soapClient soap client if you use the

// local command manager.

String host = "localhost";

String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();

config.put (AdminClient.CONNECTOR_HOST, host);

config.put (AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printIn("Config: " + config);

AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager:
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager.

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printIn("\nCreated command manager");

// Optionally create async command handler.

// Comment out the following line if no further handling
// of command notification is required:
AsyncCmdTaskHandler Tistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the Tistener with
// null for the following AsyncCommandClient object.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, Tistener);
System.out.printIn("\nCreated async command client");

// Create the command that edits the asset.
String cmdName = "editAsset";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // Edit an imported asset

// using the session created.
System.out.printIn("\nCreated " + cmdName);

// Set the assetID parameter

// Examples of valid formats for the assetID parameter are:
// - aName

// - assetname=aName

// - WebSphere:assetname=aName

// This parameter accepts an incomplete ID as long as

// the incomplete ID can resolve to a unique asset.

String assetID = "assetl.zip";

cmd.setParameter("assetID", assetID);

System.out.printin("\nSet assetID parameter to "
+ cmd.getParameter("assetID"));

// Call the asynchronous client helper to process parameters.

try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
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System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Set up the step parameters for the AssetOptions step.
String stepName = "AssetOptions";
CommandStep step = ((TaskCommand) cmd).gotoStep(stepName);

// Asset description:
String description = "asset for testing";

// destination of deployed asset
String destinationUrl = "/myInstalledAssets/assetl.zip";

// Asset type aspect:
String typeAspect = "spec=sharedlib";

// Asset validation:
String validate = "yes";

// Permission of files:
String filePermission = ".*\\.d11=755";

// Asset relationship:
String relationship = "";

for (int i = 0; i < step.getNumberOfRows(); i++) {
// The following lines set the description and typeAspect
// step parameters. There are other step parameters
// in the AssetOptions step in the following comments. Change your set
// of step parameters as required by your scenario.

// For example, set description

step.setParameter("description", description, 1i);

System.out.printIn("\nSet description parameter to " +
step.getParameter("description", i));

// For example, set the typeAspect parameter.

// Format of a typeAspect is:

// WebSphere:spec=xxx,version=n.n+

// WebSphere:spec=xxx,version=n.n

step.setParameter("typeAspect", typeAspect, i);

System.out.printIn("\nGet typeAspect: " +
step.getParameter("typeAspect", i));

// For example, set the destination parameter.

step.setParameter("destination", destination, 1i);

System.out.printin("\nSet destination parameter to " +
step.getParameter("destination", i));

// For example, set the validate parameter.

step.setParameter("validate", validate, 1);

System.out.printin("\nSet validate parameter to " +
step.getParameter("validate", i));

// For example, set the filePermission perameter.

step.setParameter("filePermission", filePermission, 1);

System.out.printin("\nSet filePermission parameter to " +
step.getParameter("filePermission", i));

// For example, set relationship.
step.setParameter("relationship", relationship, i);
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System.out.printIn("\nSet relationship paramter to " +
step.getParameter("relationship", 1));

}

// Run the command to edit the asset.
asyncCmdClientHelper.execute(cmd);
System.out.printIn("\nCompleted running of command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);
1
What to do next

After you edit the asset, you can add the asset as a composition unit to a business-level application, or
export the asset.

Editing a business-level application using programming

You can edit the information of a business-level application such as its description. A business-level
application is an administrative model that captures the entire definition of an enterprise-level application.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

Before you can edit a business-level application, you must have created a business-level application.

You can edit a business-level application using programming, the administrative console, or the wsadmin
tool.
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About this task
You must provide the blalD parameter to specify the business-level application that you are editing.

Perform the following tasks to edit a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create the command that edits a
business-level application.

The command name is editBLA. Use the required blalD parameter to specify the business-level
application that you are editing.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
7. Set up the command step parameter by setting the description parameter.

The BLAOptions step contains a description for the business-level application. You can edit the
description parameter in the BLAOptions step.

8. Call the asynchronous command client to run the command to edit a business-level application.

You could have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

9. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results
After you successfully run the code, the business-level application is edited.
Example

The following example shows how to edit a business-level application based on the previous steps. Some
statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

Chapter 8. Administering business-level applications using programming 257



import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.cmdframework.CommandStep;

import com.ibm.websphere.management.cmdframework.TaskCommand;

import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class EditBLA {

public static void main(String[] args) {
try {

// Connect to the application server.

// This step is optional if you use the local command manager.

// Comment out the following Tines to get the soapClient SOAP client if
// you are going to use the local command manager. You would

// comment out the Tines to and including

// CommandMgr cmdMgr =

// CommandMgr.getClientCommandMgr(soapClient);

String host = "localhost"; // Change to your host if it is not localhost.
String port = "8880"; // Change to your port number if it is not 8880.

Properties config = new Properties();

config.put (AdminClient.CONNECTOR_HOST, host);

config.put (AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printin("Config: " + config);

AdminClient soapClient =

AdminClientFactory.createAdminClient (config);

// Create command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following Tine to create a local command

// manager.

/!

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();

System.out.printIn("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required.
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

// This example creates a new session. You can replace the
// code below to use an existing session that has been

// created.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the listener with
// null for the following AsyncCommandClient object.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, listener);
System.out.printIn("\nCreated async command client");
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// Create the command that edits the business-level application.

String cmdName = "editBLA";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // Edit an existing business-Tevel
// application using the session
// created.

System.out.printIn("\nCreated " + cmdName);

// Set the blaID parameter (required).

// Examples of valid formats for the blaID parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an incomplete ID as long as the incomplete
// 1D can resolve to a unique business-level application.

String blaID = "blal"; // Replace blal with your value of the blalD.
cmd.setParameter("blaID", blalD);

System.out.printin("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printIn("Throwing an exception from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Set up the step parameters for the BLAOptions step.

// The only step parameter you can edit is description.
String stepName = "BLAOptions";

CommandStep step = ((TaskCommand) cmd).gotoStep(stepName);

// Edit the business-level application description.
String description = "bla for testing"; // Replace with your value.

for (int i = 0; i < step.getNumberOfRows(); i++) {
// The following lines set the description
// step parameter.
step.setParameter("description", description, i);
System.out.printin("\nSet description parameter to " +
step.getParameter("description”, i));

}

// Run the command to edit the business-level application.
asyncCmdClientHelper.execute(cmd) ;
System.out.printin("\nCompleted command execution");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand executed successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand executed with " +
"Exception");
result.getException().printStackTrace();
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} catch (Exception e) {
e.printStackTrace();
}

}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification.
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

After you edit the business-level application, you can continue administration of business-level
applications. You can do such things as start and stop a business-level application, delete a business-level
application, add a composition unit to a business-level application, and so on.

Updating an asset using programming

You can update an asset by adding, deleting, or updating a single file or Java Platform, Enterprise Edition
(Java EE) module, or by merging multiple files or Java EE modules into an asset. You can also update an
asset by replacing the entire asset.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interface documentation.

Before you can update an asset, you must have imported the asset.

You can update an asset using programming, the administrative console, or the wsadmin tool.
About this task

You must specify the assetlD parameter of the asset that you are updating. In addition, you must specify
the operation parameter. Wether or not you must specify the contents and contenturi parameters depends
on the operation that you specify.

You modify one or more files or module files of an asset with this task. You also update the asset binary
file, but do not update the composition units that the system deploys with this asset as a backing object.

Perform the following tasks to update an asset using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.
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Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is

passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Create and set up the command that updates an asset.
a. Set the parameter for the asset that you are updating.

b. Set the operation parameter.

c. Set the contents parameter unless the operation is set to delete.
d. Set the contenturi parameter if the operation is set to add, update, or addupdate.

6. Call the processCommandParameters method in the asynchronous command client to process the

command parameters.
The command framework asynchronous command model requires this call.
7. Call the asynchronous command client to run the command to update an asset.

You could have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results

After you successfully run the code, the asset is updated.

Example

The following example shows how to update an asset based on the previous steps. Some statements are
split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;

import

import
import
import
import
import
import
import
import
import

public

java.util.Properties;

com.
com.
com.
com.
com.
com.
com.
com.
com.

ibm.

ibm
ibm

ibm.
ibm.
ibm.
ibm.
ibm.

ibm

websphere.
.websphere.
.websphere.
websphere.
websphere.
websphere.
websphere.
websphere.
.websphere.

class EditBLA {

management.
management.
.Session;
management.
.cmdframework.CommandMgr;
management.
.cmdframework.CommandStep;
management.
management.

management
management

management

AdminClient;
AdminClientFactory;

cmdframework.AdminCommand;
cmdframework.CommandResult;

cmdframework.TaskCommand;
async.client.AsyncCommandClient;

public static void main(String[] args) {

try {

// Connect to the application server.
// This step is optional if you use the local command manager.
// Comment out the following lines to get soapClient soap client if
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// you are going to use the local command manager.
// Comment out the Tines to and including

// CommandMgr cmdMgr =

// CommandMgr.getClientCommandMgr(soapClient);

String host
String port

"Tocalhost"; // Change to your host if it is not localhost.
"8880"; // Change to your port number if it is not 8880.

Properties config = new Properties();
config.put (AdminClient.CONNECTOR_HOST, host);
config.put(AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR TYPE,

AdminClient.CONNECTOR _TYPE_SOAP);
System.out.printin("Config: " + config);
AdminClient soapClient =

AdminClientFactory.createAdminClient (config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following Tine to create a local command

// manager.

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();

System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required.
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

// This example creates a new session. You can replace the
// following code to use an existing session that has been
// created.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f you do not use the command handler, replace the listener with
// null for the following AsyncCommandClient object.
AsyncCommandClient asyncCmdClientHelper = new

AsyncCommandClient (session, listener);
System.out.printIn("\nCreated async command client");

// Create the command that updates the asset.

String cmdName = "updateAsset";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // Update an asset
// using the session
// created.

System.out.printIn("\nCreated " + cmdName);

// Set the required assetID parameter.

// Examples of valid formats for the assetID parameter:

// - aName

// - assetname=aName

// - WebSphere:assetname=aName

// This parameter accepts an incomplete ID as long as the

// incomplete ID can resolve to a unique asset within the

// business-level application.

String assetID = "assetl.zip"; // Replace assetl.zip with your
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// value of the assetID parameter.
cmd.setParameter("assetID", assetID);

System.out.printin("\nSet assetID parameter to "
+ cmd.getParameter("assetID"));

// Set the required operation parameter.

// Possible operation values are add, addupdate, delete, merge,

// replace, and update.

// Use the add value to add a new file or Java EE module to the asset.

// Use the addupdate value to add a new file or Java EE module to the asset, or
// update an existing file or Java EE module.

// Use the delete value to delete an existing file or Java EE module in the asset.
// Use the merge value to provide a partial update with multiple

// additions, updates, or deletions.

// Use the replace value for a full update to replace all the contents.

// Use the update value to update an existing file or Java EE module in the asset.
String op = "add"; // Replace the add value with your operation value.
cmd.setParameter("operation", op);

System.out.printIn("\nSet operation parameter to "
+ cmd.getParameter("operation"));

// Set the contents parameter.
// This parameter is required unless the operation is set to
// delete.

String contents = "/assets/abc.txt"

cmd.setParameter("contents", contents);

System.out.printin("\nSet contents parameter to "
+ cmd.getParameter("contents"));

// Set the contenturi parameter.
// This parameter is required for the
//  add, addupdate, update, or delete operations.
String contenturi = "abc.txt"; // URI within the asset to
// place the new file. Replace
// with your value.
cmd.setParameter("contenturi", contenturi);
System.out.printIn("\nSet contenturi parameter to "
+ cmd.getParameter("contenturi"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printIn("Throwing an exception from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Run the command.
asyncCmdClientHelper.execute(cmd) ;
System.out.printIn("\nCompleted command execution");

CommandResult result = cmd.getCommandResult();
if (result != null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand executed successfully "
+ "with result\n" + result.getResult());
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else {
System.out.printIn("\nCommand executed with " +
"Exception");
result.getException().printStackTrace();
}

} catch (Exception e) {
e.printStackTrace();
1

1
package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification.
System.out.printin("\nEXAMPLE: notification received: " +
notification);

}
What to do next

You can do other tasks associated with assets in business-level applications, such as adding or deleting
other assets, listing assets, exporting assets, and so on.

Viewing a composition unit using programming

A composition unit is typically created from a business-level application or an asset and contains
configuration information that makes the asset runnable. You can view the composition unit information so
that you can complete other tasks associated with the composition unit such as editing an asset or delete
a composition unit.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interfaces documentation.

Before you can view a composition unit of a business-level application, you must have created an empty
business-level application, imported an asset into the business-level application, and added a composition
unit to the business-level application.

About this task

You can view a composition unit using programming, the administrative console, or the wsadmin tool. This
topic describes how to view a composition unit using programming.

You must provide the blalD and culD parameters to specify the composition unit of the business-level
application that you are viewing. You can view configuration information of the composition unit of a
business-level application. The configuration information identifies the asset from which the composition
unit is created if the composition unit contains an asset. You can also view runtime targets on which the
deployable units of the composition unit are to run.

Perform the following tasks to view a composition unit of a business-level application using programming.
1. Connect to the application server.
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The command framework allows the administrative command to be created and run with or without

being connected to the application server. This step is optional if the application server is not running.
2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is

passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command to
view a composition unit.

The command name is viewCompUnit. Use the required blalD and culD parameters to specify the

composition unit of the business-level application that you are viewing.

6. Call the processCommandParameters method in the asynchronous command client to process the

command parameters.
The command framework asynchronous command model requires this call.
7. Call the asynchronous command client to run the command and view a composition unit.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results

After you successfully run the code, you can view the configuration information of a composition unit for a
business-level application.

Example

The following example shows how to view a composition unit of a business-level application based on the
previous steps. Some statements are split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;

import

import
import
import
import
import
import
import
import
import

public

java.util.Properties;

com.
com.
com.
com.
com.
com.
com.
com.
com.

ibm.

ibm
ibm

ibm.
ibm.
ibm.
ibm.
ibm.

ibm

websphere.
.websphere.
.websphere.
websphere.
websphere.
websphere.
websphere.
websphere.
.websphere.

management
management
management
management

management

management

class ViewCompUnit {

.AdminClient;
.AdminClientFactory;
.Session;
management.
.cmdframework.CommandMgr;
management.
.cmdframework.CommandStep;
management.

cmdframework.AdminCommand;
cmdframework.CommandResult;

cmdframework.TaskCommand;

.async.client.AsyncCommandClient;
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public static void main(String [] args) {

try {
// Connect to the application server.
// This step is optional if you use the Tocal
// command manager. Comment out the lines to and including
// CommandMgr cmdMgr = CommandMgr.getClientCommandMgr (
// soapClient);
// to get the soapClient soap client if you use the Tocal
// command manager.
String host = "localhost";
String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();

config.put (AdminClient.CONNECTOR HOST, host);

config.put (AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printin("Config: " + config);

AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager:

/1

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printIn("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required:
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace the following Tistener with
// null for the AsyncCommandClient object.

AsyncCommandClient asyncCmdClientHelper = new

AsyncCommandClient (session, listener);

System.out.printin("\nCreated async command client");

// Create the command that views the composition unit.
String cmdName = "viewCompUnit";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // View a certain composition

// unit of a business-level

// application using the session created.
System.out.printIn("\nCreated " + cmdName);

// (required) Set the blaID parameter.

// Examples of valid formats for the blaID parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an incomplete ID as long as the incomplete
// 1D can resolve to a unique business-level application.
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String blaID = "blal";
cmd.setParameter("blaID", blalD);

System.out.printin("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));

// (required) Set the culD parameter to the composition unit.
// The culD parameter has the format of

// WebSphere:cuname=name. This parameter

// accepts an incomplete ID as long as the incomplete

// ID can resolve to a unique composition unit within the

// business-level application.

String culD = "cul";

cmd.setParameter("culID", culD);

System.out.printin("\nSet culD parameter to "
+ cmd.getParameter("cuID"));

// Call the asynchronous client helper to process parameters
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Call the asynchronous command client to run the command.
asyncCmdClientHelper.execute(cmd);
System.out.printin("\nCompleted running of the command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
1
}

} catch (Exception e) {

e.printStackTrace();

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification
System.out.printin("\nEXAMPLE: notification received: " +

notification);
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What to do next

You can use the information that you viewed about the composition unit to perform other tasks. For
instance, you might edit the asset in the composition unit to make improvements to the asset. You might
export the composition unit, and then import that composition unit into another business-level application.

Viewing an asset using programming

You can view the asset information so that you can complete other tasks associated with the asset, such
as editing or exporting an asset. An asset represents at least one binary file that implements business
logic.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interface documentation.

Before you can view an asset of a business-level application, you must have imported an asset.
About this task

You can view an asset using programming, the administrative console, or the wsadmin tool. This topic
describes how to view an asset using programming.

You must provide the assetID parameter to specify the asset you are viewing. You can view configuration
information of an asset, such as the destination location and relationships with other assets.

Perform the following tasks to view an asset of a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Use the command manager that you created in a previous step to create and set up the command to
view an asset.

The command name is viewAsset. Use the required assetlD parameter to specify the asset that you
are viewing.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
7. Call the asynchronous command client to run the command and view an asset.
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You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results

After you successfully run the code, you can view the configuration information of an asset.

Example

The following example shows how to view an asset based on the previous steps. Some statements are
split on multiple lines for printing purposes.

package com.ibm.ws.management.application.task;

import

import
import
import
import
import
import
import
import
import

public

java.util.Properties;

com
com
com
com
com
com
com
com
com

.ibm.websphere.management.AdminClient;
.ibm.websphere.management.AdminClientFactory;
.ibm.websphere.management.Session;
.ibm.websphere.management.cmdframework.AdminCommand;
.ibm.websphere.management.cmdframework.CommandMgr;
.ibm.websphere.management.cmdframework.CommandResult;
.ibm.websphere.management.cmdframework.CommandStep;
.ibm.websphere.management.cmdframework.TaskCommand;
.ibm.websphere.management.async.client.AsyncCommandClient;

class ViewAsset {

public static void main(String [] args) {

try {

// Connect to the application server.

// This step is optional if you use the local

// command manager. Comment out the Tines to and including

// CommandMgr cmdMgr = CommandMgr.getC1ientCommandMgr (

// soapClient);

// to get the soapClient soap client if you use the Tocal

// command manager.

String host = "Tocalhost";

String port = "8880"; // Change to your port number if it is
// not 8880.

Properties config = new Properties();
config.put(AdminClient.CONNECTOR_HOST, host);
config.put(AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR TYPE,

AdminClient.CONNECTOR TYPE_SOAP);
System.out.printin("Config: " + config);
AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager:

!/l
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// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required:
AsyncCmdTaskHandler Tistener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// If no command handler is used, replace the following Tistener with
// null for the AsyncCommandClient object:

AsyncCommandClient asyncCmdClientHelper = new

AsyncCommandClient (session, listener);

System.out.printin("\nCreated async command client");

// Create the command to view the asset.
String cmdName = "viewAsset";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // View a certain composition
// unit of a business-level application
// using the session created.
System.out.printin("\nCreated " + cmdName);

// (required) Set the assetID parameter to the asset.

// Examples of valid formats for the assetID parameter:
// - aName

// - assetname=aName

// - WebSphere:assetname=aName

// This parameter accepts an incomplete ID as long as the
// incomplete ID can resolve to a unique asset.

String assetID = "assetl.zip";
cmd.setParameter("assetID", assetID);

System.out.printin("\nSet assetID parameter to "
+ cmd.getParameter("assetID"));

// Call the asynchronous client helper to process parameters
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Call the asynchronous command client to run the command.
asyncCmdClientHelper.execute(cmd) ;
System.out.printIn("\nCompleted running of command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printin("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}

else {
System.out.printIn("\nCommand ran with " +
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"Exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
}

1
package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;

public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) f{
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

You can use the asset information that you viewed to perform other tasks. For instance, you might edit the
asset to make improvements to the asset. You might export the asset and then import it into another
configuration repository. You can then add the asset as a composition unit to a business-level application.

Viewing a business-level application using programming

You can view business-level application information such as the description so that you can do other tasks
associated with the business-level application, such as editing the business-level application. A
business-level application is an administrative model that captures the entire definition of an
enterprise-level application.

Before you begin

This task assumes a basic familiarity with command framework programming. Read about command
framework programming in the application programming interface documentation.

Before you can view a business-level application, you must have created the business-level application.

You can view a business-level application using programming, the administrative console, or the wsadmin
tool.

About this task
You must provide the blalD parameter to specify the business-level application that you are viewing.

Perform the following tasks to view a business-level application using programming.
1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.
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Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

Create the asynchronous command client.

An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

Use the command manager that you created in a previous step to create and set up the command to
view a business-level application.

The command name is viewBLA. Use the required blalD parameter to specify the business-level
application that you are viewing.

Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.
Display the command step.
Call the asynchronous command client to run the command to view a business-level application.

You could have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results

After you successfully run the code, you can view a business-level application.
Example

The following example shows how to view a business-level application based on the previous steps. Some

statements are split on multiple lines for printing purposes.
package com.ibm.ws.management.application.task;

import

import
import
import
import
import
import
import
import
import

public

java.util.Properties;

com.
com.
com.
com.
com.
com.
com.
com.
com.

ibm

ibm.
ibm.
ibm.
ibm.
ibm.

ibm
ibm

ibm.

.websphere.
websphere.
websphere.
websphere.
websphere.
websphere.
.websphere.
.websphere.
websphere.

class EditBLA {

management.
management.
management.
management.
management.
management.
management.
management.
management.

AdminClient;

AdminClientFactory;

Session;
cmdframework.AdminCommand;
cmdframework.CommandMgr;
cmdframework.CommandResult;
cmdframework.CommandStep;
cmdframework.TaskCommand;
async.client.AsyncCommandClient;

public static void main(String[] args) {

try {

// Connect to the application server.

// This step is optional if you use the Tocal command manager.

// Comment out the following lines to get the soapClient soap client if
// you are going to use the local command manager. You would
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// comment out the lines to and including
// CommandMgr cmdMgr =
// CommandMgr.getClientCommandMgr(soapClient);

String host = "localhost"; // Change to your host if it is not localhost.
String port = "8880"; // Change to your port number if it is not 8880.

Properties config = new Properties();
config.put(AdminClient.CONNECTOR_HOST, host);
config.put(AdminClient.CONNECTOR_PORT, port);
config.put(AdminClient.CONNECTOR_TYPE,

AdminClient.CONNECTOR TYPE_SOAP);
System.out.printIn("Config: " + config);
AdminClient soapClient =

AdminClientFactory.createAdminClient(config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous lines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager.

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();

System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following line if no further handling
// of command notification is required.
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

// This example creates a new session. You can replace the
// code below to use an existing session that has been

// created.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// If no command handler is used, replace the listener with
// null for the following AsyncCommandClient object.
AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient (session, Tistener);
System.out.printin("\nCreated async command client");

// Create the command.
String cmdName = "viewBLA";
AdminCommand cmd = cmdMgr.createCommand (cmdName) ;
cmd.setConfigSession(session); // View an existing
// business-level application
// using the session created.
System.out.printin("\nCreated " + cmdName);

// Set the required blaID parameter.

// Examples of valid formats for the blalD parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an incomplete ID as long as the incomplete
// 1D can resolve to a unique business-level application.

String blaID = "blal"; // Replace the blal value with your value.
cmd.setParameter("blaID", blalD);
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System.out.printin("\nSet blaID parameter to "
+ cmd.getParameter("blaID"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printIn("Throwing an exception from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Display step data.
String[] stepNames = ((TaskCommand) cmd).listCommandSteps();
for (int i = 0; i < stepNames.length; i++) {

// Get the step.
CommandStep step =
((TaskCommand)cmd) .gotoStep(stepNames[i]);

List paramNames = step.listParameterName();
System.out.printIn("---==------ Step: " + step.getName() +

// Get the parameter values for each row.
for (int j = 0; j < step.getNumberOfRows(); j++) {
System.out.printIn(" Row " + j);

for (int k = 0; k < paramNames.size(); k++)
System.out.printin(" " + paramNames.get (k) +
": " + step.getParameter(
(String) paramNames.get(k), j));

}

// Run the command to view the business-level application.
asyncCmdClientHelper.execute(cmd) ;
System.out.printin("\nCompleted command execution");

CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand executed successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand executed with " +
"Exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
}

}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;
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public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {

public void handleNotification(CommandNotification notification) {
// Add your own code here to handle the received notification.
System.out.printIn("\nEXAMPLE: notification received: " +
notification);

}
What to do next

You can use the information that you viewed about the business-level application to perform other tasks.
You might edit the business-level application to make improvements to it. You might start and stop a
business-level application, delete a business-level application, add a composition unit to a business-level
application, and so on.

Listing control operations using programming

You can list the control operations of a business-level application or a composition unit for a session. You
can use control operations, such as start or stop, to change or query the runtime environment of a
business-level application or a composition unit.

Before you begin

Before you can list control operations of a business-level application or a composition unit for a session,
you must have created an empty business-level application, imported an asset, and added a composition
unit.

About this task

You can list control operations of a business-level application or a composition unit using programming,
the administrative console, or the wsadmin tool. This topic describes how to list control operations using
programming.

To list control operations for a business-level application of a session, provide a blalD paramaeter value,
but no culD parameter value. To list control operations for a composition unit, specify both a blalD
parameter value and a culD parameter value. To list all control operations for the specified business-level
application or the specified composition unit, do not specify an opName parameter value. To list the details
for a specific control operation, set the opName parameter value to the name of the operation to list. To list
details of the control operation definition, set the long parameter to true.

Perform the following tasks to list control operations for a business-level application or a composition unit
of a session using programming.

1. Connect to the application server.

The command framework allows the administrative command to be created and run with or without
being connected to the application server. This step is optional if the application server is not running.

2. Create the command manager.

The command manager provides the functionality to create a new administrative command or query
existing administrative commands.

3. Optionally create the asynchronous command handler for listening to command notifications.

Business-level application commands are implemented as asynchronous commands. To monitor the
progress of the running command, you have to create an asynchronous command handler to receive
notifications that the command generates.

4. Create the asynchronous command client.
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An asynchronous command client provides a higher level interface to work with an asynchronous
command. If you created an asynchronous command handler in the previous step, the handler is
passed to the asynchronous command client. The asynchronous command client forwards the
command notification to the handler and helps to control running of the command.

5. Create and set up the command that lists control operations of a business-level application or a
composition unit of a session.

6. Call the processCommandParameters method in the asynchronous command client to process the
command parameters.

The command framework asynchronous command model requires this call.

7. Call the asynchronous command client to list the control operations of a business-level application or a
composition unit of a session.

You might have created an asynchronous command handler to implement the
AsyncCommandHandlerlF interface class in a previous step. If you did, the asynchronous command
client listens to command notifications and forwards the notifications to the handler. The handler
performs any necessary actions while waiting for the command to complete.

8. Check the command result when the command completes.

When the command finishes running, control is returned to the caller. You can then check the result by
calling the command.getCommandResult method.

Results

After you successfully run the code, a control operations of a business-level application or a composition
unit for a session is displayed.

Example

The following example shows how to list the control operation of a business-level application or a
composition unit of a session based on the previous steps. Some statements are split on multiple lines for
printing purposes.

package com.ibm.ws.management.application.task;
import java.util.Properties;

import com.ibm.websphere.management.AdminClient;

import com.ibm.websphere.management.AdminClientFactory;

import com.ibm.websphere.management.Session;

import com.ibm.websphere.management.cmdframework.AdminCommand;
import com.ibm.websphere.management.cmdframework.CommandMgr;

import com.ibm.websphere.management.cmdframework.CommandResult;
import com.ibm.websphere.management.async.client.AsyncCommandClient;

public class TistControlOps f{
public static void main(String[] args) {

try {

// Connect to the application server.
// This step is optional if you use the Tocal
// command manager. Comment out the lines to and including
// CommandMgr cmdMgr = CommandMgr.getClientCommandMgr (
// soapClient);
// to get the soapClient soap client if you use the Tocal
// command manager.
String host = "localhost";
String port = "8880"; // Change to your port number if
// it is not 8880.

Properties config = new Properties();
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config.put(AdminClient.CONNECTOR_HOST, host);

config.put(AdminClient.CONNECTOR_PORT, port);

config.put(AdminClient.CONNECTOR_TYPE,
AdminClient.CONNECTOR_TYPE_SOAP);

System.out.printin("Config: " + config);

AdminClient soapClient =
AdminClientFactory.createAdminClient (config);

// Create the command manager.
CommandMgr cmdMgr = CommandMgr.getClientCommandMgr(soapClient);

// Comment out the previous Tines to create a client command
// manager if you are using a local command manager.

// Uncomment the following line to create a local command

// manager:

//

// CommandMgr cmdMgr = CommandMgr.getCommandMgr();
System.out.printin("\nCreated command manager");

// Optionally create an asynchronous command handler.

// Comment out the following 1line if no further handling
// of command notification is required:
AsyncCmdTaskHandler listener = new AsyncCmdTaskHandler();

// Create an asynchronous command client.

// Set up the session.

String id = Long.toHexString(System.currentTimeMillis());
String user = "content" + id;

Session session = new Session(user, true);

// 1f no command handler is used, replace Tistener with

// null for the AsyncCommandClient object.

AsyncCommandClient asyncCmdClientHelper = new
AsyncCommandClient(session, Tistener);

System.out.printin("\nCreated async command client");

// Create the command that lists the control operations.

String cmdName = "TistControlOps";

AdminCommand cmd = cmdMgr.createCommand (cmdName) ;

cmd.setConfigSession(session); // List all the control operations
// using the session created.

System.out.printIn("\nCreated " + cmdName);

// Set the blaID parameter, which is required.

// The blalD is for either the business-level application whose control
// units you are listing or for the business-level application whose
// composition unit control operations you are listing.

// Change the blaID parameter according to your

// scenario.

// Examples of valid formats for the blaID parameter are:

// - bName

// - blaname=bName

// - WebSphere:blaname=bName

// This parameter accepts an incomplete ID as long as the incomplete
// 1D can resolve to a unique business-level application.

// String blaID = "blal";

// cmd.setParameter("blaID", blalD);

// System.out.printin("\nSet blaID parameter to "
// + cmd.getParameter("blaID"));

// Optionally set the culD parameter to the composition
// unit whose control operations you are listing.

// Examples of valid formats for the culD parameter are:
// - name
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// - cuname=name

// - WebSphere:cuname=name

// This parameter accepts an incomplete ID as long as the
// incomplete ID can resolve to a unique composition unit
// within the business-level application.

//

// String culD = "test5.zip";

// cmd.setParameter("cuID", culD);

// System.out.printin("\nSet culD parameter to "
// + cmd.getParameter("culD"));

// Optionally set the opName parameter of the operation to Tlist.
// String opName = "opNamel";
// cmd.setParameter("opName", opName);

// System.out.printin("\nSet opnamelD parameter to "
// + cmd.getParameter("opName"));

// Optionally include details of the control operation definition
// by setting the long parameter to true.

// String long = "true";

// cmd.setParameter("long", long);

// System.out.printin("\nSet long parameter to "
// + cmd.getParameter("long"));

// Call the asynchronous client helper to process parameters.
try {
asyncCmdClientHelper.processCommandParameters (cmd) ;
System.out.printin("\nCompleted process command " +
"parameters");
} catch (Throwable th) {
System.out.printin("Failed from " +
"asyncCmdClientHelper.processCommandParameters(cmd).");
th.printStackTrace();
System.exit(-1);
}

// Run the command to Tist control operations.
asyncCmdClientHelper.execute(cmd) ;
System.out.printIn("\nCompleted running of command");

// Check the command result.
CommandResult result = cmd.getCommandResult();
if (result !'= null) {
if (result.isSuccessful()) {
System.out.printIn("\nCommand ran successfully "
+ "with result\n" + result.getResult());
}
else {
System.out.printIn("\nCommand ran with " +
"Exception");
result.getException().printStackTrace();
}
}
} catch (Exception e) {
e.printStackTrace();
1

}

package com.ibm.ws.management.application.task;

import com.ibm.websphere.management.cmdframework.provider.CommandNotification;
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import com.ibm.websphere.management.async.client.AsyncCommandHandlerIF;
public class AsyncCmdTaskHandler implements AsyncCommandHandlerIF {
public void handleNotification(CommandNotification notification) f{
// Add your own code here to handle the received notification
System.out.printIn("\nEXAMPLE: notification received: " +
notification);
}
What to do next

You can complete other tasks associated with business-level applications and composition units, such as
deleting, starting, or stopping business-level applications or adding or exporting a composition unit.
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Chapter 9. Troubleshooting deployment

When you are having problems deploying an application, perform some basic diagnostics and verify your
system’s configuration to solve the problem.

» Select the problem you are having with deploying or installing developed code for WebSphere
Application Server.
— |[Errors or problems deploying, installing, or promoting applications|

» To troubleshoot other deployment issues, use the following resources.
— For current information available from IBM Support on known problems and their resolution, see the
page.
— IBM Support has documents that can save you time gathering information needed to resolve this
problem. Before opening a PMR, see the IBM Support page.
— If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, see I'I'roubleshooting help from IBM,

Application deployment problems

You might encounter problems when deploying, installing, or promoting applications. This topic suggests
ways to resolve the problems.

What kind of problem are you having?

* [[Linstalled my application using the wsadmin tool, but the application does not display under|
Applications > Application Types > WebSphere enterprise applications” on page 282

+ [“Unable to save a deployed application” on page 282|
+ ["WASX7015E error running wsadmin command $AdminApp installinteractive or $AdminApp install” on|

page 282|

+ [“Cannot install a CMP or BMP entity bean in an EJB 3.0 module” on page 282|
+ [“Data definition language (DDL) generated by an assembly tool throws SQL error on target platform” on|

page 283|

+ [“Error message ADMAOOO4E: Validation error in task Specifying the Default Datasource for EJB|
Modules returned when installing application using the administrative console or the wsadmin tool” on|

page 283|

+ [‘Cannot load resource WEB-INF/ibm-web-bnd.xmi in archive file” on page 284

+ [“Timeout!!!" error displays when attempting to install an enterprise application in the administrative]
console ” on page 284|

+ [“I get a NameNotFoundException message when deploying an application that contains an EJB|
module” on page 284|

« [“I get compilation errors and EJB deploy fails when installing an EJB JAR file generated for Version 5.x
or earlier” on page 284|

[‘After installing the application onto a different machine, the application does not run” on page 285|
[“A single file replaces all application files during application update” on page 285

Check the following first:

» Verify that the logical name that you have specified to appear on the console for your application,
enterprise bean module or other resource does not contain invalid characters such as these: - /\:*? "
<>l

« If the application was installed using the wsadmin $AdminApp install command with the -local flag,
restart the server or rerun the command without the -1ocal flag.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, check to see if the problem is identified and documented.
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| installed my application using the wsadmin tool, but the application does not
display under Applications > Application Types > WebSphere enterprise
applications

The application might be installed but you have not saved the configuration:
1. Verify that the application subdirectory is located under the lapp_server_rooffinstalledApps directory.
2. Run the $AdminApp list command and verify that the application is not among those displayed.
* In the bin directory, run the wsadmin.bat or wsadmin.sh command.
* From the wsadmin prompt, enter $AdminApp 1ist and verify that the problem application is not
among the items that display.
3. Reinstall your application using the wsadmin tool. Run the $AdminConfig save command in the
wsadmin tool before exiting.

Unable to save a deployed application

If you are unable to save a deployed application, the problem might be that too many files are opened,
exceeding the limit of the operating system.

Only root has authority to adjust the maximum number of files for each process. Complete the following
steps to modify the application to close files with disciplines:

1. After you open a file and complete your work, call the close method of the file to release the file handle
back to the operating system.

2. Using the java.io.FilelnputStream and the FileOutputStream classes as examples, you can invoke their
close method to release any system resources that are associated with the stream.

WASX7015E error running wsadmin command $AdminApp installInteractive or
$AdminApp install

This problem has two possible causes:
 If the full text of the error is similar to:
WASX7015E: Exception running command:
"$AdminApp installInteractive C:/Documents and Settings/
myUserName/Desktop/MyApp/myapp.ear";
exception information:
com.ibm.bsf.BSFException: error while
eval'ing Jacl expression: can't find method "installInteractive"
with 3 argument(s) for class
"com.ibm.ws.scripting.AdminAppClient"

The file and path name are incorrectly specified. In this case, since the path included spaces, it was
interpreted as multiple parameters by the wsadmin program.
Enter the path of the .ear file correctly. In this case, by enclosing it in double quotes:

$AdminApp installInteractive "C:\Documents
and Settings\myUserName\Desktop\MyApps\myapp.ear"
* If the full text of the error is similar to:
WASX7015E: Exception running command: "$AdminApp installInteractive c:\MyApps\myapp.ear ";
exception information: com.ibm.ws.scripting.ScriptingException: WASX7115E:
Cannot read input file
"c:\WebSphere\AppServer\bin\MyAppsmyapp.ear"

The application path is incorrectly specified. In this case, you must use "forward-slash” (/) separators in
the path.

Cannot install a CMP or BMP entity bean in an EJB 3.0 module

When installing an EJB 3.0 module that contains a container-managed persistence (CMP) or
bean-managed persistence (BMP) entity bean, the installation fails.
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The product does not support installation of applications that have a CMP or BMP entity bean packaged in
an EJB 3.0 module. You must package CMP or BMP entity beans in an EJB 2.1 or earlier module.

To resolve this problem:
1. Package the CMP or BMP entity beans in EJB 2.1 or earlier modules.
2. Try installing your application with the EJB 2.1 or earlier modules.

Data definition language (DDL) generated by an assembly tool throws SQL error
on target platform

If you receive SQL errors in attempting to execute data definition language (DDL) statements generated by

anon a different platform, for example if you are deploying a container-managed

persistence (CMP) enterprise bean designed on Windows onto a UNIX® operating system server, try the

following actions:

» Browse the DDL statements for dependencies on specific user identifiers and passwords, and correct as
necessary.

» Browse the DDL statements for dependencies on specific server names, and correct as necessary.

» Refer to the message reference of the vendor for causes and suggested actions regarding specific SQL
errors. For IBM DB2, you can view the message references online at http://www.ibm.com/cgi-bin/|
[db2www/data/db2 /udb/winos2unix/support/index.d2w/report]

If you receive the following error after executing a DDL file created on the Windows operating system or
on operating systems such as AIX® or Linux, the problem might come from a difference in file formats:
SQLO104AN An unexpected token "CREATE TABLE AGENT (COMM DOUBLE, PERCENT DOUBLE, P"

was found following " ". Expected tokens may include: " ".
SQLSTATE=42601

To resolve this problem:
* Use EDTF to edit the file.

Error message ADMAOOO4E: Validation error in task Specifying the Default
Datasource for EJB Modules returned when installing application using the
administrative console or the wsadmin tool

If you see the following error when trying to install an application through the administrative console or the
wsadmin command prompt:

AppDeploymentException: [ADMAOGO14E: Validation failed.

ADMAGOO4E: Validation error in task Specifying the Default Datasource for

EJB Modules JNDI name is not

specified for module beannameBean Jar with URI filename.jar,META-INF/ejb-jar.xml.

You have not specified the

data source for each CMP bean belonging to this module. Either specify the data

source for each CMP beans or

specify the default data source for the entire module.]

one possible cause is that, in WebSphere Application Server Version 4.0, it was mandatory to have a data
source defined for each CMP bean in each JAR. In Version 5.0 and later releases, you can specify either
a data source for a container-managed persistence (CMP) bean or a default data source for all CMP
beans in the JAR file. Thus during installation interaction, such as the installation wizard in the
administrative console, the data source fields are optional, but the validation performed at the end of the
installation checks to see that at least one data source is specified.

To correct this problem, step through the installation again, and specify either a default data source or a
data source for each CMP-type enterprise bean.

If you are using the wsadmin tool, use the $AdminApp installInteractive filename command to receive
prompts for data sources during installation, or to provide them in a response file.
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Specify data sources as an option to the $AdminApp install command.
Cannot load resource WEB-INF/ibm-web-bnd.xmi in archive file

The Web application tmp.war installs on WebSphere Application Server Versions 5.0 and 5.1, but fails on a
WebSphere Application Server Version 6.0 or later server. The application fails to install because the
WEB-INF/ibm-web-bnd.xmi file contains xmi tags that the underlying WCCM model no longer recognizes.

The following error messages display:

IWAEQOO7E Could not Toad resource "WEB-INF/ibm-web-bnd.xmi" in archive "tmp.war"
[2/24/05 14:53:10:297 CST] 000000bc SystemErr R

AppDeploymentException:
com.ibm.etools.j2ee.commonarchivecore.exception.ResourcelLoadException:

IWAEQOO7E Could not Toad resource "WEB-INF/ibm-web-bnd.xmi" in archive "tmp.war"
[2/24/05 14:53:10:297 CST] 000000bc SystemErr R
com.ibm.etools.j2ee.commonarchivecore.exception.ResourcelLoadException:

IWAEQOO7E Could not Toad resource "WEB-INF/ibm-web-bnd.xmi" in archive "tmp.war"
IStack_trace_of nested exce!
com.ibm.etools.j2ee.exception.WrappedRuntimeException: Exception occurred Toading
WEB-INF/ibm-web-bnd.xmi

IStack_trace_of_nested_exce!

To work around this problem, remove the xmi:type=EJBLocalRef tag from the ibm-web-bnd.xmi file.
Removing this tag does not affect the application because the tag was previously used for matching the
cross document reference type. The application now works for the WebSphere Application Server Version
5.1 and later releases.

"Timeout!!!” error displays when attempting to install an enterprise application in
the administrative console

This error can occur if you attempt to install an enterprise application that has not been deployed.

To correct this problem:

« Open the file_name.ear file in an[assembly toolland then click Deploy. This action creates a file with a
name like Deployed file name.ear.

* In the administrative console, install the deployed .ear file.

| get a NameNotFoundException message when deploying an application that
contains an EJB module

If you specify that the EJB deployment tool be run during application installation and the installation fails
with a NameNotFoundException message, ensure that the input JAR or EAR file does not contain source
files. If there are source files in the input JAR or EAR file, the EJB deployment tools runs a rebuild before
generating the deployment code.

To work around this problem, either remove the source files or include all dependent classes and resource
files on the class path. Otherwise, the source files or the lack of access to dependent classes and
resource files might cause problems during rebuilding of your application on the server.

| get compilation errors and EJB deploy fails when installing an EJB JAR file
generated for Version 5.x or earlier

When installing an old application that uses EJB modules that were built to run on WebSphere Application
Server Version 5.x or earlier, compilation errors result and EJB deploy fails. The EJB JAR file contains
Java source for the old generated code. The old Java source was generated for Version 5.x or before but,
when deployed to a WebSphere Application Server Version 6.x product, it is compiled using the Version
6.x runtime JAR files.
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To work around this problem, remove all . java files from the application .ear file. After the Java source
files are removed, you can deploy the application onto a server successfully.

After installing the application onto a different machine, the application does not
run

If your application uses application level resources, its application level node information must be correct
for the application to run as expected.

When you add application level resources to an application and deploy the application onto a machine,
ensure that the application level node information is correct. Otherwise, when you install the application
onto a different machine, it is installed to the wrong location and the application does not run as expected.

You can update the application level node information using an [assembly tool. Update the nodeName from
deploymentTargets of the deployment.xml file under ibmconfig. Also, ensure that binariesURL from
deployedObiject of the deployment.xml file has the correct path.

A single file replaces all application files during application update

If you select the Replace or add a single file option of the [application update wizard and the currently
deployed application consists of several files, specify the full path name of the file to be replaced or added
for Specify the path beginning with the installed application archive file to the file to be replaced or
added.

A full path name usually has the structure directory_path/file_name and resembles the following:
PriceChangeSession.jar/priceChangeSession/priceChangeSessionBean.class

Do not specify less than the full path name for Specify the path beginning with the installed
application archive file to the file to be replaced or added. For example, do not specify only a directory
path:

PriceChangeSession.jar/priceChangeSession

If you specify less than a full path name, all files in the directory of the currently deployed application might
be replaced by the single new file that was specified under Specify the path to the file.

Application deployment troubleshooting tips

When you first test or run a deployed application, you might encounter problems.

Select the problem you are having with testing or the first run of deployed code for WebSphere Application
Server:

« [Server startup problems|

« [“Application startup problems” on page 291

* |“Web resource is not displayed” on page 294.|

 |Data access problems|.

 |Enterprise bean cannot be accessed from a servlet, a JSP file, a stand-alone program, or another cIientl
+ |Application access problems|

* [Access problems after enabling security|

» [Security enablement followed by errors]|

* |Secure Sockets Layer errors|

* |Application client sending SOAP request receives errorsl.

« [“A client program does not work” on page 286

* |WebSphere MQ connection and queue connection factory creation errorsl

You can use the following administrative console panels to inspect the configuration of your applications
and JMS resources:
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 For a view of the JMS resources for a given application, see the following panel: [Messaging resources
[for this application]

* For a view of the applications and JMS resources for a given default messaging provider destination,
see the following panel: [Application resources for this destination|

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, see [Troubleshooting help from IBM

For current information available from IBM Support on known problems and their resolution, see the

page.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the |Must gather documentsI page for information to gather to send to IBM
Support page.

A client program does not work

What kind of problem are you seeing?

ActiveX client fails to display ASP files, or WebSphere Application Server
resources (JSP files, servlet, or HTML pages) or both

A possible cause of this problem is that both 1IS for serving Active Server Pages (ASP) files and an HTTP
server that supports WebSphere Application Server (such as IBM HTTP Server) are deployed on the same
host. This deployment leads to misdirected HTTP traffic if both servers are listening on the same port
(such as the default port 80).

To resolve this problem, either:

* Open the IIS administrative panel, and edit the properties of the default Web server to change the port
number to a value other than 80

* Install IS and the HTTP server on separate servers.

For current information available from IBM Support on known problems and their resolution, see the
Support| page.

Plants by WebSphere Catalog Manager (pbwsCatalogMgr) exceptions

When you federate a standalone server into a Deployment Manager cell, the bootstrap port number of the

application server may change. This will cause the client to not be able to communicate with the server,

thus causing an exception. The following scenario may cause an exception when you start Plants by

WebSphere:

1. Install a standalone WebSphere Application Server.

2. Run the Plants by WebSphere example.

3. Create a Deployment Manager (DMGR) using the Profile Management tool or by using the
manageprofiles command.

4. Federate the standalone WebSphere Application Server into a Deployment Manager cell using the
addNode command.

5. Start pbwsCatalogMgr.

To avoid the exception, locate the new (changed) port number on the server and modify the client
configuration to match the port number on the server.

1. Go to was_server_root\profiles\your_server_name\config\cells\your cell\nodes\your node.
a. Open the serverindex.xml file.
b. Locate the BOOTSTRAP_ADDRESS port number of the application server, for example 9810.
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2. Assign this port number to the client to communicate with your newly-federated application server. Go
to was_client_root\bin and edit the setupClient.bat file.

3. Locate the line 'SET SERVERPORTNUMBER' and set the value for it to 9810.

If you have security enabled, ensure that the bus security is also enabled and that a user is defined to
the bus connector role before running pbwsCatalogMgr.

4. Restart the node agent and the application server.

The client is now properly set up to start pbwsCatalogMgr.

IBM Support has documents that can save you time gathering information needed to resolve this problem.
Before opening a PMR, see the [IBM Supporf page.

Application startup errors

Use this information for troubleshooting problems that occur when starting an application.

What kind of error do you see when you start an application?

+ [‘HTTP server and Application Server are working separately, but requests are not passing from HTTP|
server to Application Server’]

+ [“File serving problems” on page 288|

+ [“Graphics do not appear in the JSP file or servlet output” on page 288|

+ [‘SRVEO026E: [Servlet Error]-[Unable to compile class for JSP file” on page 289

« [“After modifying and saving a JSP file, the change does not show up in the browser (the old JSP file]
displays)” on page 290

+ [‘Message like "Message: /jspname.jsp(9,0) Include: Mandatory attribute page missing” appears when|
attempting to browse JSP file” on page 290]

« [‘The Java source generated from a JSP file is not retained in the temp directory (only the class file is]
found)” on page 290

« [‘The JSP Batch Compiler fails with the message "Enterprise Application [application name you typed in]|
not found.”” on page 291|

« [‘There is a translation problem with non-English browser input” on page 291|

« [“Scroll bars do not appear around items in the browser window” on page 291|

« [“Error "Page cannot be displayed... server not found or DNS error” appears when attempting to browse|
a JavaServer Pages (JSP) file using Internet Explorer” on page 291|

HTTP server and Application Server are working separately, but requests are not
passing from HTTP server to Application Server

If your HTTP server appears to be functioning correctly, and the Application Server also works on its own,
but browser requests sent to the HTTP server for pages are not being served, a problem exists in the
WebSphere Application Server plug-in.

In this case:

1. Determine whether the HTTP server is attempting to serve the requested resource itself, rather than
forwarding it to the WebSphere Application Server.
a. Browse the HTTP server access log (IHS install root/1ogs/access.log for IBM HTTP Server). It
might indicate that it could not find the file in its own document root directory.
b. Browse the plug-in log file as described below.

2. Refresh the plugin-cfg.xml file that determines which requests sent to the HTTP server are forwarded
to the WebSphere Application Server, and to which Application Server.

Use the console to refresh this file:

* In the WebSphere Application Server administrative console, expand the Environment tree control.
» Click Update WebSphere Plugin.

» Stop and restart the HTTP server.
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If you are using IBM HTTP Server for iSeries or Lotus® Domino® for iSeries, you do not need to
restart the HTTP server.
* Retry the Web request.

If you have created a Web server definition to model your Web server instance, the file is located
under config/cells/cell_name/nodes/Web_server_node_name/servers/Web_server_name.
If you have not, the file is located under config/cells.

3. Browse the plugin_install_root/10gs/web_server_name/http_plugin.log file for clues to the problem.
Make sure the timestamps with the most recent plug-in information stanza, which is printed out when
the plug-in is loaded, correspond to the time the Web server started.

4. Turn on plug-in tracing by setting the LogLevel attribute in the plugin-cfg.xml file to Trace and
reloading the request. Browse the plugin_install_root/10gs/Web_server_name/http_plugin.log file.
You should be able to see the plug-in attempting to match the request URI with the various URI
definitions for the routes in the plugin-cfg.xml. Check which rules the plug-in is not matching against
and then figure out if you need to add additional ones. If you just recently installed the application you
might need to manually regenerate the plug-in configuration to pick up the new URIs related to the
new application.

For further details on troubleshooting plug-in-related problems, see Webserver plug-in troubleshooting tips
located in the Administering applications and their environment PDF book.

File serving problems

If text output appears on your JSP- or servlet-supported Web page, but image files do not:

» Verify that your files are in the right place: the document root directory of your Web application
WebSphere Application Server follows the J2EE standard, which means that the document root is the
Web_module_name.war directory of your deployed Web application.

Typically this directory will be found in the profile_root/installedApps/nodename/appname.ear directory or
profile_root/installedApps/nodename/appnameNetwork.ear directory.

If the files are in a subdirectory of the document root, verify that the reference to the file reflects that.

That is, if the invoices.html file is stored in Windows directory Web_module_name.war\invoices, then

links from other pages in the Web application to display it should read "invoices\invoices.htm1”, not
"invoices.html”.

» Verify that your Web application is configured to enable file serving (in other words, that it is enabled to
display static resources like image and .html files):

1. View the file serving property of the hosting Web module by browsing the source .war file in an
assembly tool. If necessary, update the property and redeploy the module. For more information
about the assembily tool, refer to the assembly tools section of the Developing and deploying
applications PDF book.

2. Edit the fileServingEnabled property in the deployed Web application ibm-web-ext.xmi
configuration file.

The file typically is found in the /config/ce] 1s/nodename or nodenameNetwork/

applications/application_name/deployments/application name/Web_module name/web-inf
directory.

Graphics do not appear in the JSP file or serviet output

If text output appears on your JSP- or -servlet-supported Web page, but image files do not:

 Verify that your graphic files are in the right place: the document root directory of your Web
application. WebSphere Application Server Version 5 follows the J2EE standard, which means that the
document root is the Web_module_name.war directory of your deployed Web application.

Typically, this directory is found in the instalIedApps/nodename/appname.ear directory or
“

rofile_rooyinstalledApps/nodename/appnameNetwork.ear directory.
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If the graphics files are in a subdirectory of the document root, verify that the reference to the graphic
reflects that; for example, if the banner.gif file is stored in Windows directory Web_module_name.war/
images, the tag to display it should read: <img SRC="images/banner.gif">, not <img SRC="banner.gif">.

» Verify that your Web application is configured to enable file serving (that is, display of static resources
like image and .html files).

1. View the file serving property of the hosting Web module by browsing the source .war file in an
assembly tool. If necessary, update the property and redeploy the module. For more information
about the assembly tool, refer to the assembly tools section of the Developing and deploying
applications PDF book.

2. Edit the fileServingEnabled property in the deployed Web application ibm-web-ext.xmi
configuration file.

The file typically is found in the profile root|/config/cells/nodename or nodenameNetwork/

applications/application _name/deployments/application name/Web_module name/web-inf
directory.
3. After completing the previous step:
— In the administrative console, expand the Environment tree control .
— Click Update WebSphere Plugin.
— Stop and restart the HTTP server and retry the Web request.

SRVEO0026E: [Serviet Error]-[Unable to compile class for JSP file

If this error appears in a browser when trying to access a new or modified .jsp file for the first time, the
most likely cause is that the JSP file Java source failed (was incorrect) during the javac compilation phase.

Check the [SystemErr.log file| for a compiler error message, such as:

C:\WASROOT\temp\ ... test.war\_myJsp.java:14: \Duplicate variable declaration: int myInt was int myInt
int myInt = 122;

String myString = "number is 122";

static int myStaticInt=22;

int myInt=121;

Fix the problem in the JSP source file, save the source and request the JSP file again.

If this error occurs when trying to serve a JSP file that was copied from another system where it ran
successfully, then there is something different about the new server environment that prevents the JSP file
from running. Browse the text of the error for a statement like:

Undefined variable or class name: MyClass

This error indicates that a supporting class or jar file is not copied to the target server, or is not on the
class path. Find the MyClass.class file, and place it on the Web module WEB-INF/classes directory, or
place its containing .jar file in the Web module WEB-INF/lib directory.

Verify that the URL used to access the resource is correct by doing the following:

» For a JSP file, htm1 file, or image file: http://host_name/Web_module_context_root/subdir under doc
root, if any/filename.ext. The document root for a Web application is the application_name .WAR
directory of the installed application.

— For example, to access the mydJsp.jsp file, located in c:\WebSphere\ApplicationServeninstalledApps\
myEntApp.ear\myWebApp.waninvoices on myhost.mydomain.com, and assuming the context root for
the myWebApp Web module is myApp, the URL is http://myhost.mydomain.com/myApp/invoices/
myJsp.Jsp.

— JSP serving is enabled by default. File serving for HTML and image files must be enabled as a
property of the Web module, in an assembly tool, or by setting the fileServingEnabled property to
true in the ibm-web-ext.xmi file of the installed Web application and restarting the application. For
more information about the assembly tool, refer to the assembly tools section of the Developing and
deploying applications PDF book.
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» For servlets served by class name, the URL is http://hostname/Web_module context_root/serviet/
packageName. className.

For example, to access myCom.myServlet.class, located in profile_root/installedApps/myEntApp.ear/
myWebApp.war/WEB-INF/classes, and assuming the context root for the myWebApp module is
"myApp”, the URL would be http://myhost.mydomain.com/myApp/servlet/myCom.MyServiet.

« Serving servlets by class name must be enabled as a property of the Web module, and is enabled by
default. File serving for HTML and image files must be enabled as a property of the Web application, in
an assembly tool, or by setting the fileServingEnabled property to true in the ibm-web-ext.xmi file of
the installed Web application and restarting the application. For more information about the assembly
tool, refer to the assembly tools section of the Developing and deploying applications PDF book.

Correct the URL in the "from” HTML file, servlet or JSP file. An HREF with no leading slash (/) inherits the

calling resource context. For example:

* an HREF in http://[hostname] /myapp/serviet/MyServiet to "ServletB” resolves to
"http://hostname/myapp/serviet/ServietB”

* an HREF in http://[hostname] /myapp/serviet/MyServiet to "serviet/ServietB” resolves to
"http://hostname/myapp/serviet/serviet/ServietB” (an error)

* an HREF in http://[hostname] /myapp/serviet/MyServiet to "/ServietB” resolves to
"http://hostname/ServietB” (an error, if ServietB requires the same context root as MyServiet)

After modifying and saving a JSP file, the change does not show up in the
browser (the old JSP file displays)

It is probable that the Web application is not configured for servlet reloading, or the reload interval is too
high.

To correct this problem, in an assembly tool, check the Reloading Enabled flag and the Reload Interval
value in the IBM Extensions for the Web module in question. Enable reloading, or if it is already enabled,
then set the Reload Interval lower. For more information about the assembly tool, refer to the assembly
tools section of the Developing and deploying applications PDF book.

Message like "Message: /jspname.jsp(9,0) Include: Mandatory attribute page
missing” appears when attempting to browse JSP file

It is probable that the JSP file failed during the translation to Java phase. Specifically, a JSP directive, in
this case an Include statement, was incorrect or referred to a file that could not be found.

To correct this problem, fix the problem in the JSP source, save the source and request the JSP file again.

The Java source generated from a JSP file is not retained in the temp directory
(only the class file is found)

It is probable that the JSP processor is not configured to keep generated Java source.

In an assembly tool, check the JSP Attributes under Assembly Property Extensions for the Web
module in question. Make sure the keepgenerated attribute is there and is set to true. If not, set this
attribute and restart the Web application. To see the results of this operation, delete the class file from the
temp directory to force the JSP processor to translate the JSP source into Java source again. For more
information about the assembly tool, refer to the assembly tools section of the Developing and deploying
applications PDF book.
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The JSP Batch Compiler fails with the message "Enterprise Application
[application name you typed in] not found.”

It is probable that the full enterprise application path and name, starting with the .ear subdirectory that
resides in the applications directory is expected as an argument to the JspBatchCompiler tool, not just
the display name.

The directory path is config/cells/node_nameNetwork/applications.

For example:

e "JspBatchCompiler -enterpriseapp.name sampleApp.ear/deployments/sampleApp” is correct, as
opposed to

» "JspBatchCompiler -enterpriseapp.name sampleApp”, which is incorrect.

There is a translation problem with non-English browser input
If non-English-character-set browser input cannot be translated after being read by a servlet or JSP file,

ensure that the request parameters are encoded according to the expected character set before reading.
For example, if the site is Chinese, the target . jsp file should have a line:

req.setCharacterEncoding("gb2312");
before any req.getParameter method calls.

This problem affects servlets and jsp files ported from earlier versions of WebSphere Application Server,
which converted characters automatically based upon the locale of the WebSphere Application Server.

Scroll bars do not appear around items in the browser window

In some browsers, tree or list type items that extend beyond their allotted windows do not have scroll bars
to permit viewing of the entire list.

To correct this problem, right-click on the browser window and click Reload from the menu.

Error "Page cannot be displayed... server not found or DNS error” appears when
attempting to browse a JavaServer Pages (JSP) file using Internet Explorer

This error can occur when an HTTP timeout causes the servant to be brought down and restarted. To
correct this problem, increase the ConnectionlOTimeOQut value:

1. From the administrative console, select System administration > Deployment manager >
Administration Services > Custom Properties

2. Select ConnectionlOTimeOut.
3. Increase the ConnectionlOTimeOut value.
4. Click OK.

Application startup problems

When an application is not starting or starting with errors, the problem could be from one of various
sources.

What kind of error do you see when you start an application?

+ Aljava.lang.ClassNotFoundException: classname Bean_AdderServiceHome_04f0e027Bean” on pagel
[292] error occurs

« Al‘ConnectionFac E J_20A0102E: Invalid EJB component: Cannot use an EJB module with version 1.1|
[using The Relational Resource Adapter’ on page 292 error occurs

Chapter 9. Troubleshooting deployment 291



 ['NMSVO0605E: "A Reference object looked up from the context...” error when starting an application” on|
page 293
- [“A Page Not Found, Array Index Out of Bounds, or other error when an updated application restarts” on|

page 293|

If none of these errors match the error you see:

« |Browse the log files|of the application server for this application looking for clues. By default, these files
are: |app_server_r0011/1ogs/server_name/SystemErr.109 and SystemOut.Tog.

» Look up any error or warning messages in the message reference table by clicking the Reference view
and expanding Messages.

If you do not see a problem that resembles yours, or if the information provided does not solve your
problem, see [Troubleshooting help from IBM

java.lang.ClassNotFoundException: classname
Bean_AdderServiceHome_04f0e027Bean

An similar exception occurs when you try to start an undeployed application containing enterprise beans,
or containing undeployed enterprise bean modules.

Enterprise JavaBeans modules created in an intentionally have incomplete configuration
information. Deploying these modules completes the configuration by reading the module’s deployment
descriptor and completing platform- or installation-dependent settings and adding related classes to the
Enterprise JavaBeans JAR file.

To avoid this problem, do the following:
* Use an assembly tool and administrative console to generate deployment code and install the
application or Enterprise JavaBeans module onto a server.
1. Uninstall the [application| or [Enterprise JavaBeans module|in the administrative console.
2. Configure your assembly tool so the target server is a WebSphere Application Server installation
such as WebSphere Application Server v6. If you do not have access to the target server, you can
specify a false location such as c:\temp. Specifying a false location enables you to assemble and

generate deployment code for the enterprise bean.

3. In the Project Explorer view of an right-click the enterprise bean (Enterprise
JavaBeans) in the undeployed .ear file containing the Enterprise JavaBeans module or the
standalone undeployed Enterprise JavaBeans JAR file, and click Deploy. If your assembly tool can
access the WebSphere Application Server target server, deployment code is generated for the
Enterprise JavaBeans and the assembly tool attempts to install the application or module onto the
target server. If your assembly tool cannot access the WebSphere Application Server target server
or the installation fails, use the deployment code that is generated for the next step.

For information on using an assembly tool, refer to [Chapter 3, “Assembling applications,” on page|
4. Use the wsadmin $AdminApp install command or the |administrative console to installl the deployed
version created by the assembly tool.
* If you use the wsadmin $AdminApp install command, uninstall it and then reinstall using the -EJ